Introduction

Thank you for purchasing SoftBank 930CA.

@ For proper handset use, read this guide.

@ Keep this guide in a convenient place for reference.

@ Accessible SoftBank services may vary by service area, subscription, etc.

SoftBank 930CA is compatible with 3G network technology.

Notes

- Copying this guide in whole or part without authorization is prohibited.

- Content of this guide is subject to change without prior notice.

- Efforts have been made to ensure the accuracy and clarity of this guide. Please contact SoftBank Customer Center, General
Information (P. 15-52) about unclear or missing information.

@ Download the latest edition of this guide from SOFTBANK MOBILE Corp. Website.
http://mb.softbank.jp/mb/r/support/930ca/




Befo sing This Guide

@ SoftBank 930CA is referred to as “handset” in this guide.

@ Most operation descriptions are based on default settings and begin in Standby.

@ Sample screenshots* are provided for reference only. Actual handset windows, menus, etc. may differ
in appearance.

@ Key illustrations are simplified and differ in appearance from actual handset keys.

@ “(Japanese)” appears next to functions or services which require Japanese ability to use.

* Standby Display used in this guide is based on SoftBank 930CA Red model. Design theme of Main
Menu and windows is based on default settings.
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Basic Operations

Learn basic menu navigation
and key operations.

P. 2-2

Search Guide

Mobile Internet
Use Yahoo! Keitai to access
Mobile Internet sites tailored for

SoftBank customers.
P.5-2 P. 6-2

Text Entry

Enter text for composing
messages, creating Phone Book
entries, etc.

Messaging Services

Use S! Mail or SMS to send text
messages. Attach and send files
via S! Mail.

P. 2-11

My Phone Number

Check your phone number on
handset.

P. 1-22

Customize E-mail Address

Change the account name (part
before @) of your e-mail address.

My Account Details

Save your contact information
to Account Details to send it to
your friends.

Exchange Information Wirelessly

Send your e-mail address to
compatible devices via infrared.

P. 1-22 P. 14-23 P. 13-2

Download Music
Download songs from
Chaku-Uta® sites and set as

ringtones or play back on Music
Player. P.9-4

Add Shortcuts

Add frequently used functions
to Standby shortcut icons.

Set Ringtones

Set your favorite songs as
ringtones.

Wallpaper
Set your favorite image to appear
in Standby with clock or calendar.

P. 14-11 P. 14-4 P. 2-5

Music Player

Download songs and play them
on handset.

P. 9-2

Osaifu-Keitai®

Use your handset for payment of
purchases with electronic money
or as a commuter ticket or

point card. P.11-2

Camera & Video Camera
Shoot still images and videos.

Handset supports One Seg
Digital TV.

P.7-2 P. 8-2

Yahoo! Keitai Sites

A special portal site for SoftBank
handsets enhances your Internet

browsing experience.
P. 6-3

Graphic Mail
Create HTML messages by
changing font and background

colors, inserting images, etc.
P. 5-4 P. 9-8

S! Quick News
Subscribe to News and receive
automatic updates regularly.

Gaming Device

Play S! Appli games downloaded
from Yahoo! Keitai sites.

P. 10-2
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ackage Contents

The following items are included in the package with handset.
For additional information on accessories, contact SoftBank Customer Center, General Information (P. 15-52).

H Battery (CHBAA1) H Stereo Earphone Conversion
Cable*

H Starter Guide B Warranty (Handset)

- SoftBank 930CA supports microSD™ and microSDHC™ memory cards. Purchase a memory card to use related functions.
- Use only specified AC charger (sold separately) to charge handset.
*Complimentary sample not available for purchase.
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Safety Precaution

@ To ensure proper use of your handset, read these safety
precautions carefully before use. Keep this guide for future

reference.

@ Observe these safety precautions to prevent injuries and

damages to property.

@ SoftBank accepts no liability for any loss or damages incurred
by you or a third party as a result of missed calls, etc., due to
malfunction, erroneous operation or failure of this product.

M Labels

@ Risks of injury or damage from improper use are categorized by
levels. Understand these labels before reading this guide.

without long-term consequences that do not require
hospitalization and/or prolonged treatment.

*3 Damage to property: Includes incidental damage to
structures and household property and/or to pets and
livestock.

H Symbols

@ Make sure to understand the following symbols and
precautions before reading this guide.

Action is prohibited.

%,

/AN\DANGER

Great risk of death or serious injury from
improper use

/AWARNING

Risk of death or serious injury from
improper use

Disassembly is prohibited.

/AN\CAUTION

Risk of injury or damage to property from
improper use

Wetting the product is prohibited.

*1  Serious injury: Includes loss of eyesight, physical injury, burns
(high-temperature and low-temperature), electric shock,
bone fracture, poisoning, and other conditions with long-
term consequences that require hospitalization and/or

prolonged treatment.

*2 Injury: Includes physical injury, burns (high-temperature and
low-temperature), electric shock, and other conditions

Handling with wet hands is prohibited.

=)

Action is compulsory.

Unplug power cord.

oo e
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Safety Prec
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M Handset, Battery, USIM Card, AC Charger (Sold
Separately), & Memory Card (Not Included)

/N\DANGER

Do not use excessive force to attach Battery or
connect AC Charger to handset. Battery or AC
Charger may be the wrong way around.

Battery may leak, overheat, rupture or ignite.

Use SoftBank specified devices (Battery, AC Charger,
etc.) only.

Use of non-specified devices may cause Battery to leak,
overheat, rupture or ignite; or may cause Charger to overheat,
ignite, or malfunction. Use of non-specified USIM Card may
cause loss of data or malfunction.

Do not heat or throw into a fire.

May cause battery to ignite, rupture, or may cause a
fire.

Do not disassemble/modify/solder handset.

May cause fire, injury, electric shock or malfunction. Also,
Battery may leak, overheat, rupture or ignite. Modification
of telephone equipment violates statutory regulations and is
subject to penalty. SoftBank accepts no liability for any loss
or damage to handset or to a vehicle due to user
modifications.

@ @

2%,

Do not expose camera lens to direct
sunlight for an extended period.

May cause handset/battery to ignite, rupture, break,
or may cause a fire.

Keep away from liquids.

If handset and/or battery is not dried after exposure to fluids
(water, pet urine etc.), overheating, electric shock, fire,
malfunction, etc. may occur.

=9
A
1\“

({

Do not charge, use, or leave handset in places
subject to high temperatures (near an open flame or
heating equipment, in direct sunlight or inside a car
on a hot day).

May cause deformation, malfunction, impair
performance or shorten Battery life. Battery may
leak, overheat, ignite or rupture. Outer housing
may become hot resulting in burns or fire.

2,




/AN\WARNING

Safety Pre

Do not place handset, Battery, AC Charger,
or USIM Card in a microwave oven or
pressure cooker, or on top of an induction
heating (IH) cooktop.

May cause Battery to leak, overheat, rupture or
ignite; or may cause handset/AC Charger to
overheat, emit smoke, ignite, or malfunction; or may
cause circuitry damage.

If you notice an unusual sound, odor,
smoke, etc. while using, charging or storing
handset, immediately do the following:

1. Unplug AC Charger from outlet.

2. Turn handset power off.

3. Remove Battery from handset, being careful of burn or
injury. Continuing use may cause fire or electric shock.

Turn off handset when entering gas
stations or other places where flammable
gases (propane gas, gasoline, etc.)
generate. Do not charge battery in such
places.

Gases may ignite. Before using a mobile phone with
Osaifu-Keitai® inside a gas station, be sure to turn it
off (If an IC card lock is activated, first deactivate it
and turn power off).

Keep liquids (water, pet urine, etc.) and
conductive materials (e.g. pencil lead, metal
fragments or metal necklaces, hairpins,
etc.) away from External Device Port.

May cause short circuit, resulting in fire or
malfunction.

Do not short-circuit External Device Port
when AC Charger is plugged into an AC
outlet. Do not touch External Device Port
with your fingers, etc.

May cause fire, malfunction, electric shock or injury.

Do not drop or throw handset or expose it
to excessive shock.
May cause battery to leak, overheat, rupture or

ignite; or may cause fire, electric shock, or
malfunction.

© © O @

Do not use handset if it was dropped or
otherwise damaged and internal parts are
exposed.

May cause shock or injury from damaged parts.




Safety Preca ns
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Do not use handset in humid locations such
as bathrooms and do not touch handset
with wet hands.

May cause shock, short-circuiting, and corrosion
(When carrying handset on the body, moisture from
perspiration may cause damage. Be also especially
careful when using handset in rain or snow, at the
beach, or near water). If handset has become wet,
immediately unplug AC Charger and remove battery.
Damage caused by water or humidity is not covered
by the warranty, and repair may not be possible.

/AN CAUTION

Do not place handset on a sloping or
unstable surface.
May cause handset to fall resulting in injury or

malfunction. Take particular care when vibrator is
activated.

N

Do not play games, listen to music, or
watch TV on handset while driving a
vehicle, riding a bicycle or while walking.

Doing so is unsafe and may lead to accidents.

Keep handset out of reach from infants. Be
careful when One Seg Antenna is
extended.

Infant may accidentally swallow parts or memory
card, causing suffocation or injury.

When a child uses handset, it is
recommended that a parent provide proper
instructions to the child and keep an eye on
how the child uses handset.

Failing to do so may cause injury, etc.

O @ @ O

Do not store handset in humid/dusty places
or locations subject to extremely low/high
temperatures.

May cause malfunction.




Do not exceed maximum ratings for
outlets, cables, and wiring components.

"Piggybacking" of plugs causing maximum ratings
to be exceeded may lead to overheating and fire.

0 ©

Do not place handset near corrosive
chemicals or in locations subject to
corrosive gases.

May lead to damage and loss of stored data.

Do not use handset in locations with high
humidity.

If worn close to the body, perspiration may cause
damage and malfunction. Damage caused by water
or humidity is not covered by the warranty, and
repair may not be possible.

Safety Pre

M Handling Battery

/N\DANGER

@ Properly use and dispose of Battery after checking its
type as displayed on the label on Battery.

Display

Battery type

Li-ion00

Lithium-ion

Do not use handset for an extended period
of time with AC Charger connected.

Handset, battery and charger (sold separately) may
become warm if you operate handset for an
extended period of time while charging. Prolonged
contact with warm devices may cause redness,
itching, irritation or low-temperature burns.

N

Do not puncture Battery with a nail, hit it
with a hammer, step on it, or subject it to
strong impact.

May cause Battery to leak, overheat, rupture or
ignite.

O

Do not short-circuit Battery. Keep metal
parts (pins, etc.) away from Battery
terminals or Battery plus (®) and minus
(©) terminals. Do not carry or store
conductive materials (e.g. pencil lead,
metal fragments or metal necklaces,
hairpins, etc.) with Battery.

May cause Battery to leak, overheat, rupture, or
ignite.

Xi
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Safety Precautions

If battery fluid gets into your eyes,
immediately rinse your eyes with clean
water without rubbing them, and consult
a doctor.

Failing to do so may result in losing your eyesight.

AN\ WARNING

Do not expose battery to fresh or salt
water, pet urine, or other fluids. Do not
charge battery while wet. If handset was
dropped into water or other fluid,
immediately turn off power and
discontinue use.

Wet battery may overheat, rupture or ignite.

If battery fluid gets on your skin or
clothing, immediately stop using and rinse
the fluid off with clean water.

Battery fluid may injure your skin.

Do not use damaged or leaking battery.

May cause battery to leak, overheat, rupture or
ignite.

If battery is not fully charged after
specified charging time has elapsed, stop
charging it.

Battery may leak, overheat, rupture or ignite, and
handset may be damaged or ignite.

If you notice an unusual odor, overheating,
discoloration, deformation, etc. while
using, charging or storing Battery, remove
it from handset being careful of burn or
injury, and keep it away from fire.
Continuing use may cause Battery to leak, overheat,
rupture or ignite.

S © &9

If Battery leaks or emits an unusual odor,
immediately stop using it and keep it
away from fire.

Battery fluid is flammable and could ignite causing
fire or could rupture.




Safety Pre
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Do not use a battery that has been subject
to strong external force or shock (such as
being dropped or stepped on).

Continuing use may cause battery to leak, overheat,
rupture or ignite; or may cause malfunction or fire.

M Handling Handset

/N\WARNING

-~

Do not allow pets to bite Battery.

May cause Battery to leak, overheat, rupture, ignite;
may cause handset malfunction or fire.

/N CAUTION

O

Do not use while operating a vehicle (car,
motorcycle, bicycle, etc.)

May cause a traffic accident. Use of a mobile phone
while driving is prohibited by law, and is subject to
penalty. Stop vehicle in a safe location (where
parking is allowed) before using handset.

Do not dispose of batteries as municipal
waste.

Bring used batteries to the nearest SoftBank Shop
or recycling center after insulating the terminals
with tape.

Be sure to observe local regulations on battery
disposal.

Keep handset power off near high
precision electronic devices or devices
using weak signals.

Failing to do so may interfere with the device
operation.

* Examples of such devices:

Hearing aids, implanted cardiac pacemakers,
implanted defibrillators and other electronic medical
equipment; fire alarms, automatic doors and other
automatic control devices.

If you use an implanted cardiac pacemaker,
implanted defibrillator or other electronic medical
equipment, consult with the individual medical
device manufacturer or distributor about the
possible influence of radio waves.

xiii
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Safety Preca
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Keep handset power off where use is
prohibited, such as on an airplane or in a
hospital.

May affect electronic devices or electronic medical
equipment. Disable auto power-on functions (such
as the alarm function) before turning off handset.
May jeopardize safety of the airplane. Handset
operation aboard an airplane is prohibited by law
and subject to penalty.

%,

If you use electronic medical equipment,
do not place handset in breast pocket or
inner coat pocket.

Using handset near electronic medical equipment
may cause the equipment to malfunction.

If you have a weak heart, be careful with
incoming call vibrator and ring volume
settings.

These may affect your heart.

-~

In a thunderstorm, retract One Seg
Antenna, immediately turn handset power
off and seek shelter.

Failing to do so may attract lightning and cause
electric shock.

e

Keep handset away from your ear when
calling in handsfree mode. When playing
games or music with Earphone-
Microphone connected to handset, adjust
the volume properly.

Prolonged listening at excessive volume levels may
impair your hearing. Being unable to clearly hear
surrounding sounds may result in an accident.

2,

Do not point infrared beam at anyone's
eyes.
May cause eye injury. Do not direct infrared beam

toward another infrared device as this may interfere
with the device operation.

%,

Do not place handset on the dashboard
close to airbags.
In case of airbag inflation, handset may hit

passengers resulting in injury, malfunction or
breakage.

e

If Display or Camera Lens is damaged, be
careful of broken glass pieces or exposed
internal components.

The Display's reinforced glass prevents shattering;
however touching broken glass edges and exposed
pleces may cause Injury.




Safety Pre
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Do not turn on the light near a person's
eyes. Do not look directly into the light
and do not point the light at another
person's eyes.

This may cause impaired eyesight and other injury.
In particular, do not take pictures of infants at very
close range.

In very rare cases, stimulation by strong
light or flashing images may lead to
symptoms such as convulsive fits or
temporary loss of consciousness. If you
have experienced such symptoms in the
past, consult a physician before using the
handset.

Do not allow fluids such as water, metal
pieces or flammable materials to enter
USIM Card Slot or microSD™ Memory Card
Slot.

May cause fire, electric shock or malfunction.

/N\CAUTION

Before using handset (calls, mail, camera,
games, Internet, Media Player or TV),
check your surroundings and make sure
that the intended use is safe and
appropriate.

Failure to do so may result in falls or accidents.

If handset affects car electronics, stop use.

Handset use may affect electronics in some car
models and impair safe driving.

O 0 O O

Do not point the light at the driver of a
vehicle.

This may interfere with proper operation of the
vehicle and lead to accidents.

If skin abnormality occurs with use of
handset, immediately discontinue use and
consult a doctor.

Handset contains metal material. Depending on
your physical condition, you may experience
itchiness, rash, etc.

XV



Safety Precautions

Keep magnetic cards away from handset
and make sure that a magnetic card is not
trapped when closing handset.

Failing to do so may cause magnetic data on a cash

card, credit card, telephone card or floppy disk to
be lost.

Be careful not to pinch your fingers or
Strap when opening and closing handset.

May cause injury or damage.

Do not swing handset by its strap, etc.

Handset may strike you or others, resulting in injury,
malfunction or breakage. Do not use a strap that is
damaged.

Watch TV with adequate lighting and
distance from Display.

May contribute to impaired eyesight.

Use caution when using handset for an
extended period as handset may become
hot, especially in high-temperature
conditions.

Skin contact for extended period may cause low-
temperature burns.

Do not turn volume up too high when
using earphones.

Using earphones for extended periods at high
volume may impair hearing or harm your ears.

Do not bring speaker close to the ear
when making calls in handsfree mode or
when ring tone/melody is playing.

May impair your hearing.

© ©ee

If Display breaks do not inhale or touch
liquid crystal. If liquid crystal enters your
eyes or mouth, immediately rinse with
clean water and consult a doctor. If liquid
crystal adheres to your skin or clothing,
immediately wipe off with alcohol and
wash with soap and water.

May result in losing your eyesight or harming your
skin.

Keep objects from catching in moving
parts when sliding handset open/shut.

Failing to do so may cause injury.

Be careful when using in a location with
many people.

Antenna may hit other persons causing injury.

0@

Do not use One Seg Antenna if broken.
May cause burns or injuries upon skin contact.




Safety Pre

Do not bend One Seg Antenna or swing
handset by One Seg Antenna.

May cause injury or deformation/breakage of One
Seg Antenna.

Keep magnetized objects away from
handset.

May cause operation errors.

o

Speaker volume

As earpiece also functions as speaker, be careful of
ringtone/alarm sounding close by your ear.
Following a call or similar activity, alarm sound will
start at a low volume and progress to the set
volume regardless of the volume setting.

Keep covers (External Device Port,
microSD™ Memory Card Slot, etc.) closed.

If these are left open, dust or water may get inside
handset, causing malfunction.

M Handling USIM Card

/N\CAUTION

Be mindful of objects adhering to handset.

The magnetic field near receiver and speaker of
handset may cause small metallic objects such as
pins, clips, staples or paper cutter blades to adhere
to handset, which may lead to injury. Remove any
adhering objects before using handset.

Be careful handling the Notch when
removing USIM Card (IC chip).

May injure your hands or fingers.

e © 0 O

While watching TV on handset, avoid
prolonged direct contact with skin and do
not cover handset with paper, cloth,
blankets or similar.

May cause burns and lead to malfunction.

Use only specified USIM Cards.

Use of non-specified cards may lead to data loss
and malfunction. For information on specified USIM
Cards, contact your SoftBank dealer or SoftBank
Customer Service, General Information (P. 15-52).

®

Do not disassemble or modify USIM Card.
May lead to data loss and malfunction.
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Avoid open fire, heat sources, direct
sunlight, high temperatures or humidity,
and high levels of dust.

May cause USIM Card to melt, overheat, emit
smoke, or may lead to data loss and malfunction.

M Handling AC Charger

/N\WARNING

Take care not to touch, damage, or short-
circuit IC chip on USIM Card.

May lead to data loss and malfunction.

Do not place Charger on a sloping or
unstable surface during charging.

May cause handset to fall resulting in malfunction.

Do not drop USIM Card and protect it from
shocks.

May lead to malfunction.

Do not cover with clothing or bedding
during charging.

Heat may build up resulting in fire or malfunction.

NN %,

Do not bend or break USIM Card and do
not place heavy objects on it.

May lead to malfunction.

-
W4
fx“
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Do not let USIM Card get wet.

Exposing USIM Card to fluids such as water or pet
urine may cause malfunction.

-~

Keep USIM Card out of reach of infants.

Accidental swallowing may lead to suffocation and
injury.

%%,

Use the specified power supply and
voltage.

AC Charger may ignite/overheat, cause electric
shock/fire or malfunction.

AC Charger: 100 to 240 V AC (for household AC
outlets only)

Also, do not use commercially available transformer
for travel use. May cause fire, electric shock, or
malfunction.

Hold and unplug AC Charger from outlet if
handset is not used for an extended
period of time.

Failing to do so may cause electric shock, fire or
malfunction.
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Protect AC Charger from water, pet urine,
and other fluids. If liquid (water, pet urine,
etc.) gets into AC Charger, immediately,
hold and unplug AC Charger from outlet.
Failing to do so may cause AC Charger to overheat,

ignite, emit smoke, or may cause electric shock or
fire.

If thunder is heard, do not touch handset
or AC Charger.

May attract lightning and cause electric shock.

Firmly hold plug and unplug AC Charger
from outlet before cleaning.

Failing to do so may cause electric shock.

If dust or dirt has gotten on the plug, hold
and unplug AC Charger from outlet and
wipe off with a dry cloth.

Failing to do so may cause fire.

S e

When plugging AC Charger into outlet,
keep conductive materials (pencil lead,
metal parts, necklaces, hair pins, etc.) away
from AC Charger plug and insert plug
completely into outlet.

Failing to do so may cause electric shock,
overheating, ignition, shorting, fire, or other
dangers, or injury or malfunction. Do not use a
damaged AC Charger or damaged AC outlet.

Do not unplug AC Charger by pulling the
cord. Firmly hold plug and unplug AC
Charger.

Pulling the cord may damage the cord resulting in
electric shock or fire.

When AC Charger is connected to an
outlet, do not pull on cord or otherwise
subject Charger it to strong shock.

May cause injury or malfunction.

Do not use AC Charger if the cord is
damaged.

May cause electric shock, overheating or fire.

Do not touch AC Charger or AC outlet with
wet hands.

May cause electric shock or malfunction.

Ve O @0

Do not place heavy objects on the cord of
AC Charger.

May cause electric shock or fire.

XiX
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Safety Preca

/N\ CAUTION

Unplug Charger from outlet when
charging is finished.
Failing to do so may cause fire or malfunction.

OAN@

Do not leave AC Charger connected to
handset when battery is removed.

May cause fire or electric shock.

M Near Electronic Medical Equipment

@ The following information conforms to "The Guidelines on Use
of Mobile Phones and Other Devices to Prevent
Electromagnetic Wave Interference with Electronic Medical
Equipment" (Electromagnetic Compatibility Conference Japan,
April 1997), as well as refers to "The Investigative Research
Report on the Influence of Electromagnetic Waves on Medical
Equipment” (Association of Radio Industries and Businesses,
March 2001).

/N\WARNING

or implanted defibrillator, carry and use
handset at a distance of at least 22
centimeters away from the implanted
area.

Radio waves may interfere with the operation of
implanted cardiac pacemakers or implanted
defibrillators.

0 If you use an implanted cardiac pacemaker

other than implanted cardiac pacemakers/
defibrillators outside of medical
institutions, consult device manufacturer
about the influence of radio waves.

Radio waves may interfere with the operation of
electronic medical equipment.

0 When using electronic medical equipment




Observe the following in medical
institutions. Radio waves from handset
may affect electronic medical equipment.

* Do not bring mobile phones into an operating
room, ICU (Intensive Care Unit) or CCU (Coronary
Care Unit).

o Turn off mobile phones in hospital wards. Disable
auto power-on functions (alarm, etc.) before
turning off mobile phones.

o Turn off mobile phones even in lobbies or areas
where use is permitted if there is electronic
medical equipment nearby.

® Observe the instructions of individual medical
institutions and do not use or bring mobile
phones into prohibited areas.

Keep handset power off in crowded places
such as in packed trains because a person
with an implanted cardiac pacemaker or
implanted defibrillator may be nearby.
Disable auto power-on functions (alarm,
etc.) before turning off mobile phones.
Radio waves may interfere with the operation of
implanted cardiac pacemakers or implanted
defibrillators.
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Usage Basics

@ As handset uses radio waves, it cannot be used where signals are weak or when it is out of service area. If you move to a place with
poor signal reception (e.g. beside/inside a building, in a tunnel, underground or mountain area), calls may be suddenly cut off.

@ Take care not to disturb other people when using handset in public places.

@ If you receive a call while walking, move to a safe place before answering.

@ SoftBank accepts no liability for any damages arising from loss or alteration of data (Phone Book, mail, images, sound, etc.) stored
on your handset, microSD™ or microSDHC™ memory card as a result of accident or malfunction. We recommend you back up
important data such as Phone Book entries.

@ Handset is a wireless station under Japanese Radio Law. You may be requested to submit your handset for inspection based on this
law.

@ Using handset near a landline phone, TV or radio may affect the operation of these devices. Use handset as far away as possible
from these devices.

@ Be aware of eavesdropping. Handset employs a digital signal that provides a high level of privacy protection. However, the possibility
of eavesdropping by a third party using special means cannot be ruled out.

- Eavesdropping:
Interception of radio signals by a third party during communication, either intentionally or accidentally

@ Do not trap Strap or other objects when sliding handset open or shut. Doing so may cause malfunction or damage handset.

@ Using handset on trains or other public transportation may, in some rare cases, affect their electronic devices.

@ A call may not be connected or you may hear noises:

- In an extremely cold place (e.g. freezer storehouse) where handset may not operate normally

+ Near metal furniture which may interfere with signal transmission

- Near electromagnetic sources or magnetized items, including electric products, audio-visual equipment and office appliances (e.g.
computer, microwave oven, speaker, TV set, radio, fax machine, fluorescent lamp, word processor, electric kotatsu, inverter-driven
air conditioner, electromagnetic cooker)

@ If Battery appears deformed or scratched from external impact, contact Customer Assistance.

@ Keep a backup copy of data saved to handset. SoftBank accepts no liability for any loss of data stored on your handset.

@ If you use handset for the first time or after an extended period of disuse, charge Battery before using handset. During charging,
battery may become warm. This is normal and not a defect.

@ Battery operating time varies by the usage environment and the condition of Battery (In an extremely hot or cold environment,
capacity of battery will be reduced, and service life will also be shorter. Using handset at normal temperatures is recommended).
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@ Do not charge battery:
- At an ambient temperature outside of appropriate range (5 to 35°C)
+ In a humid, dusty or shaky place
- Near a landline phone, TV or radio

@ Although AC Charger may become warm while charging, it is not a malfunction.

@ Do not subject handset to excessive shock. Do not deform Charger Terminals. Doing so may cause malfunction.

@ \When Battery Strength Indicator flashes and Charging Indicator is out, charging is disabled. Ambient temperature may be too high
or low. Charge battery at an ambient temperature of 5 to 35°C.

@ \When Battery life nears its end, it may expand slightly. This is not a malfunction.

@ Handset's FeliCa reader/writer function uses ultra-weak radio waves not requiring radio licensing.

@ FeliCa operates at 13.56 MHz range. Maintain enough distance when using other reader/writers nearby. Be sure to check that other
wireless stations operating at the same frequency range are not nearby.

@ Keep handset away from strong magnetic force. May cause malfunction.

@ Do not scratch Display with metal objects, etc. Doing so may damage Display resulting in malfunction or breakage.

@ Back up image (Photo/Movie)/sound (Incoming melody, etc.) to a PC. Please note, copy protected files may not be backed up.

@ Do not subject Display to excessive force. This may cause damage and lead to malfunction.

@ Do not press keys/buttons with excessive force using your nails or other hard objects. This may cause damage and lead to
malfunction.

@ Stored mail and downloaded data (regardless whether fee-based or free) cannot be transferred from one handset to another when
obtaining service or when changing to a different model.

@ Do not pull External Device Port cover with excessive force; may cause damage.

@ Do not exert excessive force where there is sliding movement when sliding handset open/shut or using handset. Swinging or bending
handset may cause malfunction and damage; handle with care.

@ Earpiece should be centered over ear. Otherwise, sound may be blocked.

@ Sudden change from cold to warm/humid environment may cause condensation inside handset. Using handset in this condition may
cause malfunction.

@ Do not wind the AC Charger cord around the plug. This may lead to electric shock or fire.

@ Prolonged exposure to sound at high volume levels may cause hearing damage. When listening to music, sound may leak from
earphones; be mindful of others on trains or in public places.

@ Using handset (Music Player, TV, etc.) while walking may be cause for decreased attention, leading to accidents. Always stay alert,
especially when crossing a road, at railroad crossings etc.
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@ \When not using the handset for an extended period, remove the battery and store it in a cool, dry place.

Inside Cars

@ Handset use may affect electronics in some car models. Confirm with your car dealer whether sufficient magnetic protection
measures are implemented in your car. Failing to do so may compromise safe driving.

Handling

@ Keep liquids away from handset. Handset, battery, AC Charger and USIM Card are not waterproof. Do not use in rain or humid
locations (e.g. bathrooms). If worn close to the body, moisture from sweat may corrode internal parts and cause malfunction.
Damage caused by water or humidity is not covered by the warranty.

@ Do not place handset near an air conditioner vent. Abrupt temperature change may form condensation, leading to corrosion or
malfunction.

@ Use a dry soft cloth (e.g. eyeglass cloth) to wipe handset. Handset's color LCD may be treated with special coating for enhanced
visibility. Rubbing Display with a dry cloth may scratch the surface. Clean handset carefully using a dry soft cloth for eyeglasses. If
moisture or soil is left on Display, the coating may stain or peel off. Do not use alcohol, solvent, benzene or detergent, as it may
cause discoloration and remove printed logos.

@ Occasionally clean the power terminals and the battery terminals with a dry cotton swab or cloth. Soiled terminals may cause poor
contacts resulting in power failure and insufficient charging. When cleaning, take care not to deform the terminals.

@ Do not apply excessive force to handset and battery. Placing handset in a bag packed with many items or sitting down with handset
in your pocket may damage Display, internal circuit board or battery, and cause malfunction. Close handset before placing inside a
bag. Neglecting to do so may cause damage. Such damage is not covered by the warranty, even if there is no external damage.

@ Although handset becomes warm while being used or charged, it is not a malfunction.

@ Do not leave the Camera Lens exposed to direct sunlight. Doing so may discolor or burn Optical Element.

@ Do not affix thick stickers or labels to the Display or keypad side. Doing so may result in malfunction, and may cause keys and buttons
to be wrongly activated when handset is closed, resulting in malfunction and reduced battery life.

@ Do not leave battery removed or uncharged for an extended period of time. Doing so may alter or erase the settings and data you
saved. SoftBank accepts no liability for any damages resulting from such loss or alteration.

@ Do not store empty Battery. Doing so may degrade performance and shorten life of Battery.

@ \When removing Stereo Earphone Conversion Cable or AC Charger from External Device Port, do not pull the cord, hold the
connector. Pulling the cord may result in wire breakage or malfunction.



General Notes

@ If you use an outlet with pullout prevention feature, refer to the instruction manual of the outlet.

@ Avoid extremely cold and high temperatures. Use handset at an ambient temperature of 5 to 35°C, and a humidity of 45 to 85 %.
If handset is left in an extremely hot place, handset may power off automatically.

@ Battery is a consumable item. Replace Battery with a new one if the operation time becomes extremely short even after it is fully
charged (depends on conditions of use). Purchase a new battery designated for handset.

@ Charge Battery at an ambient temperature of 5 to 35°C.

@ The FeliCa reader/writer function should be used within Japan. Handset's FeliCa reader/writer function complies with wireless
standards and you may be subject to penalty if used abroad.

@ The IC card authentication function should be used within Japan. Handset's IC card authentication function complies with wireless
standards and has obtained certification. You may be subject to penalty if used abroad.

@ Do not attach USIM Card with labels or stickers attached to handset. May cause malfunction.

@ \When connecting an external device, do not insert the connector into External Device Port at an angle. When external device is
connected, do not pull the cord.

@ Do not use handset without Battery Cover. Battery may dislodge and result in malfunction or breakage.

@ Do not attach labels or stickers to the backside of handset's Display. Labels or stickers may catch when handset is opened or closed,
resulting in malfunction or breakage.

@ Be mindful of One Seg Antenna. When taking calls while viewing TV, take care not to injure persons around you or jab yourself in
the eye with Antenna. Retract Antenna when opening/closing handset.

Camera

@ Creating public disturbances from using handset may be subject to penalties based on applicable laws and regulations (e.g. nuisance
prevention ordinance by municipal governments).

@ Before taking photos/videos of important events (such as a wedding), perform a test to ensure that photos/videos are reproduced
properly and sound is recorded clearly.

@ Do not use handset to record copyright-protected materials such as books, or materials for which permission has not been given.

Copyrights

Copyrighted materials, such as music, images, computer programs and databases, and their respective copyright holders are protected
by copyright laws. Duplication of copyrighted materials is permitted only for individual or home use. Duplications (including data
conversion), modifications, transfers or network distributions of copyrighted materials for purposes other than stated above without
permission of the copyright holders constitute an infringement of copyrights and violation of copyright holders' rights, potentially
causing claims for reparations or criminal punishment.
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Always observe applicable copyright laws when making copies using handset and recording materials using handset camera.

The software installed in this handset is a copyrighted material and involves copyrights and human rights of copyright holders which
are protected by copyright laws. Do not duplicate, modify, alter, detach from the hardware, disassemble, decompile or reverse-engineer
the software in whole or in part by yourself, nor allow any third party to do the same, either.

Intellectual Property Rights

@ Duplicating, modifying or publicly transmitting copyright-protected contents (e.g. text, images, music, software) photographed or
downloaded from websites without the permission of the copyright holders is prohibited by copyright laws, with the exception that
the duplication or quotation of those is made only for personal use.

Shooting or recording a demonstration, performance or exhibition may be prohibited in some cases even if it is for personal use.
Shooting a photo of a person using this product without his or her permission, or posting a photo of a person you shot on websites
without his or her permission may constitute an infringement of portrait rights.

@ S! Appli, S! Mail, PC Site Browser and Graphic Mail are registered trademarks or trademarks of SOFTBANK MOBILE Corp.

@ "SOFTBANK,” SOFTBANK's equivalent in Japanese, and the SOFTBANK logo are trademarks or registered trademarks of SOFTBANK
CORP. in Japan and in other countries.

@ Yahoo! and the “Yahoo!” and “Y!" logos are trademarks and/or registered trademarks of Yahoo! Inc. in the US.

@ Osaifu-Keitai® is a registered trademark of NTT DOCOMO.

@ T9® is trademarks and/or registered trademarks of Nuance Communications, Inc. and/or its affiliates in the United States
and/or other countries. @M

@ The microSD™ logo and microSDHC™ |ogo are trademarks. micpo micpow
S® 'S
@ This product is licensed complying with MPEG-4 Visual Patent Portfolio License, and you are permitted to

use personally and for the nonprofit purpose in the following situations:

+ To record a movie based on the standard of MPEG-4 Visual (MPEG-4 Video)

- To play MPEG-4 Video recorded by the consumer engaged in the nonprofit activities

- To play MPEG-4 Video provided by the provider licensed by MPEG-LA

When you use it for other purposes, such as promotion, in-house information and profit activity, contact the U.S. corporation MPEG
LA, LLC.
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@ This product contains Adobe® Flash® Lite™ Player under license from Adobe Systems Incorporated. ADOBE
Copyright® 1995 - 2009 Adobe Macromedia Software LLC. All rights reserved. . EINI;SBT.ED

Adobe, Flash and Flash Lite are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

@ QR code is a registered trademark of Denso Wave Inc.

@ Powered by JBlend™ Copyright 2002 - 2009 Aplix Corporation. All rights reserved.

JBlend and JBlend-related trademarks are trademarks or registered trademarks of Aplix Corporation in Japan and other ‘D
countries.

Blend

@ Java and all Java-related trademarks and logos are trademarks or registered trademarks of US Sun Microsystems, Inc. in J (
the United States and other countries. t_{)
@ Chaku-Uta and Chaku-Uta Full are trademarks and/or registered trademarks of Sony Music Entertainment (Japan) Inc. in E;T//E
Japan and/or other countries. PoWERED

@ This product contains NetFront Mobile Client Suite of ACCESS CO., LTD. o~ .
ACCESS, ACCESS logo and NetFront are trademarks or registered trademarks of ACCESS CO., LTD. in the United States, AC@ES$
Japan and other countries. Netfront ..
©2009 ACCESS CO., LTD. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

@ This product is equipped with IrFront by ACCESS CO., LTD.
© 2008 ACCESS CO., LTD. All right reserved

@ Powered By Mascot Capsule®/Micro3D Edition™
MASCOT CAPSULE® are registered trademarks of Hl CORPORATION.

@ G-GUIDE, G-GUIDE MOBILE and their logos are registered trademarks in Japan of U.S. Gemstar-TV Guide International, Inc. and/or its
affiliates.

@ IrSimple™, IrSS™ or IrSimpleShot™ are trademarks of Infrared Data Association®.
@ TruMedia and Dialog Clarity technologies are industrialized based on the license from SRS Labs, Inc. y °
Trumedia, Dialog Clarity, SRS and the (@) symbol are trademarks of SRS Labs, Inc. SRS (.)
@ This product contains software licensed complying with GNU General Public License (GPL), GNU
Lesser General Public License (LGPL), etc.
For more details, visit “GPL - LGPLZICDWT “ at http://ch-mobile.jp/product/gpl/

IrFront
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@ This product is equipped with the font FontAvenue product by NEC Corporation.

@ BookSurfing is a registered trademark of CELSYS, Inc., Voyager Japan, Inc., and INFOCITY, Inc.

@ PhotoSolid® is used for image stabilization of still images. MovieSolid® is used for image stabilization of videos. PhotoSolid® and
MovieSolid® are registered trademarks of Morpho, Inc.

@ FrameSolid™ by Morpho, Inc. is used for the frame interpolation function.
FrameSolid™ is a registered trademark of Morpho, Inc.

@ 2 is a registered trademark of FeliCa Networks, Inc.

@ FeliCa is a contactless IC card technology developed by Sony Corporation. FeliCa is a registered trademark of Sony Corporation.

@ Microsoft®, Windows®, Windows Media® and Windows Vista® are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

@ Microsoft Windows Operating System is indicated in its abbreviated form as Windows.

@ OS (Japanese) are abbreviated as follows in this guide.
- Windows Vista is an abbreviation of Windows Vista® (Home Basic, Home Premium, Business, Enterprise, Ultimate).
- Windows XP is an abbreviation of Microsoft® Windows® XP Professional operating system or Microsoft® Windows® XP Home

Edition operating system.

- Windows 2000 is an abbreviation of Microsoft® Windows® 2000 Professional operating system.

@ EXILIM is a registered trademark of CASIO COMPUTER CO., LTD.

@ ©ATR-Trek Co., Ltd.

@ S! Appli are Java™ supported applications.

@ S! Appli supported SoftBank cellular phones are equipped with JBlend®, developed by Aplix Corporation and designed to accelerate
the processing speed of Java™ applications.

@ The other company names and brand names described in this guide are trademarks or registered trademarks of the respective
companies.

Functional Limitations

After handset upgrade, subscription cancellation or long periods of handset disuse, the following become unavailable:

- TV

+ Camera

If the functions mentioned above are activated more than a set number of times while out-of-range, they become unavailable.
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Activate the Camera and TV again after moving to a location with signal reception.

Caution

Do not use handset if it has been altered. Using an altered device is a violation of the Radio Law. This handset is certified to conform
to the technical standards for specific radio equipment based on the Radio Law, and Technical Conformity Mark & is printed on the
model name seal as certification. If you remove screws and make alterations inside of handset, the technical standards conformity
certification becomes invalid. Do not use handset with the certification invalid, as it is a violation of the Radio Law.

SAR Certification Information

930CA meet the technical standards set by Ministry of Internal Affairs and Communications (MIC) regarding radio wave absorption by a
human body.

These technical standards have been established on a scientific basis to prevent radio waves emitted from wireless devices such as mobile
phones that are used close to a human head from affecting human health. These standards require that the SAR (Specific Absorption
Rate), an indicator of the amount of average radio frequency energy absorbed in the side of a human head, must not exceed the permissive
value of 2 W/kg*. This value includes a substantial safety margin to assure the safety of all persons, regardless of age and physical size.
The value is equal to the international guideline recommended by the International Commission on Non-lonizing Radiation Protection
(ICNIRP) that has a cooperative relationship with the World Health Organization (WHO).

* The technical standards are stipulated in the Radio Law (Article 14-2 of Ordinance Regulating Radio Equipment).

The highest SAR value is 0.351Wrkg for 930CA. This value was obtained in accordance with the MIC testing procedure with handset
transmitting at its highest permitted power level. While there may be differences in SAR levels among individual products, they all meet
the MIC’s permissible value. Because mobile phones are designed to operate at their minimum power level required to communicate
with base stations, the actual SAR of handset during a call is usually below the highest value.

For further information about SAR, see the following websites:

- Ministry of Internal Affairs and Communications (MIC)
http:/Awww.tele.soumu.go.jp/e/ele/index.htm

- Association of Radio Industries and Businesses (ARIB)
http://Awww.arib-emf.org/index02.html (Japanese)
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SoftBank’s Body SAR Policy

* Body SAR: The SAR value at the maximum transmission power when continuously talking with handset placed on the body and using
earphone-microphone.

**Specific Absorption Rate (SAR): The value measured when having talked continuously for 6 minutes.

***Placement on the body: Measurements are taken with the rear of handset facing the body at a distance of 1.5 cm as the ordinary
handset position. In order to comply with radio frequency exposure requirements, use an accessory (e.g. belt clip, holster) that does
not contain metallic parts to maintain a 1.5 cm separation between the body and handset.

For more information, see SOFTBANK MOBILE Corp. Website:
http://www.softbankmobile.co.jp/corporate/legal/emf/emf03.html

European RF Exposure Information

This handset 930CA is a radio transmitter and receiver. This product has been confirmed not to exceed the limits recommended by
international guidelines for radio frequency.

These guidelines were developed by the independent scientific organization International Commission on Non-lonizing Radiation
Protection (ICNIRP) and include a substantial safety margin to assure the safety of all persons, regardless of age and health.

The influence on the human body of radio waves emitted from mobile phones is measured employing a unit known as the Specific
Absorption Rate (SAR). The SAR limit for mobile devices is 2 W/kg. The maximum SAR value for this model handset, when placed on the
ear, is 2W/kg for 930CA*. As mobile devices offer a range of functions, they can be used in other positions, such as on the body as
described in SoftBank’s Body SAR Policy. In this case, the maximum SAR value is 0.375W/kg for 930CA.

Since the SAR is measured at the highest transmitting power level, the actual SAR during a call is usually much smaller. This is because
mobile phones are designed to operate at their minimum power levels necessary to communicate with base stations.

The World Health Organization (WHO) has stated that present scientific information about mobile phone use does not indicate any adverse
effects on the human body. They recommend limiting the talking time or using a handsfree device to keep the mobile phone away from
the head and body to reduce influence of exposure to radio waves.

Additional information can be found at the WHO website:

http://mww.who.int/emf

* Measurements with handset placed on the body are carried out in accordance with the FCC standards. The values are based on
European requirements.



General Notes

Declaration of Conformity

C€0168

The products “930CA" is declared to conform with the essential requirements of European Union Directive 1999/5/EC Radio and Telecommunications

Terminal Equipment Directive 3.1(a), 3.1(b) and 3.2.
The Declaration of Conformity can be found on the following website:

http:/k-tai.casio.jp/

Minding Mobile Manners

Use your handset responsibly. Inappropriate handset use can be both dangerous and bothersome. Take care not to disturb others when
using your handset. Adjust handset use according to your surroundings.

@ Turn handset power off in theaters, museums and other places where silence is the norm.

@ Refrain from use in restaurants, lobbies, elevators, etc.

@ Observe signs and instructions regarding handset use aboard trains, etc.

@ Refrain from use that interrupts the flow of pedestrian or vehicle traffic.
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1 Earpiece/Speaker3

2 Charging Indicator/lllumination

3 Display

4 Front Keys (Right) (£ (Top)*
(Center)
(Left) [T} (Bottom)

5 Multi Selector (m) g KA

6 Mail Key El

7 Menu Key £

8 Send Key Wy

9 Keypad (o)-o

10 * Key EDy

11 #/Manner Key R

12 Power/End Key =

13 Clear/Back Key ozt

14 Shortcut Key (@]

15 Yahoo! Keitai Key [=]*

16 Light Sensor

17 Light

18 Camera Indicator
19 Battery Cover

20 Memory Card Slot
21 FeliCa Mark

22 Camera

23 Internal Antenna
24 Infrared Port

25 Microphone

26 Strap Eyelet

27 External Device Port?

1



Handset Parts

28 Lock Key B
29 Shutter Key 4
30 Camera Key 2
31 Viewer Key B

32 Digital TV Antenna

1 For optimal signal reception, do not cover Internal
Antenna with hands or anything else. Do not put
stickers over Internal Antenna.

2 Connect AC Charger or supplied Stereo Earphone
Conversion Cable to use earphone-microphone.
See instructions included with Stereo Earphone
Conversion Cable.

3 Earpiece also functions as speaker. Be careful of
ringtone/alarm sounding close by your ear when
receiving or ending a call.

4 Key illustrations are simplified and differ in
appearance from actual handset keys.

Basic Key Operations

OlIn Standby

No. | Key/Operations Description

31 ® Activate Snap Viewer.!

30 E] Activate Camera in Photo Mode.”
Press and hold [] |Activate Camera in BI-DO-RI Mode. '

29 0 Activate TV.2

28 | Press and hold Set/cancel Manner Mode.

1 Portrait view when handset open; Landscape view when
closed.
2 Acts as shutter when using Camera.

OlIn Standby (Handset Closed)

No. | Key/Operations Description
4 0 Activate/operate Quick Launcher.
]
28 R Lock/unlock Side Keys and Front
Keys.
Press and hold Set/cancel Manner Mode.
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OlIn Standby (Handset Open)

No. | Key/Operations Description
5 [a)} Access Shortcuts.
Press and hold @) |Open S! Quick News List.
=) Open Phone Book Search menu.
] Open Received Calls window.
Press and hold 8] |Open Received Address List.
=} Open Redial window.
Press and hold (O |Open Sent Address List.
(m] Open Main Menu.
6 Open Mail menu.
Press and hold Compose a new message.
15 Access Yahoo! Keitai portal.
Press and hold Open Yahoo! Keitai menu.
7 Open Main Menu.

Open Task Switch window (when
multitasking).

No. | Key/Operations Description
14 Activate function assigned to key.
Default Setting: Schedule
Press and hold Assign a function to key.
8 Answer/make calls.
Open Quick List.
13 Play messages on Answering
Machine.
Press and hold Set/cancel Answering Machine.
12 | Press and hold (=] | Turn power on/off.
9 | Press and hold Set/cancel IC Card Lock.

Press and hold (5]

Activate/deactivate Power Save

Mode.

- Display is dimmed in Power Save
Mode.

Press and hold

Set font type, thickness and size.

Press and hold

Set Screen Filter on/off.

- Display becomes opaque.

- Setting returns to off when
powered back on.
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No. | Key/Operations Description No. | Key/Operations Description
9 |Press and hold (8] |Toggle Light on/off. 13 Hold call.
Press and hold (O] |Enter “+" (international access 12 =) End call.
code).
) 11 | Press and hold Set/cancel Manner Mode.
11 | Press and hold Set/cancel Manner Mode. In Manner Mode, voice sent via
microphone is amplified on
ODuring Voice Calls (Handset Open) caller’s side.
No. | Key/Operations Description ODuring Voice Calls (Handset Closed)
5 (=) Increase earpiece volume No. | Key/Operations Description
(alternatively, use Viewer Key).
31 Increase earpiece volume*.
Press and hold (&) | Continuously increase earpiece P
volume. 30 o] Decrease earpiece volume*.
) D?creasg eTrpieceC\/qume ¢ * When earphone-microphone attached. Call ends when
(alternatively, use Camera Key). handset closes and earphone-microphone not attached.
Press and hold (@) | Continuously decrease earpiece P .
volume. ODuring Text Entry
) Open Received Calls window. No. | Key/Operations Description
=) Open Redial window. 5 =) Insert line feed “ 4 “ (when cursor is
at the end of text).
6 Turn handsfree on/off.
- - E Add a space (when cursor is at the
7 &7 Open Task Switch window. end of text).
14 Display function menu.
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No. | Key/Operations Description No. | Key/Operations Description
6 Toggle character entry mode (in 10 Enter dakuten (* ) or handakuten (
5-touch or T9 input mode). ° ) (in 5-touch, 2-touch or T9
Toggle double-byte and single-byte mode).
characters (in 2-touch mode). Toggle case (in 5-touch or 2-touch
mode).
Press and hold Toggle text input methods (in Insert)line feed " 4
5-touch, 2-touch or T9 input
mode). Press and hold Select area.
15 Switch to pictograph/symbol lists. 11 Toggle Shift, Caps Lock and lower
case modes (when enterin
Press and hold Access My Pictograms (in S! Mail). alphanumeri(cs inT9 inputgmode).
8 Cycle characters in reverse order (in Press and hold Paste copied or cut text.
5-touch mode).
Press and hold Undo last operation (conversion,
pasting, cut, etc.) and return to the
previous state.
13 Delete one character to right of

cursor.
When cursor is at end of text, a
character to left is deleted.

Press and hold

Delete all text to right of cursor.
When cursor is at end of text,
delete all text.




Use Front Keys to activate/operate Quick Launcher when

handset is closed. From Quick Launcher, access Camera, TV,

Music Player, etc.

@ To use Front Keys in Landscape or Portrait view, position
handset as follows.

Landscape View Portrait View
o
Bottom Front Key Top Front Key
Slide Display open. Slide Display shut. Center Front Key
Tip
» Functions activated while handset is closed remain active after C !
opening handset.

= SoftBank

)Y

(o )
Front Key WA O
Note A nggTJ

* Opening or closing handset while touching Front KeysFor Side @ Use [ (Top) or [ (Bottom) to scroll through menu then press
Keys may cause malfunction. Set Keypad Lock (press (g while to select an item.
handset closed) to prevent malfunction. @ Use (3] to lock/unlock Front Keys.

Tip

* In this guide, Front Keys are indicated as follows.
Top Front Key: [ (Top)
Bottom Front Key: [ (Bottom)
Center Front Key:

pape)s bunyan i
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Display Indicators

O@E@®O®®®O®wM 0 @

IHIIIHI?I
.TII.-'.Sl .éthEcoei

BiETARE
T

® @ @ @ @ (® @ e

_\J

_.

o] | Battery Level
. Temperature Monitoring
@ Tl signal Strength
OUT Out of Range
Y Emission OFF Mode
USIM Lock Active
@% Yahoo! Keitai Mode
% Yahoo! Keitai Communication in
Progress
" Packet Transmission (No Data Transfer)
@ Connecting to Network for Packet
Transmission
-/ % Packet Transmission (Sending/
Receiving Data)
4 % SSL Secured Site Connected
) ® Unread Messages
& Handset Message Memory Full

O]

@

B USIM SMS Memory Full (& when
there are unread messages)
B Handset & USIM SMS Memory Full
® & Software Updated
@ 7 Dial Lock Active
S Secret Mode/Secret Data Only Mode
€ Custom Lock Active
% Custom Lock Active in Secret
Mode/Secret Data Only Mode
ir Infrared Transmission
Authenticating IC Card
O S! Addressbook Back-up Synchronizing
@® B |C Card Lock Active
@ 2 Power Save Mode
T Screen FiIterOn(E when Backlight
is Off)
@ $§ Keypad Lock Active (After Closed,
Timer or Lock Key is ON*)
@) & Memory Card Inserted
8 Invalid Memory Card Inserted
Memory Card Reader/Writer in Use
& Accessing Memory Card
@ 4 Voice Call
E Video Call
& Maximum Call Cost Limit Reached
i) /B USB Cable Connected in
Communication/microSD Mode

icroSD Mode
Handsfree Device Connected in
Communication/microSD Mode
USB Cable & Handsfree Device Connected
in Communication/microSD Mode
@ {8 Vibration Set for Incoming Calls & Messages
= /lz Vibration Set for Incoming
Calls/Messages
@ Y& No Ringtone for Incoming Calls & Messages
J2 /342 No Ringtone for Incoming
Calls/Messages
@ § Manner Mode
¥ Auto Manner Mode Start On
2 Auto Manner Mode Release On
) A Alarm Set
@ Alarm Set for Today (appears prior
to set time.)
@ & TV Timer Recording in Progress
@® ﬁf New Messages at Voice Mail Center
® 2 ,. - I,. Voice Messages on Answering Machine
@ 48 - 34 Video Messages on
Answering Machine

* Lock Key is ON by default.

Tip

* To see indicator descriptions:
(m) »» Settings P (w) M) Display M
(@] M) icons »» (m)




© More Features
Customize

Display Settings

< Wallpaper

+ Display Color Scheme
< Set Font Type

+ Interface Language

< Guard from Prying Eyes
+ Display Quality

(= P. 14-9)
Backlight
% Set Backlight & Power Saving
+“ Set Brightness of Backlight

(*® P.14-7)

Standby Indicators
< Enable Indicator Selector
(% P. 14-10)
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Before Using USIM Card Other Notes on USIM Cards

Universal Subscriber Identity Module (USIM) Card is an IC

card that contains customer information (phone number,

etc.). A USIM Card must be inserted to use your handset.

@ Store Phone Book entries and SMS on USIM Card.

@ Insert USIM Card into other USIM-compatible SoftBank
handsets to use information on Card.

@ Do not apply excessive force when inserting/removing USIM
Card.

@ SoftBank is not liable for any damage caused by inserting USIM
Card into other IC card readers/writers.

@ USIM Card may become warm during use. This is not a
malfunction.

@ Keep IC chip clean.

@ For details, refer to the manual supplied with your USIM Card.

@ Do not drop USIM Card or subject to excessive shock. Doing so
may cause malfunction.

@ Do not bend USIM Card or place heavy objects on it. Doing so
may cause malfunction.

@ Avoid extreme temperatures.

@ Do not scratch, carelessly touch or short-circuit the IC chip.
Doing so may result in data loss or malfunction.

@ Clean USIM Card with a dry soft cloth (such as is used for
eyeglasses).

@ Use a SoftBank-designated USIM Card. Using a non-designated
card may result in handset malfunction.

1-10

@ USIM Cards are the property of SoftBank.

@ USIM Cards will be reissued for a fee if lost or damaged.

@ Return USIM Cards to SoftBank upon cancellation or
suspension of service.

@ Returned USIM Cards are recycled.

@ USIM Card specifications and performance may change without
prior notice.

@ Keep a separate copy of data saved on your USIM Card.
SoftBank is not liable for lost data.

@ If USIM Card or handset (with USIM Card inserted) is lost or
stolen, suspend service immediately. For details, contact
SoftBank Customer Center, General Information (P. 15-52).

@ Downloaded files (S! Appli, videos, Saved Pages, etc.) saved to
handset or memory card may be inaccessible after USIM Card
replacement, handset upgrade or service subscription
cancellation. If a different USIM Card is inserted, the cookies
and cache are cleared to protect personal information.

e

—




There are two security codes for USIM Cards: PIN1 and PIN2.
PIN1

PIN1 is a four- to eight-digit code to prevent unauthorized

handset use by a third party.

@ Default PIN1 is 9999.

@ PINT can be changed (P. 4-2).

@ When PINT Code Entry Setis set to ON, PIN1 must be entered
each time handset is turned on to be used.

PIN2

PIN2 is required to reset total call cost or to set a maximum
limit to call costs.

@ Default PIN2 is 9999.

@ PIN2 can be changed (P. 4-2).

PIN Lock & Cancellation (PUK)

If PIN1 or PIN2 is incorrectly entered three times

consecutively, PIN Lock is activated, limiting handset use to

specific functions. Enter Personal Unblocking Key

(PUK1/PUK2) to cancel PIN Lock.

@ For information on PUK, contact SoftBank Customer Center,
General Information (P. 15-52).

Note

« If PUK1 is incorrectly entered ten times consecutively, USIM Card

is locked and handset is disabled.

« If PUK2 is incorrectly entered ten times consecutively,
operations requiring PIN2 entry are all disabled.

* Write down your PUK.

* To cancel USIM Card lock, contact SoftBank Customer Center,
General Information (P. 15-52).

papels bunyan i
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@ Remove Battery (P. 1-13) before inserting or removing USIM
Card.

Insertion
A Pull Tray out by catch

paye)s bunyan

Place USIM Card on tray with gold IC part
facing downward, in the orientation shown

_—Tab

Removal
nPuII Tray out by catch and remove USIM Card

If Tray Detaches

Do not use excessive force to pull Tray; may slide out

completely.
If Tray detaches, align Tray horizontally, then push in all the
) ) way.
Side with gold IC
visible facing
downward

1-12



Battery & AC Charger

Notes on Battery Charging Battery Installation

@ Charge battery at least once every six months. If battery is left
uncharged for a long period, it may become unusable or its
operation time may decrease.

@ Avoid connecting too many things to one AC outlet. Doing so
may cause the AC outlet to overheat and cause a fire.

@ Battery and AC Charger may become warm during charging,
but this is not a malfunction. If they become too hot, however,
stop charging and contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

@ If Charging Indicator flashes during charging, battery may be
faulty. Contact SoftBank Customer Center, Customer
Assistance (P. 15-52).

@ Depending on the conditions of usage, the battery may expand
as it nears the end of its life. However, this presents no safety
problems.

@ Check the battery type on its label:

Mark Type

Li-ion00 Lithium-ion battery Yoy
Lithium-ion batteries are a %é}
recyclable resource. Do not Li-ion00
dispose of them as municipal

waste. Bring used batteries to your nearest
SoftBank Shop or recycling center after
insulating the terminals with tape. Observe
local regulations on battery disposal.

Insertion
) Press “— " mark and slide off Battery Cover

Note
* Hold handset firmly so handset does not slide open when
removing Battery Cover.

pape)s bunyan i
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Battery & AC Charger

Terminals

paye)s bunyan '

1-14

%) Align terminals and insert in direction shown

(®), and then press into handset (®).

Note

* Do not force Battery Cover shut. Tab may be misaligned, and
cause breakage.

Removal
@ Turn off handset before removing battery.

nRemove battery cover

Pressing Tab (®), lift out battery (®)




Battery & AC Charger
Pull Port Cover (as indicated by arrow ®
Open Port Cover [ ( y )

Rotate Port Cover (as indicated by arrow @)
@Using excessive force may cause damage.
@Keep Cover completely open (as illustrated) while Port
is in use.

Note

* When handset is connected to an external device, be cautious
of Port Cover. Excessive force may damage it.

pape)s bunyan i
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Battery & AC Charger

paye)s bunyan

Charging Battery

Using AC Charger

Use only SoftBank-specified AC Charger “ZTDAA1" (sold
separately). In this guide, the ZTDAA1 model AC Charger is
referred to as “AC Charger.”

Blades

External

Device Port  Port Cover

- =T e
zS
/i’@% J Release Tabs

/
Connector )

AC Charger :

1-16

) Open Port Cover
See P. 1-15.

Insert Charger connector into External Device
Port

Extend Charger blades and plug into an AC
Outlet

Charging Indicator lights while charging. When
charging is complete, Indicator goes out.

Disconnect connector from handset
Press and hold Release Tabs to remove connector.

£ Close Port Cover
BUanug Charger from AC Outlet

Note

* Battery can only be charged while inserted in handset.

+ When Charging Indicator and Display Indicator Bl go out and
Charge Unusual Stop Charge appears, disconnect handset
from AC Charger and remove battery. Set up handset and
Charger and start charging again. If the same error occurs, AC
Charger may be faulty. Contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

» When Charging Indicator and Display Indicator <« are
flashing, handset temperature is unsuitable for charging
(Temperature Monitoring). Wait until handset cools down.




Battery & AC Charger

© More Features
Customize

Backlight
«“ Set Backlight during Charging

(* P.14-7)

pajie3s bunyen i
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Power On/Off

paye)s bunyan

@ Make sure USIM Card is correctly
inserted before turning power on.

A Press and hold (=)

Tip

« After USIM Card is replaced, Security Code
is required when powering handset on for
the first time. If Security Code is incorrectly
entered five times, handset shuts down.
Turn handset on again.

1-18

OPowering Handset On for the
First Time (Initial Setup)

Setup prompt appears in Japanese.
Select NO and press (®] to exit.
After changing interface language to
English (P. 14-6), restart handset and
perform setup procedure as follows.

EDinitial Settings] window »
YES » (m]

F)Auto » (8] ) Select a time
zone ) (m]

HTo Manually Enter Date & Time
»» Manual (Date Time Set) »» (&)
» Select a time zone ) (W) M)
Enter date and time ») (®)

[E) Enter Security Code (9999)

» (m] »» Enter new Security
Code » (®] »» YES » (m]

) select a font size » (u]

BWhen Separate Setting is
Selected
Set a font size for each function
window (P. 14-6).

[Keypad Sound Setting] window
» ON or OFF ) (u]

Tip

* Setup prompt no longer appears when
all the initial setup items have been set.

* The default Security Code is 9999.

ORetrieving Network
Information
When (&), [, [E3 or (] is pressed after
initial setup, a prompt appears. Select YES
to update network settings.

Tip

* Retrieve network information to use
network-related services, such as mail
and the Internet.

* To manually update network settings:
(m) P> Settings P»(m) »» Connection
Settings »» (m) P» Retrieve NW Info
» (m) P> YES )b (m)




Power On/Off

OWelcome Mail

You will find a Welcome mail from
CASIO in Inbox at time of purchase.

Tip

« Packet transmission fees apply when
accessing links in Welcome mail.

» Welcome mail can be deleted but after
initializing handset, it will reappear in
Inbox.

Power Off

nPress and hold (=]

Handset shuts down.

More Features
Customize

Clock
< Hide Clock
< Set Auto Time Adjustment
< Manually Adjust Time
< Summer Time
% Time Zone (Sub Clock)
« Hide Sub Clock
< Summer Time (Sub Clock)
< Time Zone Major City (Sub Clock)
(* P. 14-2)
Auto Power On/Off
< Set Auto Power On/Off
(* P.14-3)
Display Settings
< Set a Wake-up Image
< Set a Wake-up Message
< Set Font Sizes Collectively
«+ Set Font Size for Each Function Window

(* P. 14-4)
Sounds
< Set Handset Open/Close Sound
(< P. 14-14)

< Set Key Sound Off

pape)s bunyan i
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Mobile Manners
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Use your handset responsibly.

Inappropriate handset use can be both

dangerous and bothersome. Take care

not to disturb others when using your
handset. Adjust handset use according
to your surroundings.

@ Turn handset power off in theaters,
museums and other places where
silence is the norm.

@ Refrain from use in restaurants, lobbies,
elevators, etc.

@ Observe signs and instructions
regarding handset use aboard trains,
etc.

@ Refrain from use that interrupts the
flow of pedestrian or vehicle traffic.

1-20

Activating Manner

Mode

Most handset sounds are muted in
Manner Mode.

) Press and hold

HlTo Cancel Manner Mode
»» Press and hold

Note

* When handset is set to vibrate for
incoming calls, be careful as handset
may slide off, slide into a stove, etc.

Tip

« Shutter click sounds even in Manner
Mode.

* Press and hold to set or cancel
Manner Mode during a call. Short
beeps sound through the earpiece
when Manner Mode is set or canceled
during a call.

« Set or cancel Manner Mode by
pressing and holding B.

© More Features
Customize

Manner Mode

< Set Manner Mode Type

« Configure Original Manner Mode

< Set Time for Auto Manner Mode Start

<+ Set Time for Auto Manner Mode
Release

< Toggle Auto Manner Mode Start and
Release On/Off

(% P. 14-13)



Security Code, Center Access Code and

Network Password are required to use

handset.

@ Do not reveal these codes to others.
Write down your codes.

@ SoftBank is not liable for any damage
due to handset misuse.

Security Code

Security Code, 9999 by default, is

required to use some handset

functions. The code can be changed.

@ If Security Code is entered incorrectly or
nothing is entered for 15 seconds, a
tone sounds and a message appears.
Enter correct Security Code.

@ Security Code is referred to as #{EFIE
SFEES (operation code) on SOFTBANK
MOBILE Corp. Website (http:/
www.softbank.jp).

Note

» The warning tone does not sound in
Manner Mode or when Keypad Sound
is set to OFF.

Changing Security Code

)= » settings » (=) »
Security » (8] » Change
Security Code ) (u]

Enter current Security Code

» (m)

Enter new Security Code »
(=] » YES » (m]

Center Access Code

Center Access Code, a four-digit code
assigned at initial subscription, is
required to access Optional Services via
landlines or to subscribe to fee-based
information.

Network Password

Network Password, a four-digit code
assigned at initial subscription, is
required to use Call Barring.

@ If Network Password is incorrectly
entered three times, Call Barring
settings are locked. Network Password
and Center Access Code must be
changed.

pape)s bunyan
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Other Basic Information
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122

Checking Battery Level

Use Battery Level meters as a guide only.

Battery Level Indicator
Battery Level indicator appears at top
of Display.

B Sufficient

B Low

E Almost out. Charge immediately.
B (Flashing) Charging

Battery Level Beeper &
Large Indicator

Check battery level by number of
beeps and large indicator.

)= » settings » (m) »
Other Settings » (8] »
Battery Level ) ()

A large battery level indicator
appears. Beeps sound according to
the battery level.

Three short beeps: Sufficient

Two short beeps: Low

One short beep: Almost out.
Charge immediately.

Note

» The battery level beeper does not sound
in Manner Mode or when Keypad
Sound is set to OFF.

OWhen Battery Is Empty

Recharge Battery appears, the battery
alarm sounds for about 10 seconds, and
handset powers off in about 60
seconds. Charge battery.

My Phone Number

Check handset phone number.

= » (o)

Account Details appear.

HMAdd Other Information
» » Edit P Enter Security
Code » (®) M) Select an item P
(@) Db Enter information »» (&) M)

HView All Information
» »» Display All Data ) (m]
» Enter Security Code M (m] M)
I3 to switch tabs

HReset Account Details
» (@ P> Reset »» (8] b YES M
(w

Checking Network

Status

Check Network Status to confirm if
voice calls and/or packet transmission
is available.

(=) » settings » (=] »
Other Settings » (8] »
Network Status ) (u)
Network information appears.

E Packet i
Dialing Transmission Description
not not Voice calls/packet
available |available |transmission not

possible.
available | not Voice calls
available |[possible, packet
transmission not
possible.
not available |Voice calls not
available possible, packet
transmission
possible.




Other Basic Information

S Packet L
Dialing Transmission Description Note
- - - » Display Settings set during Power Save
available |available |Voice calls/packet I\/:oFc)ieyrema:ngeven a?tér%ow\g/r Savev
transmission Mode is deactivated.
possible.

“Qut of Service Area” appears when out
of range.

pape)s bunyan i

Using Power Save

Mode

When set to Power Save Mode, light,
sound, and Display settings are
modified to decrease battery
consumption.

) Press and hold (5)
Power Save Mode is set, and “ 2 ~
appears.
ECanceling

»» Press and hold (5]

Tip
* Power Save Mode is canceled when
power is turned off and on again.

1-23






@Basic Operations

Menu Operations ........ccccccveeeeeeerensacens 2-2
Accessing Handset Functions.................... 2-2
Shortcuts/Notifications .........ccccocevercenene 2-5
Navigating through Menus...................... 2-7

Multi Function .........ccoceiiinienncnneenen. 2-9
Activating Another Function.................... 2-9
Toggling FUNCtions .......cccceeveeneiiieniiennns 2-10

Text Entry...cocveccceieec e 2-11
OVEIVIEW...ooiuviiiiiiieiiee e 2-11
Entering Characters in 5-touch Mode.... 2-13
Editing Text .......cooeveeieiiiiecccee e

Editing Templates
Using Dictionaries
Entering Characters in 2-touch Mode.... 2-16
Entering Characters in T9 Input Mode .. 2-16

Phone BoOK.........cccceveemmerrnnncernnnneennns
OVEIVIEW ...eeiiiiieeiie et et e e e eaee e
Creating Phone Book Entries..................
Using Phone BooK .......cccoeceeevieeniiiieennenn.
Phone Book Settings ........ccceceeeveeneeennen.

S! Addressbook Back-up...................
OVEIVIEW ...eeiiiieeiiiie et e et e e e eenee e
Using S! Addressbook Back-up ...............

Advanced Features..........cccccereeerrnenns
Main MeNU........cccoieiiiieiiieeeeeee e
Shortcuts ........

Text Entry.......
Templates.......
Dictionaries
Phone Book
S! Addressbook Back-up.........ccceeeveeennes




™ Menu Operations
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Accessing Handset
Functions
@ In this guide, most operations start from
Main Menu.
From Main Menu

Press (8] to open Main Menu. Use KX to
select an item and press (8] to open sub
menus.

Y7
Meil YehoolKefsi. SIARDi

1
TV Camera  Entertanment

|
Tools. DataFolder  MUSIC

‘A i

OwnData  PhoneBook  Settings.

Use utiities as Camera, Video,
Snap Viewer, etc.

Main Menu

Tip
* Handset returns to Standby after 15
seconds of inactivity.

Using Softkeys & Multi
Selector

Press Softkeys or use Multi Selector in
Standby to access assigned functions.

OSoftkeys

- [=): Open Mail menu.

. (Press and hold): Compose a new
message.

- [¥): Access Yahoo! Keitai portal.

- [¥) (Press and hold): Open Yahoo! Keitai
menu.

- (@]: Access the function assigned to the
key.

- (®] (Press and hold): Assign a function to
the key.

OMulti Selector

- (B): Access Shortcuts.

- @) Open Phone Book Search window.
- I3): Open Received Calls window.

- [@: Open Redial window.

Keyword Search

Enter keywords to search for menu
items.

0E» @
F)Enter keyword » (u]

<Example> Enter “mail”

Search Word =
mai Il 7Inbox
<

2Qutbox

3Draft

%Compose Message
50 IS
§Server Mail

7Retrieve New

BESel. Area 5;5"‘“'?“ o

B2

Corresponding results appear.

E)select an item » (m]

EToggling Multiple Items
Press [¥) to toggle items.



"8 Menu Operations

From Quick Launcher

Activate Quick Launcher when
handset is closed to access TV, Snap
Viewer, Movie Viewer, Photo, Movie,
or MUSIC.

E) 0 (Top). or
O (Bottom)

ETil ]

Quick Launcher

Quick Launcher

HReturning to Standby
»

OMenu Items

Icon Function

Activate Camera in Photo
Mode (P. 7-8)

Activate Snap Viewer
(P.7-19)

Activate TV (P. 8-7)

Tip
* Handset returns to Standby after a
period of inactivity.

Activate Movie Viewer
(P. 7-21)

Activate Camera in
Movie Mode (P. 7-10)

I L]
Activate Music Player

@'\ (activates in Portrait view)
(P. 9-6).

#) 0 (Top) or [ (Bottom) to
select an icon »

From Original Menu

Assign often-used functions to
Original Menu for quick access.

BE=»

Original Menu

EFAccount Details
|2Retrieve New

I3Ring Volume

|4 Vibrator

|5/Alarm

l6,Change Security Code
7 <Not Recorded>

8 <Not Recorded>

9 <Not Recorded>
0<Not Recorded>

Press ] to toggle between Main
Menu and Original Menu.
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"8 Menu Operations
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Enter Menu Item Number

Enter these numbers for direct menu

access. Note that Main Menu Theme

must be set to Standard.

@ See P. 15-21 for menu item numbers.

@ See P. 2-28 for details on changing
Main Menu Theme.

<Example> Access Select Ring Tone

(menu no. 13)
[71]0

B » =)

Menu13
Select Ring Tone

[ hone smenenannsn]
|2Video Call
|3 Mai |




" Menu Operations

Shortcuts/

Notifications

Add functions to Shortcut Icons and

use them as shortcuts.

Notifications appear on desktop to

inform you of missed calls, new

messages, etc. Select a notification to

check the information.

The following shortcuts are set by

default.

@ S! Quick News List

@ Camera (BI-DO-RI)

@ S! Appli (/U1 )UEFIR (Mobile
Organizer) (Japanese))

OShortcut Icons

Function

Icon

Function

S! Quick News List

Inbox Folder

Camera (BI-DO-RI)

Camera (Photo)

S! Appli

Camera (Serial)

For continuous shooting.

Call Phone Number

Camera (Movie)

Compose S! Mail

Schedule

Compose SMS

To Do List

Access Webpage (Yahoo!
Keitai)

e pe s

Text Memo

Access Webpage (PC Site
Browser)

Bar Code Reader

Play Melody

Text Reader

FrpeBl s g

Show Image

Music Player

==

[L[]
=

=

Play Video

TV

suonesadQ diseg n



"8 Menu Operations

=

I

Answering Machine (Video
Message)

Icon Function Icon Function/Information Icon Function/Information
Calculator Answering Machine USB Mode Communication
I |Play/delete messages.
Msg
Dictionary

Network Re-search

suonesadQ diseg !

=
S
=
o

9 Receive IR Transmission el | Play/delete Video Messages.
@ = Voice Mail %’ﬂ New S! Info Channel
E@ Original Menu
- New Messages New S! Info Channel Receive
#m, |PC Site Browser = W1 |Failure
smiﬁi'ﬁ"’ [ Miss |
Books Failed Alarms New Weather Info.
BLs (8 4
I | Miss |
Play/Erase Msg. -
@H yikrase s Missed TV Programs Weather Info. Receive
‘m‘ﬂ Failure
Siry, |Play/Erase VC Msg. ALARM [ Miss |
(=] Timer Recording Finished @‘I Content Keys Acquired
REC|
ONotifications
Icon Function/Information @ ,r\{AaXirTLém Call Cost Limit Notifications disappear after accessing the
Missed Calls eache functions or information. Answering
"‘ﬂ Soft Uod Machine and Voice Mail notifications
| Miss | @ oftware Update disappear after message is played back.




" Menu Operations

Adding Shortcuts BChanging Themes . .
e rrera O Navigating through

Select atheme M (W] M YES ») (m)  B\V PSONTTS

Add up to 15 icons per theme. Select
from three themes.

) From a function » (@) » Scrolling Pages
Add Shortcut Icon » (8] Use (X or IO to scroll next/previous
(» YES » (m)) pages.
Accessing Shortcuts & N Sanes Nl &
Notifications | 5 | e—
(7 ][] AR L d S
5. Video Gall ‘ 4. Send Location Info
6. Display 5. Intl Roaming Set
7. Call Time/Charge E] 6. Optional Services
8. Clock 7. Other Settings
9. Security

0. Slide-style Setting

12

Shortcuts

) &3 to select an icon » (u]
EScrolling Shortcuts

»

suonesadQ diseg i
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Selecting Menu Items
Using Keypad

Use keypad to enter number
corresponding to menu item.

EWNoise Reduction

ON

Kisekae Theme
2 |Incoming Call
3|Talk
4 |Dialing
5,|Video Call
6 |Display
7|Call Time/Charge
8|Clock
9| Security
0/Slide-style Setting

-1

L Menu Numbers

|2Quality Alarm
|3Reconnect Signal
|4Set Hold Tone

»

Return to Previous
Window or Standby

Press to cancel operation and
return to previous window.

Press (—] to return to Standby.

@ May not apply to all functions/windows.

More Features
@ Advanced

Main Menu
< Change Main Menu Theme
«“ Switch to Simple Menu
< Temporarily Change Design Theme of
Main Menu
(@ P. 2-28)
Shortcuts
% Delete Notifications
«+ Edit Title of a Shortcut
% Change Icon Image
% Check Icon Information
% Change icon order
<+ Delete Shortcuts
< Reset Shortcuts
< Show/Hide Shortcuts

Customize

Menu Display Settings

« List View and Details View

< Set Main Menu Theme

< Change Icon Design (Original Theme)
% Change Background (Original Theme)
<+ Reset Original Theme Settings

(< P. 2-28)

< Save Last Selected Menu Item to

Memory
< Add a Menu Item to Original Menu
(* P. 14-9)
Key

< Set Key Sound Off
< Change Function Assigned to Shortcut
Key
(< P. 14-39)

Shortcuts
< Set Shortcut Theme
% Change Icon Design of a Theme
< Change Order of Icons of a Theme
< Copy lcons to Another Theme
< Move Icons to Another Theme
+ Delete Icons of a Theme
< Show New Message Indicator as 3D
Animation
(* P. 14-7)



M

Activate up to three functions
simultaneously. Activate one function
per group at one time (except TV &
MUSIC Group).

Function Group Function

Mail Group Mail

Yahoo! Keitai Yahoo! Keitai

Group

S! Appli Group  |S! Appli

Settings Group | Settings, Optional
Services

Tools Group Data Folder, Tools,
Phone Book, Own
Data, Camera, Snap
Viewer, Movie Viewer

TV & MUSIC TV, MUSIC

Group

@ See P. 15-2 for available combinations
of functions that can be activated at the
same time.

@ Currently active functions are indicated
by task indicators in Task Indicator Area.
To switch to a different function, select
the corresponding task indicator.

[Py wer p—

[~ Y7 ~

Miail ‘Yahoo! Keitai SIARPI
i -
TV Camera  Entertainment
m @
Tools DataFolder  MUSIC
A B i

OwnData  PhoneBook  Settines

Use utilities as Camera, Video,
m E)‘,“"il' Viewer, etc. |
Task Indicator Area

@ Transmission fees are incurred while
accessing functions during a voice call.

Activating Another

Function

Activate another function without
exiting current function.

nWhiIe using a function » 53

» Select another

function » (=]

HEMail Function
After step 1 M)

HlTo Access Yahoo! Keitai Portal
After step 1 W

HTo Activate Function Assigned to
Shortcut Key
After step 1 M)

suonesadQ diseg i



_

» » HMEnding Multi Function
Toggling Functions » (=) M Quit Selected or Quit
All Function »» (u)

m ) When multiple functions are

® active » Tip
n, _ « Alternatively, press and hold 5] to end
8 e ) Multi Function and return to Standby.
.g &~ : Stand-by display
a «~ : Quit function
=3 4» . Select function
o
=2
0
NUSTC
BES

Task Switch Window

ESwitching Functions
» I3 to select a task indicator P

HOpening Main Menu
»
HReturning to Standby
»
Press [&7 in Standby to reopen Task
Switch window.

2-10



Handset has three text input methods:
5-touch, 2-touch and T9 Input.
@ This guide mainly explains Japanese

text entry in 5-touch mode.

Text Entry Window

A text entry window consists of
Character Entry Pane, Guide Pane and
Status Pane. Indicator and key
descriptions are as follows:

Character
| Entry Pane

@512 — Status Pane

Text Entry Window

OCharacter Entry Pane

OGuide Pane

OStatus Pane

Text input method

suonesadQ diseg i

Cursor

B ® (2-touch/T9 Input mode) (No
indicator for 5-touch mode)

M 0 Insert/Overwrite mode

i Character entry mode

]
Kuten code input mode

(P, 2-30)

7 7 Double-byte/Single-byte
mode

= Lower case input mode

il Shift/Caps Lock mode

R Bytes remaining for text
entry.

o Number of entered

<

End mark (end of text)

A ¥ CHG |[(@) to convert characters
[l v All (@) to search Phone Book
[4] [¥] Find

] X to specify a text range

[A][¥] Area |to copy/cut

CR to insert line feed

¥ Sel. Press and hold to

Area select area of text to
copy(cut)

Aa to switch case of each
character, or to add
dakuten (" )/handakuten
)

H AA—aa to cancel Caps Lock
mode

[H aa—Aa to set Shift mode

[H Aa—AA to set Caps Lock
mode

‘¥ Paste |Press and hold to
paste copied or cut text
¢« Back to cycle characters on

a key in reverse order (e.g.
A—=D)

characters (appears when
entering text to USIM
Phone Book/SMS message)




[+]
]
2,
n
O
T
[}
=
]
=4
o
=]
w

Split Windows

In some instances, a second window
opens with text entry window.

w
L&SSU) [F
Ddetails .
— Function
window
neelting at conference r
— Text entry
window
ISZ  RURS

Referring to Dictionary
from a text entry window

Oswitching Windows

Press and select Change Window
to switch windows.

2-12

Changing Text Input
Methods

D (Text Entry] window »
» CHG Input Method » (m]
» Select a text input
method » (@)
Alternatively, press and hold [=.

Toggling Character Entry
Modes

§D(Text Entry] window »
Press (9] to toggle entry modes.
Kanji/hiragana P> Katakana P
Alphanumerics P> Numbers

Tip
* In 2-touch mode, press (2] to toggle
single-byte and double-byte modes.

Interruptions during Text

Entry

OWhen Battery Runs Out
Battery alarm sounds and Recharge
Battery appears. Text is automatically
saved. Access the same function to
continue text entry.
Text may not be saved depending on the
function.

OWhen (—] is Pressed
A message appears asking whether to
end text entry. Select YES and press (w)
to end text entry without saving the

text. To continue text entry, select NO
and press (m).

OWhen a Voice Call Arrives

Answer the call. After call ends, text
entry window returns.



Entering Characters

in 5-touch Mode

Press a key multiple times to cycle
through letters assigned to that key.
@ For key assignment, see P. 15-11.

Kanji, Hiragana &
Katakana

Enter a reading (in hiragana) and
convert to kanji, katakana, etc.

OUsing Conversion

Enter a character and Conversion
function suggests words starting with
that character. Conversion also
suggests word selection for words to
follow.

Switch to kanji/hiragana mode to use
Conversion.

OAuto Cursor
If no key is pressed for a set time during
text entry, cursor moves to the right.
See P. 14-39 for how to switch cursor
movement speed.

<Example> Entering “ & &%~
n[Text Entry] window »
(four times)

“[F" is entered in Character Entry
Pane.

Suggestion list shows predictions
for words beginning with “[F” in
Guide Pane.

© Edit Memorandums
31

“#5& " appears in Character Entry

Pane.
A suggestion list of words that
follow "% “ appears in Guide Pane.

HWhen Required Word Does Not
Appear
»
Continue hiragana (reading) entry
in Character Entry Pane to narrow
down selection.

E)D » Select “EsE~ » (m]

© Edit Memorandums
He BEE|

[ViSel . EACIose: 55
#8 LT 93 <pLsl
£ BISBL BUHFES
g KT k3 LZT
D E [ LE H
LELE T X . B

HTo Exit Suggestion List
» or

Tip

* Handset has a learning feature that
adds entered words to the suggestion
list. Press and hold to delete an
added word from the suggestion list.

suonesadQ diseg
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OConverting Hiragana
If the required suggestion does not
appear or conversion is set to Off,
convert to Kanji as shown below:

<Example> Entering “{E< K"

[Text Entry] window »»
(once) » & »
(once) » (twice)

suonesadQ diseg

© Edit Memorandums
SSE

HlTo Delete Last Input Character
»

HTo Determine Entered Hiragana
without Converting It
» (m)

» (m]

HlTo Reconvert to a Different Word
» » Select a word

HTo Change Conversion Range

» o

2-14

Dakuten (" ) &
Handakuten (" )
<Example> Entering “ hi*
n[Text Entry] window )
(2] (once) » » (m]

Switching to Lower Case
<Example> Change “D* to "> “

§)(Text Entry] window »
(4] (three times) » »

(w)
Pictographs & Symbols

0=

© Edit Memorandums

BRe00T<av)EE@d
4 B8LY LRAVLEOYARL
4R20? | YPOOOOODO
[oolololob Y T Xl

Select a pictograph/symbol
» (w]

HTo Toggle Pictograph/Symbol
Categories

» & or (v

HlTo Toggle Full-Screen List and
Continuous Entry
»

The pictograph/symbol list
window is closed.

Emoticons
)@ » Face Mark » (s
%) select an emoticon » (=]

Common Phrases
(Templates)

§) (@ » cCommon Phrases »
(w]

) select a folder »» (] »
Select a phrase » (8] (twice)



Alphanumerics, Numbers
& Katakana

Enter alphanumerics, numbers or
katakana in kanji/hiragana input
mode.

[Text Entry] window »»
Enter hiragana » ¥ »
Select a character » (m)

Deletion & Correction

A (Text Entry] window »
Move cursor to the left of
the character to delete »

HlTo Delete All Characters to the

Right of Cursor
»» Press and hold
HlTo Delete Entire Text

»» Move cursor to the end of text
)»» Press and hold

) Position cursor » Enter
correct characters

Copy, Cut & Paste

@ Only one entry can be stored on
clipboard. If you copy or cut new text,
the previously copied or cut text is
overwritten.

@ Copied or cut text can be pasted
repeatedly until you copy or cut new
text, or turn handset power off.

§)(Text Entry] window »
» Copy or Cut ) (u]

Move cursor to beginning of
characters » (m)

E)Move cursor to end of
characters » (m)

) Position cursor » (@] »
Paste ) (m]

Editing Templates

A=) » own Data » (u] »
Common Phrases ) (8]

H__ Common Phrases

Templates (Common phrases) Window

) select a folder » (m)

Folder 3
EN<Not Stored>
|2:<Not Stored>
|3:<Not Stored>

|4:<Not Stored>
|5:<Not Stored>
[6:<Not Stored>

Templates List Window

HWhen Security Folder Selected
» Enter Security Code ) (m]

E)select an entry » &) »
Enter text » (m)

suonesadQ diseg
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Using Dictionaries

m Saving Words to Own

suonesadQ diseg

Dictionary

Save frequently used words to Own
Dictionary. For each word, save a
reading (in hiragana). When the
reading is entered in a text entry
window, the word appears among the
suggestions.

)= » own Data » (m] »
Own Dictionary » (u]

| Own Dictionary
{New>

Own Dictionary Window

) <New> » (m] ) Enter word
» (m] » Enter reading » (m]

HTo Check Saved Words
) Select a word M) (u]

2-16

Entering Characters

in 2-touch Mode

Each hiragana character is entered by

combining two key presses.

@ For combinations of character input
keys, see P. 15-12.

@ Procedures for selecting predicted
words and for converting entered
hiragana are the same as those used in
5-touch mode (P. 2-13).

<Example> Entering “Fv> 7"

)22 () » (8)0)

(change to lower case mode)

» (B (») »(B8J)0)

(change to upper case mode)
» (0)C8] (k) » (61C3)
(3) » (0I5 (C)

A= » =

Tip

* Pressing also adds dakuten (" )
and handakuten (° ) or toggles upper
case and lower case.

« Press (8] to toggle double-byte and
single-byte modes.

Entering Characters

in T9 Input Mode

Press a key once for each character,

and select the word from the

suggestion list.

@ For key assignment, see P. 15-13.

@ When character entry mode is
“Number,” 5-touch input method is
automatically applied.

<Example> Entering “&"
@ The following example is in Japanese
text entry mode.

n[Text Entry] window » (6]
» (9]

Conversions for the key
combination appear.

© Edit Memorandums
U




E—NnhAZ

HTo Change Conversion Range
» o

HToggle Kanji and Hiragana
Suggestion Lists
» 3]

HToggle English and Japanese
Suggestion Lists

» (=

) (Text Entry] window » (J]
» 1

Select word from among the
suggestions in Guide Pane.

HlTo Show Converted Words on

HTo Exit Suggestion List and
Continue Character Entry
»

(3]0

Re-entering Words
Re-enter as shown below if the desired
word does not appear.

<Example> Entering "S55 E”
@ The following example is in Japanese
text entry mode.

§D(Text Entry] window » (9]

Cursor is on the first character of
the word. The edit window opens
in Guide Pane, where hiragana

suonesadQ diseg i

Suggestion List

»

For example, if you specify “13%,”

then “5&%,” "B4% " and other

words that have the same reading

appear on the suggestion list.
HTo Show Predicted Words on

Suggestion List

»

For example, if you specify “ (&% ,"

then “&{KdH,” “:ED” and other

words that begin with the same

reading appear on the suggestion

list.

(row 5) » (O] (row D) »
(8] (row 5) » (0] (row D)
» (4] (row f2)

“BSh5hE" does not appear in
suggestion list.

characters of row 5 appear.

E)D(5) » (B (L) » (1D
(5) » (BI(A) M (E](E)

© Edit Memorandums
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HIf No Correction is Necessary
»» (®) to move cursor to the next
character

HTo End Re-entering Word
»
The words predicted/converted
from the re-entered word appear
on the suggestion list.

0=

More Features
Advanced

Text Entry

< Switch between Lower Case & Upper
Case

< Switch between Single-byte & Double-
byte

% Cycle Characters in Reverse Order

< Undo Last Operation

+» Move Cursor to Top/End of Text

< Overwrite & Insert Modes

% Insert Line Feed

“ Input a Space

< Use Dictionary

“ Quote Text

< Use Kuten Codes

(@ p. 2-29)
Templates
+ Edit a Folder Name
< Reset a Folder Name
<+ Edit Templates
< Reset Templates
(* P. 2-30)

Dictionaries
< Edit Entries

< Delete Entries

Customize

Text Entry

< Set Text Input Method

< Set Conversion

% Set to Show T9 Suggestion Words in
Kanji or Hiragana

% Clear Learning History

% Change Font Size

+ Set Auto Cursor Movement in 5-Touch
Mode

(< P. 2-30)

(< P. 14-39)



"M Phone Book

Save phone numbers, e-mail addresses and other contact information to Phone Book.

Phone Book
Data & Settings

&- [ -E Name & Reading ElBirthday
EGroup Memo

B4 Phone Numbers  EIStill Image
E£3 E-mail Addresses (@ Entry Number
EAddress

Custom Settings

Incoming Ringtone Vibration
Incoming Image Outgoing Message
Illumination

Secret Data

Contact & Personal Information

Phone Book
Usage Examples

Abbreviated dialing for numbers

SD;i)aeIed in Phone Book (P. 3-12).

. Save frequently accessed Phone
Q_U'Ck Book entries to Quick List
LISt (P. 3-12).
Reject Reject calls from phone numbers
Calls not saved in Phone Book (P. 4-7).

When you make calls or write messages, specify
phone numbers or addresses from Phone Book.

@ Back Up Important Information

Keep a separate copy of Phone Book entry information. When battery is exhausted or removed for extended periods, Phone Book
data may be lost or altered. Damage to handset may also affect data recovery. SoftBank is not liable for damages from lost/altered

Phone Book data.

suonesadQ diseg i
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*M Phone Book

Creating Phone Book
D Entries

suonesadQ diseg

<Example>
Enter a name, phone number and
e-mail address, and specify a group

A=) » Phone Book » (=] »
»» Add to Phone Book
» (=] »» Phone » (u]

» (@] » Enter last name
» (®] » Check reading » (m]
» I » (m] » Enter first
name » (8] » Check reading
» (m]

Reading is entered automatically.
Edit as necessary.
[ Add to Phone Book

GR<Not Stored>
[EXNot Stored>
[EKNot Stored>
ENot Stored>
[EXNot Stored>
[EKNot Stored>
[EKNot Stored>
[Mo10

Phone Book Entry Window

2-20

E)@ » (] » Select a group »
(m]

3 » (w] » Enter phone
number » () ) Select an
icon » (=)

HTo Save Additional Numbers
Select EJ <Not Stored> and repeat
the same step.

E)2 » (8] » Enter e-mail
address » (®] » Select an
icon » (m)

HTo Save Additional Addresses
Select & <Not Stored> and repeat
the same step.

(6=
Setting Incoming Image

n[Phone Book Entry] window
» B (m]

F) select Image » (8] »
Select a folder » (®] »
Select a still image » (m]

HTo Capture an Image with Camera
» Photo Mode »» (8] )) Capture
image ) (m]

HTo Cancel Selected Image
»» Release This »» (u]

Creating Entries from
Other Functions
Create entries from the following
functions:

+ Received calls - Dialed Calls

- Redial - Text Reader

- Receives/Sent Address List

+ Yahoo! Keitai

+ Phone Number Entry window

<Example> Create an entry from
Received Calls

DS » selectarecord » (@) »
Add to Phone Book )) (m]
» Phone » (u]

) Add » (m] ) Search Phone
Book ) Select an entry »
(@] (twice)

Phone Book Entry window with
the phone number automatically
entered opens.



Using Phone Book

MTo Save As a New Entry I3 to select a phone

» New ) (=) number » or (u

Enter other items » » Dialing from Phone Book EVideo Call
YES ) (u] »

Resuming Phone Book
Edit Operation

If battery is empty or if another
function was activated while editing

an entry, resume operation as follows:

A=) » Phone Book » (8] »
»» Add to Phone Book
» (m) » Phone » (] »

A (=] » Phone Book » (m]

] Phone Book
E3lasd td

AikawaYoko
w 09099 3bkkk1

Phone Book Entry List Window

M To Dial the First Phone Number
»

Specifying a Search
Method

(1]

[ Search Phone Book

EBSearch Reading
|2,Search Name
|8,Search Phone No.
|4/Search E-mail
|5.:8earch Memory No.
|6.:3earch Group
|Z.Search Column
|8:Search Al

suonesadQ diseg i

Recall » (m) or [+ to switch tabs » (3
HTo Save As a New Entry to select an entry » (®)
P New ) [ AikawaYoko Phone Book Search Window
¥AEnter each item » (&) » YES : 8]
2 » () o %) select a search method > (8]
& Gum'% B Search Reading:
Tip []9[]993****1 Enter a reading and press (&).
+ Save entry before you exit Phone Book. Search Name:
Otherwise, all changes will be lost. Enter a name and press (@),
Search Phone No.:

Phone Book Entry Details Window Enter a phone number and press ().
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*M Phone Book

suonesadQ diseg !

Search E-mail:

Enter an e-mail address and press ().

Search Memory No.:

Enter three-digit entry number.
Search Group:

Select a group to view saved
entries.

Search Column:

Press a key (1] - (0] or (%)) to
access the tab corresponding to
that key.

Search All:

Phone Book is organized by tabs
(Japanese syllabary order).

] Phone Book

ftd
AikawaYoko
« 09099 3kkkk

Phone Book Entry List Window

Tip
* Phone Book entries saved on USIM
Card are indicated by g .

2-22

Accessing Entries from

Other Functions

Access Phone Book entries from

Received Calls, Dialed Calls, Redial and

Received/Sent Address List.

@ Access Phone Book from Received
Calls

)< » [@ » Look-up Phone
Book » (u]

@ Access Phone Book from Dialed Calls

§)E » own Data » (u] »
Dialed Calls » (m] » (@ »
Look-up Phone Book ) (]

@ Access Phone Book from Redial

§)S » [@ » Look-up Phone
Book » (u]

@ Access Phone Book from Received
Address List

) Press and hold i5] » (@ »
Look-up Phone Book ) (s

@ Access Phone Book from Sent
Address List

) Press and hold (& » (@] »
Look-up Phone Book ) (s

Phone Book Settings

Customizing Handset
Response

Set different ringtones, images, etc.
per entry item or Group.

Olndicators
The following indicators appear for set

items.
AikawaYoko
[010)]

[AikawaYoko

No Group

ol

09099 3%xxx1

P EmEie
3¢ Ringtone (Incoming Calls)

& Ringtone (Mail)

57 lllumination (Incoming Calls)

&= lllumination (Mail)

g# Vibration (Incoming Calls)

¥ Vibration (Mail)

# Incoming Image (Calls)

88 Outgoing Message (Incoming Calls)




*M Phone Book

OTo Customize by Phone
Number/E-mail Address

<Example> Set a ringtone for
incoming voice calls

n[Phone Book Entry Details]
window » 04 to select a
phone number » [®) » Ring
Tonellmage ) (u]

) voice Call (Recv.) » (u]

E)Ring Tone » (8] ) Selecta
ringtone type » (8] (»
Select a folder » (&) »
Select a ringtone » (m])

HTo Cancel Custom Settings
) Select an item M)

OTo Customize by Group

<Example> Set illumination for
incoming messages

n[Phone Book Entry List]
window » (@) » Group
Setting » (u]

) selectagroup » (@) » Ring
Tonellmage » (1)

E)Mail (Recv.) » (m]

@) illumination » (w] )
Select a pattern » (®]

HTo Cancel Custom Settings
)) Select an item M)

Note

» Custom settings are unavailable for
secret Phone Book entries.

+ Custom settings are canceled when
entry is set as secret.

Restricting Calls to/from
Specific Phone Numbers

Restrict calls to/from specific numbers
in Phone Book. This can help manage
personal calls and prevent nuisance
calls.

n[Phone Book Entry Details]
window » K3 to select a
phone number » (@] »
Restrictions » (]

) Enter Security Code » [u]
Select a restriction type »

Restrict Dialing:
Restrict outgoing calls to all
numbers except a specified
number. To call that number, you
need to dial from Phone Book.
Call Rejection:
Restrict incoming calls from a
specified number.
Call Acceptation:
Receive incoming calls only from a
specified number.

HTo Cancel Restriction

) Select a restriction type with
n*u }} [E]

suonesadQ diseg i
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*d Phone Book

suonesadQ diseg !

OWhen Restrict Dialing is Set
The following operations are disabled:
- Dialing by Keypad
- Dialing from Received Calls
- Calling from Phone Book (except:
calling specified number in Phone
Book)

Tip

» When Restrict Dialing is set, all
records on Redial, Dialed Calls and Sent
Address List are deleted.

» Emergency numbers 110, 119and 118
are available even when Restrict
Dialing is set.

« If you change or delete the specified
number, the set restriction is canceled.
Cancel Restrict Dialing to edit or
delete.

2-24

Setting Entries as Secret

Prevent others from accessing certain

Phone Book entries by setting them as

secret data.

@ Phone Book entries set as secret only
appear in Secret Mode or Secret Data
Only Mode (P. 4-9).

n[Phone Book Entry Details]
window » (@] ) Set Secret

» (m]

HTo Cancel Secret Setting
»» Release Secret )) (m]

Tip

* Phone Book entries saved in Secret
Mode or in Secret Data Only Mode are
automatically set as secret.

« If a Phone Book entry that has been
saved to Quick List is set as secret, the
entry is canceled from Quick List.

Managing USIM Phone
Book

Phone Book entries can be copied
between handset and USIM Card.

(= » Tools » m] » USIM

Operation » (8] ) Enter
Security Code » (m]

) Copy » (%] » Phone—
USIM or USIM— Phone »
(=) »» Phone Book » (m)

Search Phone Book

) select an entry » (=]

Repeat this step to specify other
entries.

» YES » (m]



*d Phone Book

Note

* [tems that cannot be saved to USIM
Phone Book are not copied.

» Phone Book entries set as secret cannot
be copied.

* You must end copying of Phone Book
entries to make/receive calls or
send/receive messages.

€ More Features

Creating Entries
+ Save a Postal Code, Address & Memo
+“ Save Birthday
< Change Entry Number
(@ p. 2-31)

Phone Book Search

< Change Index Tab of Phone Book Entry
List Window

< Change Font Size

< Change Phone Number/E-mail Address
Order

% Compose an S! Mail from Phone Book

< Compose an SMS Message from Phone
Book
(@ p. 2-31)

Managing Phone Book

% Check Custom Ringtone/Image Settings
by Item

< Cancel Custom Ringtone/Image
Settings by Iltem

< Check Restriction Settings by Restriction
Type

+» Cancel Restriction Settings by
Restriction Type

% Check Number of Phone Book Entries

+» Edit a Phone Book Entry

< Copy a Phone Book Entry

% Delete Entries

+» Delete Items from an Entry

« Delete an Entry from USIM Card

(* P.2-32)
Customize

Phone Book
< Set Preferred Search Method
< Change Group Name
(" P. 14-16)

suonesadQ diseg i
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™ S! Addressbook Back-up

m Back up handset Phone Book to server.

suonesadQ diseg

@ Separate subscription required.
@ See SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp) for details.
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Note

* Fully charge battery beforehand.

* Packet transmission fees are incurred
for synchronizing, backing up or
downloading.

* Be careful when selecting
synchronization direction. Otherwise
newest information may be deleted.

+ All data in the server Phone Book will be
deleted if Synchronize, Sync From
Client, or Backup is performed after
deleting all data in handset Phone
Book.

+ All data in handset Phone Book will be
deleted if Synchronize, Sync From
Server, or Restore is performed after
deleting all data in the server's Phone
Book.

» The following Phone Book items are not
synchronized. Note that using Restore
will not delete all Phone Book settings.

Using S! Addressbook

Back-up

Synchronizing Phone
Book

Connect to Phone Book backed up on

server and bring it up to date with

handset’s Phone Book.

@ The first time you synchronize will be in
Synchronize regardless of the setting.

@ Synchronization can be any of the
following types.

Synchronize Synchronize handset
Phone Book and
server Phone Book.
Both Phone Books are
synced with the

newest information.

Ringtone Sync from Copy updated
Vibrator Client information to server
lllumination/Images Phone Book.

Sync from Copy update

Server information to

handset Phone Book.




"8 S! Addressbook Back-up

Backup Back up handset SeIeCt type of _
Phone Book to server synchronization » (8] » YES 0 More Features
(note that Server » E]

Phone Book is

deleted). Synchronizat!on starts. $1 Addressbook Back-up
Synchronization results appear + Delete Synchronize Log
Restore Restore server Phone after completion. (@ p.2-33)

Book to handset (note

that handset Phone

Book is deleted). Checking Synchronize S! Addressbook Bac.k-up
@ ) Tools » (8] » S? Log + Set Auto Synchronize

< Check A hroni i
Addressbook Back-up Check Auto Synchronize Settings

suonesadQ diseg i

ED(s! Addressbook Back-up] (% P. 14-16)
0 ;
SN window » Sync Log » (s

— » Select an item ) (m]

i C
|2/Auto Sync Settings
|3.Sync Log

S! Addressbook Back-up Window

) start sync » (8] » Enter
Security Code » (m]
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@ Advanced Features

Main Menu

D Start Here

suonesadQ diseg
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[Main Menu] .....ccveevveerccrnenes P. 2-2

Shortcuts

Change Main Menu Theme

[Main Menu] » P Select a
pattern »» (8] () YES or NO »

(=)

Delete Notifications

&) » Press and hold

Some notifications may not disappear
depending on the type.

Change icon order

&) »» select an icon » (@) M Sort
»» (m] »» YES » (8] )) [ to select
a position »» (=]

Switch to Simple Menu

[Main Menu] » (@ » Simple

Menu »» (] () YES or NO )) (m))

€2 n Simple Menu, font size is larger and
menu options are limited to basic
ones.

Edit Title of a Shortcut

[3) » Select an icon M (@) » Edit
Title »» (W) )} Enter title »» (®]

Temporarily Change Design Theme
of Main Menu

[Main Menu) » (& ) Select a

theme »

£ Next time you open Main Menu,
default Main Menu returns.

Change Icon Image

@] »» select an icon » (@) »» CHG

Icon Image » (8] ) Select Icon

Image » (8] ) Select a folder »

(@) »» Select a file ) (m)

To reset icon image, select Default
Icon Image and press (m).

Delete Shortcuts

3] »» select an icon » (@) M
Delete ) (m)
® To select Delete This
» Delete This »» (8] ) YES )) (m)
® To select Delete selected
» Delete selected M (W) P Select
icons P» () M ) YES M) (m)
® To select Delete All
» Delete All »» (8] »» YES )) (m]

Check Icon Information

@) » select an icon » (@) M Icon
Info Setting ») (m]

Reset Shortcuts

@] » (®) »» Reset Shortcut »» (m]
» YES ) (m)




Show/Hide Shortcuts

&) » (=) » Display Setting » (m]

» Display always or Display at Use

» (m] () (m])

&3 When Display at Use is set, shortcuts
only appear when you press (&) in
Standby.

Functions While Entering Text

@ Advanced Features

Cycle Characters in Reverse Order

[Text Entry] window »» Input a

character M

€2 This procedure is available in 5-touch
mode.

Insert Line Feed

[Text Entry] window M
€3 Press (Q) to add a space at the end of
text.

Text Entry

Start Here
[Text Entry] window ................ P. 2-11
Functions Before Entering Text

Undo Last Operation

[Text Entry] window »» Press and
hold

Input a Space

[Text Entry] window » (@) »»
Space ) (8]

3 Press (X to add a space at the end of
text.

suonesadQ diseg i

Switch between Lower Case &
Upper Case

[Text Entry] window » (@) »»
Lower Case or Upper Case ) (1]

Move Cursor to Top/End of Text

[Text Entry] window » (@] M
Jump » (8] » To Beginning or To
End »» (m]

Switch between Single-byte &
Double-byte

[Text Entry] window M (@] »
Single-Byte or Double-Byte ) (8]

Overwrite & Insert Modes

[Text Entry] window M (@] M

Overwrite or Insert ») (m]

3 Text entry windows always open in
Insert mode.

Use Dictionary

[Text Entry] window M (@) )b Refer
Dic. »» (8] »» Enter Word »» (m] »
Enter word »» (®) ») Select a
dictionary »» (] ») Select a word »»
(@) »» Read descriptions of the word
® To Enter a Word from Search History
»» Reference History »» (8] M
Select a word Pb (@] PP Select a
dictionary P> (®) D) Select a word P
(@] »» Read descriptions of the word

2-29
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Quote Text

[Text Entry] window » (@) »»

Quote Data ) (®)

® To Quote from a Phone Book Entry
»» Quote Phonebook M) (&) M
Search Phone Book »» Select a data
item to quote text from »» (] Pp

® To Quote from Account Details
» Account Details »» (®) M) Enter
Security Code »» (] Db Select a data
item P (m] P

® To Scan Text by Text Reader
»» Text Reader P () D) Scan text
with camera P

® To Scan Bar Code by Bar Code Reader
»» Bar Code Reader M) (8] D) Scan
a bar code with camera ) (®)

Templates
Start Here

[Templates (Common phrases)]
WINAOW ....oererrereeeen e ssnesnnnees P. 2-15

[Templates List] window ......... P. 2-15

Edit a Folder Name

[Templates (Common phrases)]
window D) Select a folder » (®) M
Edit Folder Name )»» (®] )) Enter
folder name »» (m]

Use Kuten Codes

[Text Entry] window M (@] »
Kuten Code »» (®) ) Enter kuten
codes (P. 15-14)

Reset a Folder Name

[Templates (Common phrases)]
window )» Select a folder M (@) M)
Reset Name ») (8] ) YES ) (u]

Edit Templates

[Templates List] window PP Select
atemplate M (@) M) Edit ) (W) M)

Edit phrase ) (m]

Reset Templates

[Templates List] window »» Select
atemplate M
® To select Delete This
»» Delete This b (w) P> YES )b (m)
® To select Delete All
» Delete All P (] D) Enter Security
Code M) (m) »» YES )) (m]

Dictionaries
Start Here

[Own Dictionary] window ....... P. 2-16
Own Dictionary

Edit Entries

[Own Dictionary] window »
Select an entry M (& » Edit word
»» (@) M) Edit reading » (m]




Delete Entries

[Own Dictionary] window »»
Select an entry »» (@) ) Delete M»

(w)
® To select Delete This
) Delete This b (&) P YES ) (m)
® To select Delete selected
) Delete selected P> (®] P Select
entries P (m] P » YES M (m)
® To select Delete All
» Delete All P (] D) Enter Security
Code »» () »» YES ) (m]

Creating Entries

Phone Book Search

@ Advanced Features

Save a Postal Code, Address &
Memo

[Phone Book Entry] window ) &
or B » (] M Enter content ) (u)

Save Birthday

[Phone Book Entry] window b»
»» (8] ) Enter date of birth »»

(w]

Change Index Tab of Phone Book
Entry List Window

[Phone Book Entry List] window
»» (@) M Change Display »» (8] »»
Alphabet, Memory No. or Group
» (m)

Phone Book

Start Here
[Phone Book Entry] window ... P. 2-20

P. 2-21

Change Entry Number

[Phone Book Entry] window »» [@
»» (@) »» Change entry number »»

(w]

Change Font Size

[Phone Book Entry List] window or
[Phone Book Entry Details] window
»» (@) M Font Setting »» (&) »»
Standard Font, Big Font or Small
Font ) (m]

suonesadQ diseg i

Change Phone Number/E-mail
Address Order

[Phone Book Entry Details] window
» Select a phone number/e-mail

address M (@) »» Move to Top »
(]

&3 This procedure is available when more
than one phone number/e-mail

address is saved to a Phone Book entry.
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Compose an S! Mail from Phone
Book

[Phone Book Entry Details] window
) 3 to select an e-mail address »
(m) »» Compose S! Mail

Compose an SMS Message from
Phone Book

[Phone Book Entry Details] window
) ¥ to select a phone number M
»» Compose SMS » (m] )»
Compose SMS message

Cancel Custom Ringtone/Image
Settings by Item

[Phone Book Entry List] window
»» [®) M Ring Tone/Image »» (&) )
Select an item with “Y“ » (=] )
Select an item with “s“ M (@] M
Release Settings »» (8] »» YES )»

(w)

Managing Phone Book

Check Custom Ringtone/Image
Settings by Item

[Phone Book Entry List] window »
»» Ring Tone/Image » (m] M
Select an item with “Y* ) (8] )
Select an item with “s“ M (@) M
Check Settings »» (8] )b Check

settings of item with "%~ ) (m]

Check Restriction Settings by
Restriction Type

[Phone Book Entry List] window
) (®) M Restrictions »» (®] )
Enter Security Code » (8] )) Select
a restriction type with “%” »
»» Check Settings »» (m]

Cancel Restriction Settings by
Restriction Type

[Phone Book Entry List] window
» »» Restrictions »» (] )
Enter Security Code » (8] )} Select
a restriction type with “%“ M
»» Release Settings »» (®] » YES
» (m)

Check Number of Phone Book
Entries

[Phone Book Entry List] window
» (®] » No. of Phone Book ) (m]

2-32

Edit a Phone Book Entry

[Phone Book Entry Details] window
» (®) M Edit Phone Book » (] »)
Edit each item ) (2] ) YES )) (m]

® To Save as a New Entry
»» [E »» (W) M) Enter entry number
The edited entry is saved as a new
entry and the original entry remains
the same as before.




Copy a Phone Book Entry

[Phone Book Entry Details] window
» (®) » Copy to USIM or Copy
from USIM » (8] » YES )) (m]

Delete Entries

[Phone Book Entry List] window
) Select an entry M (@ » Delete
Data » (=]
® To select Delete This
» Delete This »» (] M) YES )) (]
@ To select Delete selected
) Delete selected P> (@] P Select
entries P> (@) ) (=] ) YES M) (w)
® To select Delete All
» Delete All P> (] D) Enter Security
Code ) (®) P> YES )b (m] D) YES M)
(w)

Delete Items from an Entry

[Phone Book Entry Details] window
M I to select an item M (@] M
Delete Data »» (8) )) Delete Phone
No., Delete Mail Add., Delete
Address, Delete Birthday, Delete
Memorandums, Delete Image or
Delete This »» (8] ») YES ) (m]

S! Addressbook Back-up

Start Here
[s! Addressbook Back-up] window

P. 2-27

@ Advanced Features

Delete an Entry from USIM Card

(=] »» Tools » (m] »» USIM
Operation )» (8] )) Enter Security
Code »» (@) »» Delete ) (m) )
USIM »» (8] »» Phone Book ) (m)
»» Search Phone Book P Select an
entry » (8] ) [ ) YES ) (u)

Delete Synchronize Log

[S! Addressbook Back-up] window
»» SyncLog » (8] M) Select Log M
® To select Delete This
" Delete This b (w) b YES )b (m)
® To select Delete selected
» Delete selected »» (8] M) Select
Log M (@) » (=] M) YES )) ()
® To select Delete All
» Delete All P> (] D) Enter Security
Code M (=) »» YES )) (m]

suonesadQ diseg i
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Make Calls to:

7 O (E

SoftBank Non-SoftBank Landlines
Handsets Mobile Phones

Voice Cal| ==

Voice call and video call are available on handset.

Make Calls to:

n
&

i

i

Handsets Mobile Phones

Video Call =

SoftBank Non-SoftBank Landlines

compatible phone

(Other party must use a video ca

||>

Calling Abroad
il from Japan

Make/receive voice and
video calls.

* International phone service available
without separate application.

In 0

Service eligible.

Using Handset Abroad

Handset is Global Roaming

(Prior application may be required.)

* For details of service and eligible countries and
regions, see SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp), or contact SoftBank

Customer Center, General Information
(P. 15-52).

Emergency Calls

Your location is automatically reported to the
corresponding agency (police, etc.) when you
place emergency calls (110, 119, or 118) with
Softbank 3G handsets.

(Emergency Location Report)

930CA reports Location Information based on
positioning signals from radio stations.

@Registration and transmission fees do not apply.

@Positioning accuracy is affected by location and
signal conditions. Always provide your location
and purpose on the phone.

@Location Information is not reported when
emergency calls are placed without Caller ID
(such as when the number is prefixed with 184).
However, the corresponding agency may obtain
your Location Information in a life threatening
situation.

@Not available during international roaming.

Emergency calls are possible even
while some handset restrictions
are active.

- Restrict Dialing (P. 2-24)

+ Keypad Lock (P. 4-4)

+ Set Max Cost Limit (P. 14-19)

+ Emission OFF Mode (P. 4-8)

+ PIN1 Code Entry Set (P. 4-2)
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O 0O « Call ends when handset is closed.
Makmg Voice Calls Connect stereo earphone-microphone

to talk with handset closed.
) Enter phone number

Available Keys during
Voice Calls a

PHONE NUMBER

0N
)
Adjust Earpiece |(&) =
Volume 3
Q
Voice Call Window Hold Call 2z

090993%%¥1 E)(= toendcall

Tip International Calls
Phone Number Entry Window

* Always include the area code even @ International phone service available

HCorrecting Misentries . {//vvk%ee% c:/?llllnhge;rroam btrs?/ ‘S[g?ee ?I:iaéther without separate application.
»» K3 to scroll cursor PP Reenter party is on another line. '
number(s) + When you hear a message saying that nEnter phone number »
. the other party cannot be reached, the ’
.E:-‘le@t'"g Numbers 5 otherfparty's mobile phone is off or is W Int'l Call » (8]
to select a number out of signal range.

BDeleting Ph b + When you hear a message asking for SeleCt a country code »
Deleting Phone Number your caller ID, call again with your (@) ) Select an international
»» Press and hold or (=] number revealed. .

« After Display backlight turns off during prefix number » (8] »
a call, if no keys are pressed for about
two minutes, Display goes off and [E] to end call

handset enters Power Saver Mode
regardless of Lighting setting for
Backlight (P. 14-7). Handset can be
operated in Power Saver Mode in the
same way as when Display is lit.
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Answering Voice Calls Answering Machine

A When a call arrives »
E] to end call

Tip
» Open handset to answer a call.

Record caller’s messages on handset
when you are unable to answer voice
or video calls.

Setting Answering
Machine

(=) » settings » (w) »
Incoming Call » (] »
Answering Machine » (8]

F)on » (m] » Select an
outgoing message » (1]

Enter ring time

Tip

* When Voice Mail or Call Forward is
activated, set a shorter ring time for
Answering Machine than that for Voice
Mail or Call Forward.

» Answering Machine can be set or
canceled by pressing and holding
in Standby.

» Answering Machine is unavailable
when power is off, in a place with no
signal reception, or in Emission OFF
Mode. Use Voice Mail instead (see
P. 3-15).

OWhen a Call Arrives

Answering Machine activates after the
set ring time. Outgoing message plays,
and the caller’s voice/video message is
recorded.

Handset returns to Standby when
recording is complete. Answering
Machine notification and Display
indicator appear. The indicator shows
the number of messages.

RECORDING MESSAGE
Recording Messagel

HTo Answer Call during Recording
»



Playing Messages
n @] » Select notification &

& (u

Play/Erase Msg.

MJ

Tip

* Pressing in Standby also plays
recorded voice messages.
When there is a voice memo but no

voice message, the voice memo plays.

zAnswerms Machine2
|3/Answering Machine3
|4/Answering Machine4
|S/Answering Machine5
[6Voice Memo

Play/Delete Voice Message Window

Items with a message recorded are
indicated by “%.”

) select a message » ()

HTo Delete a Message While
Playing it
) (®) Wb Erase »» (&) P) YES )) (m)

Available Keys during
Playback

Stop

(®] or
Return a Voice Call
Return a Video Call

* To play voice messages from Main

Menu:

(=] »» Tools »» (@) M) Play/Erase

Msg. ) (m)

Available Keys during
Video Message Playback

Tip
* To play video messages from Main
Menu:

(] »» Tools »» (] M) Play/Erase VC

Msg. ») (u)

Activate When Call
Arrives

Activate Answering Machine when
unable to answer an incoming call.

Answering Machine setting returns,

after message is recorded.

Play Previous/Next | . _
Message nWhen a call arrives » B
Adiust Vol = Answering Machine is activated
(LB D and starts recording.

Pause/Play (w)
Stop Note . .

. * Answering Machine cannot be
Return a Voice Call activated when memory is full.
Return a Video Call

_

Buigje ﬂ
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More Features
Advanced

Outgoing Call Functions
< Show/Hide Caller ID
< Adjust Earpiece Volume in Advance
< Add Area Code and Country Code
(Prefix Numbers)
(* P.3-16)
International Calls
< Enter “+" to Call Abroad
(® P. 3-16)
Handling Incoming Calls
< Reject Calls
++ Place Calls on Hold
< Forward Calls
< Forward Calls to Voice Mail Center

(* P.3-16)
Engaged Call Operations
% Handsfree
< Send Touch Tones

(® P.3-17)

Answering Machine
+ Delete Recorded Messages
(< P.3-18)

Customize

Outgoing Calls
< Save Touch Tones
<+ Set Numbers after “%* as Sub Address
+“ Save Area Code and Country Code as
Prefix Numbers
(* P. 14-17)
Display Settings
+ Set an Outgoing Call Image
% Set an Incoming Call Image
(* P. 14-4)
International Calls
< Change International Access Code
Automatically Dialed with “+*
< Change a Country Code
< Save an International Access Code
(* P.14-17)

Incoming Call Alerts
< Adjust Ringtone Volume
< Set a Ringtone
+ Set Vibration
+ Set lllumination Color
+» Show Phone Book Entry Images for
Incoming Calls
(<*" P. 14-10)

Answering Incoming Calls

% Set to Answer Calls by Pressing Any Key
Except Send Key

< Set to Mute Ringtone by Pressing Any
Key Except Send Key

< Set to Answer Call by Opening Handset

(* P. 14-12)
Call Settings
< Set Noise Reduction
< Set Weak Signal Alarm
< Set Reconnection Tone
“ Set a Hold Message
(" P. 14-18)



ey Video Call
Video Call Window Making Video Calls

§DEnter phone number

Main
window

PHONE NUMBER

£

—
20s

Call time

Video

call i
settings | 090993%%¥%1

AlvISEcd
IikawaYoko

090993%%%*1
Video Call Window

090993x%%¥x1 [E to end call

Phone Number Entry Window

Buigje ﬂ

Sub
window

Video Call Indicators

Tip
[ Transmitting Audio Closin . :

Y ) : f ; . g handset will end a video call.
Transmission Failed I(;:réctmg M:Tentrles W R - Always include the area code even
Transmitting Video to scroll cursor eenter when dialing from the same area.
Transmission Failed number(s) * Video calls made to emergency

: WDeleting Numbers e tomaticaly switchad o voics cals
gegdthgtc?mera Image » K to select a number »» * An error mes};age with a possible cause
=] bubstitute Image Press and hold to delete all appears when a video call fails to be
@ Handsfree ON numbers to the left of the selected connected. . .

@ Handsfree OFF number. * Handset is unequipped with a front
. camera. Image sent to other party is
Mute HMDeleting Phone Number substitute image or rear camera image.
- » I3 to select the first or last + Charging may automatically stop or
Portrait number M) Press and hold camera image may switch to substitute
Scenery image if charging while making a video
B Macro call, depending on temperature and
handset usage (ex. also recording TV).

37
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Available Keys during

Answering Video

Calls

) When a video call arrives »

)= to end call

Tip
* Closing handset will end a video call.

Video Calls

Adjust [

Earpiece

Volume

Hold Call

Toggle Main | Press and hold (] to

Window toggle image as

Images follows: The other
party’s image — Your
image — The other
party’s image (sub
window off) — Your
image (sub window off)

Zoom In/Out |4 or

Outgoing press and hold IO

Camera Image

Mute Audio |(m]
To cancel mute, press

(®] again

© More Features

Outgoing Call Functions
< Show/Hide Caller ID
< Adjust Earpiece Volume in Advance
< Add Area Code and Country Code
(Prefix Numbers)
(@ P. 3-16)
Handling Incoming Calls
< Reject Calls
« Place Calls on Hold
+ Forward Calls
(® P. 3-16)
Engaged Call Operations
< Handsfree
< Set Image Quality
< Adjust Brightness
< Change White Balance
< Change Color Tone
< Change Scene
% Backlight Lighting Time
(@ P.3-17)



o Video Call

Customize

Outgoing Calls
< Set Numbers after “%“ as Sub Address
< Save Area Code and Country Code as
Prefix Numbers
(* P. 14-17)
Display Settings
< Set an Outgoing Call Image

% Set an Incoming Call Image
(® P. 14-4)

Incoming Call Alerts
< Adjust Ringtone Volume
< Set a Ringtone
« Set Vibration
+ Set lllumination Color
+» Show Phone Book Entry Images for
Incoming Calls
(< P. 14-10)

Answering Incoming Calls
< Set to Answer Calls by Pressing Any Key
Except Send Key
< Set to Answer Calls by Opening
Handset
(* P.14-12)

Call Settings
+ Set Noise Reduction

< Set Weak Signal Alarm
< Set Reconnection Tone
< Set a Hold Message
(* P. 14-18)

Video Calls

< Set an Image to be Sent during Video
Calls

+» Redial Automatically as Voice Call When
Video Call Connection Fails

< Set an Image to Appear in Main
Window

< Automatically Switch to Handsfree
Mode in Video Calls

(* P. 14-20)

Buigje ﬂ
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Dialing from Call
Logs

Phone numbers and dates and times of
incoming and outgoing calls are saved
on handset as call logs. Access call logs
to return calls quickly.

Up to 30 Dialed Calls and 30 Received
Calls (including Missed Calls) are
stored.

Call Log Indicators

The following indicators appear in
Redial, Dialed Calls and Received Calls
windows.

International Video Calls
Outgoing & Incoming
Missed

Unchecked Missed

Answering Machine
Voice Messages
Video Messages

Packet Transmission

Outgoing & Incoming Calls
Appears when outside the GMT+09
time zone.

Time appears in summer time when
summer time is set.

Voice Calls

Outgoing & Incoming
Missed

Unchecked Missed

International Calls

Redial/Received Calls
S org

i) Redial

&Y 4/16 8:23
 AikawaYoko

|2/ 4/15 23:14

12/ 4/15 11:

vl

Y H ; ¥ KoyamaKaor i ¥ EtoTakayuki
Outgoing & Incoming I3 4/15 19:36 3 4/15 9:25 (&
Missed H&}gT;lfagki H“ylalzigng}suyar
[a™ i A B |4/ N b
Unchecked Missed 03%3%3 0391933#5 :
: |5/ < |5/ & bad
5 Ouiga ik e Iy i
Outgoing & Incoming & : o : =
X 0909934k ¥ AikawaYoko
Missed

Unchecked Missed

Redial Window

Received Calls Window

) select a record » or

HMTo Check Details of a Record
» Select a record ») (m]

Dialed Calls

)= » own Data » (=] »
Dialed Calls ) (u]

i) Dialed Calls 1/2
&Y 4/16 8:23
« AikawaYoko

|2 4/15 23:14
H KoyamaKaor i
13/ 4/15 19:36

|

B

HEtoTakayuki |
|4 4/14 21:59
090993%kK%5
|5/ 4/13 19:13
H AikawaYoko
|6 4/13 12:03
H MakinoTatsuya

Dialed Calls Window

Bl B

B

HTo Check Details of a Record
) Select a record ) (®)
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Checking Number of
Missed Calls

)= » own Data » (m] »
Received Calis ) (u]

The total number of incoming
calls, number of missed calls, and
number of unchecked missed calls
appear.

AII Calls or Missed Calls »

Call Time & Cost

Check the total and last call times and
costs.

Call cost and cost limit may be
unavailable depending on your
subscription.

) (=] » settings » (w] » Call
TimelCharge » (8] » Call
Data » (u]

Tip

* Use indicated call times and costs only
as a guide. The actual call time and cost
may be different. Your handset may
not indicate call costs depending on
the service you subscribe. Indicated
costs do not include consumption tax.

» When the last or total call time exceeds
199 hours 59 minutes 59 seconds,
counting restarts from zero seconds.

Redial, Dialed Calls & Received Calls
< Change Font Size

< Show Ring Time (Missed Calls)

+“ Delete Records

(* P. 3-18)
Call Time & Cost
<+ Reset Total Call Time
< Reset Total Call Cost

(* P.3-19)

Customize

Incoming Call Alerts
< Open Missed Calls Window by Opening
Handset
(* P. 14-10)

Checking Call Logs
% Change Colors of Names, Phone
Numbers and E-mail Addresses in
Call and Message Log Windows
(* P. 14-14)
Call Costs
< Set/Cancel a Maximum Call Cost Limit
<+ Set Auto Reset of Total Call Cost
(% P. 14-19)

Buijjed
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'] Speed Dial
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Saving Entries to Quick

Abbreviated Dialing

List
Just press a number key from (0] to
(®J and then to call Phone Book n
entries with entry numbers 000 to 009. B
@ If a Phone Book entry has more than L
one phone number, handset dials the
first number.

)t (or=

Quick List

uore <Not Stored>

Dialing from Quick

List

Save frequently accessed Phone Book

entries to Quick List to quickly make

calls or send messages.

@ Quick List is unavailable in Secret Data
Only Mode.

@ Although Quick List is available in Secret
Mode, secret Phone Book entries
cannot be saved to Quick List.

Quick List Window

)G to selectatab » &) »
Search Phone Book ) Select
an entry » (]

Select a phone number or
e-mail address » (®]
When a checkbox is selected, other
numbers/addresses become grayed
and cannot be selected. To select
another number/address, first
cancel the currently selected
checkbox.

3-12

Dialing/Sending
Messages from Quick List

(1 |vd

)5 to select an entry »
CALL, MAIL or VIDEO CALL

» (m)

MTo Send an S! Mail to All Quick List
Entries
» (®] P> Broadcast Mail »» (=] )
Compose S! Mail

© More Features
@ Advanced

Speed Dial
<+ Cancel Entries from Quick List
< Change Quick List Entry Image
(® P.3-19)



Fe) Calling While Abroad (Global Roaming)

Make calls while overseas.

Buigje ﬂ

@ Global Roaming Service may require Calling within the
prior application. Details and Same country
applications are available online at
http:/Awww.softbank.jp or by A Enter phone number with Global Roaming
contacting SoftBank Customer Center, area code » * Set Operator
General Information (P. 15-52). . Do not omit “0” from area code. B Actiyate Network Re-search for an
@ 930CA is compatible with 3G networks. . Country code not required. Available Operator
Transmission is unavailable in « Set Priority for Operators
GSM/GPRS areas. +“+ Show Operator Name While Roaming

(* P. 14-21)

Calling Japan and Other

Countries
nPress and hold (0]}

“+ " is entered.

) Enter country code and
phone number with area
code (excluding the first
uou) }}

Tip
» Do not omit the first “0"” from area
code when calling Italy.
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The following services are available
with your handset.

Call Forward calls to a preset

Forward |phone number.

Voice Forward calls to Voice Mail

Mail Center when unable to
answer a call.
Missed Call Notification
Notification (SMS) arrives for
missed calls while handset
was off, out of range or
engaged, etc.

Call Place the current call on hold

Waiting”™ [to answer another incoming
call. Talk with two parties
alternately.

Group Call others during a call and

Calling® |talk with multiple parties
simultaneously.

Call Select whether to restrict

Barring |incoming and outgoing calls
and SMS.

3-14

Caller ID |Select whether to show or
hide your number when

making calls.

* Separate application is required.

Activating Call Forward

<Example> Forward calls to a specified
number after a set ring
time
) (=] » settings » (8] »
Optional Services » (8] »
Voice MaillDivert » (m]

Voice Mail/Divert

Voice Mail/Divert Window

F)Divert ON » (8] » YES »
(@) » VoicelVideo Calls,
Voice Calls or Video Calls
» (] » Enter phone
number ) (®)

M To Search from Phone Book
» () to select a search method M)
(@) »» Search Phone Book P Select
an entry P (8] ) Select a phone
number ) (8] (twice)

E)No Answer ) (8] )) Selecta
ring time » (u]

HTo Forward Calls Immediately
» Always »» (=)

Tip

« If No Answer is set, press to
answer incoming call before the call is
forwarded. If Always is set, handset
does not ring/vibrate and all calls are
forwarded to the preset number.

« Call Forward and Voice Mail cannot be
set simultaneously. Call Forward for
video calls is only available with Voice
Mail.

« If you activate Call Forward when Voice
Mail has already been set, Voice Mail is
canceled.




e Optional Services

Activating Voice Mail

<Example> Forward calls to Voice Mail
Center after a set ring time

[Voice Mail/Divert] window
» Voice Mail ON » (m] »
YES ) (u]

) No Answer » (8] )) Selecta
ring time » (1]
M To Forward Calls to Voice Mail

Center Immediately
» Always »» (u)

Tip

« If No Answer is set, press to
answer incoming call before the call is
forwarded to Voice Mail Center. If
Always is set, handset does not ring or
vibrate and all calls are forwarded to
Voice Mail Center.

» Voice Mail and Call Forward cannot be
set simultaneously. Voice Mail is only
available with Call Forward for video
calls.

« If you activate Voice Mail when Call
Forward has already been set, Call
Forward is canceled.

OMiissed Call Notification

SMS notification informs you of missed
calls while handset was off, out of
range, engaged, etc.

(1 [anleslanirsirs

Follow voice guidance.
OTo Play Messages

§)voice Mail/Divert] window
» Play Messages » (8] »
YES » (m]

Canceling Call Forward &
Voice Mail

§)voice Mail/Divert] window
» Voice MaillDivert OFF
» (m) » YES » (m)

© More Features
G@ Advanced

Call Forward & Voice Mail
+» Delete Icons for Notifying Recorded
Messages

< Check Current Setting Status
(® P.3-19)

Call Waiting
< Set Call Waiting
% Answer Incoming Calls during Calls
% Check Current Setting Status
(@ P. 3-20)

Group Calling
< Hold Current Call to Make Another Call
« Switch Parties
< Talk with Multiple Parties
Simultaneously
« Talk with a Specific Party
< End Call with a Specific Party
(< P. 3-20)
Call Barring
+%» Restrict Incoming/Outgoing Calls & SMS
< Cancel Call Barring
% Change Network Password
% Check Current Setting Status
(* P.3-21)
Caller ID
% Show/Hide Phone Number
% Check Current Setting Status
(* P.3-21)

Buigje ﬂ
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Outgoing Call Functions

Show/Hide Caller ID

Enter phone number M (@) )

Notify Caller ID »» (8) »» OFF, ON

or Cancel Prefix »» (=] )» or

Alternatively, enter “186" before the
phone number to show your number,
or “184" to hide your number.

£ Show/hide Caller ID each time you dial
from Phone Book or call logs (Redial,
Dialed Calls or Received Calls).

Add Area Code and Country Code
(Prefix Numbers)

Enter phone number » (@) M

Prefix Numbers »» (8] )) Select an

item M) (8] )) or

£33 Store area codes and country codes
beforehand. Enter prefixes before
making calls.

€3 Add prefix from Phone Book entry,
Redial, Dialed Calls or Received Calls
windows.

£30046010 is set to FEEEYS by default.

International Calls

Enter ” + " to Call Abroad

Press and hold (O »» Enter

country code M Enter area code

»» Enter phone number » »

Dial »» (w)

€3+ appears when you press and hold
(10, indicating that the international
code set in Auto Int’l Call Set. is
entered.

Adjust Earpiece Volume in
Advance

Enter phone number P Press and

hold (B » (@)

3-16

Handling Incoming Calls

Reject Calls

When a call arrives » (@) » Call
Rejection )) (u)

Place Calls on Hold

When a call arrives » (=) » To

answer call »

3 Press (=) again to end the call on
hold.




Forward Calls

When a call arrives » (@) M Call

Forwarding »» (m]

€3 This procedure is available when Call
Forward has been activated from
Voice Mail/Divert window.

Engaged Call Operations

Start Here
[Voice Call] window .......cceevunn. P.3-3
[Video Call] window........cccccucu... P. 3-7

Voice & Video Calls

Voice Calls

@ Advanced Features

Voice Calls

Forward Calls to Voice Mail Center

When a call arrives »» (@) M Call

Forwarding ) (]

3 This procedure is available when Voice
Mail has been activated from Voice
Mail/Divert window.

Handsfree

[Voice Call] window/ [Video Call]
window M) (&) M YES ) (m])

3 Press (&) again to cancel handsfree
mode.

Send Touch Tones

[Voice Call] window » 3 (twice)
) Settings »» () ) Dialing »» (&)
»» Pause Dial »» (8] (twice)
€3 Each time you press (7, a touch tone
sequence until “p” (pause) is sent.
£%save touch tones in advance
(P. 14-17).
® To send touch tones all at once:
» Press and hold (3 M) Send at one
time » (@)

Buigje ﬂ

Video Calls

Set Image Quality

[Video Call] window » (@] )
V. Call Settings » (8] W Visual
Prefer. »» (8] ) Select an item M

(w]
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Adjust Brightness

[Video Call] window » (@] »»

V. Call Settings »» (8] »
Brightness )» (®) )) Select a level
» (m)

£3 Available when sending camera image.

Change Scene

[Video Call] window »» (@] M)

V. Call Settings »» (8] )) Select

Scene »» (] )) Select a scene ) (®)

€3 Available when sending camera
image.

Change White Balance

[Video Call] window » (@) »»
V. Call Settings »» (8) »» White
Balance »» (8] M) Select an item M

(w]

£33 Available when sending camera image.

Backlight Lighting Time

[Video Call] window » (@) »»
Display Light »» (] »» All Time ON
or Same as Backlight )» (m)

Change Color Tone

[Video Call] window » (@] »»

V. Call Settings »» (m] » Color
Mode Set »» (®] ») Select an item
» (&)

Answering Machine
Start Here

[Play/Delete Voice Message] window
.P.3-5

Delete Recorded Messages

[Play/Delete Voice Message]
window P) Select a message M
» Delete This, Delete Rec. Msg. or
Delete All »» (] ») YES )) (m]
3selecting Delete All also deletes a
voice memo if it has been saved.

Call Logs

Start Here

[Redial] window........cccecerueenne P. 3-10
[Dialed Calls] window ....
[Received Calls] window ..........P.
Redial, Dialed Calls & Received
Calls

Change Font Size

[Redial] window, [Dialed Calls]
window or [Received Calls]
window »» [®) ) Font Setting »»
(@) »» Standard Font, Big Font or
Small Font ) (m]




@ Advanced Features

Show Ring Time (Missed Calls)

[Received Calls] window » (@] »»
Ring Time » (u]

Delete Records

[Redial] window, [Dialed Calls]
window or [Received Calls]
window »» (@] M) Delete ) (m)

® To select Delete This
) Delete This b (&) P YES M (m)

® To select Delete selected
» Delete selected »» (8] M) Select
records P (m] P » YES M (m]

® To select Delete All
» Delete All D) (] D) Enter Security
Code P (m] »» YES M) (m]

3 Selecting Delete All in Redial window
or Dialed Calls window deletes all
records from both Redial and Dialed
Calls.

Call Time & Cost

Reset Total Call Time

(m] » Settings »» (w) »»

Call Time/Charge »» (8] »» Reset
Total »» (8] M) Enter Security Code
»» (@) )» Reset Total Duration »
(=] »» YES ) (m)

Reset Total Call Cost

(m] »» Settings » (=) »»

Call Time/Charge »» (8] ) Reset
Total »» (8] M) Enter Security Code
)» (m] )b Reset Total Cost »» (m] )
YES )) (8] )) Enter PIN2 ) (m]

Cancel Entries from Quick List

[Quick List] window » & to
select a tab M (@) )b Release This
or Release All »» (8) ()» Enter
Security Code ) (m]) » YES )) (m]

Change Quick List Entry Image

[Quick List] window » O to
select a tab M (@ M Image ) (m)
) Select a folder M (8] M) Select
an image ) (m)

Speed Dial

Start Here
[Quick List] window ................. P. 3-12

Optional Services

Start Here
[Voice Mail/Divert] window.....P. 3-14
[Voice Call] window........ccceeuun.e. P.3-3

Call Forward & Voice Mail

Delete Icons for Notifying
Recorded Messages

[Voice Mail/Divert] window »»
Erase Icon »» (8] )» YES )) (m]

Buigje ﬂ
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Check Current Setting Status

[Voice Mail/Divert] window »» Get
Status ) (m)

Group Calling

Call Waiting

Set Call Waiting

(@) »» Settings »» (m] ) Optional
Services )» (®) ) Call Waiting »
(=] »» ON or OFF ) (m] »» YES M

(w]

Answer Incoming Calls during
Calls

[Voice Call] window »» Call

waiting tone sounds »

3 Press (m] to toggle between two
parties.

Hold Current Call to Make Another
Call

[Voice Call] window » »

Enter phone number M

% To dial from Phone Book, press »
Phone Book P» (®), search Phone
Book, select a number and then press
)

€2 To dial from Dialed/Received Calls,
press »» Redial or Received Calls
»» (m), select a phone number/name
and then press (/7).

Talk with a Specific Party

[Voice Call] window »» While

talking with multiple parties »»

) Select Ans. Call »» (8] » Select

a party » (m]

3 The other parties are placed on hold
while talking with the selected party.

Switch Parties

[Voice Call] window » (u]
&3 Press (@] to toggle parties.

End Call with a Specific Party

[Voice Call] window » While
talking with multiple parties M
»» Select Disc Call »» (] )} Select a
party ) (&)

Check Current Setting Status

(=] » Settings »» (m) ) Optional
Services ) (®) ) Call Waiting "
(m] »» Get Status » (=)

Talk with Multiple Parties
Simultaneously

[Voice Call] window » While
talking with one party » (@) »
Join Multi Party ») (m]
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Call Barring

Restrict Incoming/Outgoing Calls
& SMS

(=] » Settings »» (W) »» Optional
Services »» (8] W Call Barring M
(=] » Outgoing Calls or Incoming
Calls »» (®] )} Select an item ») (m]
»» YES »» (8] ) Enter Network
Password ») (m]

&3 Emergency numbers 110, 119 and
118 are available even when Call
Barring is set.

&3 When Bar All Outgoing Calls or Bar
All Incoming Calls is set for Call
Barring, Call Forward is unavailable
(When Call Forward is set, Call Barring
is unavailable).

€31f Network Password is incorrectly
entered three times consecutively, Call
Barring settings are locked. Network
Password and Center Access Code
must be changed. For details, contact
SoftBank Customer Center, General
Information (P. 15-52).

Cancel Call Barring

(=] » Settings »» (8] V) Optional
Services »» (] »» Call Barring »»
(=] » Cancel All Barring » (8] »
YES »» (®) M) Enter Network
Password ) (m]

Caller ID

@ Advanced Features

Change Network Password

(=] » Settings »» (W) ) Optional
Services »» (W) W Call Barring M
(@] »» Set NW Password »» (8] )
YES »» (@) )} Enter current
Network Password »» (8] )) Enter
new Network Password » (®] »
Enter new Network Password
again for confirmation » (m]

Show/Hide Phone Number

(=] » Settings »» (W) »» Optional
Services »» () M) Caller ID
Notification »» (&) »
Activate/Deactivate »» (8] )» ON
or OFF ) (] ) YES )) (m]

Buigje ﬂ

Check Current Setting Status

(=] » Settings »» (8] V) Optional
Services ) (] M) Caller ID
Notification »» (] ) Get Status »»

(w]

Check Current Setting Status

(m] » Settings »» (W) ) Optional
Services »» (8] V) Call Barring »»
(@) »» Get Status »» (8] M) Select
an item » (m]
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Setting PIN1 Entry Changing PIN1/PIN2

Set to require PIN1 entry each time @ PINT Code Entry Set must be set to
handset is turned on. ON before changing PIN1.
FA (=) » settings » (=] » ED (=) » settings » (w] »
m Security » (8] » PIN Security » (8] » PIN
Setting » (m] Setting » (u]

) Enter Security Code » (u) ) Enter Security Code ) (u]
E)PINT Code Entry Set » (8]  [E] Change PIN1 Code or

Z)on » (m] » Enter PIN1 » (] Change PIN2 Code ) (8]

WSet to Not Require PIN ) Enter current PIN1/PIN2 »
Authentication
»» OFF »» (8] )) Enter PIN1 )) (m]

KAundag

EJEnter new PIN1/PIN2 » (u]
»» Enter new PIN1/PIN2
again for confirmation » (m]



ﬁf Prohibiting Unauthorized Handset Use

Activating Dial Lock

Prevent others from operating
handset.

)™ » settings » (w) »
Security » (8] » Function
Lock » (m]

) Enter Security Code » (u)
E)pial Lock » (=]

Tip
* The following operations are possible
even when Dial Lock is activated:
- Power on/off
- Calling emergency numbers 110, 119
and 118
- Answering incoming voice/video calls

Canceling Dial Lock
) Enter Security Code » (u)

If incorrect Security Code is
entered, press (—J and enter
correct Security Code.

Tip

« If Security Code is incorrectly entered five
times, handset powers off. Turn handset
power on and enter correct Security
Code.

Setting Custom Lock

Prevent others from accessing handset

functions/data (e.g. Phone Book, Mail,

etc.) that contain personal

information. Custom Locks can be

customized.

@ For IC Card Lock and Call Remote Lock,
see P. 11-4.

Activating Custom Lock

(=] » settings » (m] »
Security ) (8] »» Function
Lock » (m]

) Enter Security Code ) [u]

1 Function Lock
laDial Lock
|2.Custom Lock 1
|3.Custom Lock 2
|4.Custom Lock 3
H0FF

Reset Lock

Lock Window

[E) Custom Lock 1 - Custom
Lock 3 » (m]

Functions/data specified under the
selected lock type are locked.

HTo Edit Title
» Select a Custom Lock M (@) M
Edit Title »» (w) ) Edit title ) (m]
OWhen Custom Lock is Set
Security Code entry is requested when
accessing a locked function or data.
Enter Security Code to unlock and
access function/data. Setting returns
when handset returns to Standby.
@ Dial/Sending Mail and
Incoming/Mail Disp. cannot be
unlocked temporarily.
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Customizing Custom Lock OLock Category or Group

Select functions/data to lock.

Olndicators

s= Selected functions/data locked.
B All functions/data locked.

OSelect and Lock Functions or
Data

[Lock] window ) Select a
Custom Lock »

) select a category » (1]

E)select a group » (u]

Select functions or data to
Lock » (=]
Function is locked. Press (] again
to deselect. Repeat to select the
function to lock.
HTo Select All Functions
» (@) M Select All )y (u)

HTo Deselect All Functions
» » Release All ») (m]

(three times)

n[Lock] window »» Select a
Custom Lock »

) select a category (» (8] »
Select a group) » (@) »
Select All ) (u)

HTo Cancel Lock for Category or
Group
» »» Release All )) (1]

(0 =)
OLock All Categories

n[Lock] window »» Select a
Custom Lock »

» Select All ) (u)

HTo Cancel Lock for All Categories
» » Release All ») (m]

OLock All Group

n[Lock] window »» Select a
Custom Lock »

) select a category » (]

» Select All ) (m)

HTo Cancel Lock for All Group
» » Release All ») (u]

(twice)

Disabling Keypad

Set Keypad Lock to automatically lock
handset keys when handset is closed or
when handset is not operated for a
certain period of time.

Setting Keypad Lock

ED(®] » settings » (8] »
Security » (8] » Keypad
Lock » (m]

) Enter Security Code » (u]
E)select an item



@ Prohi

ting Unauthorized Handset Use

HlTo Lock When Handset Closed
)» After Closed ) (®] ))» ON )) (m]

HlTo Lock After Handset Closed a
Certain Time
» Timer »» (8] ) Select time until
lock activates )) (m]

HTo Lock by Pressing and Holding
» Lock Key »» (=] ») ON ) (m]
Pressing & with handset closed
activates lock.

HTo Require Security Code to Cancel
Keypad Lock
» Security Code P (8] )b YES M)

®

OWhen Keypad Lock is Set

All key operations are disabled, except
for answering incoming calls and
turning power on/off.

When a call arrives or the alarm is
activated, @ appears at the bottom of
Display to indicate some keys are
operable.

Tip

» Emergency numbers 110, 119and 118
are available even when Keypad Lock
is set.

Temporarily Unlocking
Keypad Lock

OWhen Security Code is YES

nWhen Keypad Lock is set »
Enter Security Code ) (m]

OWhen Security Code is NO

nOpen handset
Alternatively, press and hold [.

Tip
« Alternatively, press (¥, or close and
reopen handset.

Using Secure Remote Lock

If your handset is lost, lock handset
functions remotely from a PC or other
mobile phones. Once the lock is set, all
key operations are disabled except for
turning the power on. For details, visit
SOFTBANK MOBILE Corp. Website
(http://Avww.softbank.jp), or access My
SoftBank from your handset by the
following procedure:

W X=2—1UX ,(Menu List) P (m]
» My SoftBank ) (u]
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Activating IC Card MTo Delete IC Card Registration

Using IC Card Authentication W [@ W Del. Ext. IC Card ) (8] b
Authentication Select IC Card to delete )) (@]
) (=] » settings » (=] » WEI» YES M (E)
Hold a FeliCa compatible contactless IC Security » » IC Card
card over handset to authenticate the Auth '{_ [E]E] b Ent E)ic card over handset 2)
m user ID without canceling Dial Lock or u _en Ic. nter mark
“ Keypad Lock, or without entering a Security Code » (] Once registered, the f§ on Display
®  codenumber. 1i_IC Card Authentic. disappears.
2 @ IC Card Authentication is available even o
3_- when IC Card Lock is activated. 20
<

@ Register up to two contactless IC cards.
Up to 2 of IC Card
can be saved

IC Card Authentication Window

#Jon » (m) » oK »(m)

HTo Activate Registered IC Card
»» ON ) (m]

HTo Deactivate Authentication
»» OFF »» (m])) YES or NO ) (m]
Select YES to delete or NO not to
delete all registered IC Card data.

HTo Register IC Card
» (@) P> New Ext. IC Card ») (m]
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CE Prohibiting Outgoing/Incoming Calls

Incoming calls from hidden and/or

unidentified numbers can be rejected.

EA (=) » settings » (=] »
Security » (8] » Call
Setting W/O ID » (m]

) Enter Security Code » (u]

Unknown, Payphone or
User Unset ) (u)

C)Reject » (u]
HTo Receive Incoming Calls
» Accept » (8] M) Select Ring
Tone or Select Calling Disp. »» (u)
» Select type P> (8] ) Select a
folder »» (] ) Select a ringtone
orimage » (m)

(=] » settings » (8] »
Security » (8] » Reject
Unknown )) (u]

) Enter Security Code ) (u]
E)Reject » (u)

HTo Receive Incoming Calls
» Accept ) ()

Note

* This procedure is unavailable when Set
Mute Seconds under Ring Time (sec.) is
set to ON (P. 4-7).

Rejecting Calls Rejecting Calls from Numbers 8 Delaying Ringtone for Numbers
without Caller ID Not Saved in Phone Book Not Saved in Phone Book

Delay ringtone, for calls from numbers
not saved in Phone Book. It can
prevent you from accidentally
returning calls to nuisance calls from
Received Calls; as missed calls with very
short ring times are not saved in
Received Calls, when Missed Calls
Display is set to Not Display.
@ This procedure is unavailable when
Reject Unknown is set to Reject.

(=] » settings » (8] »
Incoming Call » (8] »
Ring Time (sec.) » (&)

) set Mute Seconds » (8] »
ON ) (®] » Enter time
before ringtone plays

HMTo Set Zero Seconds
» OFF ) (u]

E) missed Calls Display » (]
» Display or Not Display
» (m)

Aundag a



ting Outgoing/Incoming Calls

Tip

* Secret Phone Book entries are also
treated as not saved in Phone Book.

* You need not to specify a time when
OFF is selected.

Emission OFF Mode

The following are prohibited in
Emission OFF Mode:

- Incoming/Outgoing Calls

+ Incoming/Outgoing Messages

- Yahoo! Keitai Access

)= » settings » (=) »
Security » (] »» Emission
OFF Mode ) (8] )» YES »
(m]

Repeat procedure to cancel
Emission OFF Mode.

KAundag

Tip

» Emergency numbers (110, 119 and
118) are available even in Emission OFF
Mode.




ﬁ"ﬁ Setting Secret Data

Secret Mode & Secret

Data Only Mode

Activate Secret Mode/Secret Data Only
Mode to view secret Phone Book
entries, secret Schedule events and
secret files.

Secret Mode:

View all data and secret data.

Secret Data Only Mode:

Only secret data is available for Phone
Book and Schedule, although all data
and secret data can be viewed for
images, mail, and bookmarks.

Activating Secret Mode &
Secret Data Only Mode

FA (=) » settings » (=] »
Security » (8] » Secret
Mode or Secret Data Only
Mode » (m]

) Enter Security Code » (u)

Canceling Secret Mode &
Secret Data Only Mode

§)n standby, (=)

Hiding Handset Data

Files stored in Secret Folders are
accessible only when Secret Mode or
Secret Data Only Mode is activated.

@ The following data can be stored in
Secret Folders: Images, videos, received
and sent messages, and bookmarks of
Yahoo! Keitai and PC Browser.

@ Data saved on memory card or USIM
Card cannot be stored in Secret Folders.

@ Each Secret Folder of Data Folder has a
fixed storage capacity as follows:
+My Picture: Approx. 2 MB
-Videos: Approx. 10 MB

Storing Data in Secret
Folders

nSet handset to Secret Mode
or Secret Data Only Mode

#)n a data list window »
Select a data item » (@) »
Keep in Secret ) (8]

Returning Data in Secret
Folders to Ordinary Data

nSet handset to Secret Mode
or Secret Data Only Mode

In a data folder list window
)» Secret » (m]

E)select a data item » (@) »
Put Out )) (u]

) select a destination folder

» (m]

Tip
« Functions available with Secret Folder
data are limited.

Aundag a
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Handset supports S! Mail and SMS.

Send S! Mail messages to phone numbers e Available Mail Services
and e-mail addresses. } ]
SMS Exchange short text messages with other
— SoftBank handsets.
vy — | D
“ S1 Mail Exchange long text messages with S! Mail
m “‘ S compatible SoftBank handsets and other
= SoftBank (cgr’:frraactf e-mail compatible mobile phones and
p PCs. Images and melodies can also be
2 q Handsets mi required) 1 ached fo S! Mail.
AL
Q‘ Customize Handset E-mail Address.
z _— E S Effective for blocking spam.
W 3 - » Mail Setting » (8] » Custom Mail Address »
0. - (=] » Follow onscreen instructions.
L 4

Handset 4 Non-SoftBank Graphic Mail

Mobile Phones Use HTML mail to change font size/color, background, etc.
L 4
.0. Image Info Mail
Server A D Based on sender’s message, handset shows a pictogram
— B ’
@|f recipient’s handset is turned off or matching the sender’s mood.
out of range, sent message is stored C

on the server up to 30 days until the Blog Upload

recipient’s handset becomes available. PCs Add the e-mail address for an upload destination to
Blog/Mail Member to upload to SNS and a blog.
. J




Sending Messages

Sending S! Mail

A Press and hold

New Mai |
<No Address>

5KNo message

Composition Window

() select address field » (8] »
Enter Address ) (1) »
Enter address » (]

BAdding Recipients
» Select address field > (m] )
Select address field P> (®] M) Enter
Address )» (8] D) Enter address M
=] »

[E) select Subject field » (=] »
Enter subject ) (8]

If [ (double-byte mode) appears,

switch to single-byte mode
(P. 2-29).

» Add up to 20 recipients total between
To, Cc and Bcc fields.

) select text field » (w) »
Enter text » (@)

-/ Message
Hi.©Are you free tonigh

for dinner?

[t? Do you want to go out

|~Add Art

rea
ly Pictograms

BECR

B 30660
Text Entry Window

HlTo Cancel Transmission

»» When Start Packet Connection

appears ) (®); o
»» During Transmission M

HIf Resend mail? Appears

» YES )b (m)

Attaching Files
Attach the following files to S! Mail:

- Images - Videos
- Melodies - Music (Songs)
- Books + Phone Book entries

- Account Details - Schedule (To Do List)
- Bookmarks

@ For information about image, video, a

melody and music files, see P. 12-2.

) (Composition] window »
»» Attach File » (m]

) select a file type » (u]
(» Enter Security Code »
(m]) » Select a file » (u]
HImages with Large File Size
)» Attach Mail, QVGA Scale Down
or VGA Scale Down )) (u]
B Attach Additional Files
)» Repeat steps 1 and 2 above
HOpen an Attached File
) Select an attached file ) (m)

Note
+ Copy protected files cannot be sent as
attachments or output to external

devices.
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Sending Messages

Graphic Mail

Create html messages to change font
color/size and background color. Add
scrolling text, paste images, etc.

<Example> Change font size,
background color, insert an
image and set flashing text.

n §)(Text Entry] window »
» A ) (m] » Select a font
size » (®] »» Enter text »» (m)

#)  : » (@ » Edtoselecta
background color » (m]

HTo Toggle Color Palettes
»» In Background color window M

Toggle between 25-color and 256-

color palettes.

» (m) » Select a folder
» (m] » Select an image »

(w)

Hinserting Images with Large File Size
»» Insert Mail or Add Art Scale
Down ) (u)

) Al » (@) » ms ) (|] )
Enter text » (8] (twice) »
CA » () » (m]

B® » =

Adding Addresses to
Blog/Mail Member List

Group addresses into Blog/Mail

Member list and send messages by

group.

Post Camera images to a blog via

e-mail (P. 5-16).

@ Set one Blog/Mail Member as a blog
upload destination.

A= » own Data » (u] »
Blog/Mail Member ) (u]

= Blog/Mail Member 1/2

ENBIog/Mail Memberl
12Blog/Mail Member2

|3Blog/Mail Member3
|4Blog/Mail Memberd
5Bl og/Mail Member5
|68l og/Mail Member6

Blog/Mail Member List

HTo Specify as Blog Upload
Destination
) Select Blog/Mail Member P
» Blog/Mail Member “ % “
specified as upload destination
appears.

HTo Cancel Blog Upload Destination
) Select Blog/Mail Member with
“ e Pp ()

) select a Blog/Mail Member

list »» (m)

¥ Blog/Mai | Member1 1/2

)
|2:<Not Stored>

|3:<Not Stored>
|4:<Not Stored>
|5:<Not Stored>
[6:<Not Stored>

Blog/Mail Member Window

[E) <Not stored> » (= »

Enter address ) (®]
HTo Save an Address from Phone

Book or Sent/Received Address List
)) <Not Stored> » Look-

up Address »» (8] ») Phone Book,

Sent Address or Received Address
»» (m] »» Search Phone Book ) (m]
)» Select an address M) (®] (twice)



Sending Messages

SNS/Blog

Obtain an upload e-mail address
beforehand from an SNS/blog service.
Contact your SNS/blog service provider
for details.

Set the e-mail address to Blog/Mail
Member and post your entries to an
SNS, a blog, etc. via e-mail (P. 5-16).

Sending SMS Messages

Send short text messages to SoftBank
handsets, specifying phone numbers as
address.

»» Compose SMS ) (m]

SMS Composition Window

»» (@) »» Enter Address
» (®) » Enter phone
number » (®)

» (@] »» Enter text » (m]

More Features
@ Advanced

Composing Messages

<+ Enter Address from Phone Book

<+ Enter Address from Sent/Received
Address List

% Specify Blog/Mail Member List
Recipients

“ Set To, Ccor Bcc

< Delete an Address

«“ Insert Header/Signature

< Enter My Pictograms

< Delete Text

% Change SMS Message to S! Mail

(® P. 5-16)

Sending Messages

«“ Set Priority (S! Mail)

+» Server Storage Period (SMS)

< Check Delivery

+» Save a Message to Draft without
Transmitting It

+“ Delete a Message without Transmitting
It

(* P.5-17)

Attaching Files
< Shoot an Image/Video to Attach to
S! Mail
+ Delete Files Attached to S! Mail
(* P.5-18)

Blog/Mail Member
+ Edit an Address
+» Delete Addresses from a Blog/Mail
Member List
< Edit a Blog/Mail Member List Name
+» Reset a Blog/Mail Member List Name
(< P.5-18)

Graphic Mail
< Apply Effects to Entered Text
% Change Effects
< Cancel Last Applied Effect
% Preview Graphic Mail
% Cancel All Effects
«“+ Save Graphic Mail as a Template
< Download Templates
% Create Graphic Mail from a Template
< Edit a Template
< Edit Title of a Template
< Delete Templates
(@ P. 5-18)




Sending Messages

Customize

S! Mail Settings
+“ Edit Header/Signature
% Insert Header/Signature Automatically
« Set to Check Delivery
(< P. 14-22)

SMS Settings
m < Set to Check Delivery
2 «» Set Server Storage Period of SMS
o Messages
= <« Set SMS Input Language
(< P. 14-22)



ing & Opening Messages

Opening New

Messages

Received Result window opens for new

messages.

@ By default, complete S! Mail messages
(including attachments) are
automatically retrieved. Transmission
fees apply, depending on your
subscription plan. While traveling
abroad, message retrieval may incur
high transmission fees.

Olmage Information Mail
When an S! Mail is received, a
pictogram matching the message
content appears.

If a message contains a specific
keyword, a corresponding indicator
appears (P. 14-23).

FINISHED

EMai | =1

— Indicator
i\ew mail

Received Result Window

@ Indicators
?6’ Urgent % Advice
@ Lowe &, Try Hard
I Hate Q.f{‘ Invitation
% Happy ﬁ? Feedback
g Angry @ Request
% Sad I:';J Announcement
& Fun & oK
!! Surprise @ Reply
P Question () Information

— appears if message content does not
match any of the above moods or
information.

) [Received Result] window »
Mail » (=]

) select a message » (8]

Tip

« Alternatively open new messages from
shortcut notification.

« Indicator may not always correspond to
message content.

Opening Inbox

Messages
E)= » Inbox » (m)

|
|2/21F0 | der1

18/29F0 I der2
|4 21Folder3
|5/ @ Trash Box

Folder List

) select a folder ) (u]

] Inbox 1/2

&B

|22 # 4/15 EtoTakayuki
13/27% 4/14 EtoTakayuki
|4/2c9 4/14 HKoyamaKaor|
15/2 2 4/13 MakinoTatsuy|
16272 4/13 AikawaYoko

Message List




Receiving & Opening Messages
[E)select a message » (m] -
mRecy. Mail & 1/1 Replylng tO Tlp
o 12089/ 4/16 9:42 .
| oA kawaoko Messages « Attachments are automatically deleted
st & Thank you. from reply messages.

Thanks for dimer last 1 n[|nbox Message List] » + Quoting text is only available for
it » ‘ . .
1% o ot T Select a message ) (8] »» o Mal reples
ke to have.®
Multiple Recipients USIng Mall List
»» To Sender or To All ) (u] Retrieve Mail List and select messages

Message Window to download or forward.

) Edit subject/text » .
HMTo Check Previous/Next Message n » Server Mail »» (8] »

= Replying (Quote "é'f'" List » (&) () YES »
Message) )
Mail List

D inbox Message List] » II=—5 3R aaraor
(2= 8:34 EtoTakayuki
Select a message » (8] » A= 832 Aikawaoko

EWhen Original Message Has
Multiple Recipients
)» To Sender or To All ) (u]

) Edit subject/text »

Mail List

) select a message » (@ »
Message Receive » (®] »
Receive This » (u]
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Recei

ing & Opening Messages

HTo Receive Multiple Messages
» (@) »» Message Receive )) ()
)» Receive Selected M) (®]
Select messages ) (] M)
HTo Receive All Messages
» (®) »» Message Receive ) (m)
»» Receive All ) (8]

Tip

« If download fails while retrieving all
messages, download is canceled.

» When there is only one message,
message opens upon retrieval.

More Features
@ Advanced

Receiving Messages
< Manually Retrieve Messages
(< P. 5-20)
Checking Messages
< Retrieve Complete S! Mail
+» Delete S! Mail from Server
% Check Message Information
(< P. 5-20)
Server Message Operations
< Update Mail List
< Switch Mail List Views
< Check Server Message Information
“ Forward a Server Message
< Delete Server Messages
< Check Server Memory Status
(< P. 5-20)

Customize

Incoming Message Alerts

+ Adjust Ringtone Volume

< Set a Ringtone

++ Set Ringing Duration of Incoming
Message Ringtone

«“ Set Vibration

+ Set lllumination Color

< Open New Mail Window by Opening
Handset

(< P. 14-10)

Incoming Message Settings
% Customize E-mail Address
«“ Set Priority When Receiving Messages
during Operation
< Do Not Show Image Indicators
% Show Keyword Indicators
+» Delete Keywords
+ Set Manual Receive
(< P. 14-23)
Reply Settings
< Change Quotation Marks
(< P. 14-24)




Handling Messages
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Message Storage

Locations

Press to open Mail Main Menu.
Sent, received and draft messages are
saved in the locations below.

[

2. Outbox

3. Draft
4. Compose Message

5. Compose SMS
6. Server Mail

7. Retrieve New
8. Template

9. Mail Setting

Message Menu

|__ Received messages
IL_ Sent messages
— Draft messages

Opening Sent &

Received Messages

<Example> Open a Sent Message

)= » outbox » (=]

Folder List

) select a folder » (u]

Qutbox 1/2

El= 9:54 AikawaYoko
2/= 4/15 EtoTakayuki
3= 4/14 HEtoTakayuki
4= 4/14 KoyamaKaor i
5= 4/13 MakinoTatsuya
6= 4/13 AikawaYoko

I had a great time too!
|©Next time, let’s have
pasta. Do you know a g0o)
d place?

Message List

E)select a message » (=]

= Sent Mail /1
—o 12009/ 4/16 9: 54

| E=TailA i kawaYoko
[sieclYou”re welcome

I had a great time too!
©Next time, let's have

Message Window

HTo Check Previous/Next Message
» o

Tip

» When Outbox/Inbox becomes full,
Trash Box messages and then the
oldest messages in Outbox/Inbox are
deleted next time a new message is
sent/received. Unread and protected
messages and Secret Folder messages
are not deleted.




Handling Messages

Mail Windows
Message types, statuses, and attached
file types are shown by indicators.

Inbox Folder Outbox Folder
List List

Message List Windows

@fac 414 1 @7 el
522 4/13 MakinoTatsuy) akinoTatsuya

® li2? 4/13 I|ikawaYoko /13 #ikawaYoko
Inbox Message — Outbox Message

List List
Message Windows

® ®
= Sent Mail
56712089/ 4/14 10:00 ICO12009/ 4/16  9:54
|Fron /8K oyamaKaor i |[EoKA i kawaYoko
|Ssect|Aquar i um |ssectlYou” re we | come

I saw a Sea-Lion Show!
I recorded a movie, so I
Il send you a movie!

sl D----

©F= o/ i 3:0)

I had a great time too!
Next time, let’s have
pasta. Do you know a goo|
d place?
----END----

128KBytes|

Received Message
Window

Sent Message
Window

The following marks appear on indicators

to inform you:

= Folder Contains Unread Messages

5 Locked Folder

* Folder with Auto Sort Set

=4 Protected Message

£ Delivery failed to Some Recipients or
Some Attachments Deleted

# Delivery Failed/All Attachments
Deleted

1 Attachment Deleted

@ High Priority Message

@ | Folder Type
1 General Folder
M Trash Box Folder
M Secret Folder
@ |Message Status
£ Unread Received Message
2 Read Received Message
&4 Protected Unread Received
Message
o= Protected Read Received Message
¥ Forwarded Message
9 Replied Message
=l Message Sent to a Single
Recipient
= Message Sent to Multiple
Recipients
® | Message Type/Attached File Type

&2 SMS on Handset

sl SMS on USIM Card

] Image Attached/Image Inserted in Text

B Video Attached

41 Melody Attached

¢+ Song Attached

& Copyright-protected File Attached

{e] Phone Book Entry, Schedule Event
or Bookmark Attached

&3 E-comic Attached

& Forwarded Server Message

f2] Other Type of File Attached

& Multiple Files Attached

Tip

« Copyright-protected files cannot be
opened/played unless they are saved in
Data Folder.

« If Delivery Report was received,
appears in (& field of message.




Handling Messages

Sorting Messages

Automatically sort incoming/outgoing
messages into folders.

D Folder List] » Select a
folder » (@) »» Auto-sort »

D

HWhen Auto Sort is Already Set to
the Folder
» Select another criterion »)

) Address Sort » (8] )
Look-up Address, Look-up
Group, Look-up Member
or Enter Address ) (u]

HTo Sort by Subject
»» Subject Sort »» (] ») Enter
subject M) (m)

HTo Sort Messages Failed to be
Replied/Sent
»» Reply Impossible or Send
Impossible ) (u)

HlTo Sort Addresses Not Stored in
Phone Book
» Unregistered Add. ) (m]

5-12

Tip

* Only one Inbox folder can be specified
for sorting Reply Impossible
messages.

* Only one Outbox folder can be
specified for sorting Send Impossible
messages.

« Search addresses from Phone Book,
Received Address List, or Sent Address
List in Look-up address.

Canceling Auto Sort

EDFolder List] » Select a
folder » (@) »» Auto-sort »

(w)

) select a criterion » (@] »
Release ) (u]

E)Release This » (8] » YES
» (m)

HTo Cancel Multiple Criteria
) Release Selected ) (®] )
Select criteria P> (8] »» (&) M YES
0

HlTo Cancel All Criteria
»» Release All »» (&) )) YES )) (m]

Prohibiting Access to
Messages
Setting Mail Box Lock

E) = » mail setting » (8] »
Mail Box Lock » (®] »
Enter Security Code ) (m]

) select a mail box » (]

Repeat step 2 to specify other
boxes.

Setting Folder Lock

EIFolder List] » Selecta
folder » (@) » Folder Lock
» (®] »» Enter Security Code
» (8] » YES » (m)

Locked folders are indicated by _&.




Handling Messages

Tip

*» Repeat the same procedure to cancel
mail box or folder lock.

* Trash Box folder can also be locked.

« Security Code entry is required to view
messages in locked mail boxes and
folders.

Storing Messages in

Secret Folders

Set handset to Secret Mode or Secret

Data Only Mode beforehand (P. 4-9).

@ Unread Messages cannot be stored in
Secret Folders.

[Message List] »» Select a
message » (@) » Keep in
Secret ) (u]

) Keep This » (u]

HTo Store Multiple Messages
»» Keep Selected »» (8] M) Select a
message P> (8] )b Repeat the same
step to specify other messages P
» YES ) (m]

HlTo Store All Messages in a Folder
» Keep All »» (8] ») YES ) (m]

OReturning Messages in
Secret Folders to Ordinary
Messages

EDFolder List] » Secret » (]

) select a message » (@) »
Put Out » (u]

E)Put Out This » (8] 1 Select

a folder » (m]

HTo Return Multiple Messages
»» Put Out Selected »» (] »»
Select a folder ) (] ») Select a
message )b (8] )) Repeat the same
step to specify other messages M
» YES ) (u]

HTo Return All Messages
» Put Out All »» () )) Select a
folder P (@) »» YES M) (u]

Saving S! Mail
Attachments

Saving Image, Video, Melody,
Music, Flash® and Book Files

) (Message] window » Select
afile » (@) »» Save Data »

(@) » YES » (u]

) select a folder » (m]

HTo Set an Image as Wallpaper, etc.
»» YES ) (®) M) Select an item M)
(m] (M Select display method »»
(=] »» Confirm display »» (m])
Select NO and press (8] when you
do not want to set the image.

HTo Set a Melody as Ringtone, etc.
»» YES » () M) Select an item M)
(w]

Select NO and press (8] when you
do not want to set the melody.
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Handling Messages

Saving an Image Inserted
in Text

D (Message] window » (@] »
Save Insert Image » (8]

) select an image » (8] »
YES » (®] ) Select a folder

» (m]

E) YES » (] »» Select an item
» (m]

HWhen You Do Not Want to Set the
Image
» NO M (m]

Saving a Phone Book

Entry

A (Message] window » Select
contact information (a
phone number, etc.) » (8]
(twice) » Phone or USIM )»
(] » New » (m]

) Edit each item »

5-14

Saving a Schedule Event

n[Message] window )» Select
Schedule data » (®] (twice)

Saving a Bookmark

n[Message] window )» Select
a link (URL, etc.) » (m]
(twice) » Select a
destination » (®] »» Selecta
folder » (m]

Note
* Mail-attached bookmarks cannot be
saved to microSD.

© More Features
G@ Advanced

Managing Messages
< Protect a Message
< Move Messages to a Different Folder
< Drop Messages into Trash Box
< Delete Messages
+» Delete All Read Messages
< Delete All Delivery Reports
% Delete Attached Files
< Copy SMS Messages between Handset
and USIM Card
< Delete SMS Messages on USIM Card
< Change Message Color
< Add a Folder
+ Edit a Folder Name
< Change Order of Folders
< Delete a Folder
+» Check Number of Saved Messages
% Check Sent/Received Addresses
(* P.5-21)
Using Messages
< Edit a Sent Message
+ Edit & Send a Draft Message
+ Forward a Message
++ Save Sender, Recipient’s E-mail Address
or Phone Number to Phone Book
< Call a Phone Number in Text



Handling Messages

< Send an S! Mail to an E-mail Address in
Text
+» Access the Internet from a URL in Text
+» Save Number/Address in Text to Phone
Book or Blog/Mail Member
< Switch Subject Field Views
% Change Font Size of Text
+» Search for Messages in a Folder
< Sort Messages
« Filter Messages ﬂ
+» Reset Message List View to Default 2
+% Switch All Unread Messages to Read o
Messages =
< Open S! Mail Delivery Report

(® P.5-23)
Customize

Message View Settings & Others
% Set Number of Text Lines to Scroll
% Set Font Size of Text
< Set Message List View
< Play Attached Melodies Automatically
< Check Mail Settings
< Reset Mail Settings
(* P. 14-24)
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@ Advanced Features
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Sending Messages

Start Here

[Composition] window .............. P.5-3
[Text Entry] window ...P.5-3
[Blog/Mail Member List] ........... P.5-4

[Blog/Mail Member] window .... P. 5-4
[SMS Composition] window...... P. 5-5

Composing Messages

Enter Address from Phone Book

[Composition] window/ [SMS
Composition] window »
(m) »» Phonebook »» (8] )b Select
search method )» Select an entry
»» (@] M Select an e-mail address
or phone number ) (]

Enter Address from Sent/Received
Address List

[Composition] window/ [SMS

Composition] window »» »

(=] »» Sent Address or Received

Address »» (8] )) Select an e-mail

address/phone number M

(m] (twice)

Alternatively, select and press o
to open Sent/Received Address List.

Specify Blog/Mail Member List
Recipients

[Composition] window M »

(=] » Blog/Mail Member »» (m] »»

Select a Blog/Mail Member list M)

(w]

€3 All addresses in the selected Blog/Mail
Member list are entered in the address
field.

€3 You must save addresses to a
Blog/Mail Member list in advance.

Set To, Cc or Bcc

[Composition] window » »
Select an address »» (@) )» Change
Rcv. Type » () » To, Cc or Bec M

€3 Cc (Carbon copy): S! Mail copies are
sent to other addresses. Addresses in
the Cc field are revealed to the other
recipients.

€3 Bcc (Blind carbon copy): S! Mail copies
are sent to other addresses. Addresses
in the Bcc field are hidden to the other
recipients.

£EWhen there is no address in the To
field, the message cannot be sent.

Delete an Address

[Composition] window P Select
an address ) (@) ) Delete
Receiver »» (8] )» YES ») (m]




Insert Header/Signature

[Composition] window » (@] M
Add Header or Add Signature »

(w]

€2 Save header/signature in advance.

Sending Messages

@ Advanced Features

Enter My Pictograms

[Text Entry] window »» Press and

hold (&) »» Select a pictograph »

(=] »

E3Toggle categories by pressing =) or
.

&3 My Pictograms are only available for
S! Mails.

Set Priority (S! Mail)

[Composition] window » (@) »»
Priority »» (8] )» High, Normal or
Low )) (m]

Delete Text

[Composition] window/ [SMS
Composition] window M (@ »
Erase Message » (] )» YES )) (m]

Server Storage Period (SMS)

[SMS Composition] window )
»» SMS Valid. Per. )» (8] )) Select a
period ) (m]

&3 Specify a period the SMS message is
stored in the server in case it fails to
reach the recipient because the
recipient’s handset is out of range,
etc.

When None is set, the SMS message
is deleted from the server after it is

resent once in a certain period of time.

Check Delivery

[Composition] window/ [SMS

Composition] window » (@) )
Delivery Report or SMS Report
Req. »» (] )» ON or OFF )» (m]

When ON is set, handset receives a
delivery report.

Save a Message to Draft without
Transmitting It

[Composition] window/ [SMS

Composition] window » (@) »

Save » (u)

&3 The message is saved to Draft.
Messages saved in Draft can be edited
and sent at a later time.

Change SMS Message to S! Mail

[SMS Composition] window M
»» S! Mail Conversion ) (®)

Delete a Message without
Transmitting It

[Composition] window/ [SMS
Composition] window » (@] »»
Delete »» (8] ») YES ) (m]
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@ Advanced Features

Attaching Files

Shoot an Image/Video to Attach
to S! Mail

[Composition] window » (@] »»
Activate Camera »» (8] » Photo or
Movie »» (8] ) Shoot image/video
» (m]

Delete Files Attached to S! Mail

[Composition] window P Select
an attached file » (@) »» Delete

Att. File or Del All Att. Files )) [m]
»» YES ) (m]

Delete Addresses from a Blog/Mail
Member List

[Blog/Mail Member] M Select an
address
® To select Delete this
) Delete this P> (&) P> YES )) (m]
® To select Delete all
» Delete all > (8] M) Enter Security
Code P» (@] D) YES M) (m]

Graphic Mail

Blog/Mail Member

Edit a Blog/Mail Member List
Name

[Blog/Mail Member List] P Select
a Blog/Mail Member list M (@] M)
Edit Member Name ) (8] ») Edit
name ) (|

Apply Effects to Entered Text

[Text Entry] window »» »

weax| P> (W) M) Select beginning of

characters »» (@) ) Select end of

characters »» (m] M) Select effects

menu P (m) »» Apply an effect

E3select &/ and press () W YES P
(@] to select the entire text.

Edit an Address

[Blog/Mail Member] window »
Select an address M) (@) M) Edit
Address »» (8] )) Edit address M

(w)
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Reset a Blog/Mail Member List
Name

[Blog/Mail Member List] P Select
a Blog/Mail Member list »» (@) )
Reset Member Name ») (8] )) YES
» (m

Change Effects

[Text Entry] window »» »

x| P (@) M) Select beginning of

characters »» (@) ) Select end of

characters »» (m] M) Select effects

menu P (@) ) Change effects

Select gy and press (¥ to select the
entire text.

Cancel Last Applied Effect

[Text Entry] window » »
Huxe P (m)




@ Advanced Features

Preview Graphic Mail

[Text Entry] window »» »
21 » =) » or (¥ to close

preview

Cancel All Effects

[Text Entry] window b» »
reect| D) (M) D) YES )) (®] (D) (m])

Create Graphic Mail from a
Template

»» Template » (8] ) Select a
template ) (m] M

Save Graphic Mail as a Template

[Text Entry] window »» Enter text

» (=] » (@ M Template » (1] »»

Save Template ) (8) ) YES )) (u]

£3 Attached files except images inserted
in text are not included in a template.
Save up to 45 templates including
downloads. Delete saved templates as
needed.

Edit a Template

»» Template »» (8] M) Select a
template > (8] ) (@) » Edit ») (m]
) Edit text M (®] (twice) P> YES M

(w]

Delete Templates

)» Template »» (8] M) Select a
template »» (@) M) Delete » (m]
® To select Delete This
» Delete This »» (8] M) YES )) (m]
® To select Delete Selected
) Delete Selected »» (@] M Select
templates P> () P> (=) P> YES Pb (m)
® To select Delete All
» Delete All P> (8] D) Enter Security
Code P» (@] D) YES M) (m]

Edit Title of a Template

»» Template »» (8] M) Select a
template M) (®) V) Edit Title »» (m]
» Edit title »» (m]

Download Templates

»» Template » (8] »
Download Templates »» (8] V) YES
»» (@] » Follow onscreen
instructions
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Receiving/Opening Messages

Start Here

[Message List] .....cooueeenmeemmreeeenecens P.5-7
[Message] window..........cccvenene. P.5-8
[Mail List] P.5-8

Receiving Messages

Checking Messages

Manually Retrieve Messages

»» Retrieve New )» (8] »»
Received Result window opens M
Mail »» (®) M) Select a message »»

Press or press and hold to
cancel message retrieval.

£ Retrieve messages that were stored on
the server while handset was off or

Retrieve Complete S! Mail

»» Inbox »» (8] ) Select a

folder »» (@) )) Select an S! Mail

notification »» (&) »

£2An S! Mail notification is deleted
when you retrieve the message text.

£ Use this procedure when Message
Download under S! Mail Settings is
set to Manual.

Check Message Information

[Message List] » (@) »» Mail Info

» (m]

&3 This procedure is available only in
Inbox Message List window.

Server Message Operations

Update Mail List

[Mail List] » (@ »» Mail List »» (m]

out of range.

Delete S! Mail from Server

»» Inbox M (®) M) Select a
folder »» (@) » Select an S! Mail
notification » (8] »» (@) )b Delete
)» (m] » Notification, Server Mail
or Notifi./Server »» (8] )} YES M

(w]

Switch Mail List Views

[Mail List] »» [®) M) List Setting »
(] »» Subject, Name or Address M

(w]

Check Server Message Information

[Mail List] M Select a message M
»» Mail Info »» ()




Forward a Server Message

[Mail List] »» Select a message P
»» Forward »» (8] ) » (m)
»» Enter address M)

Delete Server Messages

[Mail List] »» Select a message M
»» Delete )) (m]
® To select Delete This
) Delete This b (&) P YES M (m)
® To select Delete Selected
» Delete Selected »» () M) Select
messages P> (8] ) (=) M) YES M) (m)
® To select Delete All
» Delete All D) (] D) Enter Security
Code " () » YES ) (m]

Managing/Using Messages

Start Here

[Folder List] ........ccommrernmecenerrnnnes P.5-10
[Message List] .......cocceneeumecenneeennens P. 5-10
[Message] window ... P.5-10

[Inbox Folder List] .. .P.5-11
[Inbox Message List] ........cccoucunnee P. 5-11
[Received Message] window ..P. 5-11
[Sent Message] window.......... P.5-11

Managing Messages

Protect a Message

[Message] window ») (@) M
Protect ON/OFF )) (m)

€31f a message is protected, this

procedure cancels protection.

Check Server Memory Status

»» Server Mail »» (®) ) Server
Mail Memory »» (&)

@ Advanced Features

Move Messages to a Different
Folder

[Message List] »» Select a message
» (@ »» Move »» (8] »» Move
This, Move Selected or Move All
»» (@) M) Select a destination
folder »» (W) (M) Select messages
» (m) » =) W YES ) (]

&3 A message can also be moved to a
different folder from Message
window.

Drop Messages into Trash Box

[Message List] » (®) »» Move to
Trash Box »» (8] )} Select a
message ) (8) ) (=2 M) YES M (m]

£ Protected messages and delivery

reports cannot be moved to Trash Box.
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Delete Messages

[Folder List] »» (®) )» Delete All Y
(] »» Enter Security Code » (®) M
YES » (m]
[Message List] P> Select a message
» (@ ) Delete ) (m]
® To select Delete This
»» Delete This b (8) P> YES ») (m)
® To select Delete Selected
» Delete Selected »» (®) M Select
messages b (=] ») » YES)) (m)
® To select Delete All
» Delete All P (] D) Enter Security
Code " () »» YES ) (m]
&3 Protected messages cannot be
deleted.

Delete All Delivery Reports

[Inbox Message List] » (@) »»

Delete » (8] )» Delete All Reports

»» (m] »» Enter Security Code » (m]

» YES ) (m)

C3Protected delivery reports cannot be
deleted.

Delete Attached Files

[Message] window () Select
attached files) »» (@) ) Delete Att.
File or Del All Att. Files »» (m] »
YES ») (m)

Delete SMS Messages on USIM
Card

(=] »» Tools »» (m] M USIM
Operation )» (8] )) Enter Security
Code »» () ) Delete » (m] M
USIM »» (8] »» SMS »» (8] ») Inbox
or Outbox »» (W) M) Select a folder
»» (@] »» Select an SMS message »»
(=] » [ » YES » (m)

Delete All Read Messages

[Inbox Folder List] » (@) »» Delete
Read »» (8] »» YES )) (m]

[Inbox Message List] » (@) »»
Delete ) (®] )) Delete Read )» ()
»» YES )) (m]

3 Protected messages cannot be
deleted.
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Copy SMS Messages between
Handset and USIM Card

(=] » Tools »» (8] W USIM
Operation »» (8] ) Enter Security
Code »» (W) ») Copy » (8] W
Phone— USIM or USIM— Phone »»
(@] »» SMS »» () ) Inbox or
Outbox »» (®] M Select a folder MW
(m] »» Select an SMS message ) (®)
» (=) » YES M (m]

Change Message Color

[Message List] »» Select a message
» Press and hold

€3 Each time you press and hold (¥, the
message color toggles as follows: Red
— Blue — Black




Add a Folder

[Folder List] » (®) »» Add Folder
»» (@) M Enter folder name ) (&)
)» YES ) (8] ») Address Sort,
Subject Sort, Reply Impossible,
Send Impossible or Unregistered
Add. »» (8] »» Make auto Sort
settings M (2] > YES or NO ) (m]

3 Select NO and press (m] when you do
not want to make Auto Sort settings
to the folder.

Change Order of Folders

[Folder List] » Select a folder

) Sort Folder »» (8] M) Select a

position » (=]

2 The order of preinstalled folders
cannot be changed.

Edit a Folder Name

[Folder List] » Select a folder »

)» Edit Folder Name » (8] )»

Edit folder name ) (®)

% Preinstalled folders cannot be
renamed.

Delete a Folder

[Folder List] » Select a folder »
»» Delete Folder »» (&) ) Enter
Security Code ) (8] M) YES ) (m]

3 Folders containing protected
messages and preinstalled folders
cannot be deleted.

€3 This procedure also deletes messages
stored in the folder.

€3 Auto Sort settings are also canceled
when you delete a folder with Auto
Sort settings.

Check Number of Saved Messages

[Folder List] / [Message List] »
»» No. of Messages » (u]

&3 The total number of messages, and
the number of unread and protected
messages in a folder can be checked
from Folder List.

The number of messages in a folder
can be checked from Message List
window.

@ Advanced Features

Check Sent/Received Addresses

Press and hold 0] or press and
hold (3 »» Select an entry ) (m]

Using Messages

Edit a Sent Message

»» Outbox M (8] M) Select a
folder »» (@) M) Select a sent
message ) (2 ) Edit address,
subject and text M
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Edit & Send a Draft Message

»» Draft »» (8] M) Select a
message »» (®) )) Edit address,
subject and text M)

Forward a Message

[Received Message] window »»

»» Reply/Forward »» (8] )

Forward » (®] (twice) M Enter

address M

€3 The subject and text can also be edited.

€2 Files attached tofinserted in S! Mails
are also forwarded.

Save Sender, Recipient’s E-mail
Address or Phone Number to
Phone Book

[Message] window »» (@) M
Address List »» (8] ) Select an
e-mail address/phone number
)» Save Address ) () )» YES
»» (@) »» Phone or USIM »» (=] »
Select saving option » (m] ()
Search Phone Book )» Select an
entry » (®]) ) Edit each item »»

€3 Select an address to save to Phone
Book when the message has multiple
recipients.

Send an S! Mail to an E-mail
Address in Text

[Message] window PP Select an
e-mail address »» (8] »» Compose

S! Mail »

Access the Internet from a URL in
Text

[Message] window »» Select a URL
»» (] » Yahoo! Keitai or PC Site

Browser )) (®]

Call a Phone Number in Text

[Message] window P» Select a
phone number » (8] M Voice
Phone or Video Call »» (8) »» Dial
» (m)




@ Advanced Features

Save Number/Address in Text to
Phone Book or Blog/Mail Member

[Message] window P Select an
e-mail address/phone number M
»» Save Address ) (®] )
Phonebook or Blog/Mail Member
» (=]
® Save to Handset
»» Phone »» (8] D) Select store
method P (8] ()} Search Phone Book
» Select Phone Book M) (®)) M) Edit
items P (= (M YES or NO ) (m))
(P Enter entry number ») (m])
® To Save to USIM Card
P> USIM P (®] P Select store
method P (8] ()} Search Phone Book
» Select Phone Book M) (®)) M) Edit
items Db (& (PP Overwrite or Add
» (=] Y YES or NO P) (m))
® To add to Blog/Mail Member
) Select Blog/Mail Member to add P
Select an item (P> YES ») (m))

Switch Subject Field Views

[Message List] P> Press and hold
#)
When Mail List Disp. is set to 2 Lines,

view toggles in the order Name—
Address.

€3 When Mail List Disp. is set to 1 Line,
orto 1 Line+Body, the view cycles as
follows: Subject—Name —Address

Sort Messages

[Message List] » (@) ) Sort »» (u]
») Select a criterion M

L his procedure can be combined with
the Filter operation below.

Change Font Size of Text

[Message] window PP Press and hold

Filter Messages

[Message List] » (@) M) Filter M
(@] »» Select a criterion » (®]

€3 This procedure can be combined with
the Sort operation above.

Search for Messages in a Folder

[Message List] »» (@) M Search
Mail »» (m) »» Search Sender,
Search Receiver or Search Subject
»» (m] (P Select a search criterion
)» (m]) M Select an address, enter
address or subject )» (=]

£ Narrow down search results by
repeating the search operation.

Reset Message List View to
Default

[Message List] »» (@ » Display All

) (m)

€3 This procedure returns the message
list view that has been changed by
search, sort or filter operation to its
original view.
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Switch All Unread Messages to
Read Messages

[Inbox Message List] » (@) »
Read All » é »» YES ») ()

Open S! Mail Delivery Report

[Outbox Message] window »

»» Disp. Report ») (u]

2 0nly available in Message window of
a sent message with a requested
delivery report.
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Access the Mobile Internet via Yahoo! Keitai (SoftBank’s mobile portal site). Browse PC websites using PC Site Browser.
*Separate subscription required for Internet access.

Internet
EEEEEN Illllllll*PcwebSites
] (P. 6-5)
[ Use PC Site Browser*. ]

==u= ) Mobile Internet Sites

» When a security notice appears,
subscribers must decide for themselves
whether or not to open the page.
Opening secure pages constitutes
agreement to the terms of SSL/TLS
usage.

SOFTBANK MOBILE Corp., VeriSign
Japan K.K., Cybertrust Japan Co., Ltd.,
Entrust Japan Co., Ltd., GlobalSign
K.K., RSA Security Japan Ltd. and
Secom Trust Systems Co., Ltd. cannot
be held liable for any damages
associated with the use of SSL/TLS.

:Illll-lllllll> Yahoo! Keitai
(P. 6-3)
[ Press to access. ]
Transmission & Information Fees About Security

Some web contents automatically
connect to different pages incurring
transmission fees.

Information fees may also apply.

Handset supports SSL/TLS (encryption
protocols for Internet transmissions of
important/sensitive information). Root
certificates necessary to use SSL/TLS are
saved on handset by default.

* When Warning Messages is set to ON,

an alert appears each time handset
connects to a website using PC Site
Browser.



& Yahoo! Keitai

. Using Access History
Connecting to
Yahoo! Keitai (D Press and hold ) » History
» (m)

0
!
YarHQO! 2isite2
Bisite3
— =I Gisited
=
Web Page History List
) select an item » (=] ) select a record » (u]

Repeat this step until the page you
want to view opens.

[E) (=) to exit the Internet »
YES » (u]

Entering URLs

D Press and hold (] » Enter
URL » (w)

Enter URL

Enter URL Window

) <NEW> »» (8] ») Enter URL
» (=) » oK » (]

Tip

* A confirmation for SSL/TLS
communication appears each time a
secure page is opened. § appears in
SSL/TLS compatible pages.

» Some pages require user authentication.
Select text entry field and enter your user
ID or password.

EEVTBESTT] n
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© More Features

Yahoo! Keitai
< Switch to PC Site Browser
< Open Yahoo! Keitai Main Menu
(* P. 6-12)

History
< Save a URL in History to Bookmark
% Check a URL in History
+“ Delete Records in History
(* P.6-12)
Entering URLs
% Access a Page from an Entered URL
Record
% Access a Page by Editing an Entered URL
Record
< Send an Entered URL Record by Mail
+“ Delete Entered URL Records
(* P.6-12)
Root Certificates
< Check Certificate Details
< Switch a Certificate between Valid &
Invalid
(* P.6-13)

Customize

Yahoo! Keitai & PC Site Browser

% Clear Cache

< Delete Cookies

< Set Whether to Send Manufacture
Number

<+ Set Whether to Send Referer

<+ Enable/Disable Cookies

< Set Whether to Activate Scripts

< Check Yahoo! Keitai/PC Site Browser
Settings

« Initialize Memory Status of Yahoo!
Keitai/PC Site Browser

<+ Reset Yahoo! Keitai/PC Site Browser
Settings

(" P. 14-26)



& PC Site Browser

. About Page Layout F)Home » (8] (» YES or NO
PC Site Browser When using PC Site Browser, two page » (®)) » Select an item »

View PC websites using PC Site layout types are available for each of @
Browser. Scroll up, down, left or right ~ PC Screen and Small Screen: Repeat this step until the page you
to view entire page. PC Screen: Scroll pages vertically and want to view opens.
@ You may not be able to view as you horizontally.
want depending on the site. Small Screen: Scroll pages vertically. = s
@ Note that transmission fees may be Pages are laid out to fit Display width.
expensive for pages with large amounts o
of data. Connecting to PC
Websites
2 ) Press and hold 7] » PC Site o
Browser ) (u] Web Page

5 PC Site Browser Menu

E) (=) to exit the Internet »
YES » (m]

D PC Site Browser Menu
PC Site Browser Window

EEVTBESTT] n
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Using URL History

[PC Site Browser Menu] »
History » (m]

|1

|2site2
13isite3
4isited

History List

) selectarecord » (8] (» YES
or NO ) [m))

Entering URLs

n[PC Site Browser Menu] »
Enter URL » (u)

= Enter URL
E2NEW>

Enter URL Window

) <NEW> ) (8] )) Enter URL
» (m) »» OK » (8] () YES or
NO ) (m))

© More Features
@ Advanced

PC Site Browser
< Switch Page Layout Types
“ Return to Home
(* P.6-12)
History
< Save a URL in History to Bookmark
% Check a URL in History
+“ Delete Records in History
(* P.6-12)
Entering URLs
% Access a Page from an Entered URL
Record
% Access a Page by Editing an Entered URL
Record
< Send an Entered URL Record by Mail
% Delete Entered URL Records

(* P.6-12)
Customize

Yahoo! Keitai & PC Site Browser

< Clear Cache

<+ Delete Cookies

< Set Whether to Send Manufacture
Number



@ PC Site Browser

< Set Whether to Send Referer

< Enable/Disable Cookies

< Set Whether to Activate Scripts

% Check Yahoo! Keitai/PC Site Browser
Settings

+ Initialize Memory Status of Yahoo!
Keitai/PC Site Browser

< Reset Yahoo! Keitai/PC Site Browser
Settings

(% P. 14-26)

PC Site Browser
< Do Not Show Alert When Activating PC
Site Browser & Switching Browsers
(< P. 14-27)
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Scrolling Pages

If a page extends beyond view, use K
to scroll page.

Viewing Frames

When a page includes multiple frames,
select frames to view.

ﬁ to select a frame
» Frame In » (8]

Navigate through the frame as you
would a page.

HTo Exit Frames
» »» Frame Out )) (u]

Jumping to Next or

Previous Page

Once opened pages are stored in a
temporary storage area (cache). Press
(@), select History Back or History
Forward and press (8] to go back to the
previous page or proceed to the next
page, without connecting to the
network as long as the pages are
stored in the cache.
@ Network connection is made when the
cache is full.

Selecting Links and
Other Items

Operate as follows when buttons and
menus appear in web pages.

-Online Registration-

Terns of Use —@
Nme [ 1@
Area

[(anto [——®

Gender (+)Male OFemale 71 @
Pursuit CSports
O Readingj—— @

OMusic

—

@ |Link
Select a link and press (W] to access
the linked page.

@ | Text Box

Select a text box and press (] to
open a text entry window to enter
text.

@ | Pull-down Menu
Select a pull-down menu and press
(m] to open a list of options. Use (@)

to select an item and press (®].




@ Page Operations

Radio Button < Set Whether to Show Images or Play
@ Use K and press (W) to select only Melodies
one item from arange of options. ® (<" P. 14-26)
indicates the item is selected. - Yahoo! Keitai
®|Checkbox Fjage Operations % Set Font Size
Use £ and press (8] to select # Reload Page . « Set Flash® Sound On/Off
multiple items from a range of * Save Images/Melodies in a Page (* P.14-27)
options. [v] indicates the item is < Save Background Image of a Page
selected. < Send URL of a Page by Mail PC Site Browser
®| Command Button + Call a Phone Number in a Page “ Set Page Layout
Select a command button and press < Send an S! Mail to an E-mail Address in (< P.14-27) a
(m] to activate the assigned function. a Page -
<+ Access Another Page from a URL in a ,?..
Page e
< Save a Phone Number/E-mail Address in a

a Page to Phone Book
< Change Font Size of a Page
“ Zoom Page In/Out
< Jump to Top/End of a Page
% Change Character Code of a Page
+ Play Flash® from the Beginning
< Check Title, URL or Certificate of a Page
< Show Key Guidance

Customize

Yahoo! Keitai & PC Site Browser
< Set Scroll Unit/Speed

(* P.6-13)
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Save URLs to Bookmark for quick
access.

Saving URLs to Bookmar

B iweb Page] » (@) »
Bookmark » () »» Add
Bookmark »» (8] )) YES »

(w]
) select a folder » (u]

Accessing Pages from
Bookmark

{APress and hold ] »
Bookmark » (u]

Bookmark Folder List Window

6-10

HlFrom PC Site Browser
Press and hold (] M) PC Site
Browser ) (8] )b Bookmark M

(w]

K ) select a folder » (m)

Bookmark List Window

[E) select a bookmark » (s

Tip

* To access a bookmarked page from
another page:
»» Bookmark »» (®] M
Bookmark List P» (8] D) Selecta
folder P (@] M) Select a bookmark M

» CA’z CAFE is pre-saved by default.

Using Saved Pages

Save an open page to Saved Pages to

view the page at a later time without

connecting to the Internet.

@ Only Yahoo! Keitai pages can be saved.

@ Viewable content is page as it was
saved.

Saving a Page

B web Page] » (@ » Saved
Pages » (m] »» Add Saved
Pages » (m] »» YES )» (m]

Opening Saved Pages

) Press and hold (] » Saved
Pages » (m]

&= Saved Pages

KNA train schedule

|2 Coupon

I3 TV program information|
|&Restaurant

Saved Pages List Window



@ Bookmarks & Saved Pages

Select a page »
page ) (8] More Features
G

+ To open a saved page from another
Bookmarks

age:
g )) Saved Pages P> (8] D) Saved < Edita Title
Pages List P» E? P Select a page M % Edit a URL

% Send a Bookmark by Mail

<+ Check Number of Bookmarks

< Create a Folder

< Edit a Folder Name

% Change Order of Folders

< Move Bookmarks to a Different Folder
“ Delete a Folder

< Delete Bookmarks

(" P. 6-15)

Saved Pages
+ Edit a Title
«“ Protect Saved Pages
% Check Number of Saved Pages
< Delete Saved Pages
(® P. 6-17)
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Connecting to the Internet

Start Here
[Web Page] ......ccccererunnnnes P. 6-3, P. 6-5
[History List] .....cccoerunrune. P.6-3, P. 6-6

[Enter URL] window......... P. 6-3, P. 6-6

Yahoo! Keitai

PC Site Browser

Switch Page Layout Types

[Web Page] M (@) »» Change

Disp. Mode ) (u]

€2 The page layout toggles between PC
screen and Small screen.

Switch to PC Site Browser

[Web Page] » (@) » Switch to PC
»» (@] »» YES » (®] () YES or NO
» (m)

Open Yahoo! Keitai Main Menu

[Web Page] » (®) ) Yahoo!

Keitai » (m])

Return to Home

[Web Page] » (@ » Home » (u]

History

Delete Records in History

[History List] »» Select a record »»
»» Delete ») (m]
® To select Delete This
) Delete This »» (8] M YES M) ()
® To select Delete Selected
» Delete Selected ) (8] P Select
records P» (@) M ) YES )) (m]
® To select Delete All
» Delete All b (®] D) Enter
Security Code »» () P> YES ) (m]

Save a URL in History to Bookmark

[History List] P> Select a record »
»» Add Bookmark »» (8] » YES
»» (@] »» Select a folder »» (m]

Entering URLs

Access a Page from an Entered
URL Record

[Enter URL] window M Select a
record ) (8] »» OK ) (m]

Check a URL in History

[History List] P Select a record M

»» URL » (m]




Access a Page by Editing an
Entered URL Record

[Enter URL] window P» Select a
record »» (8] M) Select URL entry
field »» (=] » Edit URL > (®]) »)
OK ) (m)

Send an Entered URL Record by
Mail

[Enter URL] window »» Select a

record »» (@ »» Compose

Message »» (8] » Enter address,

subject and text M

£ Composition (S! Mail) window opens
with the URL inserted in the text.

Delete Entered URL Records

[Enter URL] window P» Select a
record » (@ ) Delete ) (m]
® To select Delete This
»» Delete This »» (8] P> YES ) ()
® To select Delete Selected
» Delete Selected ) (8] P Select
records P» (&) M ) YES ) (m]
® To select Delete All
» Delete All b (®] Db Enter
Security Code ) () D) YES )) (m]

Switch a Certificate between Valid
& Invalid

(m) »» Settings »» (m] M

Connection Settings »» (8] »

Certificate »» (8] ) Select a

certificate »» (@) » Valid/Invalid

» (m]

€3 This procedure switches a valid
certificate to invalid and an invalid one
to valid.

@ Advanced Features

Root Certificates

Page Operations

Check Certificate Details

(m] »» Settings P (®) M
Connection Settings »» (8] M
Certificate »» (®) )) Select a
certificate »» (m]

Start Here
[Web Page] ......cccccecrenenee P.6-3, P. 6-5

EEVTBESTT] n

Reload Page

[Web Page] » (®) M Reload »
(]
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Save Images/Melodies in a Page

[Web Page] » (@) »» Save File

(=) (P> Object M (m]) () Select a

file) » (m] »» Save »» (8] W YES

» (] (M Select a folder »» (m))

(»» YES or NO ) (m))

€3 7o play a melody, select Play and
press (m].

&3 To check file properties, select
Property and press (m].

Send URL of a Page by Mail

[Web Page] » (@) »» Convenient
Tools »» (] »» Compose Message
» (=) » Attach URL »» (=] »»
Enter address, subject and text »
Composition (S! Mail) window opens
with the URL inserted in the text.

Access Another Page from a URL in
a Page

[Web Page] M Select a URL ) (m]

jJouIdU| !

Save Background Image of a Page

[Web Page] M (@) ) Save File M

(] (» Background Image »» (m))

» (@] » Save »» (8] M) YES ) (u]

(» Select a folder) (» YES or NO

) (m)

270 check file properties, select
Property and press (m].

Call a Phone Number in a Page

[Web Page] P Select a phone

number > (8] M Voice Phone or

Video Call »» (8] » Dial » (m]

£ only available when using Yahoo!
Keitai.

Save a Phone Number/E-mail
Address in a Page to Phone Book

[Web Page] » Select a phone
number/e-mail address M »
Add to Phone Book »» (8] »» YES
»» (@] »» Phone or USIM ») (&] »
New, Add or Overwrite »» (8] ))
Edit each item M [®) () Overwrite
or Add » () ()» YES or NO »»
(m]) (»» Enter entry number » (m])

6-14

Send an S! Mail to an E-mail
Address in a Page

[Web Page] ) Select an e-mail
address ) (8] )» Compose S! Mail

» ([

Change Font Size of a Page

[Web Page] »» (@ »» Change Font

Size &] P Select a font size ) ()

&BPC Site Browser's page layout must be
set to Small Screen.




@ Advanced Features

Zoom Page In/Out

[Web Page] » (@) »» Zoom ) (m]
) Select a magnification »» (®]

£ PC Site Browser must be set to PC
Screen.

Jump to Top/End of a Page

[Web Page] » (®) »» Convenient
Tools »» (®] )» Head of Sentence
or End of Sentence »» (u]

Play Flash® from the Beginning

[Web Page] » (@) »» Convenient

Tools »» (8] M Replay » (m)

OnIy available when using Yahoo!
Keitai.

Change Character Code of a Page

[Web Page] » »» Convenient
Tools »» (8] » Change CHR Code
»» (@] ) Select a character code

» (m)

€23 Use this procedure when characters of
a page are illegible.

Check Title, URL or Certificate of a
Page

[Web Page] » (@ »» Convenient
Tools »» (8] ) Site Info »» (8] M
Title, URL or Certificate ) (m]

Bookmarks & Saved Pages
Start Here

[Bookmark Folder List] window

Show Key Guidance

[Web Page] » »» Help » (u]
&3 This procedure is only available when
using PC Site Browser.

........ . . .P.6-10
[Bookmark List] window.......... P. 6-10
[Saved Pages List] window ......P. 6-10
Bookmarks

Edit a Title

[Bookmark List] window »» Select
a bookmark » (®) M) Edit Title »»
(@) »» Edit title )» (m]

Edit a URL

[Bookmark List] window »» Select
a bookmark » (®) M Edit URL M
(=] »» Edit URL ) (m]

EEVTBESTT] n
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@ Advanced Features
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Send a Bookmark by Mail

[Bookmark List] window »» Select a
bookmark »» (@) » Compose
Message or Attach to Mail »» (=]
» Enter address, subject and text P>

£2 Compose Message: Composition (S!
Mail) window opens with the URL
inserted at the top of the text.
Attach to Mail: Composition (S!
Mail) window opens with the
bookmark file attached.

Edit a Folder Name

[Bookmark Folder List] window M
Select a folder M (@) ) Edit Folder
Name »» (8] ) Edit folder name

) (m]

Check Number of Bookmarks

[Bookmark Folder List] window or

[Bookmark List] window M »

No. of Bookmarks »» (®]

€2 The total number of bookmarks can
be checked from Bookmark Folder List
window; and the number of
bookmarks in a folder can be checked
from Bookmark List window.

Change Order of Folders

[Bookmark Folder List] window P

Select a folder M »» Sort

Folder »» (] » Select a position

) (m)

€3 The order of Preset folders cannot be
changed.

Delete a Folder

[Bookmark Folder List] window M

Select a folder » (@) » Delete

Folder »» (] » Enter Security

Code »» (] »» YES ) (m]

€3 This procedure also deletes all the
bookmarks saved in the folder.

Create a Folder

[Bookmark Folder List] window »»
)» Add Folder »» (8] ») Enter
folder name »» (@]

Move Bookmarks to a Different
Folder

[Bookmark List] window »» Select
a bookmark » » Move ) (u]
»» Move This, Move Selected or
Move All »» (8] ) Select a
destination folder ) (] (»» Select
bookmarks » (8] »» (=) > YES W

(w)

Delete Bookmarks

m To Delete All Bookmarks
[Bookmark Folder List] window P
»» Delete All »» (8] )) Enter
Security Code ) (8] ) YES ) (m]
m To Delete Bookmarks in a Folder
[Bookmark List] window »» Select
a bookmark » (@) )» Delete ) (m)
® To select Delete This
» Delete This M (8] M) YES )) (m)
® To select Delete Selected
» Delete Selected »» (8] M) Select
bookmarks M (@] M ) YES M
(m)
® To select Delete All
» Delete All P> (8] D) Enter Security
Code P> (m] ) YES )b (m]




Saved Pages

Edit a Title

[Saved Pages List] window M
Select a saved page M (@) M Edit
Title »» (] )) Edit title ) (m]

Protect Saved Pages

[Saved Pages List] window M

Select a saved page M (@) »

Protect ON/OFF ) (u]

§3 Use this procedure to toggle saved
pages between protected and
unprotected.

Delete Saved Pages

[Saved Pages List] window »
Select a saved page » (@ »
Delete »» (m]
® To select Delete This
) Delete This b (w) Db YES )b (m)
® To select Delete Selected
) Delete Selected »» (@] P Select
saved pages M) (8) Db (=] M) YES

® To select Delete All
» Delete All Db () D) Enter Security
Code »» (] »» YES ) (m]
€3Protected Saved Pages cannot be
deleted.

Check Number of Saved Pages

[Saved Pages List] window »
»» No. of Pages )» (®]

q@ Advanced Features
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Capture still images and videos with built-in camera.

Shoot Still Images/Videos

Camera Style/Cellular Style

Shoot like a camera with handset
closed (Camera Style, P. 7-3), or
like a cellular phone with handset
open (Cellular Style, P. 7-4).

Blog Upload

(Camera Style) (Cellular Style)
Upload photos and text to an SNS
or blog.
Optimal mode for portrait shots
(P. 7-6).

Auto Focus (AF)

Adopts Continuous AF. Maintains
focus automatically, enabling
shooting with minimal lag once you
press the shutter.

Snap Viewer/Movie Viewer

View still images and videos with
handset closed.

eiswe) !

* L J

Send by S! Mail
[] *

4
» y %

n
5 [

Non-SoftBank SoftBank PCs
Mobile Phones Handsets

« Still images are saved in JPEG format
and videos in MPEG4 format.

» Clean the lens with soft cloth.
Fingerprints or grime on the lens may
result in blurred images.

* Image blurring may occur when Image
Stabilizer is OFF. Setting Image
Stabilizer to Auto is recommended.

» Some points/lines may appear brighter
and some darker.

+ Shooting when handset is warm may
affect image quality.

* Exposing the lens to direct sunlight for
an extended period may result in
discoloration of photo images.

« Shutter click, Auto Timer tone, and
Auto Focus locked tone sound at a
fixed volume even in Manner Mode.

* You may hear a low hum when using
Camera*, but this is normal.

» When shooting under fluorescent
lighting, faint streaking may appear in
Display.

« If Camera is activated over a set
number of times while out-of-range,
Camera becomes unavailable. Activate
Camera again after moving to a
location with signal reception.

* Auto focusing (Auto Focus, shooting,
focus lock), camera activation, etc.



viewfinder  [intikial i
L]
(@ | Focus Frame (BI-DO-RI, Photo and

Camera settings are shown by Serial) Level Tto | Level 16
indicators. Some can be selected to White: Appears when Auto Focus set
change settings (P. 7-16). Green: Focus successful Select to Save (BI-DO-RI, Photo and
i Red: Focus failed Serial)
@Landscape View (Camera Style) [ ] AFON and in Macro ® Phone microSD
" 7 AF ON and with face detection Number of Savable Files (BI-DO-RI,
[ ] Face detection when AF ON and Phﬁﬁo.and Serial)
with face detection X\é”g\‘; 111Oc:3rrrIT;2£e
® ﬁl;%w;ngﬁl (BI-DO-RI, Photo and Serial) Red: No memory space
OFF Select to Save (l\/lov?e)
) ® Phone microSD Q
® gjtgglmer Storage Capacity (Movie) 3
No indicator: OFF Blue: 500 KB or more 1]
BI-DO-RI, Photo and Continuous : Yellow: Less than 500 KB B
Shooting Viewfinder @ |Light Red: No memory space
ﬁ‘é}é’at SF'\; ©|BI-DO-RI (BI-DO-RI)
i L& BI-DO-RI Mode
M
% ® @ac'\r/l:cro ON Shooting Status (Movie)
® No indicator: Macro OFF 2 g:waonoci?r?/g
Image Stabilizer (BI-DO-RI, Photo and - - -
@ ® MO\?ie) Hlizer @ | Quality Setting (Movie)*
| @ Auto INong Dlur. Mode
W ® No indicator: OFF = Norma

Fine Mode
Super Fine Mode

Movie Viewfinder




_ @owewen A

®| Movie Type Set (Movie) @Portrait View (Cellular Style) Indicators
[
\N/%;n;al @ | Focus Frame (BI-DO-RI, Photo and
B Voice Serial)

White: Appears when Auto Focus set

Green: Focus successful

Red: Focus failed

[ ] AF ON and in Macro

" " AF ON and with face detection

[ ] Face detection when AF ON and
with face detection

© —H ®|Macro

* Fine Mode and Super Fine Mode are
available when VGA(Video L) or
QVGA(Video S) are selected for Select ®
Size.

O ® Macro ON
2 = No indicator: Macro OFF
9 BI-DO-RI, Photo and Continuous —
3 Shooting Viewfinder @ |Image Stabilizer (BI-DO-RI, Photo, and
H Movie)
py ETil F10:10 (M) Auto

No indicator: OFF

@0 06 e

Movie Viewfinder
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@

Select to Save (BI-DO-RI, Photo and
Serial)

® Phone microSD

Number of Savable Files (BI-DO-RI,
Photo and Serial)

White: 11 or more

Yellow: 10 or less

Red: No memory space

© | Quality Setting (Movie)*
Long Dur. Mode
Normal

Fine Mode

Super Fine Mode

Select to Save (Movie)

® Phone microSD
Storage Capacity (Movie)
Blue: 500 KB or more
Yellow: Less than 500 KB
Red: No memory space

Movie Type Set (Movie)
Normal

Video

[ Voice

@ | Shooting Status (Movie)

STEY Standby
@REC Shooting

AFchange (BI-DO-RI, Photo and
Serial)

ON

OFF

BI-DO-RI (BI-DO-RI)
£ BI-DO-RI Mode

Auto Timer
No indicator: OFF

Zoom Status

BT evel 110 Bl Level 16

* Fine Mode and Super Fine Mode are

available when VGA(Video L) or
QVGA(Video S) are selected for Select
Size.

eJawie) i
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Shoot like a digital camera with
handset closed, or like a conventional
cellular phone with handset open.

Tip

« Still images and videos you shoot are
automatically saved. When this
function is set off (see P. 14-33), select
whether to save or delete after
shooting.

« Still images and videos can be mirror
displayed or uploaded to a blog.

BI-DO-RI Mode

Shoot stunning portraits of people.

@ Still images are saved to Camera under
My Picture in Data Folder. See P. 14-33
for details on changing the save
destination to Memory Card.

@Auto-tracking face focus is on and
automatically focuses on faces.

@Set AFchange to ON to automatically
focus on faces.

eiswe) !

Tip

» Time may be required for shot images
to appear.

» Depending on shooting conditions,
faces may not be effectively detected.

« For best results when shooting
portraits, observe the following.

- Remove glasses/sunglasses, masks,
hats, and other items that partially
block face.

- Subject’s hair should not cover the
face.

- Subject should look straight into
Camera and should not tilt head.

* In the following cases, BI-DO-RI effect
may not be apparent or images may
appear unnatural.

- Subject has a beard

- Poor shooting conditions, such as
camera shake, out of focus,
inadequate exposure or shadowed
face

Using Camera Style

) with Handset closed, press
and hold [l

BI-DO-RI Viewfinder

Display person to shoot » (J

Shoot and save still image.

@ Available Functions

Zoom (Telescopic) | (Top)
Zoom (Wide angle) |[J (Bottom)
Camera menu
display/confirm

Camera menu O (Top) or
selection [ (Bottom)
Light' Press and hold
AF LOCK? Half-press ()
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Function menu B Using Cellular Style @ Available Functions
Toggle BI-DO-RI Press and hold [ nWith handset open, press Zoom (Telescopic) | (4
and Photo and hold [ Zoom (Wide angle) | O]
Previous window HTo Activate From Main Menu CAEE FEny
_ (w] »» Camera »» (w) M) BI-DO-RI
End Camera Press and hold » (w) Light
1 Pressing and holding will cycle through AFchange [a]
Auto, ON, and OFF. )
2 AF locks when (D) pressed halfway. bl (2 or Half-press ()
Discontinue pressing to cancel. Function menu
Toggle BI-DO-RI Press and hold [?]
and Photo Q
Toggle Camera (] 2
, mode =
5 e o
BI-DO-RI Viewfinder Adjust Brightness |(5]
) Display person to shoot » Help o)
or(] Previous window
Shoot and save still image. End Camera =

1 Pressing will cycle through Auto, ON,
and OFF.

2 Applies AF Lock when (D lightly pressed
half-way. Discontinue pressing to
cancel.
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Using Camera Style

Tip
+ Access BI-DO-RI from a Shortcut nWith Handset closed, press
(P. 2-5). B

MTo Activate From Quick Launcher
O (Top), [ (Bottom) or to
activate Quick Launcher P» Select

8 » &

Photo Mode

Optimal setting for subjects other than

people, such as scenery.
@ The still images shot are saved to
Camera under My Picture in Data
Folder. See P. 14-33 for details on
changing the save destination to
Memory Card.
@ Make the following settings to x dj mrmmor |
automatically detect and focus on faces. Photo Viewfinder
- Select Size: WVGA(Wallpaper) or
higher

- Best Shot: Any of Auto Mode Select,
Person, Person & Night and Best
Shot OFF

- AFchange: ON

Display subject to shoot »»

Shoot and save still image.

@ Available Functions

Zoom (Telescopic) | (Top)
Zoom (Wide angle) | (Bottom)
Camera menu i
display/confirm

Camera menu O (Top) or
selection D) (Bottom)
Light' Press and hold
AF LOCK2 Half-press ()
Function menu [

Toggle BI-DO-RI
and Photo

Press and hold [2]

Previous window

S
2
2

End Camera

Press and hold

1 Pressing and holding will cycle through
Auto, ON, and OFF.

2 Applies AF Lock when () lightly pressed
halfway. Discontinue pressing to

cancel.
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©OQuick and Normal Shooting

@ Quick Shooting
When using Photo Mode in Camera

style, press shutter all the way (not half-
way) to shoot. Image Stabilizer and Best
Shot are set off, enabling you to shift to

your next shot more quickly.
+ Available when Auto Save Set is set
to ON.
@ Normal Shooting
Press the shutter halfway to lock Auto

Focus, then all the way to shoot. Shoot

more pleasing shots together with

Image Stabilizer and Best Shot.

+ Sound is emitted during Auto Focus
Lock.

* Set Auto Focus Lock off by setting

AFchange to OFF or setting Best Shot

to Night View. There is no sound

made for locking, so slowly press the

shutter all the way to shoot.

Using Cellular Style

nWith Handset open, press
and hold [

HTo Activate From Main Menu
(m] »» Camera »» (8] ») Photo M

Display subject to shoot »
or(]
Shoot and save still image.

@ Available Functions

Zoom (Telescopic) |[O
Zoom (Wide angle) o
Camera menu
Light'
AFchange ()
AF LOCK? (2 or Half-press (0
Function menu

Toggle BI-DO-RI and
Photo

Press and hold E|

Toggle Camera mode

Select Size

Quality Setting

Best Shot

Adjust Brightness

White Balance?

Help

Previous window

<

End Camera

DB B B| & ] )| k| B
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Pressing will cycle through Auto, ON
and OFF.

Applies AF Lock when (D lightly pressed
halfway. Discontinue pressing to
cancel.

Available when Best Shot OFF is set
for Best Shot.

Movie Mode

Shoot videos with or without audio, or

even audio-only videos.

@ Videos are saved to Camera under
Videos in Data Folder. See P. 14-33 for
details on changing the save location to
Memory Card.

Using Camera Style

) with Handset closed, press
(] (Top), [ (Bottom) or
to activate Quick
Launcher » Select @ »

Feereees)
S
[Eesasess]

Movie Viewfinder

Display subject to shoot »»
0

Shooting begins.

B0

Shooting ends and video is saved.

@ Available Functions

Zoom (Telescopic) |[J (Top)
Zoom (Wide angle) | (Bottom)
Camera menu
display/confirm

Camera menu D (Top) or
selection [ (Bottom)
Light” Press and hold

Function menu

Previous window

wol| (=] ﬁ

End Camera Press and hold

* Pressing and holding will cycle through
Auto, ON and OFF.
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Using Cellular Style @ Available Functions
@g )I’E] © More Features
»» Camera » » Zoom (Telescopic)
a

Movie » (m] Zoom (Wide angle) . .
During Shooting

% Shoot Up Closer

« Turn Auto Focus On/Off
«% Switch Image Color Tone
% Check Memory Space

< Change Video Types

< Set Image Stabilizer

Camera menu

Light”

Function menu

Toggle Camera mode

Select Size (® Pp.7-24)

After Shooting

+» Upload Still Image/Video to Blog
“ Open an Image as Mirror Image
< Save an Image as Mirror Image
+ Edit Video Title

File Size Setting

Select Scene

Display subject to shoot »» Adjust Brightness

or (] White Balance
Shooting begins.

(@ P.7-25)

IR EEEEEE

@ or (D Help Customize
or Previous window 707 - .
. . . Video Settings
Shooting ends and video is saved. N .
End Camera =) +» Reduce Flicker

. - + Set Shutter Sound
* Pressing will cycle through Auto, ON “ Set View When Shooting With Handset
and OFF. Closed

(® P. 14-31)

7-11
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File Storage
% Toggle Whether to Automatically Save
Still Image/Video
«» Set Still Image/Video Save Destination
(* P.14-33)



@ Various Camera Features

. Using Camera Style E)Display subject to shoot »
Continuous Mode Use [CJ) (Top) or [J] (Bottom) for menu D

Shoot a sequence of up to 10 still and setting selections. Shoot and save all still images.
images in a single shutter release. . . .
@ See P. 14-32 for setting the interval and n[BI-DO-RI Viewfinder], Using Cellular Style
number of still images. [PhOt_O Vl_ve|INder] or _ n@ » Camera » (8] »
Tip [Movie Viewfinder] » Serial » (m]
« VGA(Wallpaper) and » Select &, ) or & M
QVGA(Wallpaper) are available for
Select Size.

Display subject to shoot »»
@ or(D

Shoot and save all still images.

kbl

Continuous iwinder

713



@ Various Camera Features

esowe) [

»JDisplay subject to shoot »
Add Frames to .@
Images Shoot and save still image.
Shoot with an overlay. Using Cellular Style
@ Add a frame with the following
) [Photo Viewfinder] » (@) »

settings.
Select Frame » (8] »

Camera mode: Photo
Select Size: WVGA(Wallpaper), Select folder » (®] ) Select
frame » (u]

VGA(Wallpaper), QVGA(Wallpaper)

Using Camera Style

Use [CJ) (Top) or [l (Bottom) for menu
and setting selections.

[Photo Viewfinder] » [l »
Select Frame » »
Select folder » »
Select frame »

Frame Viewfinder

Display subject to shoot »
or (]
Shoot and save still image.

7-14

Tip

« Press (8] to confirm frame selection.
Press |8) again to rotate the frame
180°.

@ Shoot during Auto Timer countdown by
pressing (@) or (0.

@ Auto Timer goes off when shooting
ends.

Using Camera Style

Use [C] (Top) or [ (Bottom) for menu
and item selections.

§D(B1-DO-RI Viewfinder],
[Photo Viewfinder],
[Continuous Viewfinder] or
[Movie Viewfinder] » [l »
Auto Timer »

#)on » » Set time with
(O] (Top) or ] (Bottom) »

fFeereees)
fecsiees)
SEE



@ Various Camera Features

Display subject to shoot » Display subject to shoot »
play subJ P [3],] ! © More Features

D (] or
Auto Timer starts and Camera Auto Timer starts and Camera @ Advanced
Indicator ﬂashes. Five second:s Indicator flashes. Five second§ During Shooting
before shooting, handset emits a before shooting, handset emits a .
% Shoot Up Closer
tone and flashes faster. tone and flashes faster. .
Shoot and il r Shoot and Gl r « Turn Auto Focus On/Off
hoot and save still image. For hoot and save still image. For 2 Switch Image Color Tone
videos, shooting starts. videos, shooting starts. (* p.7-24)
EWhen shooting Video HTo Cancel Auto Timer Shooting After Shooti
»0 W& or Tter Shooting .
Video shooting ends and video is EWhen shooting Vid “ Open an Image as Mirror Image
saved en shooting Video % Save One Continuous Still Image
' »@ or0 . . . % Save Several Continuous Still Images
Using Cellular Style Video shooting ends and video is « Save All Continuous Still Images 0
saved. ) ) - o
. . % Save Continuous Still Images as Original 3
D (B1-DO-RI Viewfinder], Animation ]
[Photo Viewfinder], (*p.7-25) @
[Continuous Viewfinder] or After Shooting Framed Images
[Movie Viewfinder] » » < Change Frame Before Saving
. - R
Auto Timer » (u] (¢ P.7-26)
|
#)on » (8] » Enter time ) (1) @

Camera Settings
< Set Shooting Interval/Number of Still
Images for Continuous Mode
(* P. 14-31)

715
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Change settings from Cameramenu. [ Select menu » @®Indicators and Settings
Settings differ with each Camera
mode.

Tip

* In Photo Mode or Continuous Mode,
White Balance is available when Best
Shot OFF is selected for Best Shot.

- - Menu Selection Window + e o .
Changing Settings BI-DO-RI, Photo and Continuous

. Press [ to cancel menu selection. Viewfinder
Using Camera Style . ___
Use [ (Top) or [ (Bottom) for menu seIeCt setting »»
and setting selections. Press B to cancel the setting.
§D(B1-DO-RI Viewfinder],

[Photo Viewfinder],

[Continuous Viewfinder] or

[Movie Viewfinder] »

Mvie Viewfinder

Indicators

@ |CHG Camera-mode

& BI-DO-RI & Photo
Serial & Movie
J i T Bar Code Reader
Menu Selection Window




®

Select Size (Photo/Serial)' 2
8M(A3 Size)

@z 6M Wide(A3 Size)

BM 5M(A3 Size)

M 3M(A4 Size)

2M 2M(2L Size)

1M 1M(L Size)

WA WVGA(Wallpaper)
YeA VGA(Wallpaper)
QVGA(Wallpaper)

®

Brightness
HE-2-2 to @e2+2

®

White Balance (Photo, Serial and
Movie)®

AWB(Auto)

%% Fine & Cloudy

Light Bulb

Fluorescent Lamp

Select Size (Movie)
YeA VGA(Video L)
QVGA(Video S)
QCIF(Mail L)
SubQCIF(Mail S)

Quality Setting (Photo/Serial)?
Fine Normal

File Size (Movie)
& Mail Attachment 2s 2MB
Long Time

Best Shot (Photo/Serial)* >

Auto Mode Select

& Person 7\ Scenery

) Night View %3 Person & Night
R Sports Best Shot OFF

Select Scene (Movie)
& Person 7\ Scenery

w

Select Size is fixed at 2M in BI-DO-RI
Mode.

VGA(Wallpaper) and
QVGA(Wallpaper) are available in
Continuous Mode.

Fixed at Fine in BI-DO-RI Mode.

Fixed at Auto Mode Selectin BI-DO-RI
Mode.

Night View and Person & Night are
not available in Continuous Mode.

In Photo Mode or Continuous Mode,
settable when Best Shot OFF is
selected for Best Shot.

Using Cellular Style

§)(B1-DO-RI Viewfinder],
[Photo Viewfinder],

[Continuous Viewfinder] or

[Movie Viewfinder] »

Menu Selection Window

) Press (33 to select Menu
Indicator

Press (& to select setting »

(w)

Press to cancel the setting.

eJawie) i
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@Indicators and Settings
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BI-DO-RI, Photo and Continuous
Viewfinder

Movie Viewfinder

Indicators

@

CHG Camera-mode
&5 BI-DO-RI (8] Photo
Serial 5 Movie
Bar Code Reader

Select Size (Photo/Serial)? 2
0 ew 8M(A3 Size)

O s 6M Wide(A3 Size)

O sw 5M(A3 Size)

0 em 3M (A4 Size)

O 2zm 2M (2L Size)

O iM 1M (L Size)

Owes WVGA (Wallpaper)
Ovea VGA (Wallpaper)
Oever, QVGA (Wallpaper)

®

Best Shot (Photo/Serial)*®

Auto Mode Select

Person Y Scenery

Night View Person & Night
Sports Best Shot OFF

Select Scene (Movie)

Person Scenery

®

Brightness
-2 to Ba+2

®

White Balance (Photo, Serial and
Movie)®

AWB(Auto)

£% Fine & Cloudy

Light Bulb

&% Fluorescent Lamp

Select Size (Movie)
Ove: VGA (Video L)
QVGA (Video S)
mecE QCIF (Mail L)
ol SubQCIF (Mail S)

Quality Setting (Photo/Serial)?

Fine Normal

File Size (Movie)
Mail Attachment
Long Time

2w 2MB

Select Size is fixed at 2M in BI-DO-RI
Mode.

VGA(Wallpaper) and
QVGA(Wallpaper) are available in
Continuous Mode.

Fixed at Fine in BI-DO-RI Mode.

Fixed at Auto Mode Selectin BI-DO-RI
Mode.

Night View and Person & Night are
not available in Continuous Mode.

In Photo Mode or Continuous Mode,
settable when Best Shot OFF is
selected for Best Shot.



@ Snap Viewer/Movie Viewer

View still images and videos. Access
them even when handset is closed.
@ This function browses the folder set

with Camera’s save settings (P. 14-33).

See P. 7-27 for how to switch folders.

Tip

« Pressing (¥ activates the viewer
window suited to the current Camera
mode.

* Images read in to handset may not
display properly.

Checking Still

Images
Using Camera Style

D Press [ with handset closed

HTo Activate From Quick Launcher
D (Top), LI (Bottom) or to

activate Quick Launcher P Select

a» @

Snap Viewer (3D)

Still images appear together.

HTo Toggle Snap Viewer
» @ M Layout Change »
Thumbnail, 1 Picture or 3D M
@ Default Setting: Thumbnail

il

2009,
S

[E32009/04/16 10:10 EI®E

Snap Viewer (1 Picture)

) select still image with [
(Top) or LI (Bottom)

The selected still image appears.
HReturning to Snap Viewer

» B

7-19



@ Snap Viewer/Movie Viewer

@ Available Keys in Snap Viewer

Select still image | (Top) or

I (Bottom)
Display still image
Function menu B

End Snap Viewer

R
2

@ Available Keys When a Still
Image Is Displayed

Toggle zoom/full
view

eiswe) !

Toggle still image

In full view
O (Top) or
I (Bottom)

Zoom in/out

In zoom view
1) (Top) or
[CJ (Bottom)

Function menu

End Snap Viewer

Press and hold

7-20

Using Cellular Style
D Press [ with handset open

HlTo Activate From Main Menu
(@] »» Camera »» (8] ) Snap
Viewer ) (u]

o

EZBD?/%?/% 10:10

Snap Viewer (3D)

Still images are displayed together.

HlTo Toggle Snap Viewer
»
Toggle through Thumbnail, 1
Picture and 3D with each press.
@ Set to Thumbnail by default.

52009/3%416 10:10

Snap Viewer (Thumbnail)

BTl 10:10

[%2009/@4/16 10:10
HL%

Snap Viewer (1 Picture)



@ Snap Viewer/Movie Viewer

Press KX to select still image

HTo Delete Still Images

* To select Delete This
» »» Delete This ) (u) ))
YES ) (u]

* To select Delete All
» » Delete All )) (1) ))
Enter Security Code P> (8] D) YES
» (m]

E)=
Display selected still image

HReturning to Snap Viewer
M (zv7)

@ Available Keys in Snap Viewer

@ Available Keys When a Still
Image Is Displayed

Toggle zoom/full (m]

view

Rotate still image |In full view

Toggle still image |In full view IO}

Scroll In zoom view K4

Zoom in/out In zoom view
or

Function menu

End Snap Viewer |(—]

Select still image!  |K3

Display still image | (m]

Toggle display?
Function menu

End Snap Viewer or (=)

1 Available when display is 7 Picture or
3D.
2 Toggles each time pressed.

Playing Videos

@ See P. 9-3 for the playback window for
videos.

Using Camera Style

n@ (Top), LI (Bottom) or
to activate Quick
Launcher » Select £ »

EN=12009/ 4/16 10:10
=0 2 4IRS

13112009/ 4/14 8:30

Movie Viewer

Videos are displayed as a list.

) select video with [ (Top)
or [J] (Bottom) »

The selected video plays.

eJawie) i
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@ Snap Viewer/Movie Viewer

eiswe) !

@ Available Keys in Movie Viewer

Select video O (Top) or
I (Bottom)

Play video

Function menu

End Movie R

Viewer

Playing

@ Available Keys When Video Is

Play/pause

Adjust volume

O (Top) or
I (Bottom)

Play next video

Press and hold
I (Bottom)

Play from start or
play previous
video

Press and hold
1 (Top)

End play

S
2
2

End Movie Viewer

Press and hold

7-22

Using Cellular Style

@ See P. 9-3 for playback window in
cellular style.

)= » camera » (8] »

Movie Viewer ) (u)

Camera

&NE2009/ 4/16 10:10
=B 8 I

2112009/ 4/15 15:30

3/1=12009/ 4/14 8:30

Movie Viewer

Videos are displayed as a list.

) Press [T to select video

HlTo Delete Videos

¢ To select Delete This
» ) Delete This ) (1] )
YES ) (m]

¢ To select Delete Selected
» ) Delete Selected )) (m)
» Select video »» (8] M) »
YES ) (m]

* To select Delete All

» » Delete All »» (m) ))
Enter Security Code ) (] )
YES ) (u]

(3]0

The selected video plays.

@Available Keys in Movie Viewer

Select video @

Play video (w)

Toggle
thumbnail*

Function menu

End Movie or (=)
Viewer

* Showr/hide toggle each time pressed.




@ Snap Viewer/Movie Viewer

@ Available Keys When Video Is
Playing

Play/pause (w)

Adjust volume

[=]
Play next video =]
=]

Play from start or
play previous

video
Function menu
End play 7u7

End Movie Viewer |(—]

Uploading Still Images

& Videos to Blog

Upload to a blog from Snap Viewer or

Movie Viewer.

@ You must add an upload e-mail address
beforehand to Blog/Mail Member
(P. 5-4).

@ You may not be able to upload
depending on video image size.

From Snap Viewer

n From [Snap Viewer], select
still image »

) Attach Mail, QVGA Scale
Down or VGA Scale Down
» (®] (» Check image » (m])

[E) select Blog/Mail Member »
(@] » Create and send S!
Mail

From Movie Viewer

nFrom [Movie Viewer], select
video »

%) select Blog/Mail Member »
(®] » Create and send S!
Mail

© More Features

Snap Viewer/Movie Viewer

< Toggle Snap Viewer/Movie Viewer

+» Toggle Browsed Folder in Snap Viewer
or Movie Viewer

< Attach/Insert Still Image/Video in S! Mail

eJawie) i

(® P.7-27)
Customize
Snap Viewer
++ Hide Guide at Top of Landscape View
(* P. 14-34)
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@ Advanced Features

During Shooting Turn Auto Focus On/Off Check Memory Space
Start Here ® Camera Style @ Cellular Style
[BI-DO-RI Viewfinder].......P. 7-6, P. 7-7 [BI-DO-RI Viewfinder], [Photo [BI-DO-RI Viewfinder], [Photo
[Photo Viewfinder]........... P.7-8,P.7-9 ViEWﬁ“def; f:; écf:‘ﬁ“uous N VieWﬁnder; 0:’ Oxie
[Movie Viewfinder] ......P. 7-10, P. 7-11 | Viewfinder AFchange Viewfinder ® Memory
[Continuous Viewfinder] ........... P.7-13 » ON or OFF W Info ) (u]
o Cellular Style -
Shoot Up Closer [BI-DO-RI Viewfinder], [Photo e i
® Camera Style Viewfinder] or [Continuous ® Camera Style
[BI-DO-RI Viewfinder], [Photo Viewfinder] » (& [Movie Viewfinder] » Fl »» Movie
Viewfinder], [Movie Viewfinder] Switch Image Color Tone Type .‘.Set » » Normal, Video
A |or [Continuous Viewfinder] » [ 9 or Voice ) EE
g » Macro ON » e Camera Style @ Cellular Style
o e Cellular Style [Photo Viewfinder], [Movie [Movie Viewfinder] » »
o [BI-DO-RI Viewfinder], [Photo Viewfinder] or [Continuous Movie Type Set »» (8] > Normal,
Viewfinder], [Movie Viewfinder] Viewfinder] M E > Camera Video or Voice ) (u)
or [Continuous Viewfinder] » Settings »» »» Color Mode Set
»» Macro ON )) (u] » ) Select tone P»
£33 Select Macro OFF to cancel Macro o Cellular Style
ON. [Photo Viewfinder], [Movie

Viewfinder] or [Continuous
Viewfinder] » (@) »» Camera
Settings » (8] » Color Mode Set
»» (@] »» Select tone » (=)
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@ Advanced Features

Set Image Stabilizer

o Camera Style

[BI-DO-RI Viewfinder], [Photo
Viewfinder] or [Movie
Viewfinder] M B »» Image
Stabilizer M » Auto or OFF
»

o Cellular Style

[BI-DO-RI Viewfinder], [Photo
Viewfinder] or [Movie
Viewfinder] » (@) M Image
Stabilizer »» (8] »» Auto or OFF )

(w)

After Shooting

If Auto Save Set is set off, a preview
appears after shooting in BI-DO-RI,
Photo, Movie or Continuous mode

(P. 14-33). The following functions are
available.

Upload Still Image/Video to Blog

o Cellular Style

[BI-DO-RI Preview], [Photo

Preview] or [Movie Preview]

window » (@) » Blog Upload »

(] (M Attach Mail, QVGA Scale

Down or VGA Scale Down )»» (=)

P Select Blog/Mail Member ) (m]

» Create and send S! Mail

€2 You must add an upload e-mail
address beforehand to Blog/Mail
Member (P. 5-4).

€3 You may not be able to upload
depending on video image size.

Save an Image as Mirror Image

o Camera Style

[BI-DO-RI Preview] or [Photo
Preview] window M B » Mirror
Save »

o Cellular Style

[BI-DO-RI Preview] or [Photo
Preview] window » »» Mirror
Save ) (u]

Edit Video Title

o Cellular Style

[Movie Preview] window »» (@] »»
Edit Title »» (®) »» Edit title ) ()

Open an Image as Mirror Image

® Camera Style

[BI-DO-RI Preview] or [Photo
Preview] window » [l »» Mirror
Display or Normal Display »
o Cellular Style

[BI-DO-RI Preview], [Photo
Preview] or [Continuous Preview]
window ) (@] P> Mirror Display or
Normal Display »» (&)

Save One Continuous Still Image

® Camera Style

[Continuous Preview] window »
[ (Top) or [ (Bottom) to select
still image » » B » Save or
Mirror Save ) EE)

o Cellular Style

[Continuous Preview] window »»
Select still image »» (8] » [ »
Save or Mirror Save )) (u)

eJawie) i
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@ Advanced Features

eiswe) !

7-26

Save Several Continuous Still
Images

® Camera Style

[Continuous Preview] window M

O (Top) or O (Bottom) to select

still image » »» Repeat step

» [l »» Save or Mirror Save M

€370 deselect a still image, reselect and
press [EE.

o Cellular Style

[Continuous Preview] window M

Select still image »» () »» Repeat

step M »» Save or Mirror Save

» (m)

€3 To deselect a still image, reselect and

press (m).

Save All Continuous Still Images

® Camera Style
[Continuous Preview] window »
Press and hold [ »» Save or Mirror
Save M
o Cellular Style

[Continuous Preview] window »
Press and hold () ) Save or
Mirror Save ) (m]

After Shooting Framed Images

If Auto Save Set is set off, a preview
appears after shooting (P. 14-33). The
following functions are available.

Save Continuous Still Images as
Original Animation

o Cellular Style

[Continuous Preview] window »»
) Store All&Anime » (8] )
Save or Mirror Save »» (8] )
Select save destination ) (m]

Change Frame Before Saving

® Camera Style

[Frame Preview] window » [ )
Change Frame » P Select
folder » ) Select frame »»
(twice)

@ Cellular Style

[Frame Preview] window M) »
Change Frame »» (8] )) Select
folder » (] M) Select frame M) ()
(twice)




Snap Viewer/Movie Viewer

Start Here
[Snap Viewer] ................ P.7-19, P. 7-20
[Movie Viewer] ............... P. 7-21, P. 7-22

Toggle Snap Viewer/Movie Viewer

o Camera Style

[Snap Viewer] or [Movie Viewer]
» [ » Photo/Movie SW M

o Cellular Style

[Snap Viewer] or [Movie Viewer]
» (@) " Photo/Movie SW ) (u]

Toggle Browsed Folder in Snap
Viewer or Movie Viewer

@ Camera Style

[Snap Viewer] or [Movie Viewer]
» & »» Memory SW » »
Phone or microSD » » Select
folder »

o Cellular Style

[Snap Viewer] or [Movie Viewer]
» (@) »» Memory SW »» (1] »»
Phone or microSD »» (8] ) Select

Attach/Insert Still Image/Video in
S! Mail

@ Cellular Style (Attach still image)
[Snap Viewer] » »» Compose
Message »» (8] )b Attach Image »
(m] »» Attach Mail, QVGA Scale
Down or VGA Scale Down )» (®]
(M Check image »» (®)) ») Create
and send S! Mail
o Cellular Style (Insert still image)
[Snap Viewer] » (@) »» Compose
Message » (8] » Insert Image »
(@) »» Insert Mail or Add Art Scale
Down )»» (8] ()b Check image M
(m)) M Create and send S! Mail
o Cellular Style (Attach Video)
[Movie Viewer] M »» Compose
Message » (8] ()» YES )) (=) »»
Create and send S! Mail
&3 You may not be able to attach
depending on video image size.

folder » (=)

@ Advanced Features
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Handset supports One Seg Digital TV for cellular phones and other information

terminals.

@ One Seg is available only in Japan. Because other countries use different broadcast
systems and frequencies, watching One Seg Digital TV is not possible outside of Japan.

One Seg is a digital TV broadcasting
service for mobile devices. It uses
one segment of the terrestrial digital
band for TV and data broadcasts
that you enjoy at home, on your

handset.

Watch TV in
Widescreen

7

Data Broadcasts

Enjoy data broadcasts while
watching TV. Access
program-related information and
even participate in the program
(P. 8-8).

Record Programs

Record a program on memory
card while viewing it and enjoy it
again at a later time (P. 8-10).

View and Record Timer
Book programs you want to
view/record. Program Guide can be

used for booking programs (P. 8-13).

New Message Notification
Sender and subject information
appears for new message while TV
is active (P. 14-6).

\

Precautions

@ Never watch TV while riding a bicycle,
motorcycle, or driving a car. You may
not hear the sounds around you clearly,
or TV image/sound may distract you
creating the risk of accident. Even while
walking, pay attention to the traffic
around you. Be especially careful at
railway crossings and pedestrian
crosswalks.

@ TV image/sound may be affected if a call
or message is received while watching TV.

@ TV information (TV links or data you
entered in Data Broadcast Mode) saved
on handset cannot be transferred to
another handset when you change your
handset to another model or when it is
repaired. Keep a memo of necessary
information.

@ TV is available when USIM Card is
inserted and with a valid SoftBank
contract.

@ If TV is activated over a set number of
times while out-of-range, TV becomes
unavailable. Activate TV again after
moving to a location with signal
reception.



_ @

@ Sufficiently extend TV Antenna to
improve signal reception. An
inadequate picture may be improved by
changing antenna direction, moving
handset away from/closer to you, or
changing locations.

@ TV image/sound may deteriorate or
signal reception may become
impossible in the following areas:

- Areas far from signal towers

- Mountain areas or places beside tall
buildings

+ In tunnels, underground malls or buildings
with a lot of signal obstructions

@ For more information on One Seg
services, visit the following website:
The Association for Promotion of Digital
Broadcasting
From PC: http://www.dpa.or.jp/

From handset: http://www.dpa.or.jp/
1seg/k/ (Japanese)

When You First Activate TV

The first time you activate TV,

following information appears.

- How to switch between Portrait and
Landscape view

- Functions unavailable in Landscape view

Read information then press (8], select

YES, and press (8. If NO is selected,

information no longer appears when

activating TV.

When a Call Arrives While
Using TV

When a call arrives or when Alarm or
Schedule Alarm is activated while
using TV, TV is interrupted to receive
the call, etc. TV resumes after the
interrupting function ends.

TV Antenna

@ Do not use force when changing
antenna direction.

Extend
nExtend until Antenna stops

Retract

) change direction of
Antenna

§DHold lower part of Antenna
and push in all the way
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TV Windows

Portrait View

@ |Incoming Message Info @ |Recording Status
Information about messages received @MEEC Recording
while watching TV appears in tickers @EEC Timer Recording Activated
(P. 14-6). IFEISE (Red) Recording Paused
Time Shift Status
® |Channel (Remote Control No.) WFENEE (Green) Paused
@ Program Title @AY Normal Speed or Time Shift
Playback
@ | Subtitles @@ 1.3 1.3x Speed (With Sound)
- - @WFP 2x Speed (Without Sound)
® | Appears while Sound Effect is ON
(no setting required) @|Image
® |Signal Strength @®|ECO Mode
Strong & ECO Mode Active
Q \l\//lvgggrate @ |Data Broadcast
4 Out of Broadcasting Area @| TV View Mode
@|TV Effect mage Mode
Sound Effects OFF sl Data Broadcast Mode
CS5.1ch
ICMEE Auto
| Live [Concert | Drama [ Sports |
| News |Variety| Movie EViElJER{)s
Each Genre
[EIT Manner Mode
Receiving Subtitle Information
Subtitles Available
@®|Volume




El Initial Setup

Configure channel settings for your

area and save stations to a channel list.

E3 (=] » 7v » (8) » Channel
Settings » (]

) select Area » (8] » Select
area ) (8] » Select
prefecture/city » (®) »» YES

) (m]

Stations for the area are saved to a
channel list.

Tip

« If signals from stations of the selected
area are difficult to receive, search for
stations using the Automatic option.

More Features
Advanced

Channel Settings

< Save Stations to a Channel List
Automatically

«“ Save Stations of a Different Area to a
Channel List

< Switch Channel Lists

Customize

Channel List

< Change Title of Channel List

< Delete a Channel List

+ Assign Channels to Remote Control
Numbers

< Delete a Channel

(< P. 8-15)

(< P. 14-28)
Other Settings

<+ Reset Channel Settings
(* P. 14-30)
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= » v » (8] » Watch TV .E] toendTV » YES » (8] Available Functions

» (m) * When you select YES, use @ for  (Handset Open)
‘ Landscape view, and (@) for
Portrait view. Pause or (w]
- Alternatively, press and hold Play
(97))» YES P> (). Follow the Save Still
same steps to end TV in Portrait Image
view.
4 Adjust [s]]
TV Window - Volume
(Landscape View) Tip
. . » TV volume is “0” when Manner Mode Mute
Alterr\atlvely, activate TV by is active and no earphone is connected.
pressing (0. Adjust with (3. Toggle Press and hold (9
Portrait
m Use Keypad to select a and
channel Landscape
< Press for channel 10, (0 for Toggle Press and hold
channel 11, and for channel Windows? |Windows toggle as
12. follows: Data Broadcast —
HTo Change Next/Previous Channel Image & Data Broadcast —
» o Image & Subtitles & Data
. Broadcast
HlTo Automatically Search for
Receivable Stations 1 TV viewing will resume in Time Shift
» Press and hold 3§ playback.
Press (2] or to stop station 2 Available in Portrait view.

search.



Time Shift Playback e

While Watchlng * Up to two minutes of playback datacan @ yse Quick Launcher to activate TV from
. be stored. Data is overwritten starting closed position
Resume watching TV even after from the oldest data. If you resume :
pausing with playback. viewing after pausing for more than npress Front Button (IJ (Top)
@ Time Shift playback is available when two minutes, viewing starts from the @ y
you have stopped watching One Seg or beginning of stored data (not from (Bottom) or ()
you receive a call. where you paused). HReturning to Standby
@ Time Shift playback is unavailable when » B or Press and hold
Time Shift Setup is set to Auto OFF. Tip @ (Top) or @ (Bottom) to
[TV] window » (u] + Other channels are unavailable while select B »

TV viewing is paused or during Time

TVi d.
is pause Shift playback.

) wWhen it is possible to
resume watching TV » (s

OHandset Closed

Time Shift playback starts. n[TV] window »

HTo Toggle Playback Speed TV is paused. AU\
P’:es?to cycle through Normal When it is possible to TV Window (Landscape View)
Speed, 1.3x Speed (With Sound), resume watching TV » BReturning to Standby
and 2x Speed (Without Sound). or » Press and hold B ) YES M

HTo End Playback Time Shift playback starts.

» (=) HTo Toggle Playback Speed

» Press and hold [ (Top)

HTo End Playback
»
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Keys in TV Window
(Handset Closed)

Still image ]

recording

Starts/Ends Press and hold
Video

recording

Adjust Volume

D) (Bottom) or

(Volume <low> | [ (Top)

or <high>)

Forward Press and hold
channel O (Top) or
selection Press and hold
(Station <+>up |[J (Bottom)

or <->down)

Returning to

Standby

Press and hold B P>
YES "

Data Broadcasts

(Japanese)

Data broadcasts are available while
watching TV in Portrait view. Access
various kinds of program-related and
other information in Data Broadcast
Mode.

ATVl window »

Data Broadcast Mode is activated.

Access the Internet from a link to

view pages relating to the current

program.

HReturning to Image Mode
»

Available Functions

Select a Link [(f)

Confirm

Selection of a |(m)

Link

Switch Pages |{Of

Previous Page

Toggle Press and hold

Windows Windows toggle as follows:
Data Broadcast — Image &
Data Broadcast — Image &
Subtitles & Data Broadcast

Note

+ Viewing data broadcasts requires no
fees. However, accessing the Internet
incurs transmission fees.

» Data broadcasts are unavailable in
Landscape view.
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Program Guide

@ Use Program Guide to set timer to
record/activate programs.
@ Activate TV from Program Guide.

§A= » 1v » (8] » Program
Guide » (m]
See Program Guide help for
further operations.
Before first using Program Guide,
configure initial settings and agree
to the terms of use. Follow the
onscreen instructions.

© More Features

Watching TV
% Show Program Information
< Adjust Brightness
< Switch Main & Sub Audio
< Switch Audio Channels
<+ Show Current Channel List Information
< Add Current Station to Channel List
«“ Select a Program
(® P. 8-15)

Data Broadcasts
% Reload Page Accessed from Data
Broadcast

< Check Certificate for SSL Page

+ Exit Page and Return to Data Broadcast
(* P. 8-16)

TV Link

< Save TV Links

< Access Pages/Information from TV Links

<+ Show Details of a TV Link

< Show Number of Saved TV Links

«“ Delete TV Links

Customize

Image & Sound

« Set Subtitle Display

+ Set Sound Effect

«» Set Visual Image Effect

«% Save Battery by Dimming Backlight

< Keep Backlight Lighted While Watching
v

< Set Time Backlight Stays Lit While
Watching TV

«+ Show/Hide Icons in Landscape View

+“ Set TV to Pause or Continue for Incoming
Calls (Time Shift Playback)

(® P. 14-28)

(< P. 8-16)

Data Broadcasts

< Set Whether to Show Images in Pages
Accessed from Data Broadcasts

<+ Enable/Disable Sound Effects of Data
Broadcasts

< Set Whether or Not to Show
Confirmation Window Again

(* P. 14-29)

Other Settings
< Check TV Settings
+» Reset Channel Settings
++ Clear Data Broadcast Memory
< Reset TV Settings
(* P. 14-30)

as
2



El Recording/Playing Programs

-

Recording Programs

TV programs can be recorded on

memory card while you are watching

them.

@ Data broadcasts are not saved with
recording.

A1Vl window » Press and
hold
Recording starts.

HTo Capture a Still Image
»
Captured still images are saved to
TV folder in Data Folder.

Recording ends.

HEWhen Memory Becomes Full
Recording ends and the recorded
portion is saved.

8-10

Note

* The channel remains fixed during
recording.

* Recording certain programs is
restricted. If a restriction is activated
while recording a program, recording
automatically ends, and the part that
has been recorded so far is saved.

» When &g appears to indicate handset is
out of the broadcasting area, recording
is paused. When the signal strength
recovers to weak or better, recording
automatically resumes.

* Recordings that you make are for
personal use only. Other uses require
the permission of the copyright holder.

Tip
* Recordings and still images can also be
saved when handset is closed (P. 8-8).

Playing Programs

A (=) » Data Folder » (=] »
TV ) (8]

) video » (] »» microSb »

(w)

microSD
=1200904161030001
|2/2200904132000001
3/22200904121900001

Recorded Program List Window

HlTo View Captured Still Images
» Image »» (] ) Select a folder
20



ﬁl Recording/Playing Programs

E)select a file » ()

VDAL 2BVTHET,

Recorded Program Playback Window

HTo Stop Playback
»

Available Keys during
Program Playback
(Handset Open)

Available Keys during

Program Playback
(Handset Closed)

Tip

« If a program was stopped partway
through, resume playback from that
point. Select YES and press (m].

Pause/Play (w) Pause/Play FE
Adjust Volume |[@ Adjust Volume | (Top) or
Bottom
Mute D¢ :
- Skip Back 30 Press and hold
Toggle Portrait |Press and hold (9] Seconds & (top)
and Landscape
View Skip Ahead 30 |Press and hold
Seconds Bottom
Fast Play = O« )
Stop Pla
Frame Forward | (3 during pause Y

Skip Ahead 30

Press and hold (&

Seconds?

Skip Back 30 | Press and hold 5]
Seconds?

Toggle

SoundEffects

1 Press the key to toggle normal and fast
play.

2 Available when recorded program is 30

seconds or more.




Ifl Recording/Playing Programs

© More Features
C@ Advanced

Recording Programs

+ Edit Title of a Recorded Program

«“ Reset Title of a Recorded Program

< Switch Views of Recorded Program List
Window

% Check Information on a Recorded
Program

% Check Volume of Recorded Programs

++ Delete Recorded Programs

(* P.8-17)
m Playing Programs
-
<

+» Specify Point to Start Playback
(< P.8-17)

Customize

Recording Programs
< Continue/End Recording at Low Battery
(< P. 14-30)

8-12



El View/Record Timer

. . . » (m) »» Enter Date ) (m] . .
Setting View Timer NTET NN O Setting Record Timer

E3® » 7V » (8] » Booking  MTo Select a Date from Calendar  ([}(®) » TV »» (8] ) Timer

Program List » (&) " Choose Date ) (8] )} Select a Recording List » (u]
g date ) (W) ) Enter time ») (m] g
®=Booking Program List =Timer Recording List
2009/ 4/17(Fri) 19:00 02009/ 4/16(Thu) 20:00
IR » (@] » Select a channel 2””9{,@8%“3) 0
lieVariety sh ch L E
5/ 417Gr : » E] T--':gl—)orts news
A e 5
[EMovie H u) 21:5§
a2/ 4718t 00 B0 » (8] » ON, ONiset Time EBFLEXX
B o or OFF » (8] ( » Select a -
time » (m))
Booking Program List Window B Timer Recording List Window
» New ) [u] » New ) (u]
= Edit booked Program - Edit Program
02009/ 4/16 20:00 02009/ 4716 10:10
[Ed<Not Stored> 32009/ 4/16 10:18
[E3<Not Stored>
(EE<Not Stored>
&1 Time
(EJON
BiLevel 4
[&Recording
View Timer Setting Window Record Timer Setting Window

8-13



ﬁl View/Record Timer

D
-
<

8-14

» (m) »» Enter Date » (u]
» Enter recording start and
end time » (=]

HTo Select a Date from Calendar
»» Choose Date »» (] D) Select a
date »» (8] M) Enter time ) ()

» (m) »» Select a channel
0

» (8] » ON or OFF » (m]

(3= (» YES or YES (Confirm
Once) » (m))

When the Set Time Comes

View Timer:

Alarm sounds for five minutes, and
recording information and animation
appear. Press any key to stop alarm
tone.

Record Timer:

At one minute before recording start,
a short alarm sounds. Recording
information and animation appear,
and TV activates. Recording starts at
the start time.

Note

» Set a timer start date and time that is
more than one minute from the present
time.

© More Features
@ Advanced

View/Record Timer

< Select a Timer Alarm Tone

«+ Enter Title of Booked Program

< Set Regular Activation of View or
Record Timer

< Set Timer Alarm Volume

< Activate TV Directly from Timer Alarm
Notification Window

«+ Set Priority at Recording Start Time
When a TV & MUSIC Group Function is
Active

< Edit View/Record Timer Settings

< Change Order of Booked Programs

«“ Delete Booked Programs

< Check Volume of Recorded Programs

< Check Result of Timer Recording

(@ P. 8-18)



@ Advanced Features

Channel Settings

Watching TV

Save Stations to a Channel List
Automatically

(@) »» TV » (®) »» Channel
Settings »» (8) ) Automatic ) (u]
»» YES » (8] )b YES ) (m] )
Enter title ) (m])

Start Here
[TV] WIiNdOW ..coeeeeerceecreerreeraeenens P. 8-6

Show Program Information

[TV] window » (@) »» Program
Info »» (m]

Switch Audio Channels

[TV] window » (@] »» Sound »

(@) »» Sound Switch »» (] »

Select an audio channel » (=

€% Sound Switch is available when there
is more than one audio channel.

Save Stations of a Different Area
to a Channel List

(@] »» TV »» (®] M Channel List »»
(@) )» Not Stored »» (®) » Channel
Settings » (8] ) Select Area )
(@) »» Select area > (®] M Select
prefecture/city »» (8] )b YES )) (m]

Adjust Brightness

[TV] window » (®) »» Display
Setting »» (8] ) Brightness » (m]
P Select a level ) (m]

Switch Channel Lists

(®) »» TV » (8] M Channel List »
(@) »» Select a channel list »» (m]

Switch Main & Sub Audio

[TV] window » (@] »» Sound »
(@) »» Main/Sub Sound » (] »
Select an audio output option M

(w]

Show Current Channel List
Information

[TV] window » (@) »» Channel »
(@) »» Channel Info »» (m]

Add Current Station to Channel
List

[TV] window » (®] »» Channel »»

(@) »» Add Channel »» (8] )b YES

» (m)

3 Use Add Channel when you find a
new station by holding down i03.

8-15



@ Advanced Features

AL

Select a Program

[TV] window »» (®] »» Channel »
(@) »» Tune Service »» (®] M Select

a service (program) »» (m)

€2 Tune Service is available when more
than one service (program) is
broadcast from the same station.

Data Broadcasts

Start Here
[Data Broadcast Mode] window ......P. 8-8

Reload Page Accessed from Data
Broadcast

[Data Broadcast Mode] window
) (®) M Data Broadcast »» (&) )
Reload Contents » (u]

Check Certificate for SSL Page

[Data Broadcast Mode] window
»» (@] M Data Broadcast »» (&) )
Show Certificate »» (®]

8-16

Exit Page and Return to Data
Broadcast

[Data Broadcast Mode] window
»» (®] M Data Broadcast »» (&) )»
Back to Data BC )) (m]

TV Link

Start Here
[Data Broadcast Mode] window...P. 8-8

Access Pages/Information from TV
Links

(= TV = (8] = TV Link = (u)
€3 Types of TV links are indicated by the
following icons:
Memo information
Data broadcast site
Internet content

Save TV Links

[Data Broadcast Mode] window
) Select an item »» (8] () YES or
YES (By default) »» (m])

€3 Some TV links may have expiration dates.

Show Details of a TV Link

(=] » TV » (8] )b TV Link »» (m] »»
Select a TV link »» (@) »» Display
Detail »» (u]

Show Number of Saved TV Links

(=) » TV » (8] D> TV Link »» (&) )
»» No. of TV Link »» ()




Delete TV Links

(@] » TV ) () M TV Link »» (m] )
Selecta TV link M
® To select Delete This
M Delete This b (8) P> YES )b (m)
® To select Delete Selected
» Delete Selected »» () M) Select
a TV link »» (] M) Repeat step of
selecting TV link »» (@) ) (&) M) YES
» (u]
® To select Delete All
» Delete All P (] D) Enter Security
Code ) (@] M) YES )) (u]

Reset Title of a Recorded Program

[Recorded Program List] window
) Select a program M (@] M
Initialize Title »» (m) »» YES )) (m]

Switch Views of Recorded
Program List Window

[Recorded Program List] window
» > Switch List »» (8] V) Title
or Title + Image » (m]

Recording Programs
Start Here

[Recorded Program List] window
.................................................... P. 8-10

Check Information on a Recorded
Program

[Recorded Program List] window
P Select a program » (®) M
Show Info ) (m)

Edit Title of a Recorded Program

[Recorded Program List] window
» Select a program M » Edit
Title »» (m) »» Edit title ) (®]

Check Volume of Recorded
Programs

[Recorded Program List] window
» (@) M Check Memory » (m]

@ Advanced Features

Delete Recorded Programs

[Recorded Program List] window
» Select a program M
® To select Delete This
" Delete This b (w) b YES ») (m)
® To select Multiple-choice
»» Multiple-choice »» (8] M) Selecta
file »» (@] D) Repeat step of selecting
file P> (@) P» Delete Db (@) D) YES
» (u]
® To select Delete All
» Delete All Db 8] D) Enter Security
Code P> (] M YES ») (m]

Playing Programs

Start Here

[Recorded Program Playback]
window

P. 8-11

al
-
<

Specify Point to Start Playback

[Recorded Program Playback]
window »» (8] » (@) M) Location

»» (m) M IO to specify point »» (m)

8-17



@ Advanced Features

8-18

View/Record Timer
Start Here

[Booking Program List] window
.................................................... P. 8-13
[View Timer Setting] window
.................................................... P.8-13
[Timer Recording List] window
.................................................... P. 8-13
[Record Timer Setting] window
.................................................... P. 8-13

Set Regular Activation of View or
Record Timer

[View Timer Setting] window or

[Record Timer Setting] window »

»» (] »» 1 Time, Daily or Select

Day ) (w)

£3When Select Day is specified, select
days of the week and press (=).

Select a Timer Alarm Tone

[View Timer Setting] window »»
»» (@) () Select a folder »» (m]
» Select a sub folder »» (&]) )
Select an alarm tone » (®]

Set Timer Alarm Volume

[View Timer Setting] window or
[Record Timer Setting] window M
» (@) » (@ to adjust volume »

(w]

Set Priority at Recording Start
Time When a TV & MUSIC Group
Function is Active

[Record Timer Setting] window M
»» () »» Recording or
Operation Preferred )» ()

When Recording is set, the function
in operation is interrupted/ended, and
recording starts. When Operation
Preferred is set, a confirmation
asking whether to start recording
appears.

Enter Title of Booked Program

[View Timer Setting] window or
[Record Timer Setting] window »
»» (@] » Enter program title M

(w]

Activate TV Directly from Timer
Alarm Notification Window

[View Timer Setting] window )
(= »» (=) »» ON or OFF » (m]
£Ewhen ON is set, press (@] twice and
select YES from Alarm Notification
window to activate TV and watch the
booked program.

Edit View/Record Timer Settings

[Booking Program List] window or
[Timer Recording List] window »»
Select a booked program » »
Edit each item » (&) (> YES or
YES (Confirm Once) » (m])

Change Order of Booked Programs

[Booking Program List] window or
[Timer Recording List] window »
»» Sort M (] M) Select a
criterion »» (m]




q@ Advanced Features

Delete Booked Programs

[Booking Program List] window or
[Timer Recording List] window »»
Select a program M »» Delete »»

® To select Delete This
) Delete This b (&) P YES ) (m)

® To select Delete selected
» Delete selected »» (W) M) Selecta
program or recording M) (®) P
Repeat step of selecting program or
recording M » YES ) (m]

® To select Delete All
» Delete All Db (W) D) Enter Security
Code P () »» YES M) (m]

Select Delete past to delete old bookings.

Check Volume of Recorded Programs

[Timer Recording List] window »»
»» Memory Info »» (m)]

Check Result of Timer Recording

(] »» TV »» (8] ) Result Timer Rec
»» (@] ) Select an entry » (]

§2Press (] to play the recorded program.
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Use Music Player to play and organize songs on handset. @ Play not possible with insufficient battery charge.
@ Access the Internet to download music. @ Alarm notification, received calls, etc. while playing will pause
@ Videos can also be played with Music Player. play.

@ Some files are unplayable depending on their format.

= . .
£ Play & Organize Songs/Videos on Handset
A Save Music
n!; o= T o Inbox
'}f, 2 s Record Videos Save downloaded and transferred music from Memory Card.
S Handset .
-3 a, Memory Card
o, , .
4] ~.‘ Save music moved/copied from handset or transferred
> from PC.
)
5 Transfer to
- Memory Card - Save Videos
D Inbox*
“ﬂ"' Save shot/downloaded videos, and videos transferred
~s*® from Memory Card.
'/==\‘ »{ Download Camera* Memory Card
Wm gy |Download and play musicivideos Save recorded Save videos moved/copied
WP/ |(packet transmission fees are videos. from handset or transferred
charged). from PC.
Internet * Saved videos can be edited as well.
Tip

* Be sure to save music files from PC to Memory Card in the following folder.
¥ PRIVATE ¥ MYFOLDER ¥ My Items ¥ Music




Playback Windows

NOW PLAYING
MusicPlayer

@ Q@.@@@@@ ® ®

Full Screen Mode
(For Video Playback)

Artist Name <Creator>*

Title

Shuffle Mode

3% ON OFF

Playback Image <Video>*

99|00

Playback Status

PR Play MFILEE Pause
WEF  Fast Forward <4BEN Rewind
PELEW Slow Play @Y Fast Play

To Web
Connect to the URL in the song.

Change the playback song or file.

Sound Effect on (always on)

@ e

Current Track/Total Tracks in
Folder (Current File Number/Total
Files in Folder)

W)
@ |Song/file Selection
®

Playback Position

i1 indicates the current playback
position. Use I3 to move playback
position during pause.

Equalizer

& Equalizer OFF
RopEiveRlVocailBreakd@ilight
(WootellBalladMRapMionce @R oGk

Kiss &Emﬂ For each genre of music

o5 e s User settings

@

Elapsed Playback Time/Total
Playback Time

@ |Volume

Sound Effect

&% Effect OFF
Tt OS5 ety D™ S
leatie RS WD For different song
styles

nir nibe migs User settings

Repeat Mode
8 OFF
G Repeat One

@ Repeat All

* Descriptions in < > apply to video
playback.

a 11ddy s 18 19feld d1snnl



J)J) About Music Player
Downloading Music

@ Check the fees, expiration date, etc. on
the download site.

EA(= » music » (=] »
Download Music » (8] »
YES ) (u]

HlTo Search for Songs to Download
)) Search Music »» (&) )b YES M

(w]

FoIIow onscreen instructions

! 11ddy is 18 1ahe|d ds1snin



- = - Set Equalizer o
Playing Music Tip d
» To play videos downloaded or recorded Set Sound Effect =7
E3® » music » (u) with camera: 1
(W) = Data Folder = () = Videos  |5€t Repeat Mode
) select a folder » (u] => (@] = Specify a video to play Set Shuffle Mode a)
Available Keys during Access the Internet 5)
g}:ggtgg Playback Toggle Normal Screen 9]
4] 2. Trackd OWhile Handset is Open and Full Screen
S List Windo v7)?2
ong Li indow Pause/Play O End Playback 79
Se|9Ct asong » (®] Adjust Volume o 1 Press the key to toggle settings.
2 Available when playing videos.
ezl Play from Beginning ]|
ROWCAING Play Previous Song or
Video
Jf J Play Next Song or Video |3
‘ Rewind Press and
hold [0)
e & DERDW] Fast Forward Press and
Music Player Playback Window hold (0¥
(Video Player Playback Window)
Move Playback Position |3 during
pause
Select a Song or File or(8)

ﬂ 11ddy s 18 19feld d1snnl
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956

Playing Music From

Quick Launcher

@ Use Quick Launcher to activate Music
Player from closed position.

@ Activates in Portrait view for music
playback even when handset is closed.

(D Press Front Button ([ (Top),
O (Bottom) or EEE)

HReturning to Standby
» & or Press and hold

)0 (Top) or [ (Bottom) to
select @ »

Music Player Playback Window
(Video Player Playback Window)

HReturning to Standby
»» Press and hold

Available Keys in
Playback Window

Play/Pause

Adjust Volume
(Volume
<high>/<low>)

O (Top) or
D) (Bottom)

Play next song
or video

Press and hold

D (Top)

Play from start
or play previous
song

Press and hold
D (Bottom)

End Music

Player

Press and hold

Note

» When a song has not yet been played,
you must first select the song with

handset open before listening.

Using Playlists

Use playlists to play songs in your

preferred order, by genre or artists, or

just replay your favorite songs.

@ Songs saved on memory card can also
be added to playlists.

Creating a Playlist

EA(=] » music » (=] »
Playlist » (u]

Playlist

Playlist List Window
» Create Playlist » (]

E)select a folder »» (8] »
Select a song » (m)

Repeat this step to specify other
songs.

When all songs are specified »
» Enter playlist name »

(w)



HTo Start Playing the Playlist
» (a]

Playing a Playlist

A Playlist List] window »
Select a playlist »» (u]
HTo Play a Playlist from the
Beginning
) Select a playlist b

Playlistl

EN@Track0l
[PE=E

2] & Track02
13/ & Trackd3
|4 & Tracke4

Playlist Song List Window

HTo Play All Songs
" All Tracks P> (] (twice)

) select asong » ()

More Features
@ Advanced

Playing Music
<+ Resume Playback
+% File Property
“ Repeat
«“ Set Preferred Sound Quality
% Set Preferred Sound Effect
+» Specify Play Start Position
< Use a Different Function While Playing
Music
(® P.9-11)
Organizing Songs
< Set a Song as Ringtone
« Search for Songs
% Change Order of Songs
% Check Volume of Saved Music
(* P.9-12)
Playlists
< Add Songs to Playlist
% Change Order of Playlist Songs
< Cancel Playlist Songs
+ Edit a Playlist Name
< Add All Music in Memory Card to
Playlist
< Copy a Playlist

< Check Playlist Information
< Delete Playlists

(* P.9-12)
Customize
Playback Window
< Change Playback Window Mode (Video
Playback)

< Change Design of Playback Window
(Song Playback)
+ Set Image Display Size (Video Playback)
(@ P. 14-35)

ﬂ 11ddy s 18 19feld d1snnl
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About S! Appli

S! Appli are applications designed for
SoftBank handsets. Download games
and other applications.

OAbout Lifestyle-Appli

Handset includes Osaifu-Keitai®
compatible S! Appli “Lifestyle-Appli”
(P. 11-3). Change Lifestyle-Appli
settings as any other S! Appli.

OAbout Network S! Appli

Since network S! Appli require network
connection, transmission fees are
incurred. A confirmation may appear
when an application is connecting to
the network. Follow onscreen
instructions.

Tip

« For information on transmission fees,
contact SoftBank Customer Center,
General Information (P. 15-52).

OAbout License Information
To check Java™ and JBlend™ license
information:

ED(=] » 51 Appli » (=] »

Information » (=]

Downloading

S! Appli

EX(=] » s1 Appli » (8] »
S! Appli List » (8] »
Download S! App » (8] »
YES » (u)

) select an S! Appli »
(@] (twice)

HTo Activate S! Appli Right Away
» YES P (W) )} Select an S! Appli
» (a]

HTo Activate S! Appli Later
» NO ) (m]

Note

* Check the battery level before
downloading S! Appli. If the battery
level is low, download may fail.

* If you replace USIM Card due to
damage or loss, downloaded S! Appli
are no longer available.

« If you initialize handset when using an
S! Appli moved to Memory Card, the S!
Appli will no longer be usable.You will
need to download it again.

* When using an S! Appli moved to
Memory Card, using the procedures
below will resave the S! Appli to your
handset and the S! Appli in Memory
Card will no longer be usable.

- Download the same S! Appli with no
Memory Card inserted

- Download the same S! Appli with
different Memory Card inserted
Use an S! Appli resaved to handset as
it is in handset, or again move it to
Memory Card.

Tip

« For how to download Lifestyle-Appli, see
P.11-3.

* See S! Appli's Help menu or the
download site for operational
information.




Activating S! Appli About E/\1 |L{EFIIR Activating E/\1 JL{EFIIR

ﬂ 11ddy s 18 19feld d1snnl

6™ » s Appli » @) » (Mobile Organizer) (Mobile Organizer)
S! Appli List » [m] /A JLEEFIE (Mobile Organizer) EA (=) » st Appli » (w) » S!
(Japanes.e) is an S! Appli for getting Appli List » E] W E/ 0L
more enjoyment from camera or to EFIE » (W)
‘1‘0“’“'“" St ko search useful lifestyle information
@Dovmload LifeApn from pre-installed contents. E/\1 JU{E AR ¢
@ FIR (Mobile Organizer) contains the 'SRTODHE
L 2 following contents. P HRUSIU-) 5
w@Tﬂ‘Hf‘/ .
@uw wwn Contents Entries Publisher
& Cute 42 and kst
S! Appli List Window Photographer |6 columns BLATEEROBUES |
@?ﬁ/@%—?l:ﬁht
. . =57 == 5
) select an application » (] SHCOL &R (32 B ) : ,
; & (Photo-It E/\A JL{EFIE (Mobile Organizer)
HlTo End S! Appli Crafts) List Window
» (=] » End » (m) e Cute Photographer ~& U » 1S SEMMEN
SRII5YF — |approx. AL %A~ (%) :©2008 SHOEISHA Co., Ltd,
Ti J w2 (Useful |800 TERUAKI NAGAMINE
P , Etiquette) EECOL HHE (BRI  ©2008 saorin
« S! Appli is paused when a call arrives. Printed in Japan
S! Appli resumes when the call ends. BRUBNS —TJ v (BEXH) (OB X+ 1989
Tip
« Alternatively, access from a shortcut
(P. 2-5).

99
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9.10

Select contents ) (m]

SRTOSDHE ¢

'FE L]

Contents Top Menu

Searching Mobile
Organizer Contents
Search for entries in pre-installed

contents by selecting headwords one
after another.

<Example>Viewing information for
Photo-It Crafts

D sclect an entry » (8] )
Select an item » (®]

SRCOSDHME +

Mobile Organizer Page

© More Features

S! Appli

% Check S! Appli Information

< Check Volume of Saved S! Appli

< Delete an S! Appli

< Change Mobile Organizer Font Size

(* P.9-13)
Customize

When Running S! Appli

+ Set Sound Volume

% Set Vibration

< Set Backlight

+» Set Blinking of Backlight

< Allow/Prohibit S! Appli to Connect to
Network

<+ Allow/Prohibit S! Appli to Write
Personal Information

+» Reset Security Settings of S! Appli

(< P. 14-35)
S! Appli Settings
<+ Reset S! Appli Settings
< Delete All S! Appli

(<* P. 14-36)



@ Advanced Features

Music Player

Start Here
[Music Player Playback] window

...... . . v P.9-5
[Song List] window .........ccceeeune P.9-5
[Playlist List] window................. P.9-6

[Playlist Song List] window ....... P.9-7
Playing Music

Repeat

[Music Player Playback] window
» (®] M Action Setting »» (8] M
Repeat Setting »» (8] )» All Repeat
or Single Repeat )) (u]

Resume Playback

(®] »» MUSIC »» (] b Resume
Play ») (a]

File Property

[Music Player Playback] window
»» (@) »» File Property »» (] )) File
Property » (u]

View file information.

Set Preferred Sound Quality

[Music Player Playback] window
»» (@ M Action Setting »» (8] »»
Sound Effect )» (8] ) Equalizer »»
(m] » Select user setting 1to 3 M
) Set level for each
wavelength ) (]
® To return sound quality to initial state
P Select user setting 1to 3 b
(twice)

Set Preferred Sound Effect

[Music Player Playback] window
) (®] M Action Setting »» (8] M
Sound Effect »» (] )) Effect )» ()
P Select user setting 1to 3 M)
»» Set level for each effect » (m]
® To set by existing effects
P Select user setting 1to 3 M) (=] M)
M Select effect M (@)
® To return sound effect to initial state
P Select user setting 1to 3 M
(twice)

Specify Play Start Position

[Music Player Playback] window
»» (@] »» Specify play start position
with [ ») (=)

ﬂ 11ddy s 18 19feld d1snnl

Use a Different Function While
Playing Music

[Music Player Playback] window
» (=) M Switch to BGM ) (m] )

Activate another function




@ Advanced Features

! 1ddy s 1 19fejd s1sniy

Organizing Songs

Set a Song as Ringtone

[Song List] window ) Select a
song M (@) ) Select Ring Tone »
(m] »» Select an item ) (]

Check Volume of Saved Music

[Song List] window » (@] »
Memory Info ) (m]

Playlists

Search for Songs

[Song List] window, [Playlist List]

window or [Playlist Song List]

window ) (@ M Search ) (m] )

Title »» (®) ) Enter condition M

(w]

§3 Select a song from search results and
press (@] to play it.

Add Songs to Playlist

[Playlist Song List] window ) [®) M

Edit Playlist »» (8] »» Add Music »»

(m] » Select a folder M [m) )b Select

songs » (8] » (&) » YES ) (m)

3 The songs you specified are added at
the end of the playlist.

Cancel Playlist Songs

[Playlist Song List] window »
Select a song » (@) M Edit Playlist
)» (m) M Release Settings »» (&)
® To select Release This
) Release This P (m] P) YES )) (m)
® To select Release Selected
)) Release Selected »» (m) PP Select
songs M) (] M) ) YES ) (u)
® To select Release All
) Release All b (®] W Enter
Security Code M) (®) D) YES Mb (m]

Change Order of Songs

[Song List] window or [Playlist
Song List] window »» (@) M) Sort
»» (m) M Select a criterion ) (W]

Change Order of Playlist Songs

[Playlist Song List] window M
Select a song ) (@) M Edit Playlist
»» (@] M Sort Playlist »» (m] M)

Select a position ) (u]

Edit a Playlist Name

[Playlist List] window »» Select a
playlist »» (®) »» Edit Playlist Name
»» (@) M) Edit playlist name » (m]

9.12

Add All Music in Memory Card to
Playlist

[Playlist List] window »» (®]) »»
Update All Tracks ) (®) )» YES M

(w]




Copy a Playlist

[Playlist List] window PP Select a
playlist »» (@) »» Copy to Playlist
) (m)

S! Appli

Start Here

[S! Appli List] window.........cccu... P.9-9
[Mobile Organizer Pagel] ............ P. 9-10

Check Playlist Information

[Playlist List] window »» Select a
playlist »» (®) ) Playlist Info ») (u)

Check S! Appli Information

[S! Appli List] window P Select an
S! Appli P (@) M) Properties »» (&)

Delete Playlists

[Playlist List] window »» Select a
playlist »» (®) »» Delete Playlist »»

(w)
® To select Delete This
» Delete This »» (] M) YES )) (]
® To select Delete Selected
» Delete Selected P> (8] D) Select
playlists M) (@) ») » YES » (m)
® To select Delete All
» Delete All P (&) Db YES )) (m]

Check Volume of Saved S! Appli

[S! Appli List] window » (@) »»
Memory Info )) (u]

Delete an S! Appli

[S! Appli List] window P Select an
S! Appli » (@) ) Delete ) (8] )
YES ») (m)

Change Mobile Organizer Font
Size

[Mobile Organizer Page] » (] »
XEHLIN (@)W ZEF /) (e

@ Advanced Features
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Using S! Quick News

Registered news can be updated

automatically and checked from

Standby.

@ Packet transmission fees are incurred
for using S! Quick News.

Registering News

<Example> Register news on
S! Quick News List

A Press and hold [T

3, 8! Quick News List
LlAdd News
DSIRB-1-2E (3?7

S! Quick News List Window

F)Add News » (8] ) YES »

E)select an item » (=]

Follow onscreen instructions.

10-2

Checking Updated
Information

n[S! Quick News List] window
»» Select an item )» (m]

) select information » (=]

HTo Check Next Updated Information
»

© More Features
@ Advanced

S! Quick News

< Manually Update List

< Automatically Update List

+ View Descriptions of Registered News
< Delete Registered News/Items

(* P. 10-6)
Customize

S! Quick News

+ Hide S! Quick News in Standby

< Set Ticker Speed

+ Set Information to appear in S! Quick
News

< Hide S! Quick News Images

< Reset S! Quick News Registered
Contents

(% P. 14-37)



S! Info Channel/Weather Indicator

Using S! Info Channel

This information service automatically
receives the latest news, weather, and
other information.

@ Transmission fees are incurred.

Subscribing for Service

Subscribe by registering to receive
service.

A (®) » Entertainment » (u]
»» S! Info Ch./Weather »

(w)

41 S! Info Ch./Weather

Elifhat”s New

|2 History
|3IRegister/Cancel
|4Get Latest Contents
15.5ettings

|6/Weather Indicator

S! Info Channel Menu

Pl Register/Cancel » () »
YES »(u]

E)select a contents » (1)

Continue by following onscreen
directions to subscribe.

Checking Latest
Information

A shortcut notifies you when new
information is received.

(8) » Shortcut 2t » (m]
upoATE]

Continue by following onscreen
directions. Web page operation is
the same as for Yahoo! Keitai.

Tip

* To check from a menu:
[S! Info Channel Menu] P> What's
New )) (u)

* To check previous information:
[S! Info Channel Menu] PP History P
(@) DD Select a date P> (@] PP Unread
or read backnumbers are indicated
with R or @4,

Weather Indicators

After subscribing, weather indicators
showing current weather appear in
Standby.

OWeather Indicators

... |Clear

X 3 (Daytime) > |Later

<) |Clear (Night) | / |Partial

<o |Cloudy Pollen (Low)

x| Rain Pollen (High)
UV Rays

4 | Thunder @ (Low)
UV Rays

@‘ Snow @ (High)

<Example> Cloudy, partial rain
g
@ Besides the above, indicators for chance
of rain, typhoon information, seasonal
information, etc. appear.

ﬁ juswuIelId}ug
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S! Info Channel/Weather Indicator

! jJuswiuIeId}uUg

Checking Weather Report

[S! Info Channel Menu] »
Weather Indicator ) (8] »
Weather ) (8]

10-2

More Features

S! Info Channel

< Receive Previous Unreceivable
Information

% Store Images/Melodies from Web Pages

+» Store Background Images from Web
Pages

< Add Phone Numbers/Mail Addresses
from Web Pages

(* P. 10-6)

Weather Indicators
< Manually Update Weather Information

(* P.10-7)
Customize

S! Info Channel
< Set Whether to Display Shortcut for
New Received Information
«“ Set Font Size for Web Pages
< Set Font Size for Ticker
(* P.14-37)

Weather Indicators

< Set Whether to Automatically Update
Weather Information

<+ Set Whether to Display Weather
Indicators in Standby

+» Set Whether to Display Shortcut for
Received New Weather Information

(* P. 14-38)



Download e-comics, e-photo albums, - - ®
and other CCF file books. Usmg BookSurflng
— View e-comics, e-photo albums, etc.
Obtaining Books (CCF file).

Download books from the Internet. n[E] » Entertainment » (m)
@ Downloaded books are stored in Books in » BookSurfing »E]
Data Folder. . . BookSurfing® is activated.
@ Some books require you to obtain a See the Help for BookSurfing® for
contents key (right to use contents). operation
) ®) » Data Folder » (u] » =
ip
Books » @ » Download « Alternatively, activate BookSurfing® by
Books ) (8] ) YES ) (u] selecting BookSurfing from the S!
Continue by following onscreen Appli list.

directions to download.

Tip
* Alternatively, download from
BookSurfing®.

ﬁ juswuIelId}ug
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@ Advanced Features
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S! Quick News

Start Here

[S! Quick News List] window
.P.10-2

Manually Update List

[S! Quick News List] window »»
Select an item »» (@) »» Refresh
This or Refresh All »» (8] » YES M

(w]

Delete Registered News/Items

[S! Quick News List] window »»
Select an item M
® To select Delete This
» Delete This »» (8] ) YES )) (m)
® To select Delete All
» Delete All P> (®) Db YES )b (m]
(twice) PP Enter Security Code Pp ()
(twice)

Automatically Update List

(@] »» Entertainment »» S! Quick
News )) (®] D) Settings »» (m] M)
Auto Refresh » (B) ) Select an
item > (@) M Select an interval,
ON or OFF ) (®] (twice)

S! Info Channel

Start Here

[S! Info Channel Menu] window
P. 10-3

Store Images/Melodies from Web
Pages

[Web Page] M (@) ) Save File W

(m] () Object »» (m]) () Selecta

file) »» (@] »» Save »» (W) ) YES

»» (@] () Select a folder »» (®]) ()

YES or NO ) (m))

3 select Play and press (®) to play
melody file.

€3 Select Property and press (8] to check
file information.

View Descriptions of Registered
News

[S! Quick News List] window »»
Select an item M) (®) M Outline »

(w)

Receive Previous Unreceivable
Information

[S! Info Channel Menu] window
)» Get Latest Contents )» (B] )
YES » (u]

Store Background Images from
Web Pages

[Web Page] » [®) M Save File

(=] » Background Image »» (m] )

Save ) (8] » YES )) (u]

&3 Select Property and press (8] to check
file information.

10-6




Add Phone Numbers/Mail
Addresses from Web Pages

[Web Page] M Select a phone
number or an e-mail address »»
»» Add to Phone Book »» (8] )» YES
»» (@] »» Phone or USIM »» (] »
New or Add (overwrite) »» (8] ()
Search Phone Book P» Select an
entry )b [®)))) Edit items P»

Weather Indicators
Start Here

[S! Info Channel Menu] window
...... P. 10-3

Manually Update Weather
Information

[S! Info Channel Menu] window
»» Weather Indicator »» (8] »
Manual Update »» (8] ) YES )

(w]

q@ Advanced Features

ﬁ juswuIelId}ug
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Q% Osaifu-Keitai
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About Osaifu-Keitai®

“Qsaifu-Keitai®” is a range of IC Card-
based services used by Osaifu-Keitai®
compatible handsets.

Make purchases using e-money or
e-ticketing. Hold handset up to a
reader/writer to pay for your purchase.

OOsaifu-Keitai® Terms

Tip

» Data saved in IC Card varies by service
content and usage history.

Procedures to delete IC Card data vary
by Lifestyle-Appli.

Contact Osaifu-Keitai® service
providers for details.

« Softbank is not liable for damage from
accidental loss or alteration of IC Card
data or settings.

« IC Card data can be misused if your
Osaifu-Keitai® compatible handset is
lost or stolen. Softbank is not liable for
any resulting damages.

Osaifu- | Cellular phone equipped

Keitai® |with “FeliCa” contactless IC
card technology for reading
and writing data by holding
phone up to a reader/writer.

ICCard |AnIC chip embedded in

Osaifu-Keitai®-compatible
handsets.

Lifestyle- |S! Applications to use
Appli Osaifu-Keitai®. Some
applications are preinstalled.

112

Getting Started

Downloading Lifestyle-Appli

Download Lifestyle-Appli via

Internet website.

- Lifestyle-Appli is saved to
Data Folder.

v
Registrations/Settings

Activate Lifestyle-Appli to complete

registration or customize settings.

- Make deposit into account, check
payment records or balance, etc.

Note

* Keep a copy of service passwords,
customer service contact, etc. in a
separate place.




Y Osaifu-Keitai®

Downloading Lifestyle-

Appli

) ®)» Tools » (m) » Osaifu-
Keitai »» (] » Lifestyle-
Appli » (8] »» Download
LifeApp » (8] » YES » (u]

Select a Lifestyle-Appli »

(@] (twice)

HTo Activate Lifestyle-Appli Right
Away
P> YES P> (m] DD Select a Lifestyle-
Appli » (=]

HTo Activate Lifestyle-Appli Later
» NO Ph(u]

Note

* Check the battery level before
downloading Lifestyle-Appli. If the
battery level is low, download may fail.

« If you replace USIM Card due to
damage or loss, downloaded Lifestyle-
Appli are no longer available.

Activating Lifestyle-Appli

(= » Tools »(m)) Osaifu-
Keitai » (®] » Lifestyle-
Appli » (u]

= |ifestyle-Appli 1/2

_LDown load LifeApp

_ WiV qlSuicar7’y
=L © &

&

13 BFv4-nanaco)
nanag B Q2

|4 EFV4- [Edy)
g g

- .
oumpay%ﬁ?:;a

Lifestyle-Appli List Window

) select a Lifestyle-Appli »» (1]

HTo End Lifestyle-Appli
» (=] » End »» (u]

Note

» Keep a copy of service passwords,
customer service contact, etc. in a
separate place.

Tip

« Lifestyle-Appli is paused when a call
arrives. Lifestyle-Appli resumes when
the call ends.

Using Osaifu-Keitai®

Reader/Writer Transactions

@ There is no need to activate a Lifestyle-
Appli during transaction.

@ Make sure battery is adequately
charged.

@ Transactions are possible even when
handset power is off or during calls or
Internet transmissions.

§)Hold 2) logoup toa
reader/writer »» Check scan
result on reader/writer
display

Place this part
over readerAwriter

- Hold handset parallel to the
reader/writer. Try moving handset
around if recognition is slow.

a sjool
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Note

« Softbank is not liable for damages from
accidental loss or alteration of IC Card
data or settings.

Tip

+ Data may be unreadable if a metal
object, etc. is between 5) logo and
reader/writer.

Activating IC Card

Lock

Use this function to restrict access to
and prevent unauthorized use of
Osaifu-Keitai®.

A= » To00Is » (m]
»» Osaifu-Keitai » (m) »
IC Card Lock Set. » (u]

sjoo1

114

) Enter Security Code » (u]

i IC Card Lock Set.
ENIC Card Lock

121IC Lock(Power-off)

IC Card Lock Setting Window

E)ic card Lock » (8] » ON
» (m]

- B appears in Standby.

- Alternatively, set IC Card Lock by:
Press and hold in Standby.

HlTo Set Operation of IC Card Lock
after Power Off
P> IC Lock(Power-off) bp (=] »»
Maintain or IC Card Lock ON »»
(w]

HlTo Cancel IC Card Lock
PP Press and hold in Standby
»» Enter Security Code »p (m]

Remote Lock
Call from a specified phone to activate
Call Remote Lock.

OsSaving Numbers to Activate
Call Remote Lock

)= » Tools » (m] »
Osaifu-Keitai »» (8] » Call
Remote Lock »> (u)

) Enter Security Code » (u]
Ejon » (m]

Ml To Cancel Call Remote Lock
> OFF »» (m]

i Call| Remote Lock
E¥ <Not Recorded

2/ {Not Recorded)
3/ <Not Recorded>

Call Remote Lock Setting Window



,Q% Osaifu-Keitai®

) <Not Recorded> »» (u] »
Enter Phone Numbers » (m]
HlTo save numbers from Phone
Book, Redial or Received calls
»» (®) PP Look-up Address ) (u]
»» Phone Book, Redial or Received
Calls »» (®] P) Select a number M

(w]

HlTo save a Payphone number
»» (®) P» Payphone ) (u]

OActivating Call Remote Lock

Using one of the specified
phones, call handset
- Send Caller ID.

Z)Hang up after handset
receives the call

[E) Within three minutes,
repeat [[})-) twice
« After the third Missed Call, IC Card
Lock is set; a message announces IC
Card Lock activation.

Note

« If series is interrupted by another call,
Missed Call count is reset. Start over
from the beginning.

© More Features
@ Advanced

Osaifu-Keitai®

% Check Lifestyle-Appli Properties
< Check Memory Status

< Delete a Lifestyle-Appli

< Edit Call Remote Lock Numbers

++ Delete Call Remote Lock Numbers

(* P.11-21)
Customize

Osaifu-Keitai®
+ Set illumination for IC Card
+» Delete all Lifestyle-Appli
% Set Whether to Enable Opening from
Browser
(* P. 14-40)

a sjool
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Save future events to Schedule. Set the
alarm to be activated at a specified
time with message and animation
appearing to remind you of the event.
Saved events can be checked from
Schedule window.

Schedule Window

© 2009/ 4/16(Thy) |
SMTWTF S

12 3 4
S 6 78 9100
“12 13 14 15 "0 17 18
19 20 21 2 B 4B
2% 21 28 29 30

»—

6T
® 16(T)
16(T)

2 13:00 Smeeting
= 14:30 lguest

- 15139 Zgoing out
5 19:30 drinking

! sjoo1

Schedule Window

116

@

Calendar

Blue date: Saturdays

Red date: Sundays, public and other
holidays

__: Today

[[]: Events for the morning

W Events for the afternoon

®

Information Panel

Date, day of the week, content type
icon, time, and saved content
+ Content Type Icon

@ (or a user icon) Event

@ Holiday

Event Repetition Icon

[ Daily event

{7 Weekly event

[ Monthly event

Annual event

Event for over a day

.

Saving Events to
Schedule

@ Schedule is assigned to (@] by default.
See P. 14-39 for how to change the
assigned function.

(=) » Tools » (=] »
Schedule » (u]

»» Schedule » (u]

©  Edit Schedule
=t<Not_Recorded>
((32009/ 4/16 10:10
(C32009/ 4/16 10:10
€ Time

ESOFF

BXCIock Alarm Tone
EEKNot Recorded>

[EKNot Recorded>

Event Edit Window

»» (] »» Enter subject »
(@) » Select an icon » (=]

Entered content appears when
alarm sounds or vibrates.



»» (®] »» Enter start/end
date and time » (®]

» (8] » 1 Time, Daily
(), Weekly (), Monthly
(M) or Annually (i) » (u]

HTo Specify Days of the Week
» Weekly (IT) »» (=) P Put
checkmarks to days of the week PP

(33 » (8] » Select an alarm
notification option » (u]
HTo Activate Alarm Prior to Event

»» ON/Set Time P> (@) ») Enter
time

»» (@) » Select an alarm
tone type » (8] (»» Select a
folder »» (m]) » Select an
alarm tone » (m))
Folders are unavailable when

Clock Alarm Tone or OFF is
selected.

)& » (m) » Enter place » (w]

E)E » (m) » Enter details »
= » =

Entered content appears when
alarm sounds or vibrates.

OAlarm Notification
Operations
When the set time arrives, alarm sounds
and animation appears on Display for
approximately five minutes.
Press any key to stop the alarm tone.
Press any key again to end notification
message.

Tip

« If the set alarm time arrives during a
call, alarm tone sounds through
earpiece.

« If a call arrives while the alarm is
sounding, the alarm stops.

Adding Holidays

D (schedule] window » (=] »
Holiday »» (m]

»» (m] »» Enter year,
month and date » (®]

»» (@) » 1 Time or
Annually () » (8]

Z)E » (m] » Enter content »

Checking Saved Events

(=) » Tools » (m] »
Schedule » (m]

© 2009/ 4/16(Thu)
SMTWTF S
1.2 3 4
56 7 8 9 11
12 13 14 157 17 18
“19 20 21 2 23 24 2
2% 21 28 29 30

= 13:00 Gmeeting
16(T) = 14:30 Gguest

= 15:30 Qlgoing out

5 19:30 drinking

Schedule Window

a sjool

HlTo Toggle between Weekly View
and Monthly View
»
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)3 to select a date with

events ) (®)

@ 19:30~22:00 drinking

Event List Window

[E)select an event » (u]

! sjoo1

© Schedule
Date (from):
4/16(Thu)13:00
Date (to):
‘|1/16(Thu)14:ﬂﬂ

Event Details Window

Deleting Events

OTo Delete One Event

D (Event List] window »»

118

Select an event »

) Delete »» (] ») Delete This
» (®] » YES ) (]

OTo Delete Multiple Events
ED(Event List] window »»

F)Delete » (8] » Delete
selected »» (m]

[E)select an event »» (u]

Repeat this step to specify other
events.

» YES » (a]

OTo Delete All Events Prior to
a Specified Date

D n [Schedule] window, select
date, [Event List] window or
[Event Details] window »

P)Delete » (8] » Delete Past
» (@) »» Select an item »» (m]
» YES » (u]

© More Features
@ Advanced

Schedule

«“ Sort Events by Icon

% Check Number of Saved Events

+ Edit an Event

< Copy an Event

< Make/Cancel Secret Setting of an Event
“ Delete All Events

< Reset Holidays

Customize

Alarm
«» Set Priority at Alarm Notification Time
< Change Alarm Tone

(* P. 11-21)

(* P. 14-3)



Save tasks to To Do List. Set Alarm to
remind you of deadlines.

Saving Tasks

)= » Tools » (8] » To Do
List » (8] » (@] »» New »
(w]

HTo Edit a Saved Task
PP Select a task PP

© Edit To Do List

E=prepare for_meeting
12009/ 4/16(Thu)15:30
(P1H]

[CiNone
IE3ON
EXCIock Alarm Tone

Task Edit Window

F)E » (8] » Enter task » (1]

Task appears when alarm time
arrives.
E) & » (m] »» Enter Date » (u]

»» Enter due date and time

0

HTo Enter Due Date from Calendar
)» Choose Date ») (®] PP Select a
date on Calendar ) (8] P) Enter
date/time )b (m)

HTo Cancel a Due Date
»» No Date ») (u]

)= » (=] » Select a priority
level » (m]

£ » (m] » Select a category
» (m]

(A3 » (=] » Select an alarm
notification option » (]
HTo Activate Alarm Prior to Due
Time
)» ON/Set Time P) (8] PP Enter
time

»» (m] »» Select an alarm
tone type » (8] (»» Select a

folder » (m] » Select an
alarm tone » (®)) »

Folders are unavailable when
Clock Alarm Tone or OFF is
selected.

OAlarm Notification
Operations
When the set time arrives, alarm sounds
and animation appears on Display for
approximately five minutes.
Press any key to stop the alarm tone.
Press any key again to end notification
message.

_ Eprevost

Tip

« If the set alarm time arrives during a
call, alarm tone sounds through
earpiece.

« If a call arrives while the alarm is
sounding, the alarm stops.

a sjool
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Checking Saved Deleting Tasks
Tasks

OTo Delete One Task Advanced
A=) » Tools » (8] »» To Do [fJ[Task List] window »» Select ~ T° Do List
List » (m] atask » + Sort Tasks by Category

% Change Order of Tasks

To Do List:All EX
T ) Delete »» (8] »» Delete This Set Task Status
Eledprepare for meetin » [E » YES » [E] < Delete All Tasks
(* P.11-22)
OTo Delete Multiple Tasks Customize
Task List Window
A (Task List] window » Alarm
Select a task » (|] « Set Priority at Alarm Notification Time
) Delete » (m) »» Delete % Change Alarm Tone
brepare for meeting selected » E] (< P.14-3)
= 23399a§5i6(1hu)15~3u
8 ﬁomglition Date: Select a task » E]
w Cgte:oiy:None Repeat this step to specify other
Priority:
m larn:ON tasks.
Status: Elad
» YES » (]

Task Details Window

Tip
« Overdue tasks are indicated by red
status icons (e.g. [Eiadl).

11-10




_ Greememo A

Save short notes or messages as text

memos.

@ Saved text memos can be inserted in
Schedule or in messages.

Saving Text Memos

E)(=] » Tools » (m] »» Text
Memo » (]

© Text Memo

&NGood morning! Did you
|2/Thank you for everythi
|3/<Not Recorded>
|4/<Not Recorded>
|5/<Not Recorded>
|6/<Not Recorded>
|Z/<Not Recorded>
18/<Not Recorded>
19/<Not Recorded>
|0/<Not Recorded>

Text Memo List Window

) <Not Recorded> » (8] )
Enter content »» (]

HTo Edit a Saved Text Memo
) Select a text memo M) (2 M)
Edit content P) (m]

Deleting Text Memos [l More Features

OTo Delete One Text Memo

. . Text Memo

n[TeXt Memo List] window » < Save a Text Memo to Schedule

Select a text memo » % Sort Text Memos by Category

- < Check Text Memo Information

@) Delete » (8] ») Delete This - Delote All Toxt Mermos

» (8] » YES » (] (* p.
OTo Delete Multiple Text

Memos

A (Text Memo List] window »»

F)Delete » (8] »» Delete
selected » (u]

E)select a text memo » (w]

Repeat this step to specify other
text memos.

» YES ) (]

11-23)
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The following two types of voice
memos can be recorded with Voice
Memo:

“Voice memo during a call” to record

the other party’s voice during a call;

and “Voice memo in Standby” to
record your voice in Standby.

@ Only one entry, either a voice memo
during a call or a voice memo in
Standby, can be saved on handset.
When a new voice memo is recorded,
the previously saved entry is
overwritten.

@ The available recording time is 20

seconds for both types of voice memos.

@ See P. 3-5 and P. 3-18 for playing and
deleting a recorded voice memo.

1112

Recording the Other

Party’s Voice

) Press @ during a call »
Voice Memo )) (]
A short beep sounds through the
earpiece, and recording starts.
When remaining recording time
reaches five seconds, a short beep
sounds. When recording is
finished, two short beeps sound.

HTo Stop Recording

» (m]

Recording Your Voice

A=) » Tools » (8] » Voice
Memo » (u)

) YES » (8] »» Record your
voice
Speak into microphone after short
beep sounds through earpiece.
When remaining recording time
reaches five seconds, a short beep
sounds. When recording is
finished, two short beeps sound.

HTo Stop Recording

» (m]

Tip

* Recording stops automatically when a
call arrives, alarm goes off or another
function is activated.




A=) » Tools » (u] »
Calculator » (u]

) Enter numbers with Keypad
»» Enter +, —, X or = with
Multi Selector

HTo Calculate Negative Numbers
»» i8] ) Enter numbers with

keypad PP Enter +, —, X or +
with Multi Selector

(3]0

Result appears.

Available Functions

Enter Number (o) -=)
+ (Add) E

— (Subtract) =]

X (Multiply) [a]

+ (Divide) ©

= (Equal) (w)
Decimal Point

Cancel Calculation (LAC)
Clear Number (e
Tip

« If the calculation result exceeds 10
digits, .E appears.

a sjool
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- ) select an alarm » (3 & » (=] » Select an alarm
Setting Alarm — tone type » (8] (» Select a

E)(®] » Tools » (8] » Alarm folder » (m] » Select an
» (m] alarm tone » (m))
Folders are unavailable when

A|arm1 — o — [EiAuto Power OFF Clock Alarm Tone or OFF is
6:30 W selected.
|2/Alarm2 OFF
\aiATarm3 oFF » (m] » (T to adjust
L{"::am: E:: Alarm Setting Window volume »» E]
IS/Alarm
- . af >
» [ » Enter title »» ) EJ5 (21 ON »» (8] ») Enter
. . number of activation times
- Title appears in Alarm message. ) X
Alarm List »» Enter time interval
. . » E] »» Enter time »» E] HlTo Cancel Snooze
Y WTo View Alarm Entries - . »» OFF ») (8] D) Enter ringing
g ») Select an entry »» (@) » (8] » 1 Time, Daily Suration
& (@) or Select Day (1) » (8]
m et HMTo Specify Days of the Week g » (8] »» ON or OFF »» (]
STURTIFrS) Y Select Day () P> (®) D> Put »
Level 4 ‘ checkmarks to days of the week P
Snooze 5times/Smin
lAuto Power OFF

Alarm Details Window

1114
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OAlarm Activation

Operations

When the set time arrives, alarm is
activated and animation appears on
Display. When the auto power-on
function is set to ON in Alarm Setting
window, handset is automatically
turned on, if it has been off, to activate
the alarm.

Press any key to stop the alarm tone.
When Snooze is set to OFF, press any
key again to cancel the alarm with two
short beeps, and return to the window
before the alarm activation.

When Snooze is set to ON, the alarm
sounds repeatedly in the set time
interval. Press (=] to cancel Snooze
with two short beeps.

Note

» The alarm and snooze cancellation
beeps do not sound when Keypad
Sound is set to OFF.

+ Set the auto power-on function to OFF
in Alarm Setting window and turn off
handset, when you are near high-
precision electronic devices or devices
using weak signals, on an aircraft or in
a hospital where handset use is
prohibited.

« If a call arrives while the alarm is
sounding, the alarm stops.

« If the alarm activation time comes
during a call, Snooze does not work
even if it is set to ON.

Canceling Alarm

n[AIarm List] »» Select an
alarm »

Each time you press ¥, the alarm
toggles between ON and OFF.

Tip
+ Alarm settings are retained even if the
alarm is canceled.

© More Features
@ Advanced

Alarm
< Cancel All Alarms
< Edit Alarm Settings

Customize

Alarm
% Set Priority at Alarm Notification Time
< Change Alarm Tone

(* P.11-23)

(® P. 14-3)

a sjool
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Q% Bar Code Reader

! sjoo1

JAN codes and QR codes can be
scanned by Bar Code Reader using
handset camera.

About JAN & QR Codes

OJAN Code

A bar code made of vertical lines (bars)
with different widths and spaces in
between, representing numbers.
Handset can scan 8-digit (JAN8) and
13-digit JAN13) bar codes.

OQR Code

A two-dimensional code representing
alphanumerics, kanji, kana, or
pictographs. Some QR codes are made
up of several data areas that are
scanned as individual QR codes and
then automatically combined as one QR
code.

11-16

Scanning Bar Codes

@ Position handset camera at a distance of
6 to 8 cm from the bar code.

(=] » Tools » (8] »» Bar
Code Reader ») (]

Frame the bar code in the
recognition field

Scanning

Bar Code Scanning Window

Scanning starts automatically.
r,m , band- indicate the corners
of the recognition field.

HTo Cancel Scanning
»» (1] »» oK P> (u]

HTo Adjust Zoom
»» i8] (Zoom out) or (3§ (Zoom in)

HlTo Scan a QR Code Made of
Several Data Areas (QR Codes)
»» OK P» (] (twice) PP Scan a QR
code
Repeat this step to scan other QR
codes.
All component QR codes must be
scanned in order to access or save
scanned data on handset.

[E) Check scanned data
HTo Discard Scanned Data
» > YES ) (m]

»» Store »» (8] ) YES »
(=] » OK » (m]

Tip

« A JAN code/QR code must be
accurately focused and be enlarged to
fill the recognition field.

» Scanning may take a while.

» Some bar codes may not be scanned
depending on the size, version or print
quality, or due to scratches, stains,
damage or the reflection of light.




Bar Code Reader

Checking Scanned
Bala

D Bar Code Scanning] Using Scanned Data
window » (@) » Reading  * MakeacCall
Data List » (W) < Compose a Message
% Access the Internet

© Bar Code Reader < Save to Phone Book
|1/20090416_1010_0000

Pi20090415 20350000 # Save a Bookmark
|3/20090415_1218_0000 < Copy Text

«+ Edit Title of Scanned Data

Scanned Bar Code Data List Window  * Delete Scanned Data

) select an entry » (1]

© Bar Code Reader
http://www.XXXX.co. jpl

(< P. 11-24)

a sjool

Scanned Bar Code Data Details Window

Tip

« Characters that are not supported by
Bar Code Reader are replaced with
spaces (blanks).
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Text Reader

Use Text Reader to scan printed text.

Scan Modes

Free memo

Scan Japanese or English
text, and save the text to

(©)

Recognition Frame

1118

Text Memo.
Card read Scan name, phone
number, e-mail address, | Text Scanning Window
postal code, address and
memo printed on Card Read
business cards, and save hen not fitting in & Frane
all scanned data 'Itic'"’_ ®
collectively as a Phone o— I BF
Book entry. ) e
®
Compose Scan address, subject or ——
message message text, and open t_ﬁllg SLLL
Composition (S! Mail) @— 4
window with the
address, subject or -
= message text entered. @ ——(ateral R 24Nega] — ®
e —
% URL Scan URL, and access the Text Scanning Window
page or save the URL to
m Bookmark.
Mail address |Scan e-mail address, and
compose an S! Mail to
the address.
Phone Scan phone number,
number and make a call to the
number.

®

Scan Item Icons
[&] Name

[&] Phone number
[ E-mail address
[ Postal code
[&] Address

B Memo

[To] Address

fut] Subject

[Bl Message text

Recognized Text Field

Recognition Mode

Key Guidance

@ e 6|

Negative Mode
Nega appears when NEGA/POSI
Mode is set to Negative Fix.

Remaining Number of Characters
That Can be Scanned




Text Reader

Scanning Text

@ Position handset camera at a distance of
6 to 8 cm from the text.

<Example>Scanning in Card Read
mode

) (=] » Tools » (8] » Text
Reader »» (u)

@) New » (8] » Select a scan
mode ) (|

Card Read

== © = @ &
g
a_Name

o

Lateral B 32
Text Scanning Window

[E) S to select a scan item icon
»» Frame text in the
recognition frame

HTo Adjust Zoom
» (& (Zoom in) or (@) (Zoom out)

0=

The text is scanned.
The recognized text appears.
HTo Rescan the Same Text
» > YES ») (u]
HWhen Scanned Text Overflows
Recognized Text Field
»» B3 to scroll the field
HTo Save Scanned Text without
Correcting It
»
HTo Scan Following Text
)» (@) PP Frame text in the
recognition frame (include several
scanned characters of the
preceding text) P) (m]
HlTo Scan Another Item
> (] M) I3 to select a scan item
icon PP Frame text in the
recognition frame ) (1)

»» Store ) (u)

Tip
* Text must be accurately focused and be
enlarged to fill the recognition frame.
» When Processing appears, do not
move handset.
» Handwritten text is not recognized.
« Text may not be recognized correctly
when:
- Faxed or copied text is scanned.
- Decorated characters are scanned.
- Spaces between characters are
uneven.
- Text is indistinguishable from the
background.
- Ambient lighting is inappropriate.

a sjool
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Text Reader

Checking Scanned Text More Features
)™ » Tools » (m] » Text

Reader » (] »» Reading Scanning Text

Data List »» (] RS qurect Scanned Text
+ Edit Scanned Text

— < Set Printing Status of Text
< Set Guidance OFF/ON
< Set Vertical/Lateral Scan
(* P. 11-23)

© Text Reader

Scanned Text List Window Using Scanned Data
< Make a Call
) select an entry » (] + Compose a Message

©  Text Reader < Access the Internet

lemo < Save to Phone Book
<+ Save a Bookmark
«“ Search Phone Book

d i ind < Save a Text Memo
Scanned Text Details Window + Copy Text

< Delete Scanned Data

! sjoo1

(* P. 11-24)
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@ Advanced Features

Osaifu-Keitai®

Start Here
[Lifestyle-AppIi List] window
...... .P.11-3

[call Remote Lock Setting] window
...... . . . .P.11-4

Edit Call Remote Lock Numbers

[Call Remote Lock Setting]
window P» Select phone number
»» (] »» Change phone number M)
(=] » YES » (m) » (=)

Check Lifestyle-Appli Properties

[Lifestyle-Appli List] window »»
Select a Lifestyle-Appli M (@) M
Properties ) (m)

Check Memory Status

[Lifestyle-Appli List] window M
» Memory Info ) (m]

Delete a Lifestyle-Appli

[Lifestyle-Appli List] window »»
Select a Lifestyle-Appli M (@) M
Delete »» (u] )b YES )) (m]

Delete Call Remote Lock Numbers

[Call Remote Lock Setting]
window P» Select phone number
»
® To select Delete this

) Delete this P (8] D) YES b) (m])
® To select Delete All

» Delete All »» (] ) YES ) (u]

Schedule

Start Here

[Schedule] window................... P. 11-6
[Event Edit] window....
[Event List] window..... .
[Event Details] window............ P 11-8

Sort Events by Icon

[Schedule] window, [Event List]
window or [Event Details]
window » (@) M) Icon Display M
(@) » Select an icon M) (W)

Check Number of Saved Events

[Schedule] window »» (@] »» No.
of Schedules »» (u]

Edit an Event

[Event List] window/ [Event
Details] window (P Select an
event) M (@) ) Edit Pb (] ») Edit
each item M

E sjool
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@ Advanced Features

! sjoo1

Copy an Event

[Event List] window/ [Event

Details] window P (@) P> Copy M

(m] » Edit each item M)

£ Repetition setting of an event is
canceled when it is copied.

Make/Cancel Secret Setting of an
Event

® To Make Secret Setting

[Event Edit] window PP Enter each

item P

® To Cancel Secret Setting

[Event List] window/ [Event

Details] window »» @) P) Release

Secret P» (@) ) YES ») (m]

€3 Before making/canceling secret
setting, set handset to Secret Mode or
Secret Data Only Mode (P. 4-9).

Delete All Events

[Schedule] window, [Event List]
window or [Event Details]
window P (@] »» Delete »» (m] M)
Delete All ») (8] D) Enter Security
Code »» (@) »» Select an item )) (@]
»» YES ») (m]

Change Order of Tasks

[Task List] window »» (@] P
Sort/Filter »» (8] ») Select a
criterion »» (m)

Reset Holidays

[Schedule] window »» (@] ) Reset

Holiday »» (8] ) YES ») (m]

To Do List

Start Here

[Task List] window ................. P. 11-10
[Task Details] window............ P. 11-10

Set Task Status

[Task List] window/ [Task Details]
window (PP Select a task) M (@) M
Change Status »» () ») Select a
status »» (m]

&3 The set status is indicated by the status
icon in Task List window and in Task
Details window.

When Completion is set as status,
enter the completion date.

1122

Sort Tasks by Category

[Task List] window ») (@] bp
Category Display »» (8] ») Select a
category ) (®)

Delete All Tasks

[Task List] window »» (@] ) Delete
»» (m] »» Delete All »» (8] ») Enter

Security Code »» (8] ») YES )) (m]




@ Advanced Features

Text Memo

Start Here
[Text Memo List] window...... P. 11-11

Save a Text Memo to Schedule

[Text Memo List] window D) Select

a text memo »» »» Edit

Schedule P> (8] P Enter each item

»»

3 Event Edit window opens with the text
memo details set as event content.

Delete All Text Memos

[Text Memo List] window M) (@] M)
Delete »» (8] ») Delete All V) (]
P» Enter Security Code M) (m] »»
YES ») ()

Alarm

Start Here

[Alarm List] ...ccccceerienienierinninnns P. 11-14
[Alarm Details] window......... P.11-14

Sort Text Memos by Category

[Text Memo List] window PP Select
atext memo P> (@) ») Category M
(m] ) Select a category ») (8]

Cancel All Alarms

[Alarm List] / [Alarm Details]
window »» (@] ) Release All »» (m]
»» YES ) (m]

Check Text Memo Information

[Text Memo List] window PP Select
a text memo »» (@) M Text Memo
Info »» (m]

Edit Alarm Settings

[Alarm List] / [Alarm Details]
window (P) Select an alarm) »p
»» Edit each item )

Bar Code Reader & Text Reader
Start Here

[Scanned Bar Code Data List] window
. . ..P.11-17
[Scanned Bar Code Data Details]
WINAOW ...oererreereese e nnenees P. 11-17
[Text Scanning] window ........ P. 11-19
[Scanned Text List] window

. ..P.11-20
[Scanned Text Details] window
.................................................. P. 11-20

Scanning Text

Correct Scanned Text

[Text Scanning] window »» Scan
text ) IO§ to move cursor to the
character you want to correct P>
Press the number key
corresponding to the correct
character on the suggestion list
TEpress to toggle between upper
case and lower case.

E sjool
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@ Advanced Features

! sjoo1

Edit Scanned Text

[Text Scanning] window P» Scan

text P (@) PP Edit P» (m) M) Edit

text using keypad

£3To cancel editing and return to
scanned text, press (@), select Select
Recog. Data and then press ().

Set Vertical/Lateral Scan

[Text Scanning] window » (@) »
Vertical Writing or Lateral Writing
30

Using Scanned Data

Access the Internet

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window P Select a URL M (@ M
Internet »» (] ») YES »» (m)

Set Printing Status of Text

[Text Scanning] window » (@] M)

NEGA/POSI Mode »» (] ) Auto

setting, Positive Fix or Negative

Fix »p (m)

€% set to Positive Fix when dark-colored
text is printed on a light-colored
background.

EEset to Negative Fix when light-
colored text is printed on a dark-
colored background.

Make a Call

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window PP Select a phone number
»» @) P» Dialing »» (m] P) Voice
Phone or Video Call »» (®) »» Dial
»» (@) »» Talk »» (=) to end call

Set Guidance OFF/ON

[Text Scanning] window »» (@] P)
Guidance OFF or Guidance ON »»

(w]

Compose a Message

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window PP Select an e-mail
address P (@ ) Create S! Mail »»
(@) » Compose and send S! Mail

1124

Save to Phone Book

[Scanned Bar Code Data Details]

window/ [Scanned Text Details]

window PP Select an item P (@) P»

Add to Phone Book »» (m)

® To select Phone
» Phone » (8] M) New or Add M
(@] (P Search Phone Book P Select
an entry M) (8] (twice)) PP Edit each
item P> (=) (M YES M (m])

® To select USIM
» USIM »» (=] P> New or
Overwrite »» () (D) Search Phone
Book PP Select an entry M) (®] (twice))
» Edit each item P (&) (Db
Overwrite* or Add P (m))

* To select Overwrite, press (®], select
YES, then press (®].




Save a Bookmark

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window P Select a URL M (@] M
Add Bookmark »» (8] (twice) M
Select a folder » (w)

Search Phone Book

[Scanned Text Details] window »»
Select an item »» (@) M) Search
Phone Book ») (8] ») Search
Phone Book

Copy Text

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window P (@) »» Copy » (8] »
Select beginning of characters M
(@] P Select end of characters »»

(w)

Save a Text Memo

[Scanned Text Details] window )
Select an item P (@) M) Add to

Memo ») (m]

Edit Title of Scanned Data

[Scanned Bar Code Data List]
window PP Select an entry P
P) Edit Title P> (8] P Edit title Db

(w]

Delete Scanned Data

[Scanned Bar Code Data List]
window/ [Scanned Text List]
window P Select an entry M)
® To select Delete This

» Delete This »» (] M) YES )) (]
® To select Delete All

» Delete All P> (] D) Enter Security

Code M (®] »» YES M) (m)

@ Advanced Features

a sjool

1125






.Data NManagement

About Data Folder.........cccceeeeernnnncen. 12-2 Managing Memory Cards................ 12-12
Accessing Files ........cccoccecrrreeeericncenn. 12-3 Formatting a Memory Card .................. 12-12
OpPening FileS........covueveeeererrerenseiaeienanne 12-3  Accessing Memory Card Data............... 12-12
Creating ANiMations..........cccceeevevueunnne.. 12-4  Copying Data between Handset &
Using Playlist (Melodies).........c.ocvuen..... 12-4 Memory Card ......cccoeeeeieeeieenieeeieesee e 12-13
Using Playlists (Vid€os) ......c.cccceoeueueemncnses 12-5 Configuring Print Settings of
Editing Files.....cccoovvereeererrnerereresnnaeenes 12-7 IMAagES .. 12-14
Editing Still Images ......ccoecevveeieriinnen. 12.7 Advanced Features.........coocunenneee. 12-15
Editing VidEOS .......cvevvreeeeeeeeeeeeeeseeeeesnens 12-8  Accessing Files........cccvinmnininisisninnnnne, 12-15
File & Folder Management ............... 12_9 EdltlngFIleS ............................................ 12-16
Creating a Folder .........oooveveeeeeerrreeesnnnn. 12.9 ~ Managing Folders..........ccccoocccooiiiinii 12-17
Moving Files to a Different Folder-........ 12-9 Managing Files........ccceieeeiieicneieeeenee 12-17
About Memory Card ..o 12-10 Memory Card ........ccocooveeieereiee i 12-18
Inserting & Removing a Memory
Card. ..o 12-10

124



@ About Data Folder

Use Data Folder to manage data on handset. New data created by handset functions or obtained via the Internet or mail

are saved to different folders according to the file format.
@ Some folders contain links. Use the links to access download sites in Yahoo! Keitai.

Folders & Files in Data Folder

My Picture Melody S! Appli Ring Songs + Music
Image files such as those Melodies and audio Downloaded S! Appli Chaku-Uta®,
taken by camera and files recorded by Voice and Lifestyle-Appli Chaku-Uta Full® and
downloaded My Pictograms Announce downloaded music files
Videos Books TV
Video files such as Downloaded book Recorded programs' and
those recorded by files still images captured
camera/Downloaded from programs?
video files

1 Can be saved on memory card only.
2 Can be saved on handset only.

! jusawabeuel) eyeq

When Data Folder memory is full or number of files savable is reached, a message asks whether to delete unnecessary data (note,
however, this message may not appear depending on the data type). Follow the steps below to delete data:

YES »» (m]) M) Select a folder P» (m] D) Select a data item P» (=) M) » YES M (m])

@ You may need to select a data type before selecting a folder if the data you want to delete has multiple storage areas.

@ You may need to select more than one data item to delete depending on the degree of insufficient memory.
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@ Accessing Files
. . Functions in My Picture Functions in Melody
Opening Files Window Window

» Data Folder » Selecting a file in My Picture folder Selecting a file in Melody folder opens
@ E] opens a window such as below. a window such as below.

) select a folder and a sub
folder » (m)

2] & Tracke2
13/ & Track03
|4 & Track0d

File List Window

Sound 1

3

]

.T o F.I M c d — AMVOLUME [PISKIP
o Open a File on Memory Car My Picture Window Melody Wind
» microSD »» (m] ' ' ' elody Window
The following operations are possible  The following operations are possible

O
o
-,
o
. =
E)select a file » (u) in My Picture window. in Melody window. 5
o
Switch Files = Switch Files = e
NOW PLAYING Toggle Normal Adjust Volume [s] 3
s Screen and Full e
Screen Stop (=) A

Zoom In/Zoom Out* ((m] M (¥ or End 7 G

Show at Actual Size* |(m] )

Scroll Large-sized or | K3
Zoomed-in Image*

Opened File Window * Press (W] to return to the original size.
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@ Accessing Files

Tip

Selecting a file in S! Appli folder
activates S! Appli. For details on

S! Appli, see P. 9-8.

Selecting a file in Ring Songs - Music
folder or Videos folder activates Music
Player. For details on Music Player, see
P. 9-3.

! jusawabeuel) eyeq
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Creating Animations

Create animations each of which is
made of up to 20 frames using still
images in My Picture folder.

) (=] » Data Folder » (u] »
My Picture » (®] »
Original Animation ) ()

mm Original Animation1/2

Original Animation List Window

) <New> » (u]

E)select a frame » (8] »
Select a folder » (®] »
Select a still image » (m]
Repeat this step to assign a series
of images to their respective
frames.

HTo Cancel an Assigned Image
)) Select a frame »» (8] ) Release
This ) (m]

Note

* Only images in JPEG format can be used
for creating animations.

» Some images may be unavailable
depending on the image size or file size.

* Images saved on external memory devices
(i.e. memory card) cannot be used.

Tip

+ Select an animation you created in
Original Animation List window and
press (m] to play the animation.

Using Playlist

(Melodies)

Save melodies to Playlist to play back
in the saved order.

) (=] » Data Folder » (8] »
Melody » (8] » Playlist »
» Edit Playlist » (]

HTo Clear Playlist
» (®) P> Release Playlist ») (=] )
YES ) (m]




@ Accessing Files

) select a number » (8] »
Select a folder » (®] »
Select a melody » (m]

Repeat this step to assign other
melodies to different numbers.

HlTo Cancel an Assigned Melody
)) Select a number »» (8] M)
Release This »» (m]

Tip

« Select Playlist folder in Melody and
press (®] to play Playlist.

+ Changing file names of melodies on
Playlist, or deleting melody files clears
Playlist.

Using Playlists

(Videos)
Save videos to a playlist to play them in
the playlist order.

)= » Data Folder » (8] »
Videos » (8] » Playlist »

(w)

Playlist

|5 -IPlaylist5
Playlist List Window

) select aplaylist » (®) »» Edit
Playlist » (m]

[E)select a number » (8] »
Select a folder » (®] »
Select a video » (m]

Repeat this step to assign other
videos to different numbers.

HTo Cancel an Assigned Video

» Select a number M (8] P
Release This »» (8] »» YES )) (u]

Tip
* Select a playlist in Playlist List window
and press (8] to play the playlist.

ﬂ juswabeuely ereq
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@ Accessing Files

Display Settings
< Set I)rlnage Ligc View
Opening Files (* P. 14-4)
% Check File Information
< Change Order of Files
< Set an Image to Appear in Standby
< Set a Video to Appear in Standby

< Set a Melody/Video as Ringtone
(* P.12-15)

Viewing Images
+» Play Animation from the Beginning
% Compose Four Images to Make One
< Set Display Size of an Image
+ Edit Title of an Original Animation
+ Cancel an Original Animation
(* P. 12-15)

Playing Melodies
% Play All Melodies in the Same Folder
Repeatedly

! juswabeue eyeq

(< P. 12-16)

Playing Videos
< Switch Display Format of File List
Window
% Clear a Playlist
(* P. 12-16)
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@ Editing Files

» YES or NO » Adding St
Editing Still Images 40 or (=] Ing Stamps

Basic Flow of Operations

A=) » Data Folder »» (] »
My Picture » (8] » Selecta
folder » (®] » Select an
image » (u]

My Picture Window

» Edit Image » (8] »
Select an editing option »
(=] » Editimage

) (®] to end editing

]

Selecting YES overwrites the
original image. Selecting NO saves
the edited image as a new file in
the same folder.

Note

» Only images with % can be edited.

* Repeated editing may cause deterioration
of image quality or increased file size.

Adding a Frame
DMy Picture] window »

» Edit Image » (8] »
Frame ) (u

) select a frame » (u]

HTo Change Frame
» O

HTo Rotate Frame 180 Degrees
»

HTo Cancel Frame
» (®) » Cancel »» (m]

(3]0
Z)(®] » YES or NO » (u]

B My Picture] window »
» Edit Image » (8] »
Marker Stamp » (8]

) select a marker stamp » (]

HTo Rotate Marker Stamp
» (®] b 90° to right, 90° to left or
180° »» (m)

HTo Enlarge/Reduce Marker Stamp
» ) Scale up or Scale down
» (w)

HTo Cancel Marker Stamp
»

[E) ¥ to select a position » (u]

HTo Paste Another Marker Stamp
» (&) M Select a marker stamp M

(w)
4]0
E(®] » YES or NO » (u]

ﬂ juswabeuely ereq
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@ Editing Files

jusawabeuel) eyeq

Pasting a Text Stamp

A My Picture] window »
» Edit Image » (8] »
Character Stamp ) (u)

) Enter text » (m)

M To Edit Text
» (@) P Character input »» (=] )
Enter text P) (m)

HlTo Change Text Color
»» (®) D) Character Color »» (®] M)
Select a color ») (m]
Press (2] to toggle color palettes.

HlTo Change Font Type
» »» Font Type » (m] )
Gothic or Ming-Cho »» (u]

HTo Change Font Size
) (®) M) Font Size »» (®] M) Select
a font size )) (m)

[E) &5 to select a position » (=]

(4]0
E3(®) » YES or NO » m]

128

Cropping an Image

DMy Picture] window »
» Edit Image » (8] » Trim
away » (m

) select a size » (] ) KX to
position cropping area » (1]

3]0
Z)(®] » YES or NO » (u]

Editing Videos

Clip the desired scenes from saved
videos.

) (=) » Data Folder » (u] )
Videos » (8] » Select a
folder » (] »» Select a video
» (@) » Edit Video » (m]

» Trim Videos » (8] »
Any Size or 295KB ) (m]

The video playback and clipping
start at the same time.

HTo Start from a Halfway Point
»» (] ») At a desired point M) (m]
»

) (®) to stop »
Selected portion plays.
When 295KB is selected, clipping
stops automatically when the size of
clipped video reaches 295 KB.

E)(®) (twice) » YES » (u]

Note

» Only QCIF (176 X 144) or smaller videos
with 3 can be clipped.

» Editing may cause deterioration of
image quality.

© More Features
G@ Advanced

Editing Files

< Retouch an Image

< Adjust Image Brightness
< Rotate an Image

< Change Image Size

< Correct Backlight

+» Refresh Skin Tone

(* P. 12-16)



@ File & Folder Management

Creating a Folder

A (=) » Data Folder » (8] »
Select a folder type » (u]

<Example>When My Picture is
Selected

|2,%2Down | oad Pictures

|2/%2Download My Pict
|3/ 1Inbox
Ci@Camera |
|5/ Mai | Art

|6/ My Pictograms

|20 iPreset Screen

|8/ :0riginal Animation
9 C:microSD

|0 1Frame

| :Stamp

Folder List Window

» Add Folder » (8] »
Enter folder name ) (®]

Tip
* Folders can only be created in handset
Data Folder.

Moving Files to a

Different Folder

EDfFile List] window » Selecta
file » (@ » Move » (]

) Move this » (8] ) Select a
destination folder » (8] »
YES ) (u)

HTo Move Multiple Files
»» Move selected »» (8] M) Select
a destination folder ) (®] )
Select a file »» (W) P> Repeat the
same step to specify other files P
» YES )) (m)

HlTo Move All Files in a Folder
» Move all »» (8] ) Select a
destination folder »» (®) )b YES M)
(w

© More Features

Managing Folders
< Edit a Folder Name
< Delete a Folder
< Delete All Files in My Picture, Melody or
Videos Folder
(% P. 12-17)

Managing Files
+ Edit a Title in My Picture File List
Window
<+ Check Volume of Saved Files
+ Edit a File Name
< Delete Files
(* P. 12-17)

ﬂ juswabeuely ereq

129



@ About Memory Card

! jusawabeuel) eyeq

Save files to memory cards. Still images

and videos shot with handset camera

can be saved directly to memory card.

Data can be copied and moved

between handset and memory card.

Data on memory card can also be

accessed from Data Folder.

@ Handset supports microSD™ and
microSDHC™ memory cards of up to
8 GB (as of February 2009).

@ Be sure handset power is off when
inserting/removing memory cards.

@ Insert memory cards properly. Otherwise,
they cannot be used on handset.

@ Do not affix stickers or labels to memory
cards. As memory cards are very thin
and precise mechanisms, even a thin
sticker or label on a memory card may
cause contact failure or destruction of
data.

@ Keep memory cards out of reach of
infants who may accidentally swallow
them or be injured.

@ Use only memory cards recommended
by SoftBank. Other memory cards may
not work properly and cannot be used
on handset.

@ Do not remove a memory card or power
off handset while writing and reading

12-10

data with that memory card. It may
cause data loss or malfunction.

@ Access to memory cards may be
unavailable when the battery level is
low.

Inserting & Removing

a Memory Card

Insertion
nOpen Slot cover

%) Insert memory card into
Memory Card Slot until it
locks

Insert gently with the printed logo
facing up.

Memory Card
Slot Cover

Tip

« If & appears in Display, there may be a
contact failure. Remove and reinsert
memory card.




@ About Memory Card

Removal

nPress and release
Gently pull out memory card.

Note
* Memory card may break if inserted or
removed with force.

ﬂ juswabeuely ereq
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@ Managing Memory Cards

E)select a file » (]

Formatting a Accessing Memory
09041600
Memory Card card Data é@-- for meeting
= jogging
@ Format memory cards on handset only. nE] )» Tools » (=] »
Memory cards formatted on another microSD Manager » @
device or PC may not work. . Data List Window
@ Formatting a memory card deletes all °M mP'CVtOSD Manager /2
: ] icture .
the data on it. l2Melody Select a data item ) (]
38! Appli .
n@ »» Tools » (&) » g{};ggo?““'“”sm ° 09041600
microSD Manager » [E] iBooks og't’:g;s’e for meeting
o gghﬁng Eliook aﬁesory
- one
-4 » microSD format » @}gbgouL?st om et on Date
v (m] » Enter Security Code » [0utoox eriod
=z 2009/ 4/16 15:30
g (@) » YES » (m] microSD Manager Window hafge Sttt
Q Priority
Q  Note ) select a category » (u] .
‘% + Do not remove memory card while To Do List Data Details Window
3 formatting. Handset/memory card Nw09041600
= " |2.7/09041601
malfunction may occur. 13109041602
m » Make sure that there is no important |4/7109841603
data left on the memory card before

formatting it. File List Window

12-12



% Managing Memory Cards

Copying Data between

Handset & Memory Card

Following items can be copied to/from
handset and memory card:

PIM Data Phone Book entries,
Schedule, To Do List,
text memos, Inbox,
Outbox, Draft,
bookmarks, content

keys

) Copy this » (u]

HTo Copy Multiple Data
»» Copy selected »» (] M) Select a
data item »» (®] M) Repeat the
same step to specify other data M)
» YES ) (m]

HlTo Copy All Data
»» Copy all »» (] M) Enter Security
Code »» (] »» YES )) (m]

Files in Data
Folder

Still images, My
Pictograms, Flash®,
melodies, videos, songs

Copying Handset Data to
Memory Card

Copy Phone Book entries, Schedule,
messages, images, videos, etc.

<Example> Copy data in Data Folder
to memory card

) pata List] window » (@] »
Copy to microSD )) (u]

Tip

« If the maximum storable number of
items is reached when copying all
items, copying stops at that point.

« Content keys are copied collectively at
one time.

« Files attached to messages may be
deleted.

* You need to select a destination folder
when copying data in Data Folder.

+ Data saved in Pre-installed folders of
Data Folder cannot be copied.

Copying Memory Card
Data to Handset

OTo Copy Images or Other
Data to Handset

A (=) » Data Folder » (w] »
Select a folder type » (8] »
microSD » (®] ) Select a
folder » [®] » Select a data
item » (@) » Copy to
Phone » (u]

) Copy this » (u]

HTo Copy Multiple Data
»» Copy selected »» (8] M) Selecta
data item P> (m] M) Repeat the
same step to specify other data M
» YES ) (m)

HlTo Copy All Data
»» Copy all »» (] M) Enter Security
Code »» (] »» YES )) (m]

ﬂ juswabeuely ereq
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@ Managing Memory Cards
OTo Copy PIM Data to Handset - - - ) Print » (] ) Print Sheets
<Example> Copy Data in Overwrite conflgurlng Print » E] » Enter number of
Mode Settings of Images prints ) ()

@ » Tools » (8] » Specify which images on memory card a Date »» (®) )» ON or OFF
microSD Manager » IE] )»  to be printed and the number of » (m)
Select a PIM data type » @ prints, etc. in DPOF (Digital Print Order
» Select a dataitem » » Formf;t) settings so that the images can B
Copy/OW to Phone » E] be printed by DPOF compatible

printers or print service shops.
) Copy This » (u] © More Features

) (=] » Data Folder » (u] »

HTo Copy Multiple Files .
[v) »» Copy selected »» () M) Select a My Picture ) (8] »
9 file »» (8] ) Repeat the same step microSD » (] »» DCIM »»  Memory Card
; to specify other files b (w] N &:ﬁigvggfgle Memory Space of
2 .1;;’ g_gpy 2',', F::“@ ) select a folder » (m]) » < Check & Repair Memory Card
a i Select a still image » »» < Delete Data on Memory Card
] Enter Security Code » (m] » DPOF setting » (8] + Cancel Print Settings of Images
3 YES » (m] )) YES ) (u] (* P.12-18)
3 E)DPOF set One » (u]
L5 . HTo Specify Multiple Images
m : x\/h?jn ctqpylng me_rtnory %ardtgata to »» DPOF set Choice »» (®) )} Select
andset in overwrite mode, the "
corresponding data on handset is ?as::lel ;:;agti :’ e%]f ’;tizﬁeii::hees
overwritten by the copied data. p pecity 9
« If the maximum storable number of »

items is reached when copying all
items, copying stops at that point.

1214



@ Advanced Features

Accessing Files

Start Here

[File List] window ........ccccovuuenne P.12-3
[Opened File] window ............. P. 12-3
[My Picture] window...... ..P.12-3
[Melody] window.... P. 12-3

[Original Animation List] window
...... .P.12-4

[Playlist List] window............... P.12-5

Opening Files

Set an Image to Appear in
Standby

[File List] window/ [My Picture]

window (> Select a file) » (@) M

Set as Display » () »» Stand-by

Display » (8] (»» Select a layout

»» (@) M Confirm preview ) (m))

3 Set images to appear when making
calls or sending messages.

Viewing Images

Check File Information

[File List] window/ [Opened File]
window ()) Select a file) M (@] )
Image Info, Video Info, Melody
Info or Memory Info ») (m]

Set a Video to Appear in Standby

[File List] window P Select a file
» (@) M Stand-by Display »» (s]
»» YES ) (m]

Change Order of Files

[File List] window » (®) M» Sort M
(@) »» Select a criterion M) (W)

Set a Melody/Video as Ringtone

[File List] window/ [Opened File]

window ()) Select a file) M @] »»

Ring Tone ) (®] )) Select an item

» (m)

€2 0nly a melody can be set as a ringtone
from Opened File window.

Play Animation from the Beginning

[My Picture] window » (@) »
Retry »» (m)

Compose Four Images to Make One

[File List] window » (@) »»
Composite Image » (8] ) Select a
position M (8] ) Select a folder M
(m] » Select an image » () »
Repeat the same step to assign
three other images to their
respective positions ) (@) ) (=]
3 0only images in JPEG format can be
used for creating composite images.
&3 Copyright-protected images are
unavailable.
€8 Images saved on memory card cannot be
used.

ﬂ juswabeuely ereq

12-15



@ Advanced Features

B jusawabeuel) eyeq

Set Display Size of an Image

[My Picture] window » (@) ») Set
Image Disp. » (8] »» Normal or Fit
in Display »» (u]

Playing Videos

Edit Title of an Original Animation

[Original Animation List] window
P Select an animation » (@) »»
Edit Title »» @] )} Edit title )» (m]

Switch Display Format of File List
Window

[File List] window »» (@] M List
Setting »» (8] ) Title or
Title+Image » (u)

Adjust Image Brightness

[My Picture] window » (@) » Edit
Image » (m) )» Brightness )» (m]
P ¥ to adjust brightness » (m]
(twice) » YES or NO ») (m]

Cancel an Original Animation

[Original Animation List] window
»» Select an animation » (&) M
Release Animation »» (®) )) YES
» (m]

Clear a Playlist

[Playlist List] window ») Select a
playlist » [®) M Release Playlist »»
(=] »» YES » (m]

Rotate an Image

[My Picture] window » (@) ) Edit
Image »» (8] ) Rotate ) (u]) )
90° to right, 90° to left or 180° »»
(@] (three times) P> YES or NO ) (=]

Playing Melodies

Play All Melodies in the Same
Folder Repeatedly

[Melody] window » (@) ) Set
Repeat Play »» (8] »» ON )) (=]

Editing Files

Start Here
[My Picture] window................ P. 12-7

Change Image Size

[My Picture] window »» (@) » Edit
Image » (8] )» Change Size ) (m)
) Select a size )b (W] (three times)
»» YES or NO )) (m]

12-16

Retouch an Image

[My Picture] window » (@) » Edit
Image » (m] »» Retouch » (] )
Select an effect »» (] (three times)
»» YES or NO ) (m]

Correct Backlight

[My Picture] window »» (@) » Edit
Image » (] »» Correct Backlight
»» (m] (three times) » YES or NO
) (m]




@ Advanced Features

Refresh Skin Tone

[My Picture] window » (®) »» Edit
Image M » Refresh Skin Tone
»» (@] (three times) »» YES or NO
) (=)

Managing Folders

Start Here
[Folder List] window ................ P. 12-9

Edit a Folder Name

[Folder List] window »» Select a

folder » (@) ) Edit Folder Name

»» (@] » Edit folder name ) (]

2 0nly names of user-created folders
can be edited.

Delete a Folder

[Folder List] window ») Select a

folder » @) ) Delete Folder »»

(=] » Enter Security Code »» (&)

(Select delete method »» (®))))

YES » (m]

3 only user-created folders can be
deleted.

EFiles in the selected folder are also
deleted.

3 When files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted,
their settings are reset to default.

Managing Files

Start Here
[File List] window .........ceucn..... P. 12-3

Edit a Title in My Picture File List
Window

[File List] window M) Select an

image file M (®) ) Edit Title ) (m)

»» Edit title »» ()

CETitles of files saved in Pre-installed
folders cannot be edited.

Delete All Files in My Picture,
Melody or Videos Folder

[Folder List] window »» (@] »

Delete all Image or Delete All »»

(=] » Enter Security Code »» (&)

» YES ) (u]

£EWhen files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted,
their settings are reset to default.

Check Volume of Saved Files

[File List] window M (@]
Memory Info ) (u]

Edit a File Name

[File List] window »» Select a file

» (@] ) Edit File Name »» (1] )

Edit file name » (=)

B Names of files saved in Pre-installed
folders cannot be edited.

ﬁ juswabeuely ereq
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@ Advanced Features

B jusawabeuel) eyeq

Delete Files

[File List] window »» Select a file
» (@ M Delete ) (m]
® To select Delete This
M Delete This b (8) P> YES )b (m)
® To select Delete Selected
» Delete Selected »» () M) Select
afile »» (@] M) Repeat the same step
to specify other files P> (=) P> YES M)
(w)
® To select Delete All
» Delete All P (] D) Enter Security
Code P> () »» YES )b (m]

Memory Card

Start Here

[microSD Manager] window
.................................................. P. 12-12
[File List] window .. ..P.12-12
[Data List] window .P.12-12
[Data Details] window ........... P. 12-12

1218

Check Available Memory Space of
Memory Card

[microSD Manager] window, [File
List] window, [Data List] window
or [Data Details] window »
»» microSD Info ) (m]

Delete Data on Memory Card

[File List] window M Select a data
item M (@) » Delete /) (m])
® To select Delete this
) Delete this P> (@) ) YES M (m])
® To select Delete selected
» Delete selected »» (8] M) Select
data »» (@) P » YES ) (m)
® To select Delete all
» Delete all P> (@) W) Enter Security
Code »» (] » YES ») (m]

Check & Repair Memory Card

[microSD Manager] window M

»» Check microSD »» (] ) YES »»

(w]

€3 To cancel checking and repairing a
memory card, press (2] or (—]J.

€2 Some memory cards may not be
repairable.

Cancel Print Settings of Images

(@) »» Data Folder »» (8] »» My
Picture »» (] »» microSD »» (®) )»
DCIM ) (] )) Select a folder »»
(m] » Select a still image » (@) »
DPOF setting »» (8] » DPOF set
One or DPOF set Choice » (8] ()»
Select an image » (8] )» Repeat
the same step to specify other
images »» (@)) " Print OFF or All
Print OFF ) (m)
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Getting Started

Wirelessly exchange files with infrared

compatible devices.

The following data can be transferred

via infrared:

- Still images

- Melodies

- Videos

+ My Pictograms

+ Songs

- Books

- Phone Book entries, Account Details

- Schedule events

+ To Do List tasks

- Received messages, sent messages

- Draft messages

+ Text memos

- Common Phrases (Templates)

- Own Dictionary data

- Bookmarks (Yahoo! Keitai and PC Site
Browser)

Note

* Handset cannot send all still images,
melodies, videos, My Pictograms, songs
or books at one time.

132

Precautions

@ Data may not be sent depending on the
status of the receiving device. Folder
settings of received messages or
bookmarks, etc., or contents of Graphic
Mails may be lost or incorrectly
transferred depending on the receiving
handset model.

@ Handset is out of range during infrared
transmission, so such functions as voice
and video calls, the Internet access and
sending/receiving S! Mails are
unavailable. This may continue even
after infrared transmission is finished.

@ Transferring data may take a while
depending on the amount of data.
Some data may not be received by
handset.

@ During transmission, progress bar
shows approximate number of files
transferred. Note that actual progress
may be faster.

@ Some pictographs and symbols in
messages and Phone Book entries may
not be received by handset correctly.

@ All the still images on handset are
overwritten, even those set as Phone
Book entry images, if handset receives
all still images at once.

@ Align Infrared Ports of both sending and
receiving devices, as shown below.

Within +15°

@ Do not move either device until a
message appears indicating completion
of data transmission. Do not place any
objects between the devices. Do not
obstruct Infrared Ports.

@ Infrared transmission may be disrupted
by direct sunlight, directly under
fluorescent lighting or near other
infrared devices.



Authentication Password
To transfer multiple files at once, the
same authentication password must
be entered on both sending and
receiving devices.

Transferring Data via

Infrared
Sending One File

Send one file at a time from a data list
window/data details window.

) n a data list window, select
a file or open a data details
window » (@) »» Send Ir
Data ) (m]

HTo Send a JPEG Image
In a data list window »
This enables faster transmission.

@) YESs » (=]

Transfer starts.
When the file is sent, a message
appears indicating completion of
transfer.

HMTo Cancel Transfer

» =@

Tip

* In the case of high-speed transmission
of JPEG images, the receiving device
may fail to receive images, even when
the image transmission is successfully
completed by the sending device.

Receiving One File

(=] » Tools » (=] »
Receive Ir Data » (8] )
Receive » (u]

Transfer starts.
HMTo Cancel Transfer

» =@

When file is received » YES
» (m])
File is saved to handset.
File is discarded if no operation is
done in about 30 seconds of
transfer.

Sending All Files

Send all files at one time from a data
list window/data details window.

nln a data list window/data
details window » (@] »
Send All Ir Data )» (®]

) Enter Security Code » (8] »
Enter authentication
password

YES » (m]
Transfer starts.
When all files are sent, a message
appears indicating completion of
transfer.

HMTo Cancel Transfer

» =

ﬂ STV R RETITT s
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Receiving All Files

E) (=) » Tools » (=] »
Receive Ir Data »» (] »
Receive All » (u]

) Enter Security Code » (8] »
Enter authentication
password

E)YES » (u]

Files start being received when the
sending device begins sending.

When an overwrite
confirmation appears »
YES » (u]

Transfer starts.
When files are saved to handset, a
saving completed message
appears.

HMTo Cancel Transfer

» =

134

Note

» When handset receives all files, the
corresponding files on handset are
overwritten. For example, when
handset receives all messages, all the
messages on handset including
protected ones are overwritten; and
when it receives all Phone Book data or
Schedule data, all the Phone Book
entries or events, including those set as
secret, are overwritten.

* Receiving of data ends automatically if
data reaches the maximum storable
capacity.

© More Features
Customize

Phone Book
+» Do Not Send Phone Book Entry Images
via Infrared

(< P. 14-16)



‘\Af/ PC Connection

Connect handset to a PC with a USB

cable to use the following functions.

@ USB cable is sold separately as an
optional accessory.

Function Description

Data transfer* | Transfer Phone Book,
Schedule and To Do
List data between
handset and a PC

(P 13-5).

USB memory Use memory card
inserted in handset as
an external drive of a
PC to read and write
data with memory card

(P 13-5).

* USB driver must be installed in advance.

This product contains software licensed
complying with GNU General Public
License (GPL), GNU Lesser General Public
License (LGPL), etc.

For more details, visit “GPL - LGPLZ(CDWL)
C " at http://ch-mobile.jp/product/gpl/

USB Driver Setting USB Mode

This software is required for your
handset to connect with a PC. First
install on your PC referring to the web
site below for installation details.
http://k-tai.casio.jp/

Data Transfer

Use SoftBank Utility Software to
connect with a PC via USB cable and
use various kinds of data on a PC. See
the following web site for software
details.
http://k-tai.casio.jp/
@ USB Driver must be installed before
using SoftBank Utility Software.
@ Synchronization unavailable for Phone
Book, Schedule, and To Do List.

Set USB mode before connecting
handset to your PC via USB cable.

To use a data transfer tool, or use
handset as a modem for packet
transmission, set USB mode to
Communication Mode.

To access memory card data from a PC
in the same manner as USB memory,
set it to microSD Mode.

) (=] » settings » (m] »
External Connection ) (u]
»» USB Mode Setting » (m]

Communication Mode or
microSD Mode ) (u)

Accessing Memory

Card Data from a PC

Connect handset to your PC using a

USB cable, and access memory card

data from the PC.

@ Set USB Mode Setting to microSD Mode
in advance.

A)IA13d>3UU0)
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\‘A”/ PC Connection
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[} Connect handset to your PC
using a USB cable

This enables memory card data to
be accessed from your PC.

When you are finished,
disconnect handset from the
PC
Follow the procedure for safely
removing external devices (which
differs slightly according to the
operating system), when
disconnecting handset from the
PC.

Note

* Make sure handset and the PC are properly
connected. Otherwise, data cannot be
transferred, and may even be lost.

« If handset's battery is almost or
completely empty, data cannot be
transferred, and may even be lost.
Check handset's battery level and the
power of your PC.

+ Do not remove the USB cable while
copying data from your PC to handset.
If the USB cable is removed during data
transfer, data cannot be transferred,
and may even be lost.

136

Using Handset as

Modem

Use handset as an external modem for

packet transmission.

@ Refer to the instructions of your Internet
service provider or the manual of your
PC for the network connection settings
on your PC.

@ To use “Access Internet” for data
communication, you do not have to
sign up with a service provider. For
information about the service overview,
access points and setting procedures,
contact SoftBank Customer Center,
General Information (P. 15-52).
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{§} Clock, Display & Sounds

Clock
CHAED =) » settings » (8] » Clock » (8]
Hide Clock »» Clock Display »» (8) M) Display »» (8] > ON or OFF )) (m]
Clock Size »» Clock Display »» (8] b} Size »» (] ) Select a size M (m]
Clock Color »» Clock Display »» (8) »» Color »» (8] W Black or White ) (m]
Set Auto Time Adjustment »» Set Main Time » (8] ) Auto Time Adjust »» (8] )» Auto » (=] )
Select a time zone ) (m]
- Press (&) to change city/area name in Time Zone Selection field.
Manually Adjust Time )» Set Main Time »» (8] »» Auto Time Adjust »» (8) Y Manual(Date Time
Set) » (m] )) Select a time zone M (8] M) Enter date and time ) (m)]
- Press [®] to change city/area name in Time Zone Selection field.
A |Summer Time »» Set Main Time » (8) »» Summer Time » (8] )» ON ) (m]
c
“  |Time Zone (Sub Clock) »» Set Sub Clock »» (8] V) Display Method » () )b Always »» (8] ) YES
] .
3 »» (m]) M) Select a time zone ) (]
E' - Press (2] to change city/area name in Time Zone Selection field.
"3" Hide Sub Clock )» Set Sub Clock »» (W) V) Display Method )) (8] )» OFF )) (m]
=
m Summer Time (Sub Clock) P Set Sub Clock » (8] »» Summer Time » (8] )» ON ) (u]
Time Zone Major City (Sub Clock) ) Set Sub Clock »» () > Area Name »» (8] )} Display ) (m]
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{§} Clock, Display & Sounds

Alarm

CEED ® » settings » [®) » Clock » (@)

Set Priority at Alarm Notification Time

»» Alarm Setting »» (®] )» Operation Preferred or Alarm Preferred » (m]

Change Alarm Tone

»» Clock Alarm Tone Set »» (8] M) Select an item »» (®] M) Set an alarm
tone

Auto Power On/Off

Set Auto Power On/Off

(m] »» Settings » () »» Clock »» (8] M Auto Power ON or Auto Power
OFF » (m] »» ON » (8] » Enter time »» (8] M) 1 Time or Daily » (m]

Kisekae Theme

CHED (=) » settings » ®) » Kisekae Theme ) (m)

Set Display Design Collectively

P Select a style »» (W) b YES ) (m]

Check Kisekae Theme Details

P Select a style »»
- Details of some items can be checked/played by selecting an item and pressing (&).

Edit Title of a Style

) Select a style M (@) M Edit Title »» (8] ») Edit title ») (W]
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Save Current Kisekae Theme as W B5I/CA D (Favorites) M (&) ) @) W Take Setting Info ) () ) YES M
Favorite 0

- The current kisekae theme can later be recalled collectively from S&ICAD when
they are changed.

Change Each Item for Favorites W E5/CA D (Favorites) M P Select an item P (8] M) Set an image
Clear All Favorite Settings W B5ICA D (Favorites) M (@) )b Reset Setting Info ») (8] M) YES )) (m]

Display Settings

EEED ®) » settings » () » Display » (1]

Wallpaper »» Display Setting »» (8] » Stand-by Display » (8] » My Picture or
Videos »» [®) ») Set an image/video (M Select a layout M (m] (twice))

Show Calendar in Standby ) Display Setting »» (8] ») Stand-by Display »» () »» Calendar ) (®] »»
Background »» (8] M) Set an image »» Select a layout M) (8] (twice)

- Select No Background if you do not want any image in the background of the

calendar.
- Press (B, use (@) to select the calendar and press (8] to operate it. Use (&) to switch
to the previous/next month. Press (B] to activate Schedule.

Set Random Display of Images in »» Display Setting » (8] » Stand-by Display » (8] » Random Display
Standby »» (W) M) Select a folder M (8] M Select a layout »» (W)
+ Images switch at random each time handset is opened or returns to Standby.
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Set a Wake-up Image

»» Display Setting »» (8] »» Wake-up Display » (8] »» My Picture » (u]
» Set an image

Set a Wake-up Message

Y Display Setting »» (8) »» Wake-up Display » (8] ) Message »» (=] ))
Enter message ) (m]

Set an Outgoing Call/Message Image

»» Display Setting »» (8) V) Dialing, Video Call Dialing or Mail Sending »
(m) »» Set an image

Set an Incoming Call Image/Video

Y Display Setting »» (8] ) Calling or Video Call Calling »» (8] »» Select
Calling Disp. »» (8] »» My Picture or Videos »» (8] M) Set an image/video

Set an Incoming Message Image

»» Display Setting »» (8] »» Mail Receiving » (8] V) Select Receiving
Disp. »» (m] ») Set an image/video

Set an Image for New Messages or
Received Result Window

Y Display Setting »» (8] )» Retrieve New or Mail Rec’d Result )» (8] »»
Set an image

Display Color Scheme

»» Display Design »» (8) »» Color Pattern » (8] ») Select a color ) (8]

Set a Battery Level Indicator/Signal
Strength Indicator Pattern

»» Display Design »» (8] ») Icon Pattern ) (8) ) Battery Icon or Antenna
Icon » (m] )} Select a pattern ) (m]

Change Softkey Color

»» Display Design »» (8) )» Soft Key »» (8] ) Select a color ) (m]

Set Font Type

»» Font » (8] »» Font Type » () »» Gothic or Ming-cho »» (&)
- Alternatively, press and hold in Standby to make font settings.

ﬁ uoljeziwoisn)

Set Font Thickness

»» Font » (] » Thickness »» (8] » Thin or Bold »» (m]
+ Alternatively, press and hold in Standby to make font settings.
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Set Font Sizes Collectively »» Font »» (8] ) Character Size »» () V) Standard or X-large »» (u]

+ Items settable with Separate Setting for Character Size can be set collectively.
- Alternatively, press and hold in Standby to make font settings.

Set Font Size for Each Function »» Font »» (] )b Character Size V) (] V) Separate Setting »» [®) M) Select
Window a window »» (8] )} Select a size )) (m] )

- Alternatively, press and hold in Standby to make font settings.
+ In PC Site Browser, this procedure is available in Small Screen view.

Interface Language ) S:ZER W (W) W H%EE or English ) ()
- To change interface language from Japanese to English:

) (=] M ZZ W (W) W X TL W () W Language V) () W English D) (]
Set Image List View ) Viewer Settings » () ) Picture or Title )» ()

Guard from Prying Eyes »» Screen Filter »» (8] )» ON )) (u]

- Alternatively, press and hold in Standby to toggle Screen Filter on and off.
- Display has a white hue and a narrower viewing angle when on.

- Screen Filter is off when handset is turned back on.

Display Quality »» Image Display Mode »» (8) »» Normal, Vivid or Dynamic » (m]

+ Normal is standard quality, Vivid is brighter quality, and Dynamic is high-contrast
quality.

+ The Visual Image Effect setting in TV Effect has preference for TV display quality.

+ A preview image for each mode appears during selection in Image Display Mode to
check the effect.
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Show Information of Messages »» Mail Rec’d Setting »» (8] W Display Sender or Display Sender/Subject
Received When Watching TV ) (m)
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Backlight

(@] ) Settings » (8) » Display » (8] ) Backlight ) (]

Set Backlight & Power Saving

Y Lighting »» (8] »» ON or OFF »» (] ()) Select time Backlight is lit
(/) »» ON or OFF » [®] () Enter a time before the Power Saver Mode is
activated)

+ When the Power Saver Mode is activated, nothing appears in Standby and Keypad
backlight flashes. Pressing any key cancels the Power Saver Mode.

Set Backlight during Charging

)» Charging »» (8) ) Standard or All Time ON » (m]

Set Whether to Light Keypad
Backlight

> Area » (] ») LCD+Keys or LCD ) (m)]

Set Brightness of Backlight

)» Brightness »» (8] > ON or OFF »» (8] ) Select a Level ) (m]

+ Set Brightness to Level 6 to use Display with the maximum brightness. Backlight is
Level 4 by default. A higher setting reduces battery life.

Shortcuts

(m] »» Settings » (8) » Display ) ()

Set Shortcut Theme

»» Shortcut »» (8] M) Select a theme » (8] ) YES ) (u)
* Press to see details of the selected theme.
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Change Icon Design of a Theme »» Shortcut »» (8) » Select a theme M (& M) Select an icon M (@] ) CHG
Icon Image » (8] » Select Icon Image or Default Icon Image » (8] ()
Set an icon)

Change Order of Icons of a Theme »» Shortcut » (8] )} Select a theme M (&) M) Select anicon M (@) M Sort
»» (m] ) Select a position »» (m]

Copy Icons to Another Theme »» Shortcut »» (8] M) Select a theme M (&) M Select an icon W (@] M
Copy » (] » Copy This, Copy Selected or Copy All »» (8] M) Select a
destination theme M (8] (M) Select icons M (8] M) (&)

- When Copy Selected or Copy All is selected, select YES and press (W] at the end of
the procedure.

Move Icons to Another Theme »» Shortcut »» (®) M) Select a theme M [&] W Select an icon M @) M
Move » (8] »» Move This, Move Selected or Move All »» (8] M) Select a
destination theme »» (8] (») Select icons » (8] » (=) » YES » (u]

Delete Icons of a Theme »» Shortcut »» (8] M) Select a theme M (&) M Select an icon » (@) MW
Delete ) (m)
® To select Delete This
» Delete This »» (8] ) YES )) (m)
® To select Delete selected
» Delete selected »» (8] M) Select icons P> (8] M &) M YES ) (m)
® To select Delete All
» Delete All P (®) ) YES P) (m]

Show New Message Indicator as 3D | > 3D Display Setting »» (8] »» ON ) (u)
Animation
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Menu Display Settings

(=] »» Settings »» (8] »» Display »» (8) »» Menu Display Set ) (m]

List View and Details View

»» Menu Display »» (8] M) List or Detail »» (&)
- Select View for menus from (8] M) Settings M (m]

Set Main Menu Theme

»» Theme » (8] ) Select a theme »» (m]

Change Icon Design (Original Theme)

)» Theme » (8] M) Original Theme »» (8] ) Select a menu item ) (8] H)
Set an image
+ Change Main Menu icons to any preferred image.

Change Background (Original Theme)

»» Theme » (m] )) Original Theme ) (8] »» Background Image » (8] )»
Set an image
- Change Main Menu background to any preferred image.

Reset Original Theme Settings

)» Theme » (8] M) Original Theme »» (8] ) Select a menu item M (@) I
Reset or All reset ») (8] )) YES )) (]

+ This procedure is only available when any Original theme settings have been
changed.

Save Last Selected Menu Item to
Memory

»» Memory Focus »» (8) )» ON » (m]
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I » =

Add a Menu Item to Original Menu »» <Not Recorded> M (&) »» K to select a function ) (8] (»» YES ) (=)
Change Order of Original Menu Items | ) Select an item » (@) » Sort » (8] ) Select a position ) (&)

Cancel Original Menu Items ) Select an item P (@) P> Release or Release All »» (8] )) YES )) (m]
Reset Original Menu »» (@) M Reset Org. Menu »» (®) ) YES )) (m]

Standby Indicators

Enable Indicator Selector (m] »» Settings »» (@) W Display »» (8] ) Icons Setting »» (8] )» ON ) (]

- The indicators at the top of Display are enabled by pressing (@) in Standby. Use 3
to select an indicators and press ®] to access the corresponding function.

Incoming Call/Message Alerts

(m] »» Settings » (8) » Incoming Call ) (=)

Adjust Ringtone Volume »» Ring Volume »» (8] »» Phone, Video Call or Mail »» (] » (] to adjust
volume » (m)

+ When Step is set, the ringtone volume increases every three seconds. When Silent
is set, no ringtone sounds.

! uoneziwolsn)
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Set a Ringtone

) Select Ring Tone » (8] )» Phone, Video Call or Mail »» (8] )» Select
Ring Tone »» (8] )) Select an item »» (W) M) Select a folder M (B ) Set a
ringtone

Set Random Playback of Melodies as
Ringtones

»» Select Ring Tone » (8] ) Phone, Video Call or Mail »» (8] »» Select
Ring Tone »» (8] )» Random Melody »» (8] M) Select a folder » (m]
- Melodies in the selected folder are played at random as ringtones.

Set Ringing Duration of Incoming
Message Ringtone

»» Mail Ring Time » (8] » Mail »» (=] »» ON ») (8] )) Enter ringing
duration

- When OFF is set, no ringtone sounds and handset does not vibrate when receiving
messages.

Set Vibration*

) Vibrator »» (®) » Phone, Video Call or Mail »» (8] M) Select a pattern ) (m]
- When Melody Linkage is set, handset vibrates to the melody set as ringtone.

Set lllumination Color

» IHllumination »» (] )» Set Color »» (8] »» Phone, Video Call or Mail »»
(@) »» Select a color ) (m]

Set lllumination Pattern

) lllumination )» (®) )» Set Pattern »» () ) Standard or Melody
Linkage »» (m)

- Even when Melody Linkage is set, lllumination may not flash to the melody
depending on the set ringtone.

Set lllumination to Flash for Missed
Calls/New Messages

» Hlumination » (8) »» Missed Info »» (8] )» ON ) (]

* When Vibrator is not set to OFF, be careful not to let handset fall off a desk or slide too close to a stove, etc. when it vibrates.

ﬁ uoineziwoljsn)
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Set an Incoming Call/Message Image

)» Select Ring Tone » (8] » Phone, Video Call or Mail »» (8] » Select
Calling Disp. or Select Receiving Disp. »» (8) (M My Picture or Videos M
(m]) » Set an image/video

Show Phone Book Entry Images for
Incoming Calls/Messages

»» Disp. Phone Book Image ) (8] )» ON ) (m]

CHLED ®) » settings » (8] ) slide-style Setting » (1]

Open New Mail Window by Opening
Handset

) Setting When Open »» (8] )) Display New Mail »» (®] )»

Open Missed Calls Window by
Opening Handset

)» Setting When Open »» (8) ) Display Missed Call > (m] »»

Answering Incoming Calls

(=] »» Settings » (8] »» Incoming Call ) (m]

Set to Answer Calls by Pressing Any
Key Except Send Key

»» Answer Setting »» (8) »» Any Key Answer ) (m]

- Answer incoming voice calls by pressing a key from (/7), (m]), (0] - (9, (¥, (297,
(=), [, @, B and K. The any key answer function is disabled for incoming video
calls.

Set to Mute Ringtone by Pressing Any
Key Except Send Key

»» Answer Setting »» (8) M Quick Silent »» (m]

+ Mute the ringtone by pressing a key from (0] - (9], (3¢, 297, (] (for voice calls
only), (), @, & and ¥ or by opening handset.
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[®] » Settings » (8) » Slide-style Setting ) (1]

Set to Answer Calls by Opening
Handset

) Setting When Open ) (8] )» Answer Incoming »» (8] »»
+ When set to OFF, operation follows Answer Setting.

Manner Mode

(m] »» Settings » (8) » Incoming Call » (8] »» Manner Mode Setting ) (8]

Set Manner Mode Type

»» Manner Mode Set »» (8] )} Select a Manner Mode »» (m]
+ When Super Silent is set, all tones emitted through the earpiece are also muted.

Configure Original Manner Mode

»» Manner Mode Set »» (8] ) Original »» (8] M) Set each item »

Set Time for Auto Manner Mode Start

»» Manner Start Time »» (8] »» Start Time Set1 or Start Time Set2 »
> 1 P (m] D) Enter time P (] )b &1 M) (W] W) 1 Time, Daily () or Select
Day () »» [m) »» (Select day M (=) »

Set Time for Auto Manner Mode
Release

»» Manner Release Time )» (B] )) Release Time Set1 or Release Time Set2
» = » @ ) (W) M Enter time > & ) (8] W) 1 Time, Daily () or Select
Day () » (m) »» (Select day » (=) W

Toggle Auto Manner Mode Start and
Release On/Off

»» Manner Start Time or Manner Release Time »» (] ) Select an item M)

- On/off toggles each time you press (). Settings (e.g., time) are not updated.

- Use the following procedure to cancel all settings at once.
» (@) W Release All P (w] )b YES D) (m]

ﬁ uoineziwoljsn)
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Checking Call Logs
[®] ) Settings » (8] » Incoming Call » (a)

Change Colors of Names, Phone »» Disp. Call/Receive No. »» (8] ») Select a color ) (]
Numbers and E-mail Addresses in Call |. pregsing (B toggles the color palette between 16 colors and 256 colors.
and Message Log Windows - To reset the color settings to default, press ().

Sounds

[®] ) Settings » (8] » Other Settings ) (1]
Set to Play Charging Start/End Tones | »» Charge Sound )»» (8] ») ON ) (u]

Sound Emitted at Level 1 for First »» Volume Restriction »» (8] )» ON ) (]

three Seconds - Applies to ring tone and alarm.
- After three seconds pass, ring tone and alarm sounds at set volume.

CHED ®) » settings » (8] » Slide-style Setting » (1)

Set Handset Open/Close Sound »» Slide Sound » (8] »» Open Sound or Close Sound »» (8] »» Melody »
(m] » Select a sound »» (8] D) Ring Time » (®] )) Select time sound
emitted ) (m]

+ Slide and close sounds not emitted when set OFF.

! uoneziwolsn)
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(w) »» Tools » () )» Voice Announce )) (8]

Record Sound to Set as Ringtone or
Outgoing Message

»» Select an item > (8] »» YES »» (8] ) Record sound (for about 15
seconds)
- Press (W] to stop recording.

Play Recorded Sound

) Select an item with “ % ») (m]

Delete Recorded Sound

P Select an item with “%“ M (@] M Erase »» (8) )b YES ») (m)

Earphone-Microphone

(@] » Settings » (8]

Audio Output

»» External Connection )» [B) )» Headset Usage Setting »» (®) )»
Headset+speaker or Headset Only ) (u]

Microphone Setting

»» External Connection )» () )» Headset Mic. Setting »» (8) M) Built-in
Microphone or Headset Microphone ) (8]

Answer Calls Automatically

»» External Connection »» (8] )» Auto Answer Setting »» (8) »» Phone or
Video Call »» (=] »» ON »» (8] M) Enter ring time

Save a Phone Number to Dial with an
Earphone-Microphone

»» Dialing »» () »» Headset SW to Dial )» () »» Voice Call » (m) »»
Select a Phone Book search method »» (8] M) Search Phone Book »»
Select an entry » (8] » Select a phone number » (®]

ﬁ uoineziwoljsn)
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Phone Book

Set Preferred Search Method [Phone Book Search] window (P. 2-21) ) Select a search method » »

OK » (m]

+ To cancel the preferred search method, press in Phone Book Search window,
select the search method with “ %" and then press (2).

Change Group Name [Phone Book Entry List] window (P. 2-21) »» (®) »» Group Setting »» (8] »

Select a group » (8] » Edit group name ) (m]

- The name remains the same only for No Group.

Do Not Send Phone Book Entry (=] » Tools »» (8] M Forwarding Image »» (8) )» OFF ) (u]
Images via Infrared

S! Addressbook Back-up

(=] » Tools » (m))» S! Addressbook Back-up ) (8]

Set Auto Synchronize »» Auto Sync Settings »» (8] »» ON/OFF ») (8] ») ON )» (8] ) Enter
Security Code »» (8] M Set synchronize timing »» (8] () Set synchronize
cycle and day M (®]) M Select synchronize type ) (8] ) YES ) (m]
(twice)

Check Auto Synchronize Settings »» Auto Sync Settings »» (8] )» Confirm Settings »» (m]

! uoneziwolsn)
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Outgoing Calls

CHED ®) » settings » (8] » Dialing » (=)

Save Touch Tones

»» Pause Dial »» (8] » & M Enter touch tone numbers »» (®]
+ Press and hold to enter “P” (Pause).

Set Numbers after “%* as Sub
Address

»» Sub-address Setting »» (8] »» ON )) (u]

Save Area Code and Country Code as
Prefix Numbers

P> Prefix Setting »» () )» Select an item »» (2] P> Enter name M (] )
Enter prefix numbers ») (m]

International Calls

CHED ®) » settings » (8] » Dialing » (8) » Int'l Dial Assistance » (8]

Change International Access Code
Automatically Dialed with “+*

»» Auto Int’l Call Set. »» (8] )» ON ») (8] )} Select a country code ) (8]
W EEESE W ()

+ When OFF is set, the international access code is not entered when you press and
hold (0.

+ Select an international access code you set in IDD Prefix Setting.

Change a Country Code

»» Country Code Setting »» () )» Select an item P &) M) Enter country
name » (8] » Enter country code ) (8]

Save an International Access Code

»» IDD Prefix Setting »» (8] » Select an item »» (2] )b Enter international
access name ) (8] ) Enter international access code )» (m]
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Call Settings
CILED ®) » settings » [®) » Talk » (1)

Set Noise Reduction »» Noise Reduction »» (8] »» ON )) (m]

Set Weak Signal Alarm »» Quality Alarm »» (8] ) High Tone or Low Tone ) (]

- Calls may be disconnected without sounding the alarm when signal suddenly
becomes too weak.

Set Reconnection Tone »» Reconnect Signal »» (8) »» High Tone or Low Tone )) (u]
Set a Hold Message )» Set Hold Tone » (8] » On Hold Tone »» (®) »» Select a hold tone »
(=) (» (=)
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Call Costs

CHIED (=) » settings » () » Call TimelCharge » (8]

Set/Cancel a Maximum Call Cost
Limit*

»» Set Max Cost Limit »» (8] )» Enter Security Code »» (8] ) E2 ) (m] )
Enter cost limit »» (®] »» E3 ») (®] )b ON »» (8] )} Set alarm tone P> Set
alarm volume M (&) (M Enter PIN2 )) (m))

- A call ends automatically and & appears in Display when the total call cost exceeds
the set maximum limit.

+ When the set total call cost limit has been reached, all outgoing calls are disabled. To
enable outgoing calls, set the maximum call cost limit to 0:
»» Set Max Cost Limit P> (8] P Enter Security Code P (w) »» E3 M (@] » Enter
0 » (=) » [& M Enter PIN2 » (u]

Set Auto Reset of Total Call Cost

)» Auto Reset Total Cost ) 8] )) Enter Security Code ) (8] )) Auto
Reset »» (8] )» ON ») (8] )) Enter PIN2 )» (m]

+ When ON is set, the total call cost indication is automatically reset to zero at twelve
midnight on the first day of each month.

* Cost display may not be available depending on your subscription. If unavailable, you will also be unable to set a cost limit.
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Video Calls
(8] »» Settings » (8) » Video Call » ()

Set an Image to be Sent during Video | ¥ Select Image » (8] ) Select an item »» () M) Pre-installed or Original
Calls ) (m]

+ To set an image other than the preinstalled image:
P> Original W (®) P> Change Setting P» (m] PP Set an image

Redial Automatically as Voice Call )» Auto Redial as Voice »» (8] )» ON ) (u)

When Video Call Connection Fails

Set an Image to Appear in Main »» Display Setting »» (8) Y Main Display »» (8) ) Other Side or My Side
Window ) (m]

Automatically Switch to Handsfree »» Hands-free Switch »» (8] )) ON )» (]
Mode in Video Calls
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Global Roaming

(8] »» Settings » (8) » Int’l Roaming Set » (8]

Set Operator

»» NW Search Mode »» (8) »» Manual »» (8) ») Select an operator »» (8]

+ When Auto is set, an available operator is set automatically.
- Use this procedure when handset is out of the service area of the currently used
operator.

Activate Network Re-search for an
Available Operator

»» NW Search Mode »» (8] »» Network Re-search » (8] M) Select an

operator ) (m]
+ An operator is available when NW Search Mode is set to Manual.

Set Priority for Operators

»» PLMN Setting »» () )} Select an operator ) (@) V> Change Priority »
(=] » Select a position on the priority list »» (8] ) (2] » YES )) (u]
- When Auto or Network Re-search is set under NW Search Mode, you are

automatically connected to the highest priority operator among available operators.

Show Operator Name While Roaming

»» Display Operator Name »» (8] V) Display ON )» (u]
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S! Mail Settings
» Mail Setting » (8]

Edit Header/Signature »» Header/Signature »» (8] ) Edit Header or Edit Signature »» (8] (twice)
»» Edit header/signature »» (8] M)
Insert Header/Signature »» Header/Signature »» 8] )) Insert Setting »» (8] M Header or
Automatically Signature » (8] )
Set to Check Delivery »» S! Mail Settings »» (8) »» Delivery Report »» (8] )» ON » (m]
- After a recipient receives your S! Mail, a message titled S/ Mail Report is sent to your
handset.

SMS Settings

) Mail Setting » (8] )» SMS Settings » (8]

Set to Check Delivery )» SMS Report Request »» (8] ») ON ) (u]

+ After a recipient receives your SMS message, a message titled SMS Report is sent to
your handset.
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Set Server Storage Period of SMS »» SMS Validity Period »» (8] »» Select a period ) (&)

Messages - When None is set, SMS messages you send are not stored on the server.

Set SMS Input Language »» SMS Input Character »» (8) V) Japanese (70char.) or English (160char.)
» (m)
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Incoming Message Settings

) Mail Setting » (8]

Customize E-mail Address »» Custom Mail Address »» (8] »» Follow onscreen instructions

Set Priority When Receiving Messages | > Receiving Setting »» (8] »» Alarm Preferred or Operation Preferred »

during Operation O]

Do Not Show Image Indicators »» Image/Keyword »» (8] ) Press 8] to take the checkmark off from
Image Info »

Show Keyword Indicators »» Image/Keyword »» (8] »» Put a checkmark to Keyword Info M Select a

keyword entry field »» (8] M) Enter keyword »» (8] M)

+ When handset receives an S! Mail containing the specified keyword, a keyword
indicator 4P - 42 appears.

+ In case a message contains both the content that matches an image indicator
(P. 5-7) and a specified keyword, the keyword indicator takes priority.

Delete Keywords »» Image/Keyword » (] ) Select a keyword M » Delete Keyword
or Delete All Keyword »» (8] »» YES ») (8] ) Press (8] to take the
checkmark off from Keyword Info »»

Set Manual Receive »» S! Mail Settings »» (8) > Message Download »» (8) »» Manual ) (u]
- The entire text is receivable by user operation.
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Reply Settings

Change Quotation Marks »» Mail Setting » (8] »» Header/Signature »» (8] ») Edit Quotation
Marks »» (8] »» Edit quotation mark »» (®]

Message View Settings & Others
) Mail Setting ) ()

Set Number of Text Lines to Scroll »» Scroll »» () M 1 Line, 3 Lines or 5 Lines »» (]
Set Font Size of Text )» Font Size »» (®] M Select a size M (m]
Set Message List View »» Mail List Disp. »» (8] M 2 Lines, 1 Line or 1 Line+Body » (®] )

Subject, Name or Address )» (]

Play Attached Melodies Automatically | »» Start Attachment (auto) »» (8] )b ON ) (m]
- Automatic play only for received mail.

Check Mail Settings )» Check Settings ) (m]
Reset Mail Settings »» Reset »» (] ) Enter Security Code »» (8] ) YES ) (m]

! uoneziwolsn)
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SMS Server Settings

(8] »» Settings » (8] » Connection Settings ) (8] ) SMS Center Selection ) (8]

Change SMS Center Address

)» 819066519300 »» (8] M) Enter SMS Center address )» (8] ))
International or Unknown )) (8]

+ Address is 819066519300 by default. SMS may become unavailable if Center
address is changed.

Reset to SoftBank SMS Center
Address

)» Reset » (] ) Enter Security Code »» (8] ) YES ) (m]

ﬁ uoneziwolsnd
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Yahoo! Keitai & PC Site Browser

S E R SR E I GIEID Press and hold » Browser Settings »» (w)
S R ISRV Press and hold (7] )» PC Site Browser ) (8] ) PC Site Brw. Settings ) (8]

Set Scroll Unit/Speed

»» Scroll »» (8] »» Whole Page, Half Page or Single Line »» (m]

Set Whether to Show Images or Play
Melodies

»» Downloads »» (8] ) Display Images or Play Sounds »» (] »» ON or
OFF » (u]

Clear Cache

»» Memory Manager »» (8) ) Delete Cache »» (8] ) Enter Security Code
» (m) » YES » ()

Delete Cookies

»» Memory Manager »» (8] ) Delete Cookies »» (8] »» YES )) (m]

Set Whether to Send Manufacture
Number

»» Security »» () Y Manufacture Number )» (8] )» ON or OFF )» (u)

Set Whether to Send Referer

»» Security »» (W) »» Send Referer »» (8] )» ON or OFF )» (m)

Enable/Disable Cookies

»» Security »» (W) M Cookie Settings »» (8] )) Select an option » (m]

Set Whether to Activate Scripts

P> Security »» (W) M) Script Settings » (8] ) Select an option ) (m]

Check Yahoo! Keitai/PC Site Browser
Settings

»» Check Settings or Check PC Site Brw. Set )) (u]

Initialize Memory Status of Yahoo!
Keitai/PC Site Browser

Y Initialized Browser »» (8] M) Enter Security Code » (8] » YES )) (&)
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Reset Yahoo! Keitai/PC Site Browser | » Reset, or Reset PC Site Brw. Set »» (8] ) Enter Security Code » (m] )
Settings YES » (m)

Yahoo! Keitai

Press and hold () » Browser Settings ) (8]

Set Font Size »» Font Size »» (8) ) Select a size ) (|

Set Flash® Sound On/Off »» Flash Sound Effect »» (8) )» ON or OFF ) (m]

PC Site Browser

Press and hold (] ) PC Site Browser » (8] ) PC Site Brw. Settings » (1]

Do Not Show Alert When Activating | »» Warning Messages ) (8] )» OFF )) (u]
PC Site Browser & Switching Browsers

»» Display Mode Settings »» (8] »» PC Screen or Small Screen »» (8] )»

Set Page Layout
Select a size ) (m]

Network Connection Settings

Set Whether to Send Location
Information »» (@] »» Confirm, Send or Not Send »» (]

- Set to Confirm or Send to obtain information.

(m] » Settings »» (W) M) Send Location Info »» (8] ) Enter Security Code

ﬁ uoineziwoljsn)
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Channel List

CHED ® » Tv » (8) » Channel List » (8]

Change Title of Channel List ) Select a channel list > (@) )b Edit Title > (] » Edit title » (m)

Delete a Channel List P Select a channel list P> (®) M» Delete This »» (8] ) YES )) (m]
+ The currently used channel list cannot be deleted.

Assign Channels to Remote Control | ) Select a channel list »» (2] » (®) » Remote Control No. » (=] »

Numbers Select a remote control number »» (8] M Select a channel » (8] )
Repeat the same step M ) YES ) (m)

Delete a Channel ) Select a channel list > (&) M) Select a channel M (@) »» Delete This M
(=] » YES » (m]

- Delete a channel from any channel list except for the currently used list.

Image & Sound

(=] »» TV » (®) » User Settings ) (8]

Set Subtitle Display )» Subtitles »» (8] »» ON (Wide: Bottom), ON (Wide: Top) or OFF )) (m]
Set Sound Effect > TV Effect »» (8) )» Sound Effect »» (8] M) Select an effect ) (m]
Set Visual Image Effect > TV Effect »» (8] W Visual Image Effect )» () )) Select an effect ») (8]

! uoneziwolsn)
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Save Battery by Dimming Backlight

»» ECO Mode » (8] ») YES ) (m)

+ Following these steps when ECO Mode is on will cancel ECO Mode.

Keep Backlight Lighted While
Watching TV

Y Display Light »» (8] »» Constant Light »» (u]

+ ECO Mode must be off to set Display Light.

Set Time Backlight Stays Lit While
Watching TV

»» Display Light »» (8) M) Lighting Duration »» (8] » Enter lighting time

) (m)]

+ ECO Mode must be off to set Display Light.

Show/Hide Icons in Landscape View

»» Icon Always Show » (B8] »» ON or OFF )) (u]
- Icons other than for program title no longer appear if set to OFF.

Set TV to Pause or Continue for
Incoming Calls (Time Shift Playback)

»» Time Shift Setup »» (8) »» Auto ON or Auto OFF )) (®]

Data Broadcasts

(=] »» TV » (8] M User Settings » (8) » Data BC Settings ) (m]

Set Whether to Show Images in Pages
Accessed from Data Broadcasts

»» Set Image Disp. »» (8] »» ON or OFF )) (u]

Enable/Disable Sound Effects of Data
Broadcasts

»» Sound Effect »» (] »» ON or OFF ) (]

ﬁ uoineziwoljsn)
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Set Whether or Not to Show )» Reset Disp. Set. »» (8] »» YES or NO ) (u]

Confirmation Window Again - Once you select YES (By default) in a confirmation window for accessing a web
page from Data Broadcast, the window no longer appears. Use this procedure to set
the window to reappear.

Recording Programs

Continue/End Recording at Low (=] »» TV » (m] M) User Settings » (8] »» Rec. While Low Battery ) (m]
Battery »» ON or OFF ) (u]

Other Settings
(=] »» TV » (®) ) User Settings ) (8]

Check TV Settings »» Check TV Settings » (m]

Reset Channel Settings )» Reset Channel Setting »» () ) Enter Security Code ) (8] M) YES M
(w]

Clear Data Broadcast Memory )» Reset Storage Area »» (8] M) Select an affiliated station »»

- To select Delete This
» Delete This »» (8] b YES P (m]
+ To select Delete All
» Delete All P> () D) Enter Security Code P> (8] M) YES ) (m]

Rest TV Settings »» Reset TV Settings »» (8] ) Enter Security Code »» (8] »» YES ) (m]

! uoneziwolsn)
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Cameral/Video Settings

Reduce Flicker

® Camera Style
[BI-DO-RI Viewfinder] (P. 7-6), [Photo Viewfinder] (P. 7-8), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-10) » Fl » Camera
Settings " P Flicker »» »» Auto, Mode 1(50Hz) or Mode
2(60Hz) »

o Cellular Style
[BI-DO-RI Viewfinder] (P. 7-7), [Photo Viewfinder] (P. 7-9), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-11) » )» Camera
Settings » (8] » Flicker »» (8] » Auto, Mode 1(50Hz) or Mode 2(60Hz)

P (m]

Set Shutter Sound

® Camera Style
[BI-DO-RI Viewfinder] (P. 7-6), [Photo Viewfinder] (P. 7-8), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-10) » [ »» Shutter
Sound » » Select a shutter sound M

o Cellular Style
[BI-DO-RI Viewfinder] (P. 7-7), [Photo Viewfinder] (P. 7-9), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-11) » » Shutter
Sound »» (] )) Select a shutter sound »» (®]

ﬁ uoineziwoljsn)
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Set View When Shooting With ® Camera Style
Handset Closed [BI-DO-RI Viewfinder] (P. 7-6), [Photo Viewfinder] (P. 7-8), [Continuous
Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-10) » Fl »» Icon Always

Show » »» ON or OFF )) (m]

+ The following indicators appear when set to OFF.
@BI-DO-RI Viewfinder
BI-DO-RI indicator
@Movie Viewfinder
Shooting time

o Cellular Style

[BI-DO-RI Viewfinder] (P. 7-7), [Photo Viewfinder] (P. 7-9), [Continuous
Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-11) M » Icon
Always Show )»» (8] »» ON or OFF )) (u]

Set Shooting Interval/Number of Still |® Camera Style
Images for Continuous Mode [Continuous Viewfinder] (P. 7-13) M Bl » Interval/Number MW »

Shot Interval » » 0.5 Seconds, 1.0 Seconds or 2.0 Seconds »
»» Shot Number »» » Set number with [ (Bottom) or [ (Top) M

Jiseeie]
fiEeeeis

@ Cellular Style
[Continuous Viewfinder] (P. 7-13) » (@] » Interval/Number »» (8] »» Shot

Interval » (®)» 0.5 Seconds, 1.0 Seconds or 2.0 Seconds »» (8] »» Shot
Number »» (8] » Enter number ) (&)

! uoneziwolsn)
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File Storage

Toggle Whether to Automatically
Save Still Image/Video

® Camera Style
[BI-DO-RI Viewfinder] (P. 7-6), [Photo Viewfinder] (P. 7-8), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-10) » [E »» Auto Save
Set W »» ON or OFF »»

+ When set on, the still image/video is automatically saved after shooting to the folder
selected in Select to Save.

o Cellular Style
[BI-DO-RI Viewfinder] (P. 7-7), [Photo Viewfinder] (P. 7-9), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-11) M »» Auto Save
Set »» (8] »» ON or OFF » (m]

+ When set on, the still image/video is automatically saved after shooting to the folder
selected in Select to Save.

Set Still Image/Video Save
Destination

® Camera Style
[BI-DO-RI Viewfinder] (P. 7-6), [Photo Viewfinder] (P. 7-8), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-10) » B »» Select to
Save M »» Phone or microSD » ) Select folder M

+ Select INBOX to save to memory card.

o Cellular Style
[BI-DO-RI Viewfinder] (P. 7-7), [Photo Viewfinder] (P. 7-9), [Continuous

Viewfinder] (P. 7-13) or [Movie Viewfinder] (P. 7-11) M ) Select to
Save »» (8] »» Phone or microSD »» (] » Select folder » (u]

+ Select INBOX to save to memory card.

ﬁ uoineziwoljsn)
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Snap Viewer

Hide Guide at Top of Landscape View |® Camera Style
[Snap Viewer] (P. 7-19) » [ » Display Icons » »» OFF »

+ This setting returns to ON when viewer is ended.

o Cellular Style
[Snap Viewer] (P. 7-20) » (®) »» Display Icons »» (8] )b OFF )) (u]

+ This setting returns to ON when viewer is ended.

* When at full size in zoom view, the guide appears even when Display Icons is set to OFF.

! uoneziwolsn)
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{§} Player & S! Appli

Playback Window

Change Playback Window Mode
(Video Playback)

[Video Player Playback] window (P. 9-5) »» (@) M) Action Setting » (=] »»
Screen Setting »» (8] »» Normal Screen Mode (Portrait View) or Full
Screen Mode (Landscape View) ) (8]

Change Design of Playback Window
(Song Playback)

[Music Player Playback] window (P. 9-5) »» (@) M Action Setting »» (m] »»
Change Skin »» (8] )) Select a design »» (®]

Set Image Display Size (Video
Playback)

[Video Player Playback] window (P. 9-5) »» (@) M) Action Setting » (=] »»
Set Image Disp. »» (8] »» Normal or Fit in Display » (=]

When Running S! Appli

(m] »» SI Appli »» (8] )) Settings » (8]

Set Sound Volume

»» Sound/Vib Settings » (8] > Volume » (8] »» (@) to adjust volume ») (=]

Set Vibration

»» Sound/Vib Settings »» (8] M) Vibration »» (8] »» ON or OFF ) (m]

Set Backlight

»» Backlight Settings »» (8] »» Switch ON/OFF »» (] »» Always ON,
Always OFF or Link To Phone Set. )) (]

Set Blinking of Backlight

»» Backlight Settings »» (8] V) Blink »» (=] »» ON or OFF )) (m]

ﬁ uoineziwoljsn)
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{E;:} Player & S! Appli

(8] »» 51 Appli ¥ (8) ) ! Appli List » (8]
Allow/Prohibit S! Appli to Connect to | » Select an S! Appli P> (@) M Security Settings » (8] )» Net Access )» (m]

Network »» All Permit, Prompt at 1st only, Prompt each time or Disable » (m]

Allow/Prohibit S! Appli to Write P Select an S! Appli ¥ (®) M) Security Settings »» (8] )» Write User Data

Personal Information »» (m) M All Permit, Prompt at 1st only, Prompt each time or Disable »»
(]

P> Select an S! Appli P [®) P Security Settings »» (8] ) Reset Security

Reset Security Settings of S! Appli
Set. » (8] )) YES ) (m])

S! Appli Settings
CHED ®) » st Appli » (1) ) settings » (1)

D |Reset S! Appli Settings »» Reset »» (m] )} Set to Default ) [®) ) Enter Security Code M (] »
& YES ) (m]

]

3 |Delete All S! Appli »» Reset »» (] )» Delete All S! App »» 8] M) Enter Security Code » (m]
N » YES ) (a]

=4

o

5
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{§} Entertainment

S! Quick News

EEED (®) » Entertainment » (8] » S! Quick News » (8] ) Settings » (1)

Hide S! Quick News in Standby

)» Standby Settings »» (8] )» Standby Disp. Set. )» (8] »» OFF ) (m]
(twice)

Set Ticker Speed

)» Standby Settings »» () )» Speed Settings » (8] » Fast, Normal or
Slow » (®] (twice)

Set Information to appear in S! Quick
News

)» Standby Settings »» (8) )» Unread & Read Set. »» (8] »» Unread Only
or Unread & Read »» (8] (twice)

Hide S! Quick News Images

)» Set Image Disp. »» (8) »» OFF » (®] (twice)

Reset S! Quick News Registered
Contents

»» Del. Quick News »» (8] )) YES )) (] (twice) M Enter Security Code »»
(@] (three times)

S! Info Channel

(=] »» Entertainment » (8] )) S! Info Ch./Weather )» (8] )) Settings ) (8]

Set Whether to Display Shortcut for
New Received Information

»» S! Information Notif. »» (8] > ON or OFF ) (m]

Set Font Size for Web Pages

»» Font Size »» (®] M Select font size ) (®)

ﬁ uoineziwoljsn)
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CHED ®) » settings » (8] » Display » (8] » Font » (1]

Set Font Size for Ticker »» Character Size »» (8) V) Separate Setting »» (8) M) S! Info Ch. »» (8] )»
Select font size »» (8] )

Weather Indicators

(] »» Entertainment »» (8] ) S! Info Ch./Weather »» () »» Weather Indicator »» (8] )) Settings ) (8]
Set Whether to Automatically Update | > Weather Update »» (8] )» ON or OFF »» (8] ()) YES )) (m))
Weather Information

Set Whether to Display Weather )» Standby Setting »» (8] »» ON or OFF )) (&)
Indicators in Standby

Set Whether to Display Shortcut for | »» Weather Notif. »» (8] »» ON or OFF ) (u]
Received New Weather Information

! uoneziwolsn)
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{§} Other Settings

Text Entry

(8] »» Settings » (8] » Other Settings » (8] ) Character Input Set » (1)

Set Text Input Method

»» Input Mode » (8] » Select an input method » (m]

Set Conversion

»» Conversion »» (®] »» ON or OFF )) (m]

Set to Show T9 Suggestion Words in
Kanji or Hiragana

»» T9 Change Mode » (8] ) T9 Kanji Change Mode or T9 Kana Change
Mode )) (u]

Clear Learning History

P Clear Learned » (8] M Enter Security Code » (m] »»
T9/Conversion/Pic. or Kana/Kanji Change/Face )» (u]

Change Font Size

»» CHG Input Size »» (8] » Select a size ) (®]

Set Auto Cursor Movement in 5-Touch
Mode

»» Auto Cursor V> (8] ) Fast, Normal, Slow or OFF )) (u]
+ Set speed cursor moves when entering characters.

g

(8] » Settings » (8) » Keypad Setting » (u)

Set Key Sound Off

»» Keypad Sound »» (8] )» OFF )) (u]

Change Function Assigned to Shortcut
Key

»» Shortcut-key Setting »» (8) M) Select a function ) (8] ) YES ) (m]

+ Alternatively, press and hold [®] in Standby to set Shortcut-key Setting.
- To return to original settings, press (@), select Reset Shortcut-Key, and press (w].

ﬁ uoineziwoljsn)
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{§} Other Settings

Osaifu-Keitai®

Set illumination for IC Card (@) »» Tools »» (®] »» Osaifu-Keitai »» (®) W) IC Card lllumination » (8] M)
ON or OFF ) (m]
Delete all Lifestyle-Appli (m] » SI Appli »» (W) M) Settings »» () D> Reset »» (] ) Delete All

LifeApp »» [®) »» Enter Security Code » (8] ») YES )) (]

Set Whether to Enable Opening from ((®] » Tools »» (8] ) Osaifu-Keitai )» () V) Interface Settings » (=) »
Browser Enter Security Code »» (8] »» Browser »» (8] »» ON or OFF )) (u]

! uoneziwolsn)
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{§} Other Settings

Resetting Handset

(m] »» Settings » (8] »» Other Settings ) (8

Reset All Settings to Default

»» Reset Settings »» (8] M) Enter Security Code » (] )b YES )) (m]

Initialize Handset to Default Status

M Initialize »» (8] M) Enter Security Code » (8] »» YES )) (8] ) YES M)
(w]

+ When the initialization is completed, handset automatically shuts down and restarts.
+ When handset is initialized, all data downloaded and saved on handset are deleted

and cannot be restored.
+ Your Security Code will also be reset to default.

ﬁ uoneziwolsnd
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Multi Function Combinations

xipuaddy

Function Yahoo! . .
q el S! q Data Optional | Phone | Own Original

Currently Mail | Keitai Appli Settings | 1 ior | TOOIS | ovices | Book | Data |MUSIC| TV |Camera) "\
Active Function menu
Mail Group 0% |0 O ok O 08 O o3 O O O O O
Function
Yahoo! Keitai O |x O ol O o8 |O o3 O O O @) O
Group Function
S! Appli Group o |O X oK @) o8 O o3 @) O O @) O
Function
Settings Group o o O X O 08 X o O O O O O
Function
Tools Group O |0 @) 0% X X @) X X 0% 0% |x O
Function’
TV & MUSIC Group |03 |O* o5 |o® o* |0% |O om @) X X o' |Oo
Function
During a Voice Call |O O X x7 X 0° omnnz o3 o4 X x15 |x O
During a Video Call | x X X X X x 10 Ix X X X X X X
During Packet O |0 O (ol e 08 e) ol O x MEEE 0

Transmission with a

PC Connected

O: Can be activated.

X : Cannot be activated.

1 Except Receive Ir Data and USIM Operation which cannot be activated with another function.
2 Compose Message and Compose SMS cannot be activated at the same time.

15-2

m 3 Audio functions such as those for playing attached melodies and videos cannot be activated at the same time as Music Player or TV.




Multi Function Combinations

Audio functions such as those for playing melodies and videos cannot be activated at the same time as Music Player. TV is
temporarily paused.

S! Appli cannot be activated when Music Player is playing. TV is temporarily paused.

Cannot be activated depending on the function.

Only Pause Dial, IC Card Lock Set., Keypad Sound and Network Status are available.

Receive Ir Data, Voice Announce and USIM Operation are unavailable.

Only the following functions are available: Schedule, Calculator, Dictionary, Text Memo, To Do List, IC Card Lock Set.

(Osaifu-Keitai), S! Addressbook Back-up, Account Details and Voice Memo during a call.

Voice memo during a call is available only when accessed from video call function menu.

Playing messages at Voice Mail Center is impossible.

Caller ID Notification is unavailable.

Restrictions is unavailable.

Common Phrases and Own Dictionary are unavailable.

Only Booking Program List, Timer Recording List and Program Guide (only during packet transmission) are available.
Camera cannot be activated when Music Player is playing or TV is activated.

—
v
w ﬁ xipuaddy



] Software Update

a xipuaddy

Check if software on handset needs to
be updated, and update it through the
network if necessary.

@ Before updating software, turn off
handset and restart it to make sure that
all handset functions have ended.

@ Disconnect the USB cable from handset.
The software update, if it is done with
the USB cable connected, may not be
properly completed.

@ No transmission fees apply to check or
update software.

@ Updating software may take 30 minutes
or so. Wait for the software update to
finish before using handset.

@ Make sure battery is sufficiently charged
before updating software.

@ Update software in a location of good
signal reception. Do not change
locations while updating software.

@ Never remove battery or USIM Card or
turn off handset while updating
software.

@ Other handset functions are available

once the software update is completed.

154

@ Data saved on handset is retained when
you update software. However, data
may be lost depending on the handset
condition (e.g. a malfunction). We
recommend that you make backups of
important data (though it may be
impossible to back up some
downloaded data) before updating
software. SoftBank is not liable for any
data loss.

@ If software update fails, handset may
become inoperable. If this happens,
contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

Updating Software

) (=] » settings » (8] »
Other Settings » (8] »
Software Update » (8]

) software Update » (u]

1l Software Update

update. Continue?

[E)Follow onscreen instructions

O After Software is Updated
After an update completion message
appears, handset restarts automatically,
and update results appear.

1l Software Undate

Software Updated Window

Checking Update Results

) (=] » settings » (8] »
Other Settings » (8] »
Software Update » (B

) Update Result » (u]



Software Update

Using Regular Updates

A confirmation for software update
appears at the scheduled time. Press
(m] or leave handset for a while to start
automatic software update.

@ If other functions are being used at the
scheduled time, software update
cannot start. End all functions to open
the software update confirmation
window (if you keep using other
functions for more than ten minutes
after a scheduled time, software update
is canceled).

—
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Troubleshooting

a xipuaddy

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Cannot turn on |Are you pressing and holding (=] ?| P 1-18 Cannot make |[Is handset out of service area or in -
handset. - calls. a location with a weak signal?

Is battery properly installed? P 1-13
Are you calling using the area -
Is battery exhausted? P 1-22 codey? E g
Is the battery terminal dirty? - Are you covering the area around | P 1-2
It takes a long | It takes time if there are large - the antenna with your fingers?
time to turn on amounts of data (e.g. Phone Book Are you pressing after P33
handset. entries) saved on handset. entering the phone number?
gatrj[not charge |lIs battery properly installed? P 1-13 Is the USIM Card inserted? P1-12
attery. -
Charging Is the AC charger plugged intoan | P.1-16 Has Emission OFF Mode been P 4-8
Indicator does | Outlet properly? set?
not light up.
gntup Is the connector of AC Charger Is a maximum call cost limit set? | P 14-19
correctly inserted into handset?
Cannot make |Is Keypad Lock active? P 4-4
Battery drains | Has the battery reached the end P 1-13 calls using P
too fast. of its service life? Keypad. Is Dial/sending Mail specified to P. 4-3
The battery life may shorten be locked in Custom Lock mode?
depending on the usage - —
environment. Is Restrict Dialing set? P 2-23
Do you use handset where ouT P18 A message is |Did youvinvclude the area code -
appears often? heard saying when dialing a phone number?
that the
The battery operation time P 1-13 number you

fluctuates according to how you
use handset.

have reached is
not in service.
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Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Only a busy Does Network is busy at this - The other Is the earpiece properly placed -
toneis heard  |moment Please try again later party’s voice is |against your ear?
after dialing a  |appear in Display? difficult to hear - -
phone number. - during calls. Is anything obstructing the -

Is the USIM Card inserted? P 1-12 speaker if it is in handsfree mode?
Is handset out of service area or in - Is the earpiece volume properly P.3-3,
a location with a weak signal? adjusted? P. 3-8
Cannot receive |Is handset in Manner Mode? P.1-20 The other Is the earpiece volume properly P.3-3,
calls. - - party’s voice is |adjusted? P. 3-8
The incoming Are you outside the service area or - too loud during
fingtone does where signals are weak? calls.
not sound. ; ;
Have mcor;nng calls been P.4-7 A snapping Are you in a location with weak -
prohibited sound occurs  |signals? This sound occurs when
Is handset in Emission OFF P48 during calls. S|gpals are Wealk and handset
Mode? switches to a different area.
Is Ring Volume set to Silent? P 14-10 Handset is slow | This may occur when there are -
to react when |large amounts of data saved on
OUT appears. | Are you covering the area around P 1-2 keys are handset, or when large amounts
the antenna with your fingers? pressed. of data are being transferred

Are you outside the service area or
where signals are weak?

between handset and memory
card.

Cannot hear
key operation
tones.

Is Keypad Sound set to OFF?

P 14-39

Is handset in Manner Mode?

P 1-20

—
v
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Troubleshooting

a xipuaddy

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Side Keys and  |Is Keypad Lock active? P 4-4 Display Is Lighting under Backlight set P 14-7
Front Keys are backlight does |to OFF?
inoperable not light.
when handset Is Power Save Mode set? P 1-23
is closed. A message The image or video is unavailable -
There is no Has Dial Lock or Keypad Lock P43, appears instead |with the function being used
response when |been set? P 4-4 of an image, when any of the following
keys are video or song. | messages appear.
pressed. Not available and No preview

data

Nothin Is Power Saver Mode activated? P 14-7
appearg in appears The image file may be corrupted. -
Display. If handset is left in a very hot place, - instead of an

it may automatically shut down. image or preview.

If this happens, move handset to a - -

location g{)an appropriate The Flash® If C=) is pressed while a -

temperature (5 to 35°C) and wait appearing in wallpaper Flash® is running it will

for a while until the keys become Standby is pause. ,

operable again. paused. Play continues after a while.
Display is hard  |Is Brightness under Backlight set | P. 14-7 Images shot When shooting images indoors, P 14-31
1o see. to Level 1? with handset  |flicker may occur due to

camera flicker. |fluorescent lighting, etc.
Has Screen Filter been set to P. 14-6 Changing the Flicker setting may

ON?
Set Screen Filter on/off by
pressing and holding (8.

help reduce flicker.

158




Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Still images or | Were the still images or videos P 14-31 Network is This may be due to errors or heavy -
videos shot shot with Flicker not set to busy at this traffic on the voice call lines or packet
with handset | Auto? moment transmission network. Try again after
camera are too |Set Flicker to Auto. Please try a while.
bright. again later Emergency calls to 110, 119 and 118

— - - appears. are still possible.

Still images or | Select settings suited to the P.7-16
videos shot subject or scene. Function End one of the currently active -
with handset cannot functions to continue operation.
camera are operate any
blurred. more appears.
Cannot watch Is handset out of the digital - The earphone- |Has Headset Mic. Setting been P 14-15
TV. terrestrial broadcast service area microphone set to Built-in Microphone?

or in a location with a weak cannot be used.

signal?

Is Digital TV Antenna extended? Other_ These messages appear when you -

function try to use an unavailable function
Are the channel settings done? P.8-5 active Cannot |when another function is active.
- - start appears.
Insert USIM USIM Card is not properly inserted | P. 1-12
appears. or may be damaged. Other
- - function

Insert microSD |Memory card is not properly P.12-10 active Cannot
appears. inserted or may be damaged. operate
Replace with a |Perform a scan disk on memory P 12-18 appears.

new one or
check the disk
appears.

card.

—
v
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Troubleshooting

Problem Possible Cause & Remedy Refer to
Memory This message appears when -
shortage operation is interrupted due to
appears. insufficient memory. Reboot

handset.
Connection Network connection is interrupted -
failed appears. |due to weak signal.

The page you are trying to access -

is very busy. Try again after a

while.
& (Memory The indicator appears when a P 12-18
card indicator | defective memory card is inserted.
marked with ?) |Perform memory card check.
appears.
Osaifu-Keitai® |Has the battery run out? P 1-16
cannot be used.

Has IC Card Lock or Call Remote P11-4

Lock been set?

B xipuaddy
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Text Entry Key Assignments

Key | Kanji/hiragana Entry Mode | Katakana Entry Mode Alphanumeric Entry Mode Number Entry Mode
J BLIZBBLNSZ B FAOIFPAoTH 1 Je—:~1 1 1
=) hELIFT HhFo532 abcABC2 2
TLIEE YIAtEY3 de fDEF3 3
ta) fe5DTED FFYT R4 ghiGHI4 4
5) IKICHRRD FTIIAR/S j k1T JKL5 5
(=N FORNGF J\ETAIRE mnoMNO6 6
FHTOHH RELXET parsPQRS7 7
PIOL® 10 & +v13va138 tuvTUVs 8
=N 5b3Nn3 ZuU)uo9 wxyzWXYZ9 9
(o) DEAD— 032520 0 0+3
- 456 < - 456 75 "
wo ? ! - Space”’ «o ? | - Space’ ,.? 1" -&() ¥ Space #

1 Appears as “~" during double-byte entry.

2 The lower case of “J" can be entered in double-byte mode.

3 Press and hold (%] to enter "+

4 Can be toggled between upper case and lower case.

5 Press (¥]to insert line feed “ 4 .

6 Before confirming characters, press (3§ to display “_,“ and press again in this state to enter ** “or “* .

7 00,2, mand - 7 cannot be entered when entering readings in Own chtlonary or in USIM Phone Book.

ﬁ xipuaddy
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Text Entry Key Assignments

OlIn Single-byte Mode

15-12

Key [ Press Next Key [ Press Next
112|3(4|5|6|7|8|9|0 112(3|(4|5|6|7|8| 9 |0
%’ H|IW[D|A|HB|A|B|C|D|E a'? 1|7 (49| I|#|A|B|C| D |E
a p|lW|>5|&x|sB|a|blc|d]|e o PlAv || #a|blc| d e
et MEIL|F|IT|IF|IGIH]I|J 2| h|(*F|7|5|3|F|G|H I J
a fleg|h|i]] 4 fleln| i [}
TlLU|T|EB|[ZF|K|[L|M|IN|O S|V |y |A|lE|Y|K|L[M] N |O
kil|m|n]|o kK1 |{m| n|o
el B 2| TlE|PIQIR|IS|T 4 (5| F|Y|[T7|MIP]Q|R|] S |T
> plalr|s|t Y plafr] s |t
T B[ R|DIU[VIW|IX]Y S{F (2| X4 /|U[V[IW|l X |Y
ulviw|x]|y ufv]wl] x |y
FlO || N|EF|Z][?2]! |—|/ 6| N || T [AN|R|[Z]?2]! - /
z i
F|H | D|H|B|¥|& ! 7|3 hlx[E[\V]& @
> P () | &£ # | 2 g8lv|(l1])[3]*]z MEE
T » ) ES i 1 3
kS 5(o|a(n|a|1]2]3]4]5 ol ulnlv]o|i|e]a] 4|5
g_ e|/|-|_ nejp| cojp facip [EsHoen
~3 |z |k~ 6|17|18[9]|0 0|7 |7 |V 61718 9 |0
m 8) o ) ww. | com | il | hitps/ [nitpsy

1

OIn Double-byte Mode

Katakana are entered in

double-byte mode when

entering readings in USIM

Phone Book.
Can be entered as double-
byte characters when
entering pictographs is
possible, such as in Text
Memo and Common Phrases.
Press (07 to toggle
between upper-case and
lower-case modes. Pressing
after entering an upper
case character switches to the
lower case character.

: A space is entered for these

key combinations.



Text Entry Key Assignments

In T9 Input Mode

Key K::j:xil::ggga E':::;';:::e Alphanumeric Entry Mode
()| Rowd, 1 Row7, 1 J@21(),-_:" “>&¥ 1 Space
2] Rowh, 2 Row 73, 2 ABCabc?2
Row<, 3 Row't, 3 DEFdef3
) Row’z, 4 Row?%, 4 GHlghi4
5) Row7&, 5 Row7, 5 JKLjKI5
=D RowlZ, 6 Row/\, 6 MNOmMnN o6
Rows, 7 Row<, 7 PQRSpagrs7?
Row*>, 8 Row 7, 8 TUVtuvs
(8J| Rowb5,9 Row3, 9 WXYZwxyz9
o) D' A oIy 0

n—,0 54—,0
12 12 2
3 3 6

- For key assignments in number entry mode,

see the table in “In 5-touch Mode."”

- Numbers do not appear when entering

readings in USIM Phone Book and Own
Dictionary.

- Caps Lock mode: All characters are entered

in upper case.

Shift mode: The first characters of words are
capitalized and the rest of characters are
entered in lower case.

Caps-lock cancel mode: All characters are
entered in lower case.

- Once characters entered in Shift mode have

ul

been determined, the mode is switched to
Caps-lock cancel mode.
When editing a reading, pressing

adds/cancels “* “ or “* ."
Press to insert line feed “ d .*
u"u u°’u u?’u M!’u “. " and ”(Space)”

appear right after a reading or character is
determined.

The lower case of “J " can be entered in
double-byte mode.

“~ " is entered in double-byte mode.
Each time pressed, cycles through
Caps-lock cancel mode — Shift mode —
Caps Lock mode

ﬁ xipuaddy
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Kuten Code List

@Actual Display font may differ in appearance from the following.

® WEEE KRR REE KRR

ge SHLEH  REXEER QBETER  BREEDE R

m7 i A LG 4 4 0 JigHI=] et

geo WELE eI | = JORE  DIREERKPEHLE
ol o IHMEHE MIRKEE B OHE | G
A EERK ~OSRRRWE  BY  EREERE
ge HERE  PBMBITHCERSEEE SRE MHRIREIER
meu adibani: Y YUY iR XBESE
Solc BEHERD BEKKER BEE KRR
ol HEEE BRHER HEKN RERER
mmH ceeee ©eeweer RRRR RRRRRR
ol MOBF os>0 TFF ©@OK3E OEN
g=|x  Xao  skao L @@8Lg HRJ
S~|o we = VR L1+ QOB M EEN
folws wol xoa 44 @@Stg: 284
m5 NS OIS o c I a9 T @E>12i5 &
maux LST oo3 L @QOEMmEY BW
Se|<® MEXE oI L @082 850w
Ealxd WO¥E6Q L3I — | 4++ @@=, Y @—
Ce|~h OS> wsxc [H{4 O~ a2 @l
olob S0 vov¥82 AT ©OXi3IE @I
PEz2 SSNRIESRE 2533 853335853
olo> BUNIH 8Q RANKRZEAD - &
g == IRDPNBCL Q HHEPIRZCHD OW N
S~lEZ2 wROEOPNORY £ HEMNIYC »0O Io
fol—> NUBNGCHAT DAXKDINCHIAL NC ‘o
Zolvs NV NQEER DOKANNRRAR WO >
£v|—= SWOWLBHO  YHARKNIOD <nca
Tol—0 SHIOLSBOL YHARIIDNINDN 233
Lolce BRNMBEOKLEY RRPARUMMN mSx

C-lwo BANNNDI KK RRPALUEMM <<e

olvanN BIRUDHER RONLVIEAH Y&

olc s | . ——VI¥ I ql Y% &= ® 00 o
go|- |1+ ——AO® % U m A + & LAND
8l O:im=v.® P M > ¥ + ~ wWo>o
ms cxi==# . ox D WU § I A o 0OzXa
Lol o F—m—ll, I 4 T o 2O0Z= ®©
S<| v H=—— kO r o0 oo-d>

Fol oo 3 | ~AAXHROM— C> ©—f ~<N¥D

ol o, N oo W@ DL (e © oF

E-Z, AN\ ~1 82061 N -y o —0

of —7 vx ~+HANBK P U N S <+ I

E2tlo-raumswormao—~aumT ©ON®® —QU®<S 0O
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Kuten Code List
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Kuten Code List

Appendix

Fourth digit of Kuten codes

BrInSE R UK EER
B FR A o 1K 553
YO B i 9 e
U PR R EI 8

=R RERER
153 Bt 2 U it K AR R
SRR
Eoaskist Pobaputid i

H R AR S RISIEE
R AR
BEYE R G LS
i SR S K

MK ERESUE R
BEIERMEER
RIS KT K
HEJRPEERn

18 15 18 &=
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L1 S 00 0 O 0 R )R 8 72 S0 410 50 0 At R o S AEC T OGS T DR i KE IR 22 i o

ST TRl CRROHIKER B XEERIRRE  RKESERKE

digit50123455789

1st-3rd

Fourth digit of Kuten codes
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P4 K 0 B AR K
K 41 2 it K 2 K
EEMMEEE?Q
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w% %EE%M
DRDERRIER
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digits |0 1 2 3 4 5 6 7 8 9

1st-3rd

o
o
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o
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Fourth digit of Kuten codes
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4 EH T 108 S
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e I R
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Fourth digit of Kuten codes

1 | 480
B | 481
i
& | 485
Ji:|
E B
&
B
F) 55 | 494

e
R

B
A
4

EEEE o
T
SRR BISEEEE CHA
o EEEC M WRLENEESRER
oK EBISEEE o BIFRE KB R
BE S HREUIME HoREE BN
mgEs HMEREEE MEHES  BEE
PN BB WEEEREE HEasm

N

-
1=
#

digits |0 1 2 3 4 5 6 7 8 9
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Kuten Code List

Fourth digit of Kuten codes
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digits [0 1 2 3 4 5 6 7 8 9

1st-3rd
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Fourth digit of Kuten codes
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Fourth digit of Kuten codes
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EEXEE R T2

digit50123458789

1st-3rd
640

645

©
<
©

650

Fourth digit of Kuten codes
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Kuten Code List

Appendix

Fourth digit of Kuten codes
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Weather Indicators

Indicator List

Normally Displayed

Clear (Day)

Clear (Night)

Cloudy

Rain

Snow

Thunder and Lighting

0% Chance of Rain

10% Chance of Rain

20% Chance of Rain

30% Chance of Rain

40% Chance of Rain

50% Chance of Rain

60% Chance of Rain

70% Chance of Rain

80% Chance of Rain

90% Chance of Rain

100% Chance of Rain

Later

N |V || B | Bel | el | B | = | el | B Bl | Bl | Bl | (60| B | B | |38

Partial

B xipuaddy
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Pollen Typhoon
g Low Forming
] Somewhat High Approaching
= High 9 Emergency Status
Extremely High
Disaster
Sakura Blossoms A Heavy Rain
EY] Budding Strong Winds
[y Near Full Blossom
Full Blossom Topic
Falling Notification
&) Special
Autumn Leaves
& Unchanged
Changing
| Perfect for Viewing
Falling
UV Rays
Weak
= Somewhat Strong
) Strong
7 Extremely Strong




- Enter menu item numbers for direct menu access. Note that Main Menu theme must be set to Standard.

OMail

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Inbox — — Welcome message from CASIO stored P.5-10
Outbox - - - P. 5-10,
P 5-23
Draft — — — P 5-24
Compose Message — — - P. 5-3
Compose SMS - - — P. 5-5
Server Mail Mail List — — P. 5-8
Server Mail Memory - - P. 5-21
Retrieve New - - - P. 5-20
Template — — — P.5-19
Mail Setting Custom Mail Address - — P 14-23
Scroll 1 Line P 14-24
Font Size Standard
Mail List Disp. 1 Line+Body
Start Attachment (auto) OFF
Header/Signature Edit Header, Edit Signature, Edit Quotation Marks: Not Stored, >
Insert Setting: Selected g
Mail Box Lock Inbox, Outbox, Draft, Server Mail: Unlocked P.5-12 g
Receiving Setting Operation Preferred P. 14-23 o
Image/Keyword Image Info: ON, Keyword Info: OFF E-
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Mail Setting S! Mail Settings - Message Download: Auto(All), Delivery Report: OFF P 14-22,
P. 14-23
SMS Settings SMS Report Request: OFF, SMS Validity Period: 3 Days, SMS  |P. 14-22
Input Character: Japanese(70char.)
Check Settings — P 14-24
Reset -
OYahoo! Keitai
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Yahoo! Keitai — — — P 6-3
Bookmark — — One bookmark for accessing CASIO website stored P.6-10
Saved Pages — — —
History - - - P. 6-3
Enter URL - - -
PC Site Browser - - See “©OPC Site Browser” (P. 15-23). P.6-5
Browser Settings Font Size — Standard P 14-27
Scroll Single Line P 14-26
Downloads Display Images: ON, Play Sounds: ON
Flash Sound Effect ON P 14-27
Memory Manager - P. 14-26

Security

Check Settings

Initialized Browser

Manufacture Number: ON, Send Referer: ON, Cookie Settings:
Enabled, Script Settings: Ask NW Access
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Browser Settings Reset - - P. 14-27
OPC Site Browser
3rd-level Menu 4th-level Menu | Menu Item No. Default Setting Refer to
Home - - - P. 6-5
Bookmark - - — P 6-10
History — — — P. 6-6
Enter URL - - -
Yahoo! Keitai - - - P 6-3
PC Site Brw. Warning Messages - ON P.14-27
Settings Scroll — Single Line P 14-26
Display Mode Settings - PC Screen (PC Screen: 100%, Small Screen: Standard) P 14-27
Downloads — Display Images: ON, Play Sounds: ON P 14-26
Memory Manager - -
Security - Manufacture Number: ON, Send Referer: ON, Cookie Settings:
Enabled, Script Settings: ON
Check PC Site Brw. Set — —
Initialized Browser - —
Reset PC Site Brw. Set - - P. 14-27 _°>
OS! Appli S
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to 5.
S! Appli List Download S! App - — P 9-8 x
Download LifeApp - - P 11-3 a
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Settings Sound/Vib Settings - Volume: Level 4, Vibration: ON P 14-35
Backlight Settings - Switch ON/OFF: Link To Phone Set., Blink: ON
Reset - - P 14-36
Information - - — P 9-8
oTVv
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Watch TV - - - P. 8-6
Program Guide — — — P. 8-9
Booking Program List - - — P 8-13
Timer Recording List - - —
Result Timer Rec - - - P.8-19
TV Link - - - P 8-16
Channel List - - - P.8-15
Channel Settings — — — P. 8-5
User Settings Subtitles — ON (Wide: Bottom) P. 14-28
Rec. While Low Battery ON P. 14-30
TV Effect Sound Effect: Auto, Visual Image Effect: Dynamic P. 14-28
ECO Mode - P 14-29
Display Light Constant Light

Data BC Settings

Icon Always Show

Time Shift Setup

Set Image Disp.: ON, Sound Effect: ON

ON

Auto ON
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
User Settings Check TV Settings - — P 14-30
Reset Channel Setting —
Reset Storage Area -
Reset TV Settings -
OCamera
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
BI-DO-RI - - - P.7-6
Photo — — — P 7-8
Serial - - — P 7-13
Movie — — - P.7-10
Bar Code Reader - - - P 11-16
Snap Viewer — — - P.7-19
Movie Viewer — — - P 7-21
OEntertainment
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
S! Quick News S! Quick News List - - P.10-2
Settings See " O Settings under S! Quick News” (P. 15-26). - >
ST'Info Ch./Weather |What's New - - P 103 3
History - g
Register/Cancel — E‘
Get Latest Contents — P 10-6
Settings S! Information Notif.: ON, Font Size: Standard P.14-37 a
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
S! Info Ch./Weathe |Weather Indicator - See " ©Weather Indicator under S! Info Ch./Weather” -
(P. 15-26).
BookSurfing - - P.10-5
OSettings under S! Quick News
4th-level Menu 5th-level Menu | Menu ltem No. Default Setting Refer to
Auto Refresh S! Quick News — OFF P 10-6
General — OFF
Special — ON
Standby Settings Standby Disp. Set. — ON P 14-37
Speed Settings — Normal
Unread & Read Set. - Unread & Read
Set Image Disp. — — ON
Del. Quick News — — —
OWeather Indicator under S! Info Ch./WWeather
4th-level Menu 5th-level Menu | Menu ltem No. Default Setting Refer to
Weather — — — P 10-4
Manual Update — — — P.10-7
Settings Weather Update — ON P 14-38
Standby Setting — ON
Weather Notif. - ON

a xipuaddy
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OTools
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Alarm - 44 Alarm1-10: OFF P 11-14
Schedule — 45 — P 11-6
Calculator - 85 — P 11-13
Dictionary Enter Word - — P 2-29
Text Reader — — P 11-18
Reference History — - P.2-29
Text Memo - 42 - P 11-11
To Do List — 95 - P.11-9
Osaifu-Keitai Lifestyle-Appli — — P 11-3
IC Card Lock Set. |C Card Lock: OFF, IC Lock(Power-off): Maintain P 11-4
Call Remote Lock OFF
IC Card lllumination ON P. 14-40
Interface Settings Browser: ON
S! Addressbook Start Sync — — P 2-26
Back-up Auto Sync Settings — — P 14-16
Sync Log - - P.2-27
Bar Code Reader — — — P 11-16
Text Reader - - — P 11-18
Account Details — 0 — P 1-22
Receive Ir Data — 79 - P 13-3
Play/Erase Msg. - - - P 3-5.
P.3-18

ﬁ xipuaddy
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Play/Erase VC Msg. - - — P 3-5
Voice Memo - 43 - P 11-12
Voice Announce — 91 Voice Announce 1: (Not recorded), Voice Announce 2: (Not  [P. 14-15
recorded)
Forwarding Image - - ON P 14-16
microSD Manager — — — P 12-12
USIM Operation Copy — — p.2-24
Delete - — P.2-33
OData Folder
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
My Picture — 46 - P 12-2
Melody — 16 —
S! Appli — — —
Ring Songs - Music - - -
Videos - - -
Books - - -
v - - -
> 5
T OMUSIC
E 2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
o Download Music - - - P.9-4
x Search Music - - —
m Resume Play - - - P.9-11
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Playlist - - — P 9-6
Inbox - - — P 9-2
microSD — — —
OOwn Data
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Received Calls - 24 - P 3-11
Dialed Calls - - — P 3-10
Blog/Mail Member — 97 — P 5-4
Quick List - — — P.3-12
Common Phrases — 38 Fixed common phases at handset initial state P.2-15
Own Dictionary - 82 - P.2-16
OPhone Book
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
— — - - P.2-19
OSettings
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Kisekae Theme — — — P 14-3
Incoming Call Ring Volume 50 Phone, Video Call, Mail: Level 4 P.14-10
Select Ring Tone 13 Phone (Select Ring Tone: Pattern 1, Select Calling Disp.: Differs according
to the model color), Video Call (Select Ring Tone: Pattern 3, Select Calling
Disp.: Differs according to the model color), Mail (Select Ring Tone:
sound 7, Select Receiving Disp.: Differs according to the model color)

ﬁ xipuaddy
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Incoming Call Vibrator 54 Phone, Video Call, Mail: OFF P 14-11
lllumination 89 Set Color (Phone: Color 10, Video Call: Color 8, Mail: Color |P. 14-11
1), Set Pattern: Standard, Missed Info: ON
Manner Mode Setting 20 Manner Mode Set: Manner Mode, Manner Start Time: OFF,  [P. 14-13
Manner Release Time: OFF
Disp. Phone Book Image — ON P 14-12
Answer Setting 58 Any Key Answer
Mail Ring Time 68 Mail: ON (Ring Time: 05 seconds) P 14-11
Ring Time (sec.) 90 Set Mute Seconds: OFF, Missed Calls Display: Display P.4-7
Answering Machine 55 OFF P 3-4
Disp. Call/Receive No. — Differs according to the model color P 14-14
Talk Noise Reduction 76 ON P 14-18
Quality Alarm 75 No Tone
Reconnect Signal 77 No Tone
Set Hold Tone — On Hold Tone: Tone 1
Dialing Pause Dial 84 — P 14-17
Sub-address Setting — OFF
Prefix Setting - ERS(E (Prefix: 0046010)
%’ Headset SW to Dial - OFF P 14-15
',?, Int’l Dial Assistance - Auto Int'l Call Set.: ON, Country Code Setting: H& (Country Code: |P. 14-17
g_ 81), IDD Prefix Setting: E&F(E (IDD Prefix Code: 0046010)
~3 Video Call Visual Preference — Normal P 3-17
D




2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Video Call Select Image — On Hold, Holding, Substitute Image, Answering Machine, P. 14-20
Preparing, Voice Memo: Pre-installed
Auto Redial as Voice OFF
Display Setting Main Display: Other Side
Hands-free Switch ON
Display Display Setting 56 Stand-by Display: Differs according to the model color, Wake- |P. 14-4
up Display: EXILIM Logotype, Dialing~Mail Rec’d Result:
Differs according to the model color
Backlight 70 Lighting: ON (Light Time: 15 seconds) + Power Saver Mode  |P. 14-7
(Set Light Time: 1 minute), Charging: Standard, Area:
LCD+Keys, Brightness: ON (Level 4)
Display Design 86 Differs according to the model color P 14-5
Font 66 Font Type: Gothic, Thickness: Bold, Character Size: Standard
Shortcut 63 Theme 1 (S! Quick News List, BI-DO-RI, /- J{EFIE) P.14-7
3D Display Setting — ON P 14-8
SB%IR (Language) 15 HAE P 14-6
Original Menu 52 Account Details, Retrieve New, Ring Volume, Vibrator, Alarm, |P. 14-10
Change Security Code
Menu Display Set 57 Menu Display: List, Theme: Differs according to the model color, [P. 14-9
Memory Focus: ON .°>
Viewer Settings — Picture P 14-6 s
Icons 36 - P1-8 3
Icons Setting - ON P.14-10 X
Screen Filter - OFF P 146 a
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Display Image Display Mode — Vivid P 14-6
Mail Rec’d Setting — Display Sender
Call Time/Charge  |Call Data 61 - P 3-11
Set Max Cost Limit — Notify Setting: OFF P 14-19
Reset Total 60 — P 3-19
Auto Reset Total Cost — OFF P 14-19
Clock Set Main Time 31 Auto Time Adjust: Auto, Summer Time: OFF P.14-2
Set Sub Clock - Display Method: OFF, Summer Time: OFF, Area Name: Display
Clock Display 39 Display: ON, Size: Up Small, Color: Differ according to the
model color
Alarm Setting — Alarm Preferred P 14-3
Clock Alarm Tone Set - Sound 10
Auto Power ON - OFF
Auto Power OFF - OFF
Security Function Lock - OFF P. 4-3
IC Card Lock Set. - IC Card Lock: OFF, IC Lock(Power-off): Maintain P 11-4
Call Remote Lock — OFF
> Keypad Lock — After Closed: OFF, Timer: OFF, Lock Key: ON, Security Code: |P. 4-4
L] NO
'8 Emission OFF Mode - NO (not set) P 4-8
3 Secret Mode 20 - P49
X Secret Data Only Mode 41 —
m Reject Unknown — Accept P 4-7
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Security Call Setting W/O ID 10 Unknown, Payphone, User Unset: Accept (Select Ring Tone:  |P. 4-7
Same as Ring Tone, Select Calling Disp.: Same as Display)
Change Security Code 29 9999 P 1-21
IC Card Authentic. - OFF P 4-6
PIN Setting — — P 4-2
Slide-style Setting | Setting When Open - Answer Incoming, Display New Mail, Display Missed call: OFF |P. 14-12
Slide Sound — Open Sound: Open 1 (Ring Time: 2.0 seconds), Close Sound: |P. 14-14
close 1 (Ring Tone: 2.0 seconds)
Keypad Setting Keypad Sound — OFF P 14-39
Shortcut-key Setting — Schedule
External USB Mode Setting — Communication Mode P.13-5
Connection Headset Usage Setting — Headset + speaker P 14-15
Headset Mic. Setting — Headset Microphone
Auto Answer Setting - Phone, Video Call: OFF
Connection SMS Center Selection — 819066519300 P 14-25
Settings Certificate - All Certificates: Valid P 6-13
Retrieve NW Info - P.1-18
Send Location Info — — Confirm P 14-27
Int’l Roaming Set  |NW Search Mode - Auto P 14-21 -5>
PLMN Setting - B
Display Operator Display OFF 3_
Name X
Optional Services | Caller ID Notification 17 Activate/Deactivate: ON P 3-21 a
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Optional Services | Voice Mail/Divert — — P 3-14
P.3-15
P.3-19
Call Waiting — — P 3-20
Call Barring — - P 3-21
Other Settings Charge Sound — ON P 14-14
Battery Level 71 — P 1-22
Network Status — -
Character Input Set 35 Input Mode: 5-touch, Conversion: ON, T9 Change Mode: T9 |P. 14-39
Kanji Change Mode, CHG Input Size: Standard, Auto Cursor:
Normal
Volume Restriction — ON P 14-14
Reset Settings 23 - P 14-41
Initialize — —
Software Update — — P 15-4

B xipuaddy
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Main Specifications

Model 930CA
Dimensions (H x W x D) 50X 112X 16.5 mm
Weight 138¢

Continuous Standby Time

Approx. 540 hrs

Continuous Talk Time

Voice Call: Approx. 215 min.
Video Call: 100 min. or more

Charging Time

Max. 120 min.

Camera Video recording |Handset: Up to approx. 276 sec.?
time Memory card: Up to approx. 120
min.2
Video file format| MP4
v Continuous Approx. 155 min.
watching time | Approx. 230 min. (ECO
Mode)
Maximum Depends on the memory card
recording time | capacity(300 min. per 1 GB)
Chaku-Uta® Storage Capacity | Phone: 180 MB/Up to 100
and Chaku- files
Uta Full® Memory card: Depends on

the memory card capacity

Display Type TFT 262,144 colors
Size Approx. 3.0 inches
Pixels 409,920 pixels
(854 x 480 dots)
Camera Imaging device |CMOS

Effective pixels

Approx. 8.09 million pixels

Recording pixels

Approx. 7.99 million pixels

Zoom (digital)

Up to approx. 3 x

Still images

Up to approx. 1,000 files'

Still images for
continuous shooting

5 to 10 files?

Still image file
format

JPEG

In case the image size is QVGA(Wallpaper) and the image

quality is set to Fine (the file size is 10 KB).

Time for recording when recorded in the following conditions:
Handset | memory card
Image size SubQCIF(Mail S)
Image quality Normal
File size 2MB | Long Time
Recording type Normal
Shared with images, videos and saved pages.

ﬁ xipuaddy
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Center Front Key

PC resin

Vapor deposition
+ acrylic UV-
cured coating

15-36

Shutter key PC resin Vapor deposition
+ acrylic UV-
cured coating
Camera lens frame metal | ABS resin Vapor deposition
(outside) + acrylic UV-
cured coating
Camera lens frame metal  |Aluminum alloy |Alumite
(inside)
> Strap Pin Aluminum alloy [Alumite
% Battery Screws Iron Nickel plating
g compartment [Cover PC resin Acrylic UV-cured
o coating
o Terminal Copper alloy Gold plating

q Where Used Material Finish
Handset Materials Battery (terminal) Epoxy resin Gold plating
(glass epoxy)
Where Used Material Finish Digital TV Tip ABS resin, Nickel plating
Outer casing | Display PC resin + Acrylic Uv-cured | |Antenna bronze
surface stainless plating |coating Antenna PA, SUS —
Display back [SUS back Electrodeposited
coating
Keypad PC resin + Acrylic UV-cured
surface stainless plating |coating




Maximum Number of Storable

Maximum

(20 sec. each)

Item N':la‘j(r::g::] That Can be
Protected
Answering Machine Voice calls: 5 -
(20 sec. each)
Video calls: 2

Dialed Calls 30 -

Received Calls (Including |30 -

Missed Call)

Speed Dial 10 (Entry Number —
000-009)

Items
Item Maximum Twaaizx(ii?: It?e
Number Protected
Phone Book entries 1,000" —
Schedule 2,500 —
To Do List 100 -
Mail Received 1,000% 34 1,000?
messages
Sent 400234 200
messages
Draft 202 -
messages
Bookmarks |Yahoo! Keitai | 100° -
PC Site 100° -
Browser
Saved Pages 1002 50
S! Appli 962 -
Melodies 4002 -
Songs 1002 -
Template (Graphic Mail) 456 -

1 Up to 50 entries can be saved on USIM Card.
2 The actual number that can be saved or protected may be less

depending on the data size.
3 An additional 10 received and sent SMS messages can be

saved on USIM Card.

4 Up to 100 additional messages/files can be saved in Secret

Folders.

5 Up to 10 additional files can be saved in Secret Folder.
6 Includes data stored by default.

ﬁ xipuaddy
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Specifications

Memory Card Folders & Files

Folder File
DCIM XXXCADCF Still images captured with handset camera
PRIVATE |MYFOLDER |Mail Inbox Backup data of Inbox
Sent Messages Backup data of Outbox
Drafts Backup data of Draft
Utility Calendar Backup data of Schedule
Contacts Backup data of Phone Book
Memo Backup data of Text Memo
Rights Backup file of content keys
Tasks Backup file of To Do List
My Items Book Books
Bookmarks Backup file of Bookmarks
Flash(R) Flash® files
Games and More S! Appli files
> Music Songs
§ Pictograms My Pictograms
g_ Pictures Still images
X Sounds & Ringtones  |Melodies
m Videos Videos
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Folder File
PRIVATE |MYFOLDER |CA_Folder Other files
SD_VIDEO |MGR_INFO TV Program recording management file
PRGXXX TV Program recording files

ﬁ xipuaddy
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AUTO-SOIt ...oovviiiiieeeeeeee e 5-12

Alarm Activation Operations

Number
2-touch Mode .....cccccvecevveeveerienen. 2-16
3D Display Setting .....c.cccccveveeeens 14-8
5-touch Mode .......ccoccvveniiiicne 2-13
A
Access Files ....ooovvvriveeviieeieeeceeene 12-3
Access Handset Functions ............... 2-2
Access the Internet
From Bookmarks ............cceeeennnn 6-10
From Data Broadcasts .................... 8-8
From Entered URL Record ............ 6-12
From Scanned Data
From TV Links .......
From URL in Text ... .
From Web Page ........ccccccoevvinnnn.
PC Site BrOWSer ......cccooovvvviieiinnns
Using Access History ...........ccccoc.. 6-3
Using URL History ........cccoocveviains 6-6
Yahoo! Keitai ........
Account Details
Add folder
Bookmark ........ccccceviiiiiiiii 6-16
Data Folder ..........cocoovviiiiie 12-9
Messages ........cccooiiiiciiiiiici 5-23
After Sales Service .....cccoevevernnnne 15-51
Alarm ... 11-14

Alarm Notification Operations

Answer Setting
Answer Video Calls ..
Answer Voice Calls ...
Answering Machine
Activate When Call Arrives
Play/Delete Messages

Any Key Answer
Attach to Mail

Delete Attached Files ..

Shoot Image/Video
Authentication Password
Auto Answer Setting

Auto Power On/Off
Auto Redial as Voice ...
Auto Reset Total Cost

Backlight .....ccoovevieiiieeeeee,

Bar Code ....coovvriiiiieeceee e,

Bar Code Reader .......cccceeuveuenee.
Check Scanned Data
Delete Scanned Data

Basic Key Operations
Battery ....oocoooeveiieeeeeeeee
Installation ..........cccoooveiiiiiie
Blog/Mail Member ........cccccoovevennne.
Add ADdresses .........ccceeeveeeeiieennn..
Delete Addresses ...
Edit Address ..........
Specify Recipients .. .
Booked Programs ........c.ccceceeveeenen.
Change Order ......cccccovvviieninnn.
Delete ..o
Bookmarks .....cccceecieicieniineeee
Access Page ..o
Add Folder ..........ccccooeviiiiiiii,
Delete .........
Delete Folder ...
Edit URL ...... ..
MOVE ..
Number of Bookmarks ................. 6-16



SAVE it
Save Scanned URL
Send by Mail 6-16
Sort Folder .. ...6-16
BOOKS ..ot 10-5
BookSurfing® ......cceeeeeeeeeereerennas 10-5
C
Calculator ...vcvveeeceereee e
Call Barring .. .
Call Forward .......ccceevevvieeeceeenen.
Call Rejection
Call Time/Charge ......cccoeeevveneenenee. 3-11
Call Waiting ....cceeeeeveeeeeneeeeeee, 3-20
Caller ID ....ccvveieenee. 3-16, 3-21
Calling While Abroad ... 3-13
Camera ....ccceevvvceeeenne .72
Add Frame ........ccoeveeiiiiee 7-14
AUto TIMEer ..o 7-14
Best Shot ... 7-17,7-18
Brightness ........cccocoeiirnnn. 7-17,7-18
Camera Menu Settings ................ 7-16
Camera Mode ..............c...... 7-16, 7-18
Camera Style ..o 7-3
Cellular Style ... .7-4
Color Mode Set ....... 7-24

Continuous Shooting ................... 7-13
Image Size ......cccoviiiiiiins 7-17,7-18

Memory INfo ....cooviiiiii 7-24
SEttiNgS ..veviii e 14-31
Shooting in BI-DO-RI/Photo ............ 7-6
Shooting Videos .
Viewfinder ........ccoocoviiiiiiiiiin
Center Access Code ......ccevvriernnenne 1-21
Certificate .....ccccvvvvererinececeeee 6-13
Change
Entry Number ..., 2-31
Font Size (Message Text) .............. 5-25
Graphic Mail Effects ...........c........ 5-18

Network Password ............cccco.... 3-21
PINT/PIN2 ..o 4-2
Security Code .....ooovviiiiiiiieiien 1-21
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Warranty & After Sales Service

A warranty card is included with 930CA.

@ Check that the store name and purchase date sections have
been filled correctly.

@ Read the card carefully and store it in a safe place.

@ See the card for the warranty period.

Note

» SoftBank assumes no responsibility for any damages incurred
by you or third parties as a result of losing opportunities to
make calls, etc. due to a failure or malfunction of this product.

After Sales Service

Refer to “Troubleshooting” (P. 15-6) before submitting your

handset for repair.

If problem:s still persist, contact SoftBank Customer Center,

Customer Assistance of your area (P. 15-52), or consult with

your nearest SoftBank shop.

Provide us with detailed information of your problems.

@ Repair within the warranty period is carried out in accordance
with the conditions of the warranty.

@ Repair after the warranty period is carried out if possible, and
the owner of handset is responsible for any repair costs.

@ Data and settings you saved may be lost or altered as a result
of failure or repair of handset. It is recommended that you keep
a backup copy of important data (e.g. Phone Book entries,
image and sound files). SoftBank assumes no responsibility for
any damages due to the loss or alteration of handset data.

@ Disassembling or modifying handset may constitute a violation
of Radio Law. Your handset will not be accepted for repairs if
it has been modified.

Disclaimer

» SoftBank assumes no responsibility for damages arising from
natural disasters beyond the control of SoftBank including
earthquake, lightning, wind or flood damage, actions of third
parties, or other accidents, or from intentional misuse or negligent
use, misoperation or otherwise abnormal conditions of use.
SoftBank assumes no responsibility whatsoever for incidental
damages (including alteration or loss of stored content, loss of
profit, interruption of business) arising from the use or failure
of this product.

It is recommended that you keep a backup copy of important
data (e.g. Phone Book entries).

SoftBank assumes no responsibility whatsoever for damages arising
out of non-observance of the descriptions given in this User Guide.
SoftBank assumes no responsibility whatsoever for damages arising
out of any malfunction as a result of combination with connection
devices or software with which SoftBank has had no involvement.

It is recommended that important data be stored on computer
hard disk or other medium. Even in the event of alteration or
loss of stored information content, please be aware that
SoftBank assumes no responsibility for data regardless of the
cause of the failure or trouble.

Tip

» For information on after sales service, contact your nearest
SoftBank shop or SoftBank Customer Center, General
Information (P. 15-52).

ﬁ xipuaddy
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If you have any questions about SoftBank handsets or services, call General Information. For repairs, call Customer

Assistance.
SoftBank Customer Centers SoftBank Global Call Center
From a SoftBank handset, dial toll free at 157 for General From outside Japan, dial +81-3-5351-3491 (Make sure to
Information or 113 for Customer Assistance. dial the correct number. International charges will apply.)

B Call These Numbers Toll Free from Landlines

Subscription Area Contact
Hokkaido, Aomori, Akita, lwate, Yamagata, Miyagi, Fukushima, Niigata, Tokyo, | General Information @ 0088-240-157
Kanagawa, Chiba, Saitama, Ibaraki, Tochigi, Gunma, Yamanashi, Nagano,
Toyama, Ishikawa, Fukui Customer Assistance @ 0088-240-113
Aichi, Gifu, Mie, Shizuoka General Information @ 0088-241-157

Customer Assistance @ 0088-241-113

Osaka, Hyogo, Kyoto, Nara, Shiga, Wakayama General Information @ 0088-242-157

Customer Assistance @ 0088-242-113

Hiroshima, Okayama, Yamaguchi, Tottori, Shimane, Tokushima, Kagawa, Ehime, | General Information @@ 0088-250-157
Kochi, Fukuoka, Saga, Nagasaki, Oita, Kumamoto, Miyazaki, Kagoshima,
Okinawa Customer Assistance @ 0088-250-113

! xipuaddy
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